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Preface
 Java is definitely here to stay. The number of developers working with Javacontinues to increase dramatically, while Sun and other Java developmentorganizations continue to release new developments, such as the JavaFoundation Classes and Enterprise JavaBeans.
 In 1998, the focus of Java development changed somewhat — from applets toencompass servlets and enterprise computing. As a typical Java developer,you no longer whip up a simple applet in an afternoon. Today you need aserious development environment to create large and complex applications.You need an environment with code management, powerful searching andbrowsing, GUI building, and JavaBean creation and manipulationcapabilities. You need an environment that helps you think in terms ofobjects. With the new and improved features of Version 2, VisualAge for Javais the development tool for serious Java development.
 Programming with VisualAge for Java Version 2 shows you how to useVisualAge for Java to develop Java applets, applications, and servlets. Youwill learn the right way of coding with VisualAge for Java and how to use thetool productively.
 How to Use This BookThe book is organized as a tutorial where many chapters build on theexamples in the previous chapters. Specifically:
 ❑ Chapter 6, “Finishing the ATM Application”, depends on the ATM modelyou build in Chapter 3, Beginning the ATM Project.
 ❑ Chapter 7, “Making Your Data Persistent”, Chapter 8, “CreatingServlets”, Chapter 9, “Internationalization” and Chapter 11, “AdvancedTopics” depend somewhat on the code you develop for the Bookmark Listin Chapter 4, “Building User Interfaces”.
 The book is not a complete set of documentation for VisualAge for Java. Usethe online documentation included with the product for specific referencematerial or to see another way of approaching some of the topics.
 © Copyright IBM Corp. 1998 xix
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Conventions Used in This BookBold font is used for headings and things you can select, such as buttons andmenu items.
 Italic font is used for the names of fields in the interface as well as the firstuse of terms.
 Monospace font is used for code samples, project, package, object, attribute,variable, and type names, or anything that you enter.
 Tips are placed throughout the book. Read these to find out how to be moreproductive in VisualAge for Java. “Tips” on page xvii lists all the Tips foundin the book.
 Wherever you see this icon, a new feature of VisualAge for Java Version 2 isintroduced.
 Wherever you see this icon, a feature of VisualAge for Java Version 2 hasbeen improved from the previous version.
 Examples in This BookThe examples in this book are located at the ftp site:ftp.almaden.ibm.com/SG245264 and were created with VisualAge for JavaProfessional Version 2 on Windows NT. If you are using VisualAge for JavaEnterprise, or VisualAge for Java Professional on another platform, you mayexperience differences in creating the examples. If so, please let the authorsknow at [email protected] and the differences will be posted to the ftp site:ftp.almaden.ibm.com/SG245264. The examples were created using the originalreleased version of the product. You should download the available fixpacksfor the product from www.software.ibm.com/vadd. If you install fixpacks, someof the behavior outlined in the examples may change.
 World Wide Web Addresses in This BookThe URLs given in this book were correct at the time the book was created.Given the dynamic nature of the Web, these addresses may no longer existwhen you read this book. Use the search services of the IBM web site or othersearch services to locate the correct sites if they still exist.
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ITSO on the InternetInternet users can find information about redbooks on the ITSO World WideWeb home page. Point your Web browser to:
 http://www.redbooks.ibm.com/redbooks
 IBM internal users can also access redbooks from the internal IBM Redbooks home page:
 http://w3.itso.ibm.com/redbooks
 The ftp server, ftp.almaden.ibm.com, stores the samples from the book. Toretrieve the sample files, check the contents of the /redbooks/SG245264directory for the file: sg245264.zip. Unzip this file into a directory on yourmachine. Any references to the exmaples or samples directory in the bookrefer to this directory.
 If any errors are discovered in the book, the errata will also be in the ftpdirectory.
 VisualAge for Java Service and SupportVisualAge for Java Service and Support is staffed by knowledgeabledevelopers who handle everything from how-tos to complex technicalproblems. The most common way of contacting VisualAge for Java Serviceand Support is through this Web site:http://www.software.ibm.com/ad/vajava. The site has links to newsgroups,fixes, announcements, and other information. Check the site periodically forinformation.
 VisualAge for Java Service and Support monitors several VisualAge for Javanewsgroups:
 ibm.software.vajava.beansibm.software.vajava.enterpriseibm.software.vajava.ideibm.software.vajava.installibm.software.vajava.languageibm.software.vajava.non-technical
 If a new version of VisualAge for Java is being beta-tested, there may also bean ibm.software.vajava.beta forum.
 You can find these newsgroups at news.software.ibm.com.
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IBM employees can also participate in internal VisualAge for Java forums.
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1 Introduction to the EnvironmentVisualAge for Java is an integrated, visual development environment thatsupports the complete cycle of Java program development. With theVisualAge for Java programming environment, you can build 100% pureJava applications, applets, and JavaBean components. Using the true rapidapplication development (RAD) provided by VisualAge for Java, you canshorten the development life cycle of your applications and improve theirtime to market.
 In this chapter you will find a short description of the VisualAge for Javaproduct family and an overview of VisualAge for Java Version 2. You willlearn the basic terms that you need to understand to create your firstprogram. Before you finish reading this chapter, you will have your first Javaprogram up and running!
 VisualAge for Java Product FamilyVisualAge for Java Version 2 is available in three versions:
 © Copyright IBM Corp. 1998 1
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❑ VisualAge for Java Professional
 ❑ VisualAge for Java Entry
 ❑ VisualAge for Java Enterprise
 This book covers the VisualAge for Java Version 2 Professional and Entryeditions without describing the features of VisualAge for Java Enterprise.
 IBM also has several other offerings related to VisualAge for Java, including:
 ❑ VisualAge Developers Domain Subscription for Java, which provides asingle access point on the World Wide Web for everything you need tobuild business-critical Java applications, including Java-related samples,education, support, and the ability to network with a community of Javaprofessionals. VisualAge Developers Domain is also the place forregistered owners of VisualAge for Java products to obtain updates andfixes. For example, as VisualAge for Java updates the Java developmentKit (JDK) and Java Foundation Classes (JFC) it uses, you can downloadthe updates from the VisualAge Developers Domain.
 You can learn more about VisualAge Developers Domain atwww.software.ibm.com/vadd.
 ❑ WebSphere Application Server, which serves as the foundation forbuilding advanced Web sites with true functionality. It includes two keycomponents to help you transition easily from simple Web applications topowerful e-business applications:
 • A secure and scalable runtime environment that supports HypertextTransfer protocol (HTTP), Internet Inter-ORB protocol (IIOP), andEnterprise JavaBeans.
 • An integrated tools environment, IBM WebSphere Studio, where youcan easily create dynamic content and Java-based applications.
 For more information see http://www.software.ibm.com/webservers.
 VisualAge for Java ProfessionalVisualAge for Java Professional features an Integrated developmentenvironment (IDE), which enables you to create classes, or change methods,and then incrementally compile without the need to exit the testing phase ofdevelopment. The IDE includes:
 ❑ Incremental compiler
 Changes to your code are compiled "on the fly" as you work withindividual methods and class declarations. Errors in your code are
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immediately flagged so that they can be fixed while you are concentratingon that part of the code.
 ❑ Repository-based environment
 All of the code in the development environment is stored in a repository.This repository enables incremental compilation and provides for verypowerful search capabilities. The code that you are working with is storedin a workspace. Version management is built into the repository, andversions or editions of code are automatically stored when you change anyprogram element (method, class, package, or project) in your workspace.
 VisualAge for Java Professional is a single-user, repository-basedenvironment. If you work as part of a development team, you may want toconsider using VisualAge for Java Enterprise.
 ❑ Project-based development
 VisualAge for Java provides projects. The basic Java environmentsprovide only the concept of a package to organize your work. In VisualAgefor Java you organize your packages in projects.
 ❑ Source code editor
 A full-featured syntax editor, which helps you write error-free source code.
 ❑ Advanced coding tools such as automatic formatting, automatic codecompletion, and fix-on-save
 ❑ An integrated debugger
 ❑ A Visual Composition Editor, which enables you to develop yourapplication visually
 ❑ A JavaBean creation tool to create 100% pure Java beans that you can usewith the Visual Composition Editor
 New powerful features that come with Version 2.0 of VisualAge for JavaProfessional include:
 ❑ Java Virtual Machine and JDK Release 1.1.6
 ❑ Visual Composition Editor support for the JFC Release 1.0.2 (Swing)
 ❑ Inner class support
 ❑ National language support
 ❑ Tool integration API
 ❑ Database access beans
 ❑ Notes Domino access
 ❑ Interface to external software configuration management tools
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VisualAge for Java Version 2 comes with extensive online, searchabledocumentation and many examples. Click the Help menu item at any time toaccess the documentation.
 Anywhere in this book where new or improved features are discussed, youwill see, to the left of the text, the icons shown in Figure 1.
 Figure 1. Improved and New Icons
 VisualAge for Java EntryThe VisualAge for Java Entry edition provides the same functions asVisualAge for Java Professional, with a limit of 500 Java types (classes andinterfaces). You can get it for free from the Web(www.software.ibm.com/ad/vajava).
 When using the VisualAge for Java Entry edition, you can see how manyclasses you can still create by selecting the Help→About menu bar item.
 VisualAge for Java EnterpriseVisualAge for Java Enterprise is an extremely powerful team developmentenvironment. It extends VisualAge for Java Professional with more features,including:
 ❑ Data Access Builder for accessing enterprise data managed by databaseservers, such as IBM’s DB2, through the JDBC specification for accessingrelational databases from Java programs
 ❑ CICS Access Builder for building Java programs that interface with CICStransactions
 ❑ RMI Access Builder for building pure, distributed Java applications thatuse the Java remote method invocation (RMI) specification
 ❑ C++ Access Builder for building distributed Java applications thatconnect to C++ application servers
 New features of VisualAge for Java Enterprise Version 2 include:
 ❑ Team programming support
 ❑ Servlet building support including form and HTML support
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❑ More access builders: TXSeries and SAP R/3
 ❑ IIOP support for CORBA 2.0 ORBs, specifically for IBM ComponentBroker
 ❑ AS/400 access tools
 ❑ A high-performance Java compiler, for platform-native code generation
 ❑ The Bean Extender, for building more specialized beans from other beans
 ❑ Remote debugging, for debugging Java applications from a remote console
 Updates to VisualAge for JavaUpdates to the different versions of VisualAge for Java are provided at theVisualAge Developers Domain Web site: www.software.ibm.com/vadd.
 Building Your First AppletNow that you have an idea of the capabilities of VisualAge for Java, you canbuild your first applet.
 Before starting, you should familiarize yourself with the terms in Table 1. Ifyou are not familiar with any of the terms in Table 1 or you are new to theJava language itself, try to read some of the resources listed in Appendix Bon page 385.
 Table 1. Object-Oriented Terms
 Term Definition
 ClassA template for creating objects. A class defines thebehavior and properties that are common to all objects ofthat class.
 Interface A specification of behavior that a class must provide if itimplements the interface.
 ObjectAn instance of a class. An object shares the behavior of allobjects of the same class, but each object can have adifferent state.
 Applet A special kind of class introduced in Java. Its instancesusually run in a Web browser such as Netscape Navigator.
 Attributeor field A data variable held by a class.
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Let’s Get Started!Before you go any further, you must have VisualAge for Java installed onyour computer. Your first Java class is a simple applet that displays the textof your choice in the applet’s window. You launch VisualAge for Java bydouble-clicking the IBM VisualAge for Java icon in the IBM VisualAge forJava folder or selecting Start→Programs→IBM VisualAge for Java forWindows→IBM VisualAge for Java.
 If this is the first time you have started VisualAge for Java, a dialog box willinform you that some features are being installed. Next, the Welcome toVisualAge dialog (Figure 3) is displayed. The Welcome to VisualAge dialogbox is shown when you start the VisualAge for Java IDE, unless you deselectthe checkbox at the bottom of the window. Click Close to close the dialog box.
 Accessmodifier
 In Java the access modifiers are public, private, protected,and default or package.
 Methodormessage
 Objects communicate with each other by sendingmessages. When an object receives a message, acorresponding method, defined in the class definition, isinvoked to perform the required task.
 Package
 A collection of Java classes that typically serve a commonpurpose. This is Java’s way of organizing classes intological entities that are easier to maintain and understandthan a huge set of classes at the same level.
 Term Definition
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Figure 2. The Welcome to VisualAge Dialog Box
 Somewhat confusingly, a different dialog, the Quick Start, is available fromthe Workbench→File menu (see Figure 3).
 The Workbench window opens the first time you start VisualAge for Java.The Workbench is where you usually create and manipulate your classes.From the Workbench you can also launch the Quick Start window. Open theQuick Start now, by selecting File→Quick Start from the menu bar.
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Figure 3. The Quick Start Dialog Box
 Using the Quick Start dialog, you can select from three options:
 ❑ Basic: Create a new applet, class, interface, project, or package orexperiment with code
 ❑ Repository Management: Compact the repository (see “Compacting theRepository” on page 165)
 ❑ Features: Add new features to your environment (see “Loading AvailableEditions” on page 162)
 You are going to create an applet so select Basic→Create Applet and clickOK.
 SmartGuidesVisualAge for Java uses SmartGuides (which are similar to Wizards in otherproducts) to help you create Java applets and applications. Clicking the OKbutton on the Quick Start window opens the Create Applet SmartGuide(Figure 4), which guides you through the process of creating your new appletclass.
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Figure 4. The Create Applet SmartGuide
 To create your applet, fill in the text fields (Project, Package, and Appletname) as shown in Figure 4 and deselect the Browse applet whenfinished and Compose the class visually checkboxes. The Superclass fieldalready has java.applet.Applet entered because you selected CreateApplet. Click the Finish button to complete your work with the SmartGuidewindow. VisualAge for Java now creates the code needed for your new applet.The dialog closes and lets you work with the Workbench window (Figure 5).
 Believe it or not, you have just created your first applet with VisualAge forJava! Now you can use the WorkBench to examine and run your applet.
 The WorkbenchThe Workbench is the main control center of the VisualAge for Java IDE.From the Workbench, you can access projects, packages, and classes andmodify and test your code with just a few mouse clicks.
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Figure 5. The Workbench
 To test your newly created applet, click the plus sign next to your project andyour package to expand them and then select the HiThere applet. SelectSelected→Run→In Applet Viewer from the menu bar of the Workbench torun the applet. You can also run your applet by clicking the Run button (theleft-most button with the picture of the running person).
 The Applet Viewer opens and runs your applet (Figure 6). The Applet Vieweris a utility that lets you test your applets without having to use a Webbrowser. You may have to resize the window to see the complete message.
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Figure 6. Your First Applet Running in the Applet Viewer
 Congratulations, you have built and tested your first applet with VisualAgefor Java!
 Modifying Your AppletTo modify the applet to show different text, select your class in theWorkbench. The class definition of the applet is displayed in the Source paneof the Workbench window and looks like this:
 import java.applet.*;import java.awt.*;/** * This type was created in VisualAge. */public class HiThere extends Applet {
 Font font = new Font("Dialog", Font.BOLD, 24);String str = "Welcome to VisualAge";int xPos = 5;
 }
 To change the text “Welcome to VisualAge” to any string you like, just typeover the text. Save your changes by selecting Edit→Save from the menu bar.VisualAge for Java compiles the code immediately, and you can test theresult by again selecting Selected→Run→In Applet Viewer from themenu bar.
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You do not even have to close the Applet Viewer to see the changes! Changeand save the text, then select Applet→Reload from the menu bar of therunning Applet Viewer.
 This simple example shows how VisualAge for Java can help you create Javaprograms. You did not have to edit, save or compile any file. You simplychanged the code generated automatically by VisualAge for Java, saved it,and ran it. This reduced development time is a reality thanks to theincremental compiler, which compiles changes to your code on the fly whenyou save it.
 Creating an Animated AppletNow that you are becoming more familiar with the VisualAge for Java IDE, itis time to create your second applet. With VisualAge for Java, it is easy tocreate applets that scroll text from one side of the applet to another.
 This time you create a new class without using the Quick Start. Instead,expand the Programming with VAJ V2 project by clicking on the + (plus sign)and then select the itso.samples.ch01 package. Next, click on the CreateApplet icon (the one with the capital A on it) on the tool bar of theWorkbench. The SmartGuide appears again, requesting you to fill ininformation about your second applet. Because you selected the package, theProject and Package fields are already filled in (if not use the same names asin your first applet). Enter HiThereAgain in the Applet Name field and makesure the Browse applet when finished checkbox is not selected. Click theNext> button to access the second page of the SmartGuide (Figure 7).
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Figure 7. Creating an Animated Applet
 Select the Yes, create an applet which runs in a thread radio button, andclick the Finish button. Run the applet by selecting it in the Workbench andthen selecting Selected→Run→In Applet Viewer from the menu bar.
 Your application should show a marquee text scrolling from left to right. Youhave just built an animated applet.
 Changing the Properties of the AppletAn HTML applet tag is required to run an applet within a browser, andwithin that tag there are some required fields. VisualAge for Javaautomatically creates the applet tag for you. If you want to change any of theproperties or add new ones, you open the Properties window for the class.Select the HiThere class in the Workbench and then selectSelected→Properties. The window shown in Figure 8 on page 14 appears.
 The Selected MenuThe Selected menu is contextual, that is, it differs according to theitem selected. You can also access the Selected menu by holding down the rightmouse button once you have selected an item.
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The first time you ran your HiThere applet (Figure 6 on page 11), the appletsize was not perfect. On the Applet page of the Properties window, change theWidth to 300 and the Height to 100 and run your applet again. In the otherpages of this window you can set the class path for the applet (where theApplet Viewer looks for external classes) and see other properties of the class.If this class were a Java application (which you are about to build), you couldset the command line parameters here.
 Figure 8. Class Properties Window for the HiThere Class
 Building Your First ApplicationIn this section you create a Java application that prints a string to theVisualAge for Java Console. The Console is a window that displays messagessent by your application to the standard output of the operating system andwhere you enter input for your applications. To create a class that can be runas an application, without the Applet Viewer or a Web browser, you have toimplement a method called main in your class.
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Now start creating your application. In the Workbench, select the packageyou created (itso.samples.ch01), then select Selected→Add→Class fromthe menu bar. Enter HiAgain in the Class Name field (see Figure 9).
 Figure 9. Creating the HiAgain Application
 When you created your applet the superclass was java.applet.Applet. Nowbecause you are creating a class that does not need a user interface and doesnot reuse the behavior of other objects, the superclass is java.lang.Object.
 Deselect the Browse the class when finished and Compose the classvisually checkboxes.
 Click the Next> button to access the second page of the SmartGuide (Figure10), where you specify attributes of your new class.
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Figure 10. Application Attributes
 Select the main( String []) checkbox under Which method stubs would youlike to create and click the Finish button. VisualAge for Java creates a classdeclaration and constructor for HiAgain and a stub, or skeleton code, for themain method.
 VisualAge for Java can automatically generate method skeletons for:
 ❑ The common methods listed on the SmartGuide
 ❑ Constructors declared in the superclass
 ❑ Methods that must be implemented because of abstract inheritance orinterfaces that the class implements
 In the Source pane of the Workbench you can see the definition of your newlycreated class. In the Browse pane, expand the class by clicking the plus signto the left of it, and you can see the main method. Select this method, and the
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Source pane shows you the method implementation. Only a stub of themethod has been generated, but you can change that by adding the followingcode to the method body:
 System.out.println("This is my first application!");
 The System.out.println() statement prints a string to the standard output,which in turn is displayed in the VisualAge for Java Console window.
 Your main method should now look like this:
 /** * Starts the application. * @param args an array of command-line arguments */public static void main(java.lang.String[] args) {
 System.out.println("This is my first application!");}
 Save the changes you made, using the menu bar (Edit→Save) or theControl-S key combination, and you are ready to see the results of your work.Select Selected→Run→Run Main from the menu bar. The Consolewindow (Figure 11) opens to display the result. Notice that you do not have toselect the class itself; the Run function knows which class you are workingwith and runs that class.
 Figure 11. The VisualAge for Java Console
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You have successfully created a Java application. The Console windowdisplaying the text that your application generated is used as a standardoutput window for messages and for entering input through the standardinput.
 For each Java program that writes to or reads from the Console that you arerunning, the Console shows a line in the All Programs pane. To view theoutput or enter input for that program, select it in the All Programs pane.
 The VisualAge for Java ScrapbookThe Scrapbook enables you to evaluate Java expressions. Just type in anyexpression, highlight it, and execute it. The Scrapbook can have severalpages. You can consider each page of the Scrapbook to be a separate JVMthat compiles or runs separate code fragments.
 Running a Program As an Applet and ApplicationWith VisualAge for Java, you can easily build an applet that canbe run as an application, but your applet has to implement themain method to handle opening a window without an AppletViewer or a Web browser.
 To create this kind of applet, click the Applet icon in the tool bar,and the SmartGuide creates the necessary implementation foryou. After providing names for the project, package, and class,select the Write source code for the applet radio button and clickthe Next button to access the Applet Properties SmartGuide.Select the Yes, create an Applet which can be run by itself orin an Applet viewer radio button, and click the Finish button.Notice that the Selected→Run menu has both Run main and InApplet Viewer options available if you select the class in theWorkbench.
 The Scrapbook As EditorYou can also use the Scrapbook to open files in the file system forreading or editing. You need not use a text editor that is externalto VisualAge. If you do not save pages to files, when you close theScrapbook, VisualAge prompts you to save any pages that youmodified.
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Using the ScrapbookTo enter and run Java code in the Scrapbook:
 1. From the Workbench menu bar select Window→Scrapbook (Figure 12)to display the Scrapbook window (Figure 13).
 2. Type some Java code (for example, the code shown in Figure 13) into theScrapbook and highlight the text by using the mouse or the shift andcursor keys.
 3. From the menu bar select Edit→Run or click the Run button on the toolbar.
 Figure 12. Launching the Scrapbook in VisualAge for Java
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Figure 13. Evaluating Java Code in the Scrapbook
 By highlighting the Java statements and selecting Edit→Run, you instructthe compiler to compile the statements and execute them immediately. AConsole window opens, and the output of the System.out.println("Loop number:" + i); statement is displayed (Figure 14).
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Figure 14. Console Output of the for Loop Executed in the Scrapbook
 If you want to save the code you have created in the Scrapbook, selectFile→Save from the menu bar, and you can save the Java source code into atext file.
 Figure 15 shows some examples of using operators in the Scrapbook.
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Figure 15. Using Operators in the Scrapbook
 Scrapbook ContextWhen you execute code in the Scrapbook, the code runs in thecontext of a static method in the Object class. Select Page→RunIn to change the context in which the code runs. Changing the context is not always that useful because you stillcannot access instance variables or methods of the type. However,you can create an instance of the type and then performoperations on it. The benefit of the Page→Run In selection isthat you do not have to use absolute package names and you arerunning with private access permission on the class. Because thecontext is defined by the Run In function, you cannot use importstatements in the Scrapbook.
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Correcting Errors in the ScrapbookIf you make a coding mistake, for example, you forget the closing parenthesisat the end of the System.out.println("Loop number" + i) statement, VisualAgefor Java places a highlighted message where it detects the mistake (Figure16).
 Figure 16. An Error Message in the Scrapbook Window
 In this case, four simple steps will correct the error:
 1. Read the error message to determine what is wrong.
 2. Press the Delete key to delete the compiler information.
 3. Correct your code.
 4. Run your example again.
 VisualAge for Java also provides Automatic Code Completion, also known asCode Assist or Code Clue. Code Assist can help you locate the correct type,method, or field while you are coding. You can invoke it from method source,Scrapbook, Inspector windows, the event-to-code editor and the conditionalbreakpoint editor. To see Code Assist in action, go to the Scrapbook window.Type System.out, hold down the Control key, and press the spacebar. A dialog
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appears showing all possible methods you could call in the System.outcontext (see Figure 17 on page 24).
 When you save methods, VisualAge for Java provides you with a list ofsuggested corrections for errors in your code. You can select the correction,save the code as is, or cancel the save.
 Figure 17. Using the Code Assist Facility
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 Customizing VisualAge for JavaYou may have noticed by now that your windows may not look exactly likethose in this book. We changed our environments to make the screencaptures as readable as possible. It is possible to customize VisualAge forJava in several ways:
 ❑ Workbench Options
 ❑ Tool Integration Framework
 ❑ Palette modification
 In this section you will learn about the Workbench Options. The ToolIntegration Framework is described in “Tool Integration Framework” onpage 375, and palette modification is discussed in “Beans PaletteModification” on page 115.
 Workbench OptionsThe Workbench Options (accessed by selecting Window→Options from theWorkbench menu bar), enable you to customize the VisualAge for Javaenvironment in many ways (see Figure 18 on page 26).
 If Your Scrapbook Page Remains BusyWhenever a code fragment is evaluated in a Scrapbook page, thatpage is made inactive (busy) for the duration of the evaluation.Two visual cues indicate that a page is busy: The document iconin the tab contains a small clock icon, or the status line for thebusy page contains the following text: “This page is busy runningthe selected code.”The page remains busy until the selected code fragment isfinished running. Your page may remain busy because the codeactually takes a long time to evaluate, or you are debugging athread started from that page.To terminate the evaluation of the code and return the page to itsoriginal state, select Page→Restart Page from the menu bar.Note that all threads, and therefore all windows, started fromthat page will be stopped and closed.
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Figure 18. Workbench Options
 For a complete description of the options see the VisualAge for Java productdocumentation. Some of the options you may use throughout this book are:
 ❑ General
 • Cache
 The new Cache feature improves the performance of the VisualAge forJava IDE considerably. You can set the number of classes cached inmemory and on your hard drive.
 ❑ Appearance
 • Source
 To make your source code easy to debug, you can choose the font type,size, and foreground and background color of the source code. You cancustomize different colors for the default code, its comments, keywords,literals, and errors.
 • Printer
 This option lets you chose the default printer for VisualAge for Java.
 ❑ Coding
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• Debugging -The debugger options are discussed in “The Debugger” onpage 177.
 • Formatter - Many developers are stringent about the formatting oftheir code. With VisualAge for Java Version 2 you can set the way yourcode is formatted:
 • Compound statements begin a new line
 • Opening braces begin a new line
 • Method Javadoc
 This option provides a text template for comments added when youcreate a method with the Add Method SmartGuide. The comment isinserted into Javadoc-style comments.
 • Type Javadoc
 This option provides a text template for comments added when youcreate a class or interface with the Add Class or Add InterfaceSmartGuide. The comment is inserted into Javadoc-style comments.
 ❑ RMI Registry - With VisualAge for Java Professional you can developdistributed Java applications that use RMI. You can:
 • Start the RMI registry on VisualAge startup
 • Use the default or another RMI port
 • Restart or stop the RMI registry
 ❑ Design Time
 • Generate meta data method - In VisualAge for Java Version 2 you cansave the visual builder information directly into source code (using thegetBuilderData method). If you subsequently import the Java code intoanother VisualAge for Java environment, the builder information isnot lost.
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2 Organizing Your CodeWith VisualAge for Java you use projects and packages to organize yourwork. Projects are a feature of VisualAge for Java that provide a high-levelmeans of grouping the development efforts of a project. Packages are thestandard Java scheme of organizing classes and interfaces that are intendedto work together.
 In this chapter you will learn to work with projects and packages inVisualAge for Java.
 Projects in VisualAge for JavaYou have already created a project, Programming VAJ V2, to organize all ofthe work you do while reading this book. Projects provide a way of organizingyour Java code at the highest level. Whenever you create a new package, youmust place it in a new or existing project. Projects do not have any equivalentin the Java language.
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The first time you start VisualAge for Java and go to the Workbench, you seeseveral projects in your workspace, all of which contain several packages.Table 2 lists these projects and their contents.
 The code in the projects in Table 2 cannot be modified or deleted. It isrequired by VisualAge for Java to function correctly.
 Additional projects are available in VisualAge for Java and are described inChapter 5, “Managing and Fixing Your Code” on page 153.
 The WorkbenchTo understand how VisualAge for Java organizes projects and packages, youhave to know a little more about the Workbench.
 The Workbench provides different views of your current developmentenvironment or workspace. The layout of the Workbench window depends onthe tab selection above the pane. To switch between the Projects, Packages,Classes, Interfaces, and All Problems pages, just click on the correspondingtab. The menu bar of these pages also changes as you switch from tab to tab.
 From any Workbench page you can access the menu of the currently selecteditem (project, package, class, interface, or method) in two different ways. Youcan:
 ❑ Access the pop-up menu by right-clicking the selected item
 ❑ Use the menu bar
 Table 2. Default VisualAge for Java Projects and Their Contents
 Project Contents
 IBM Java Implementation com.ibm.uvm.* packages, which enable and support the VisualAge for Java VM and envi-ronment
 Java Class Libraries java.* packages, which contain the Java Class Libraries
 JFC Class Libraries The Java Foundation (Swing) Class library
 Sun Class Libraries PM Win32 sun.* packages, which are extensions to standard java.* packages
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The pop-up menu of the Source pane and the Edit menu in the menu barhave the same contents. The Browse pane’s pop-up menu is the same as theSelected menu in the menu bar.
 The Workbench also provides a toolbar for quick access to functions. Figure19 shows the toolbar and Table 3 describes the icons.
 Figure 19. The Workbench Toolbar
 Table 3. Toolbar Icon Descriptions
 Icon Description
 Run Run the selected class or a class from the selected project or package.
 Open Debugger Start the debugger.
 Search Search for a reference or declaration of a field, method, or class.
 Add Project Add a project to the current workspace.
 Add Package Add a package to the current selected project.
 Create Class Invoke the Create a new Class Smart-Guide.
 Toggle Edition Name
 Create Field
 Create Method
 Create Interface
 Create Applet
 Create Class
 Add Package
 Add Project
 Search
 Open Debugger
 Run
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The Workbench Projects PageThe Projects page of the Workbench (Figure 20) contains two panes: a Browsepane and a Source or Comment pane.
 Create Applet Invoke the Create a new Applet Smart-Guide.
 Create Interface Invoke the Create a new Interface Smart-Guide.
 Create Method Invoke the Create a new Method Smart-Guide on an existing class.
 Create Field Invoke the Create a new Field Smart-Guide on an existing class.
 Toggle Edition Names Show or hide the edition names of pro-gram elements.
 Icon Description
 32 Programming with VisualAge for Java Version 2

Page 59
                        

Figure 20. Workbench Projects Page
 The orientation of the panes is by default set to horizontal. If you want tochange the orientation, you can select Window→Orientation and chooseVertical instead of Horizontal.
 If you select a program element in the Browse pane, which contains code,such as a class, interface, or method, the other pane is labeled Source andcontains source code. If you select a package or project, the other pane islabeled Comment and contains any comments you have added to the projector package.
 A tree view of the projects, packages, classes, and interfaces that arecurrently loaded in your workspace is shown in the Browse pane when youselect the Projects, Packages, Classes, or Interfaces views. The Projects viewis the default view shown when you open the Workbench for the first time. Tocollapse or expand any item in the list, click the plus or minus sign to the leftof the item (or use the plus sign and minus sign keys). To show the sourcecode for an item in the Source pane, select the item, using your mouse.
 Source Pane
 Browse Pane
 Tab Selection
 Menu BarTitle Bar
 Tool Bar
 Status Bar
 Bookmarks
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You can create new projects by selecting Selected→Add→Project in anybrowser window.
 The Workbench Packages ViewThe Packages page of the Workbench (Figure 21) contains three Browsepanes — All Packages, Types, and Methods — and one Source pane.
 Using the VisualAge for Java WindowsVisualAge for Java provides many useful features for viewingdifferent parts of your projects. Three of these features are:• The Projects page enables you to set bookmarks. In theupper-right corner of the Browse pane, click on the plus sign to seta bookmark. When you want to return to a particular piece ofcode, click the number that appeared when you created thebookmark.• You can clone any window in VisualAge for Java. SelectingWindow→Clone opens another window in the same context. Aclone of a window can be very useful when you need two similarviews, but be careful about updating the same class in two views.It is possible to overwrite changes you have made in one view withchanges made in another window.• Double-clicking on the title bar of any pane maximizes thatpane within the window. Double-click again to restore the normalview. You can also select Window→Maximize Pane/RestorePane.
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Figure 21. Workbench Packages Page
 You can use Packages→Layout to customize your view, and you can choosebetween Tree Layout or List Layout. You can access the same functionalitythrough the layout icons at the top right of the All Packages pane.
 The Orientation option is also available for this view under Window.
 Creating PackagesWith the JDK, directories are used to organize packages on your file system,whereas in VisualAge for Java packages and classes are kept in theworkspace.
 The workspace contains all of the program elements with which you arecurrently working. Rather than creating directory structures, VisualAge forJava organizes its packages and classes internally. If you export classes, thedirectory structure is created on your file system. This approach makes
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managing packages and classes simple. Although classes of your projects arekept in the workspace, any resources of those projects are kept separately inyour local file system in this directory:
 \ibmvjava\ide\project_resources\project_name
 In Java you can declare a class to be part of a package by using the packagekeyword at the top of your Java source file:
 package account;
 public class BankAccount{private string accountId;private double balance;
 }
 In VisualAge for Java you select the package that will contain each new typethat you create. If you specify a package name that does not exist, thatpackage will be created for you. After creating new classes in a selectedpackage, the package name is not shown in the code; it is implied in the list ofclasses in the package.
 You can also create or import code that has been defined with the defaultpackage, the package used when no package is explicitly defined. Becauseyou cannot access members of a default package from other packages, the useof a default package is not recommended.
 You can also create new packages by selecting Selected→Add→Package inany browser window. To create the Automated Teller Machine (ATM)application used throughout this book, you need two packages:
 itso.atm.modelitso.atm.view
 Create these two packages now by selecting the Programming VAJ V2 projectand then Selected→Add Package. Fill in the Create a new package namedwith field with the name of the first package and click Finish, then repeatthe process for the second package.
 Using Types from Other PackagesWith VisualAge for Java or the JDK environment, you have two ways ofusing a class from another package:
 ❑ Refer to the class by using the fully qualified name
 ❑ Use the import keyword
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You can either import all types defined within a package or be more selective.Note that importing a package does not import the subpackages of thatpackage, you have to import them separately. You can use the star notation(java.awt.*) to import all types within a package, but you have to separatelyimport any subpackages, such as java.awt.event.
 If you already know which packages you will need within your class whenyou are creating it, use the Attributes dialog box (which opens when you clickNext in the Create Class or Interface SmartGuide). The Attributes dialogbox enables you to specify the packages to be imported. Use the Add Classand Add Package buttons to browse and select classes and packages toimport into your class (Figure 22).
 You can also add the import statements manually by editing the classdeclaration.
 Figure 22. Create Class SmartGuide: Import Statement Dialog Box
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The Workbench Classes PageThe Classes page of the Workbench (Figure 23) contains three panes: ClassHierarchy, Methods, and Source.
 Figure 23. Workbench Classes Page
 You can change the layout of your classes, using Classes→Layout from themenu or the layout icons at the top right of the Class Hierarchy pane. Youcan also select the orientation of the Browse pane, usingWindow→Orientation.
 The Classes view is useful because it shows the class hierarchy of types, andyou can quickly follow the inheritance tree of classes. In the Classes view youcan quickly find a class you are interested in by selecting Classes→Go ToClass and then typing in the class name until the complete name shows upin the list.
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The Workbench Interfaces PageThe Interfaces page of the Workbench (Figure 24) is similar to the Classespage (Figure 23) except that it displays interfaces instead of classes. TheInterfaces page consists of three panes: Interfaces, Methods, and Source.
 Figure 24. Workbench Interfaces Page
 Navigation AidsThe Go To Class function is just one of the many navigation aidsin the WorkBench. Here are some other aids:• Each window has a different Go To option.• Each window has an Open To, which opens the selected item ina selected browser.• Each window has a Clone function if you want to have twoviews of the same information.• You can search for different items, using Workspace→Search.• You can find all code that has references to a selected type, usingSelected→References To.
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The Workbench All Problems PageOn the All Problems page you can find all incorrect code in the workspace.The incorrect code found within a method causes the method to be flaggedwith a red X, and the method’s class will be flagged with a grey X (see Figure25). If you have incorrect code in a class or interface declaration, the class orinterface is flagged with a red X.
 Figure 25. Workbench All Problems Page
 In your version of VisualAge for Java you should not have any errors (not yetanyway). You can create an error to see the result:
 ❑ Select the Projects tab on the Workbench.
 ❑ Expand (click on the plus sign) the HiAgain class and then select the main(String)[] method.
 ❑ Add the line: x=2; before the closing brace (}) and save the method (usingEdit→Save or Control-S).
 Figure 27 on page 42 shows the Warning dialog box that appears when youattempt to save incorrect code. At this point you can cancel, return to thecode and fix the error, or save the code with the error.
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If VisualAge for Java can suggest corrections to the code, it displays them inthe lower pane. You can select the entry under Suggested corrections andclick the Correct button to correct your code.
 ❑ Click the Save button in the Warning dialog.
 .
 Figure 26. Warning Dialog: Undefined Variable
 ❑ Select the All Problems tab on the Workbench. Figure 25 on page 40shows the error in the page. Select the main method, delete the line x=2;,and save the method. The problem should disappear.
 In most cases when you type incorrect code, you get the Warning dialogshown in Figure 26 on page 41. In some cases when the VisualAge for Javacompiler cannot parse the incorrect code, you get an Error dialog (Figure 27on page 42). In this case you must return to the code and fix it before you cansave it. If VisualAge for Java can suggest corrections to the code, it showsthem in the lower pane.
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Figure 27. Error Dialog Box: Parse Errors Detected
 Importing and Exporting Java Code with VisualAge for Java
 You have already learned that VisualAge for Java Professional stores yourprojects in a repository, not directly in the file system. To deploy your Javaprojects, or to share code with other developers, you have to import andexport Java classes. If you are part of a development team you should look atVisualAge for Java Enterprise, which provides complete support for teamdevelopment.
 Leaving Errors in Your CodeIt may seem a little strange to leave errors in your code. However,in VisualAge for Java there is little risk. For example, if you forgetto create a variable before you reference it, you can save the codethat references the variable, go the All Problems page later, andadd the variables to the class declaration.In the worst case, where you are not sure what you should fix, youcan just return to an earlier version of the code.
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You can import and export Java classes and resources to and from theVisualAge for Java environment in several formats:
 ❑ Java source code
 You can import Java source code from the file system. The code iscompiled as it is imported, and package hierarchies are retained. Youwould export Java source code when you want to share it with developerswho are using a different development environment or edit it using adifferent editor from that provided with VisualAge for Java.
 ❑ Java class files
 Java class files are exported when you are ready for testing outside theVisualAge for Java environment or to deploy your program. Class files canalso be imported into VisualAge for Java. However, the imported classcannot be modified, and the source code, as you would expect, is notvisible.
 ❑ Java archive files
 Java archive (JAR) is a platform-independent file format that enables youto compress a Java applet and its resources (such as .class files, images,and sounds) into a single file. JAR files are a good way of distributingJava applets, applications, and their supporting resources. You can installthe files on a Web server where Web browsers can access them. You canexport a complete VisualAge for Java project as a JAR file.
 JAR files can also be imported into VisualAge for Java. The classes arecompiled and placed in a project. Any supporting resource files are placedin a resource directory with the same name as the project under:
 \ibmvjava\ide\project_resources
 ❑ VisualAge for Java interchange files
 Interchange files are used to exchange Java classes built with VisualAgefor Java Professional among different VisualAge for Java Professionalenvironments. The files maintain version information and comments aswell as visual development information.
 When you import an interchange file, it is loaded into your repository. Youthen have to load it into your workspace from the repository. Any programelements that you export by using an interchange file must be versionedfirst. Versions and the repository are fully explained in Chapter 5,“Managing and Fixing Your Code” on page 153.
 Importing into VisualAge for JavaNote that importing code into the VisualAge for Java environment is not thesame as using the import keyword in Java source code.
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To import code into VisualAge for Java:
 1. Open the Import dialog, using one of these methods:
 • File→Import from the menu bar on any page.
 • Selected→Import from the menu bar on the Projects page.
 • Packages/Types→Import from the menu bar on the Packages page.
 • Classes→Import from the menu bar on the Classes page.
 • Interfaces→Import from the menu bar on the Interfaces page.
 A SmartGuide prompts you for the source of import (Figure 28).
 Figure 28. Importing Java Files into VisualAge for Java
 2. Select the source of import:
 • Directory - .java or .class files
 • Jar file
 • Repository - interchange files
 For Directory and Jar file imports, select:
 • The directory where the import files reside
 • The specific classes (source or bytecode) and resources to be imported
 • The project into which to import the classes
 • Whether or not to overwrite existing resources
 For Repository imports, select:
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• The repository file to be imported
 • The specific projects or packages to import (Figure 29 on page 45)
 Figure 29. Importing from Another Repository
 Exporting from VisualAge for JavaTo export code from VisualAge for Java:
 1. Optionally, select one or more projects, packages, or classes or interfaces.
 • When you select a package, all classes and interfaces in the packageare exported.
 • When you select a project, all classes of all the packages within thatproject are exported.
 2. Open the Export dialog (Figure 30), using one of these methods:
 • File→Export from the menu bar on any page
 • Selected→Export from the menu bar on the Projects page
 • Packages/Types→Export from the menu bar on the Packages page
 • Classes→Export from the menu bar on the Classes page
 • Interfaces→Export from the menu bar on the Interfaces page
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Figure 30. The Export SmartGuide
 3. Select the export destination:
 • Directory - .java or .class files
 • Jar file
 • Repository - interchange files
 For Directory exports, select:
 • The root directory where the export files will reside
 • The specific classes (source or bytecode) and resources to be exported
 • You can also set several options on the export:
 • Select referenced classes to export
 • Deselect the BeanInfo and Property Editor classes from the export
 • Whether to create HTML files to launch applets
 • Whether to overwrite existing files
 • Whether to open the created HTML files in a browser
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For Jar file exports (Figure 31), the options include those for Directoryexports as well as these:
 • Selecting specific beans and classes to export
 • Whether to compress the contents of the Jar file
 For Repository exports, select:
 • The repository file to be exported
 • The specific projects or packages to export
 Figure 31. Exporting to a Jar File
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Exporting Your CodeVisualAge for Java has some powerful new features for exportingcode. The Deployment Wizard is invoked by selecting the Selectreferenced types and resources button. The DeploymentWizard automatically includes the types your code needs.Therefore your exported Jar files will only include the code theyneed.When exporting a Jar file, you can select specific beans to export.This action forces the creation of a manifest file in your Jar file,enabling other environments to recognize the beans in your Jarfile and other VisualAge for Java environments to automaticallyadd beans from the JAR file to the palette.If the JAR file is to be directly used in the Classpath for a Javaapplication or applet, do not compress its contents.
 You can also now export visual builder information in Java sourceand class files. Select the Generate meta data methodcheckbox in the Design Time section of the Options dialog.VisualAge for Java will generate a getBuilderdata method thatcontains the visual builder information for the class.
 48 Programming with VisualAge for Java Version 2

Page 75
                        

3 Beginning the ATM ProjectAlthough Java was originally marketed as a language for creating applets,many Java development efforts focus on building Java applications. Theobject-oriented nature, portability and security of the Java language make ita good choice for application development.
 In this chapter you will be introduced to the basic design of the ATMapplication that is used in this book. You will learn about JavaBeans, andyou will create your first JavaBeans for the ATM application.
 ATM ApplicationThe ATM application emulates a simple automated teller machine to explainhow to build Java applications and applets using VisualAge for Java. Yes, weknow that most of you do not have card readers on your PC, so you could notactually emulate a real ATM, but this could be the basis for software runningin a real ATM machine built around a Java chip!
 The requirements for the ATM are simple. It should:
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❑ Handle two types of accounts:
 • Savings
 • Checking
 ❑ Perform withdraw and deposit transactions for each of the accounts ❑ List a transaction history log for each of the accounts ❑ Restrict withdrawals beyond a minimum overdraft amount or minimum
 balance
 Figure 32 shows a prototype of the ATM screen panels and the flow of events.When a person uses an ATM, the ATM must:
 ❑ Receive a valid card ID
 ❑ Display the card ID with a greeting and ask for a PIN to match the cardID entered
 ❑ Validate the PIN with the matching card ID
 ❑ Let the user reenter the card ID or PIN if necessary
 ❑ Let the user choose an account and display the appropriate accountinformation panel
 ❑ Display a transaction history log in a list at the user’s request
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Figure 32. Prototype ATM Application Panels and Flow
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ATM Object ModelFigure 33 shows the object model of the ATM application.
 Figure 33. Object Model of the ATM Application
 The model uses Unified Modeling Language (UML) notation. If you are notfamiliar with the notation, check the UML documentation atwww.rational.com. Even if you are not familiar with UML you should be ableto follow the diagram and this description:
 ❑ The Bank class holds all customers of the bank. In addition, the bank willvalidate cards and supply a customer object given a valid card.
 ❑ The Customer class stores the customer information and holds all of thecustomer’s accounts and cards.
 ❑ The Card class stores the card number and personal identificationnumber (PIN) and references all the accounts that are valid for the card.
 ❑ The account classes — BankAccount, the abstract superclass;CheckingAccount; and SavingsAccount — hold individual accountinformation as well as a list of account transactions.
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❑ BankAccount, SavingsAccount, and CheckingAccount are closely related.The BankAccount class represents the generic bank account, with all ofthe features of a bank account, such as account ID, balance, and customerID. SavingsAccount and CheckingAccount inherit from BankAccount, buteach of them has additional information and behavior. TheSavingsAccount class contains the information related to the minimumamount, and the CheckingAccount class contains an overdraft value thathas to be less than a specified amount. In other words, the instances of theSavingsAccount and CheckingAccount classes represent the real accountsof the customer.
 ❑ Transaction objects are needed to store customer information andtransaction history.
 ❑ Although not shown in Figure 33 on page 52, each class also implements atoString method.
 JavaBeansSoftware components are standard and reusable building blocks for softwaredevelopment. Basically, they encapsulate function and provide services basedon a strict specification of their interface. Because of this specification, theycan be used as "black boxes” (components whose internal state is hidden)and, combined with other software components, to build a completeapplication.
 The JavaBeans specification is the standard component model for the Javalanguage and is the component model used by VisualAge for Java. Itdescribes how Java classes should appear and behave in order to be treatedas JavaBeans. Beans can be visual components, such as a button or a list,that you use to build the user interface or view of your application. They canalso be nonvisual components, such as a bank account, that typicallyrepresent the business logic or domain model of your application. To build anapplication or an applet with a bean manipulator tool, such as the VisualAgefor Java Visual Composition Editor, you typically drag and drop the beansyou want to use into a working area and wire, or connect, them together. Thisvisual programming approach is an extremely productive way to createapplications.
 JavaBeans provide support for:
 ❑ Portability: Beans can be created and run on any Java platform.
 ❑ Introspection: The tool that you use to combine beans can automaticallydiscover how a bean works.
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❑ Properties and customization: Properties are a bean’s attributes. Adeveloper using a bean can customize the appearance and behavior of abean by changing its properties.
 ❑ Persistence: The state of a bean can be saved and then reloaded throughthe serialization function of the JDK 1.1.
 The key to understanding and using a bean is to understand its features,that is, the events, properties, and methods that it exposes. A bean exposes afeature by making it available to other beans. The features a bean exposesconstitute its interface, and you can use this interface to combine beans witheach other, through a tool such as the Visual Composition Editor.
 Event Features Events are fired by a bean to indicate that there has been some change in itsstate. For example, a bank account bean could fire an event when the balancechanges. Other beans can register their interest in these events and benotified of their occurrence. Beans can both fire and listen for events. Beansexpose the events that they fire in their bean interface.
 The JDK 1.1 defines an event specific to JavaBeans: the property changeevent. This event allows beans to notify each other when one of theirproperties changes (see “Property Features” on page 55).
 Figure 34 shows the sequence of calls or method invocations to supportproperty change notification:
 ❑ The Event Listener, or target bean, implements thePropertyChangeListener interface, consisting of the propertyChangemethod. This method contains the behavior to be executed when the eventis fired.
 ❑ The addPropertyChangeListener method is invoked on the Event Source(the bean that fires the property change) with the Event Listener as theparameter.
 ❑ When the value of the property changes, the Event Source fires a propertychange event resulting in the propertyChange method, with aPropertyChangeEvent object as the parameter, being executed on eachEvent Listener.
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Figure 34. Property Change Event
 Property FeaturesThe attributes exposed by a bean are called properties. Properties can beread, written, bound, indexed, and constrained. The properties exposed by abean are typically a subset of its attributes.
 The properties exposed by a bean are the data that it knows and whose valueit wants other components to be able to get and/or set. The values are alwaysaccessed and manipulated through accessor (getter) and mutator (setter)methods that follow a default design pattern, which is in fact a simplenaming convention defined by the JavaBeans specification:
 ❑ For a readable and writeable property named xxx, there are two methods,getXxx and setXxx, to access and change the value of the property. Thetype returned by the get method is the same type as the argument passedto the set method. Because of this specification, bean properties typicallybegin with a lower-case letter.
 ❑ You can also define get and set methods for a boolean property byfollowing the above convention. However, the prefix is can be used insteadof get.
 Properties can be categorized as bound, indexed, or constrained:
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❑ Bound properties are properties that fire the property change event whentheir value is changed. A PropertyChangeEvent object includes the old andnew values of the property. An example of a bound property might be thebalance property of a bank account. The setBalance method would fire aproperty change event so that the balance can be updated in a listenerobject.
 ❑ Indexed properties are simply properties that support a range of values.They are implemented through arrays and have four accessor andmutator methods to access the arrays of values by either a single elementor the entire array. For example, the indexed transactions property couldrepresent a list of transactions of a bank account. The following methodswould be defined to access the transactions:
 void setTransactions( int index, Transaction aTransaction)Transaction getTransactions( int index)void setTransactions( Transaction[] transactions)Transaction[] getTransactions()
 ❑ Constrained properties are properties that allow other beans to decidewhether a change in the property’s value is to be accepted. The otherbeans are notified through a vetoable change event, and they can throw aPropertyVetoException to veto the changes and have the property changedback to its original value.
 According to the JavaBeans specification, a property should probably beboth bound and constrained because a listener may want to know whenthe property was actually changed.
 Properties can also be designated as hidden, where they are not visible in thedevelopment environment, and expert, where they should be manipulatedonly by expert users.
 Special property editors can also be created to change the value of theproperties when the beans are being used in the development environment. Aspecial Customizer class can also be created to control the customization ofthe complete bean at development time.
 Method FeaturesMethod features are the actions that a bean exposes for invocation by othercomponents. The bean methods, by default, are the set of public methods ofthe class underlying the bean.
 Be aware of the naming convention used by JavaBeans when you writemethods. For example, accessor and mutator methods should follow the
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naming convention described in “Property Features” on page 55 for each beanproperty.
 Introspection and the BeanInfo ClassThe power of JavaBeans is evident when you use VisualAge for Java anddrag a bean off its palette and drop it on the free-form surface. At this time,VisualAge for Java creates the bean by calling its default constructor (allJavaBeans should have a default constructor defined) and extracts allinformation necessary to create a property sheet and event handlers for thebean without accessing its source code.
 The magic lies in the introspection mechanism, which allows an applicationbuilder, like VisualAge for Java, to interrogate a bean to discover itsproperties, methods, and events.
 Each bean can optionally be associated with a BeanInfo class which gives allinformation regarding the bean. An Introspector class queries the bean byusing a getBeanInfo method that returns a BeanInfo object. A BeanInfo classcan be used to define bean features that do not follow the defaultspecification. For example, the getter method for a property named addresscould be address rather than getAddress as defined by the bean specification.In addition, some things, such as setting the icon for a bean, must bespecified in the BeanInfo class.
 If a bean is not associated with a BeanInfo class, the application builder usesa reflection mechanism to study the public methods of the bean and thenapplies the simple naming conventions defined by the JavaBeansspecification for properties and events to deduce from those methods whichproperties, events, and public methods are exposed.
 All Java classes are beans, because there is no separate specificationlanguage and no BeanInfo class is required. However, some classes are notintended to be used as beans; they are intended as strictly programmaticinterfaces. For example, in this book the Transaction class is not intended tobe used as a bean. Transaction objects will only be created and then displayedin a list.
 For the remainder of this book, when you see the term bean, it refers to aJava class that was designed to be used as a bean, that is, it is intended to beused in a visual development environment: VisualAge for Java in this case.
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Using VisualAge for Java to Create JavaBeansNow that you know a little about beans, you will see how easily you cancreate and combine them in VisualAge for Java. You will use VisualAge forJava to create all of the beans for the ATM model, but first you have to knowsomething about the Class Browser and its BeanInfo page.
 The Class BrowserYou will spend a lot of time using the class browser to create and assemblebeans. The class browser consists of five views, or pages:
 ❑ Methods: A two-pane view of all methods defined on the class as well asthe source for the selected method
 ❑ Hierarchy: A three-pane view of the class hierarchy, methods and source
 ❑ Editions: A three-pane view of all the editions of the class, the methods,and source
 ❑ Visual Composition Editor: A visual builder where you assemblecomposite JavaBeans
 ❑ BeanInfo: A three-pane view of the bean features, feature definitions, andreflection information for a selected feature. The BeanInfo page alsoshows the source for methods associated with features
 When you use the Class Browser you typically only browse or edit one class.For example, in this book if the BankAccount class is opened in the ClassBrowser, that instance of the Class Browser is referred to as theBankAccount Class Browser and the BankAccount is referred to as theprimary bean or class. You may also see references in other publications tothe primary part which also refers to the class opened in the ClassBrowser when you are working in the Visual Composition Editor.
 MethodsThe Methods page is used for coding Java methods in the class being browsed(Figure 35). It is a matter of personal preference where you want to workwhen you are coding Java in VisualAge for Java. The Methods and Hierarchypages of the Class Browser are similar. You can also code in the Source panesof the Workbench windows.
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Figure 35. The Methods Page in the Class Browser
 HierarchyThe Hierarchy page is similar to the Methods page except that there is anadditional pane where you can quickly edit the class declaration and view(and edit, if you want) the class declarations of superclasses (see Figure 36 onpage 60). The Hierarchy page is a very productive place to edit Java code.
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Figure 36. The Hierarchy Page in the Class Browser
 Editing a SuperclassThe ability to edit the superclasses of the class you have openedin the class browser is very powerful. Be careful about changingthe code of a superclass because other code may be dependent onthe superclass.On the Methods page you can also set the visibility so that you canedit methods that are inherited from superclasses. Again youshould be careful when changing inherited methods.
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EditionsUse the Editions page when you want to compare and replace differenteditions of the class and its methods (see Figure 37 on page 61). Although youcan use other windows, the Editions page provides an Editions→Add toWorkspace function for each edition of the class and method, anEditions→Go To Current Edition function, and the ability to quickly vieweach different edition.
 Figure 37. The Editions Page in the Class Browser
 Visual Composition EditorThe Visual Composition Editor (Figure 38) is the main topic of Chapter 4,“Building User Interfaces” on page 99. You will spend most of your time with
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this window while learning VisualAge for Java and may continue to use itfrequently as you develop your own projects.
 Figure 38. The Visual Composition Editor Page in the Class Browser
 BeanInfoYou now know that the features of a bean interface consist of properties,events, and methods. These features represent the properties and behavior ofyour class.
 The BeanInfo page (Figure 39) is accessed from the BeanInfo tab in theClass Browser or by selecting Selected→Open To in the Workbench. TheBeanInfo page is where you create and view the events, methods, andproperties of a bean. From the BeanInfo page, you use the Features menu to
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manage bean features. You access the Features menu by either selectingFeatures or opening it as pop-up menu from the Features pane.
 Figure 39. The BeanInfo Page in the Class Browser
 Using the BeanInfo PageYou can add new features using either tool bar buttons (the buttons labeled P,M, and E) or Features menu choices. When you add new bean features,VisualAge generates methods and BeanInfo information for the features. Themethods correspond to the JavaBean specification for that type of feature.
 Each bean and each feature of the bean have a set of attributes that you canspecify in the Information pane.
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The Bean or Feature Information pane fields include:
 Customizer class
 The name of the optional Customizer class that can be used to customizethe bean at design time
 Hidden-state
 Defines whether the property settings of a bean will be generated as Javacode or whether the state of the bean will be saved to a file as a serializedbean
 Icons
 The icon that will be shown when the bean is on the palette or dropped onthe free-form surface
 All property, method, and event features on the BeanInfo page share thefollowing features:
 Description
 The description shown in the Visual Composition Editor when theproperty is shown or selected in a Connection Property dialog box,Connection dialog box, or Tear-off dialog box
 Display name
 The feature name shown in the Visual Composition Editor (or on thepalette when applied to a bean)
 Expert
 Whether the property will be shown only in the Visual Composition Editorwhen the Expert checkbox is selected
 Hidden
 Whether the property will be visible in the Visual Composition Editor
 Preferred
 Working with the ClassTo return to the information for the class when you have selecteda feature in the BeanInfo page or a method in the Methods orHierarchy pages, press the Control key and select the currentlyselected property or feature to deselect it.
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Whether the feature will be displayed on the Preferred Connections list ofthe bean
 Property FeaturesWhen you create a property feature on the BeanInfo page, the propertyfeature is shown with a set of letters in superscript at the right side of theproperty name. The letters identify the attributes of the property asindicated in Table 4.
 Table 4. Property Identifiers
 Property features can be designated whether or not they are visible in theproperty sheet at design time. You can explicitly set the Property Editor, getmethod, and set method in the Property Feature Information pane.
 The internal attribute name for a property has the prefix field, followed bythe property name with the first letter in upper-case. For example, a propertynamed accountId is represented by the private fieldAccountId attribute,and the get and set methods are called getAccountId and setAccountId.
 Method FeaturesFor each method feature you create in VisualAge for Java, a public Javamethod stub is created with a method signature corresponding to the valuesyou enter in the SmartGuide.
 The BeanInfo page lists only those method features defined on the bean youare working with, not features of the ancestors of this bean class. However,the features defined on an ancestor bean are accessible when you work withthe bean in the Visual Composition Editor.
 Identifier Property Attribute
 R Readable
 W Writeable
 B Bound
 C Constrained
 H Hidden
 I Indexed
 E Expert
 Beginning the ATM Project 65

Page 92
                        

Event FeaturesYou can add two types of event features through the BeanInfo page:
 Event Set
 You add a new event set to a bean when you want it to fire existing events.The event will be added as a feature in the BeanInfo page. In the EventFeature Information pane you can designate whether the event will be aunicast (only one listener supported) or multicast event.
 For the event to be fired you must manually add the Java code to fire theevent.
 Listener Interface
 When you add a new Listener interface you actually create a whole newevent that your bean will fire. You enter the event name and the methodsthat will be called when the event is fired.
 In the Event Feature Information pane you can designate whether the eventwill be unicast (only one listener supported) or multicast.
 Again, you must write the code to fire the event. VisualAge for Java providesyou with a convenience method that allows you to fire the event with onemethod call (see “Creating a New Event Interface” on page 78).
 To learn how to create a new Listener interface see “Creating the pinCheckedEvent” on page 87.
 What about the BeanInfo Class?A JavaBean can optionally be associated with a BeanInfo class, named byappending BeanInfo to the name of the bean. VisualAge for Java generates aBeanInfo class when you are working in the BeanInfo page and you performan action that necessitates the creation of a BeanInfo class. Such actionsinclude promoting a feature, creating a bound property or modifyinginformation in the Bean Information pane (for example, you set an icon forthe bean). You can explicitly save this information by selecting theInformation→Save menu item or, when you select another property orclose the window, you are prompted with the Bean Information dialog:Information has been modified - save changes?.
 When you are initially working with your bean, public methods that youcreate with the Methods page are automatically added as method featuresuntil the BeanInfo class is created. After a BeanInfo class exists, public
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methods are not automatically added as method features. You must add themusing Features→Add Available Features.
 You can explicitly create a BeanInfo class before you add any features byselecting New BeanInfo Class from the Features menu. This selectionopens the SmartGuide for the BeanInfo Class (Figure 40), which you use todefine bean information for the bean as a whole.
 Figure 40. The BeanInfo Class SmartGuide
 In the BeanInfo Class SmartGuide, you can specify a display name and shortdescription to use for the bean. You can also mark the bean as expert orhidden to limit or prevent accessibility to it in the Visual Composition Editor.If you want to provide customized initialization of bean properties, you canspecify a Customizer class.
 The Bean Icon Information SmartGuide (Figure 41) follows the BeanInfoClass SmartGuide. Use the Bean Icon Information SmartGuide to specifyfiles containing icons for the bean. These icons will be displayed if you addthe bean to the palette or when you drop the bean on the free-form surface.
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Figure 41. The Bean Icon Information SmartGuide
 Building the ATM ModelIn this section you will learn how to use VisualAge for Java to implement thebusiness logic classes that the ATM application uses.
 As shown in the object model of the ATM application (see Figure 33 on page52), the ATM requires the following objects:
 ❑ Transaction
 ❑ BankAccount
 ❑ SavingsAccount
 ❑ CheckingAccount
 ❑ Card
 ❑ Customer
 ❑ Bank
 You will create the beans in the above order so that the types that a bean hasas properties will already be created. With VisualAge for Java you couldcreate beans that contain references to undefined types, but it is goodpractice to define types before you use them! In VisualAge for Java youcannot create property features of undefined types.
 Create all these beans in the itso.atm.model package.
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Building the Transaction Class
 As indicated in “Introspection and the BeanInfo Class” on page 57, theTransaction class would not be used as a JavaBean. That will affect the wayyou build the class in VisualAge for Java:
 ❑ A default constructor is not required.
 ❑ JavaBean properties will not be created, so the BeanInfo page will not beused.
 The Transaction class has four attributes and a constructor that takes threeparameters. You build the itso.atm.model.Transaction class by using theWorkbench to create the class and then use the Class Browser Hierarchypage to add the attributes and the new constructor.
 Creating the Transaction ClassOn the Projects page of the Workbench, select the itso.atm.model package inthe Programming VAJ V2 project, then select Selected→Add→Class. Fill inTransaction for the Class Name. Make sure the Superclass field isjava.lang.Object and that the Browse the class when finished checkboxis selected and the Compose the class visually is not selected and clickNext. Select the toString() checkbox in the Which method stubs would youlike to create section. Click Finish.
 If you did not create the itso.atm.model package in “Creating Packages” onpage 35, you are prompted to create it now.
 Transaction
 accountId
 transTypetransAmount
 transId
 Transaction(String,int,BigDecimal)
 The toString MethodCreating a toString() method for each class makes it easy to unittest each class. Use the toString method to print out the state ofeach class when you are testing. In many cases you will reuse thetoString method somewhere else in your user interface.
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Adding attributes to the Transaction classFollow these steps to add the accountId, transType, transAmount, andtransId attributes to the Transaction class:
 1. In the Class Browser, switch to the Hierarchy page.
 2. Select Transaction in the Class Hierarchy pane.
 3. Modify the class declaration in the Source pane to match the followingcode:
 public class Transaction {private int transType;private java.math.BigDecimal transAmount;private java.sql.Timestamp transId;private String accountId;static final String transTypes[] = {
 "Deposit Transaction", "Withdrawal Transaction"};static final int DEPOSIT_TRANS_TYPE = 0;static final int WITHDRAWAL_TRANS_TYPE = 1;
 }
 Note: Throughout the book the sample code may not show the commentsthat VisualAge for Java places in the generated code.
 The transTypes string and two static integers, DEPOSIT_TRANS_TYPE andWITHDRAWAL_TRANS_TYPE, are used to define the two transaction types:withdraw and deposit.
 Adding the New Constructor to the Transaction ClassFollow these steps to add the new constructor to the Transaction class:
 1. In the Hierarchy page, select Transaction in the Class Hierarchy pane.
 2. Select Methods→Add Method.
 3. Select the Create a new constructor radio button.
 4. Change the entry field from Transaction() to: Transaction( StringaccountId, int transType, java.math.BigDecimal amount).
 5. Click Finish.
 6. In the Source pane, modify the constructor to match the following code:
 public Transaction( String accountIdParam, int transTypeParam, java.math.BigDecimal transAmountParam)
 {accountId = accountIdParam;transType = transTypeParam;transAmount = transAmountParam;transId = new java.sql.Timestamp( System.currentTimeMillis());
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}
 Notice that the transId is set to a timestamp that is constructed using thecurrent system time.
 Completing the toString MethodSelect the toString method in the Methods pane on the Methods orHierarchy page of the Class Browser. Modify the code to look like this:
 public String toString(){
 return transTypes[ transType] + ": $" + transAmount + " [" + transId + "]";
 }
 Congratulations! You have created your first class of the ATM model.
 Building the BankAccount Bean
 You will implement the BankAccount as a JavaBean, that is, you will createfeatures that will be used to connect to the bean. As indicated in Figure 33 on
 Hiding the Default ConstructorIn the Transaction class the default constructor is not needed. Infact it should never be called. One way to ensure that the defaultconstructor is not called is to make it private. A privateconstructor cannot be called outside the class, and it can never besubclassed with a more lenient access modifier.
 BankAccount
 accountId
 depositwithdraw
 Transactionbalance
 getAccountType
 1
 0..*
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page 52 the BankAccount is abstract, so you will implement theitso.atm.model.BankAccount bean as an abstract class.
 Creating the Abstract BankAccount ClassOn the Projects page of the Workbench, select the itso.atm.model package inthe Programming VAJ V2 project, then select Selected→Add→Class. Fill inBankAccount for the Class Name. Make sure the Browse the class whenfinished checkbox is selected and the Compose the class visually is notselected, and click Next.
 Select the abstract checkbox in the Select the modifiers for the new typesection and the toString checkbox. Click Finish.
 You will create the following properties on the BankAccount class:
 ❑ accountId, of type java.lang.String
 ❑ balance, of type java.math.BigDecimal (This will be a bound property.)
 ❑ transactions, of type java.util.Vector
 Adding Property Features to the BankAccountFollow these steps to add the accountId property to the BankAccount class:
 Compose the Class Visually CheckboxSelecting the Compose the class visually checkbox disables theNext button on the dialog box and causes the new class to open tothe Visual Composition Editor page of the Class Browser. If youselect the checkbox by mistake for a nonvisual class or vice versa,no harm is done.
 Bound and Constrained PropertiesIf possible, in the design phase of your project you should definewhich properties are bound or constrained. Not all properties willneed to fire these events.If properties only fire events that are expected on the basis of thedesign, the system will be easier to understand. Using bound properties too frequently can also lead to a systemwhose performance degrades because so many events are firing.
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1. In the Class Browser, switch to the BeanInfo page.
 2. From the menu bar select Features→New Property Feature to createthe property that will store the accountId.
 3. Enter accountId in the Property name field and make sure thatjava.lang.String is in the Property type field. Make sure the Readableand Writeable check boxes are selected and that the Indexed, bound,and constrained checkboxes are not selected (Figure 42 on page 73).Click the Finish button to create the accountId property.
 Figure 42. New Property Feature SmartGuide
 The feature name will appear in the Features pane, and the accessor andmutator methods as well as the property type will appear in theDefinitions pane.
 4. Repeat Steps 2 and 3 for the other properties:
 Property name Property type Indexed bound
 balance java.math.BigDecimal false (not selected) true (selected)
 transactions java.util.Vector false false
 Creating Properties in the ExamplesAs you work through the examples in this book you can assumethat properties are not bound unless the example explicitly statesthat they are bound.
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Creating the accountType Method Feature The account type method feature is implemented in the concrete subclassesof the BankAccount class, not in the BankAccount class itself. TheBankAccount class defines an abstract getAccountType method. You cannotuse the New Method Feature item to create an abstract method feature.You must create the getAccountType method and then add it as a methodfeature. In “Creating the Deposit Method Feature” on page 76, you will usethe New Method Feature item to create a method feature.
 Follow these steps to create the getAccountType method feature:
 1. In the BankAccount Class Browser go to the Methods page. Create a newmethod: public abstract String getAccountType(). Specifically
 a. Open the Create method SmartGuide, usingMethods→Add→Method.
 b. Enter String getAccountType() in the first entry field.
 c. Click Next.
 d. Select the public radio button and the abstract checkbox.
 e. Click Finish.
 f. Switch to the BeanInfo page.
 g. Select Features→Add Available Features
 h. Select accountType from the list.
 i. Click OK.
 Now when you create the CheckingAccount and SavingsAccount beans,VisualAge for Java will automatically create the concrete version of thegetAccountType method.
 The BankAccount BeanInfo page should now look like the page shown inFigure 43.
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Figure 43. BankAccount Bean with Property Features
 Adding the Deposit Function to the BankAccountBecause the deposit function is not dependent on the account type, you canimplement the deposit method in the BankAccount class and use the sameimplementation for SavingsAccount and CheckingAccount. The deposit methodadds the amount entered by the user to the current balance and then createsa new transaction record.
 The Deposit and Withdrawal FunctionsWithdraw and deposit on the bank account are implementedthrough two methods for each function. One method takes aString and calls a second method, which takes a BigDecimal. Theactual property is a BigDecimal, but the user interface text fieldswork with strings. When two different methods are used, the userinterface is separated, or uncoupled, from the property. Forexample, using two methods would allow the first method to checkfor a valid number before calling the second method.
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Create the deposit method as protected, using Methods→Add→Method onthe Methods page. The protected deposit method will rely on public depositmethods to pass it a BigDecimal parameter. Only the public deposit methodwill be exposed in the bean interface.
 The source for the deposit method is:
 protected void deposit (java.math.BigDecimal amount) {setBalance( getBalance().add( amount));getTransactions().addElement( new Transaction( getAccountId(),
 Transaction.DEPOSIT_TRANS_TYPE, amount) );return;
 }
 Creating the Deposit Method FeatureFollow these steps to create the deposit method feature:
 1. From the BeanInfo page menu bar select Features→New MethodFeature to get to the New Method Feature SmartGuide (Figure 44).
 Figure 44. New Method Feature SmartGuides
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2. Enter deposit in the Method name field and void in the Return type field.Set the Parameter count field to 1. Click Next and enter amount in theParameter name field. Select java.lang.String from the pull-down in theParameter type field. Click Finish to create the deposit method.
 Select the deposit method feature in the Features pane and then select thedeposit method in the Definitions pane to show the source code in the Sourcepane. Modify the code:
 public void deposit( String amount) {if ( !(amount.trim().equals("")) ){ deposit( new java.math.BigDecimal(amount)); }
 }
 The public deposit method invokes the previously defined deposit method. Itfirst checks to make sure that the parameter is a valid number. It has areturn type of void and one parameter, amount, of type java.lang.String.
 Adding the Withdraw FunctionThe withdraw function is also divided into public and protected methods.The actual withdrawal is dependent on the account type. Therefore, you willdefine the protected withdraw method feature in the BankAccount class asabstract and provide the implementation in the SavingsAccount andCheckingAccount subclasses.
 Create the protected withdraw method, using Add→Method in the Methodspage (or simply typing over another method and saving the new code). Thecomplete method definition for withdraw is:
 protected abstract void withdraw(java.math.BigDecimal amount);
 The public withdraw method is not dependent on the account type and can bedefined on the BankAccount class. Create it using the BeanInfo New
 Adding Parameters to Method FeaturesWhen you add property features or set parameters in the NewMethod Feature SmartGuide, there are several ways to enter theproperty or parameter types:• Enter the type directly. • If the type is a primitive or an array of primitives (such as floator int) or a String, select it from the pull-down list.• Select the type, using the Browse button.
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Method Feature item. It has a return type of void and one parameter,amount, of type java.lang.String. Add the method feature and modify thesource:
 public void withdraw( String amount) {if ( !(amount.trim().equals("")) ){
 withdraw( new java.math.BigDecimal(amount));}
 }
 If you forgot to add the public withdraw method as a method feature, you canuse Add Available Features to add it.
 Creating a New Event InterfaceThe BankAccount object fires a limitExceeded event if there are not enoughfunds for a withdrawal. If the withdrawal is not allowed, the ATMapplication can display a message to the user.
 To define and fire the event, perform the following steps:
 1. Create a new event listener interface, using the New Event ListenerSmartGuide (select New Listener Interface in the Features pull-down;see Figure 45 on page 79).
 2. On the first page of the SmartGuide, enter limitExceeded in the Eventname field, and click Next. Notice how VisualAge for Java filled in theother fields for you.
 3. On the second page, enter the name of the method that the listener classhas to implement, handleLimitExceeded, click Add, then Finish.
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Figure 45. Defining an Event with an Event Listener
 VisualAge for Java automatically generates the event and interface classesand the supporting methods for you:
 ❑ limitExceededEvent class ❑ limitExceededListener interface ❑ fireHandleLimitExceeded method ❑ addlimitExceededListener method ❑ removelimitExceededListener method
 After code generation, you will find the fireHandleLimitExceeded method inthe BankAccount class. The SavingsAccount and CheckingAccount classeswill use this method in their own withdraw method to fire the event.
 Once the event has been added, the BankAccount Bean is complete (Figure46).
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Figure 46. BankAccount Bean with Properties, Events, and Methods
 Completing the toString MethodSelect the toString method in the Methods pane on the Methods page of theClass Browser. Modify the code:
 public String toString(){
 java.util.Enumeration allTransactions = getTransactions().elements();String returnString = getAccountType() + ": " + getAccountId() +
 " Balance: " + getBalance();while( allTransactions.hasMoreElements()){
 returnString += "\n\t" + allTransactions.nextElement();}return returnString;
 }
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Building the CheckingAccount Bean
 CheckingAccount is a subclass of the BankAccount class. In addition to thefunction of the basic account class, the CheckingAccount class providesoverdraft protection. To create the CheckingAccount class, select theBankAccount class in the Workbench and then select Selected→Add Class.In the Create Class SmartGuide, enter CheckingAccount in the Class namefield. Notice how all of the other fields are filled (make sure that theSuperclass field is set to BankAccount). Click Finish to create the class.
 Next you will create a new property on CheckingAccount, called overdraft, asa java.math.BigDecimal value. The bank has decided that the overdraftproperty must be between $0 and $1000. To enforce this you can implement acustom property editor for the overdraft:
 1. In the itso.atm.model package, create a class called OverdraftEditor thatinherits from sun.beans.editors.FloatEditor.
 2. Add a void setAsText(java.lang.String text) method to OverdraftEditorwith the following code:
 public void setAsText( String text) throws java.lang.IllegalArgumentException
 {java.math.BigDecimal value = null;float floatValue;try{
 value = new java.math.BigDecimal(text);floatValue = value.floatValue();
 CheckingAccount
 overdraft
 withdraw
 Shortcut: Creating a New MethodTry this easy way of creating a new method: Select the newOverdraftEditor class and select Selected→Method Templatein the Workbench (in the Class Browser the Method Templatemenu item is in the Class, Classes, and Methods menus). Replacethe generated source with the source for the method and replacethe method using Shift-Control-S.
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if( floatValue >= 0. && floatValue <= 1000.){setValue( value);
 }else{
 throw new java.lang.IllegalArgumentException(text);}
 }catch( NumberFormatException e){
 throw new java.lang.IllegalArgumentException(e.getMessage());}
 }
 Now create the overdraft property of type java.math.BigDecimal on theCheckingAccount class, using the BeanInfo page, and set the property editorto itso.atm.model.OverdraftEditor as shown in Figure 47 on page 83.
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Figure 47. Adding the Overdraft Property and Property Editor
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The CheckingAccount class has to implement its own withdraw method. Thismethod checks whether the account balance can be updated on the basis ofthe balance and overdraft properties. It notifies other interested objects ofthe result of the withdrawal transaction, using the LimitExceeded eventdefined in the BankAccount class:
 protected void withdraw(java.math.BigDecimal amount) {
 if ( getBalance().add( getOverdraft()).compareTo( amount) > 0.0) {
 setBalance( getBalance().subtract(amount));getTransactions().addElement( new Transaction(
 getAccountId(),Transaction.WITHDRAWAL_TRANS_TYPE, amount));} else {
 fireHandleLimitExceeded( new LimitExceededEvent( this));}
 }
 This is a good time for you to see the Code Assist and Fix on Save functions.To see the Code Assist function, in the Source pane of the withdraw methoddelete WITHDRAWAL_TRANS_TYPE from Transaction.WITHDRAWAL_TRANS_TYPE. Positionyour cursor at the end of Transaction. and press Control-Spacebar. Figure 48shows the list of possible fields and methods you can choose from in thecontext of a Transaction object. Code Assist will prompt you with types,fields, and methods, depending on the context. Select WITHDRAWAL_TRANS_TYPE bydouble-clicking or using the cursor and the return key.
 Attribute InitializationWhen VisualAge for Java creates the attribute to hold theoverdraft, it creates the following code:private java.math.BigDecimal fieldOverdraft =new java.math.BigDecimal(0);This way you do not have to worry about the initial value of theoverdraft or the initial minimum balance value in the Savingsaccount.
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Figure 48. Code Assist
 To see the Fix on Save function, change WITHDRAWAL_TRANS_TYPE toWITHDRAWAL_TYPE and save the code. You should see the dialog shown in Figure49 on page 85. Select Correct to correct and save the code.
 Figure 49. Fix on Save
 One last thing and you are finished with the CheckingAccount class.Remember the getAccountType method? You created it as an abstract method
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on the BankAccount class (see “Creating the accountType Method Feature” onpage 74). Now you must fill in the source for the getAccountType method.
 Select the getAccountType method and modify it:
 public String getAccountType() {return "Checking Account";
 }
 Building the SavingsAccount Bean
 SavingsAccount is also a subclass of the BankAccount class. In addition to thefunction of the basic BankAccount class, it has to maintain a minimumbalance.
 Create the SavingsAccount class the same way you created theCheckingAccount class. Add a new property feature, minAmount, as aBigDecimal value. Implement the withdraw method:
 protected void withdraw(java.math.BigDecimal amount) {if ( getBalance().subtract(amount).compareTo( getMinAmount() ) >= 0){
 setBalance( getBalance().subtract( amount)) ;getTransactions().addElement( new Transaction( getAccountId(),
 Transaction.WITHDRAWAL_TRANS_TYPE, amount));} else {
 fireHandleLimitExceeded( new LimitExceededEvent( this));}
 }
 Now modify the getAccountType method in SavingsAccount:
 public String getAccountType() {return "Savings Account";
 }
 SavingsAccount
 minAmount
 withdraw
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Building the Card Bean
 Create a new class, itso.atm.model.Card, that extends Object. Click Next inthe Create Class SmartGuide and select the toString() checkbox in theWhich method stubs would you like to create section.
 Now create the following property features on the Card class:
 Modify the toString method:
 public String toString(){
 java.util.Enumeration allAccounts = getAccounts().elements();String returnString = "Card: " + getCardNumber() + " PIN: " + getPinNumber();while( allAccounts.hasMoreElements()){
 returnString += "\n\t" + allAccounts.nextElement();}return returnString;
 }
 Creating the pinChecked EventThe Card bean has to send messages to other objects about the result of thePIN validation. This behavior is implemented as one event, pinChecked, inthe ATM application. The pinChecked event is slightly different from thelimitExceeded event. The pinChecked event will use one event object,PinCheckedEvent, but will define two methods to handle the event:
 Name Type Bound
 accounts java.util.Vector false
 cardNumber java.lang.String false
 pinNumber java.lang.String false
 BankAccount
 CardcardNumberpinNumber
 checkPin0..*
 0..*
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handleValidPINhandleInvalidPIN
 To define and fire the event, perform the following steps:
 1. Create a new event listener interface (similar to the listener interfacecreated in “Building the BankAccount Bean” on page 71), using the NewEvent Listener SmartGuide (select New Listener Interface in theFeatures pull-down).
 2. On the first page of the SmartGuide, enter the name of the event,pinChecked, and click Next.
 3. On the second page, enter the name of the methods that the listener classhas to implement. Enter handleValidPin, then click Add. EnterhandleInvalidPin, click Add again, then Finish.
 Now, all you have to implement is the logic to fire the events:
 1. On the BeanInfo page, add a new method feature to the Card class andcall it checkPin, with a Return type of void. Enter 1 in the Parameter countfield. On the next page, enter pinEntered in the Parameter name field andjava.lang.String in the Parameter type field (Figure 50 on page 89). Clickthe Finish button. The checkPin method compares the pinEnteredparameter with the pinNumber property and notifies listeners by firing thepinCheckedEvent, using the handleValidPIN or handleInvalidPIN method asappropriate.
 2. Change the checkPin method stub to match the following code:
 public void checkPin( String pinEntered){if ( getPinNumber().trim().equals( pinEntered.trim()) ){
 fireHandleValidPin( new PinCheckedEvent( this));}else{
 fireHandleInvalidPin( new PinCheckedEvent( this));}
 }
 88 Programming with VisualAge for Java Version 2

Page 115
                        

Figure 50. Adding the checkPin Method Feature
 The Card bean needs one more method feature, getAccount, returning aBankAccount object and taking one parameter, index of type int. Add themethod and modify it:
 public BankAccount getAccount( int index) {return (BankAccount)getAccounts().elementAt( index);
 }
 The accounts property was not created as an indexed property because it usesa Vector rather than an array to store the values. Therefore you do not haveto know anything about the number of elements beforehand. If an array hadbeen used, accounts could have been created as an indexed property.
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Once you have added these methods features, the Card Bean should look likethat shown in Figure 51.
 Figure 51. The Card Bean
 Deleting FeaturesNow that you have created features, you probably want to know how to deletethem (especially when you create one incorrectly). It is simple: You select thefeatures you want to delete and then select Features→Delete. You arepresented with a dialog that confirms the deletion of the feature and asks youto select the methods to delete. Select any methods that will not be used.
 Once you have deleted the feature and the selected methods, you have othercode to clean up, depending on the type of feature:
 ❑ Property
 The attribute holding the property value must be deleted. For example,the string property, accountId, is represented by this attributedeclaration:
 private fieldAccountId = new String();
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You must delete this declaration manually from the class declaration.
 ❑ Event listener interface
 When deleting an event, you must manually delete:
 • Any of the convenience methods that fire the event; for example, if youwere deleting the PinChecked event you would have to delete thefollowing methods from the Card class:
 fireHandleInvalidPin(itso.atm.model.PinCheckedEvent event)fireHandleValidPin(itso.atm.model.PinCheckedEvent event)
 • The event, event multicaster, and listener classes created. For thePinChecked event, you would delete:
 PinCheckedEventPinCheckedEventMulticasterPinCheckedListener
 • The listener attribute created in the class declaration that fires theevent. For the PinChecked event:
 protected transient itso.atm.model.PinCheckedListener aPinCheckedListener = null;
 Building the Customer Bean
 To create the Customer class, select the itso.atm.model package in theWorkbench and then select Selected→Add→Class. Enter Customer in theClass Name field and click Next. Select the toString() checkbox in theWhich method stubs would you like to create section. Click Finish.
 Now create the following property features on the Customer class:
 Customer
 titlefirstNamelastName
 BankAccount
 Card
 customerId
 1
 1
 1..*
 0..*
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Select the toString method in the Source pane and modify the code:
 public String toString() {java.util.Enumeration allCards = getCards().elements();String returnString = getTitle().trim() + " " +
 getFirstName().trim() + " " +getLastName().trim();
 while( allCards.hasMoreElements()){returnString += "\n\t" + allCards.nextElement();
 }return returnString;
 }
 The trim method just trims extra whitespace from a string. Save the code byselecting Save from the Source pane pop-up menu.
 Adding a Custom Property Editor to the Customer BeanCustom property editors are used in JavaBean development environments tocustomize a JavaBean at development time. They are defined in the BeanInfoclass or found through JavaBean naming patterns. When the property sheetfor a bean is displayed in the Visual Composition Editor, any custom propertyeditors that are defined for the bean’s properties are instantiated and used tochange the properties in the property sheet.
 The following is a simple (but not particularly useful) example of a customproperty editor. The title property for the Customer bean has three validvalues: Mr., Mrs., and Ms. You can create a custom property editor so thatonly these choices are available for setting the property in the developmentenvironment. To create the custom property editor for the title property,follow these steps:
 Name Type Bound
 accounts java.util.Vector false
 customerId java.lang.String false
 firstName java.lang.String false
 lastName java.lang.String false
 title java.lang.String false
 cards java.util.Vector false
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1. Create a class called CustomerTitleEditor that inherits fromjava.beans.PropertyEditorSupport in the Programming VAJ V2 project anditso.atm.model package.
 2. Add a public method to CustomerTitleEditor named String[] getTags()with the following code:
 String result[] = {"Mr.", "Mrs.", "Ms."};return result;
 The getTags method is used when the property value must be one of a setof known values.
 3. Open the Customer bean in the Class Browser and switch to the BeanInfopage. Select the title property and click in the entry field to the right ofProperty editor. Click on the drop-down list arrow and then selectitso.atm.model.CustomerTitleEditor. Select Information→Save.
 Now when you use the Customer bean in the Visual Composition Editor, youwill be able to choose the title property rather than type it in.
 It is always a good idea to test each class you create when coding. In thiscase, you could type the following into the Scrapbook and run it to begintesting to see that your class is functioning properly:
 itso.atm.model.Customer c = new itso.atm.model.Customer();c.setCustomerId( "1234567");c.setFirstName("John");c.setLastName("Doe");c.setTitle("Mr.");System.out.println( c);
 You can create test scripts for each of the classes you create to ensure theyare working as designed. Alternatively you can add a main method to eachclass and put the test code within the main method. Then you can simply runeach class to test it.
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Building the Bank Bean
 The itso.atm.model.Bank bean is fairly simple. Create the Bank class andagain add the declaration for the toString() method. Add one propertyfeature: customers of type java.util.Vector. Create two method features:Customer getCustomer( Card cardParam), which returns a customer given avalid card, and Card validCard( String cardParam), which checks whether acard is valid based on its number.
 The method bodies should match the following code:
 public Customer getCustomer( Card cardParam) {java.util.Enumeration allCustomers = getCustomers().elements();while( allCustomers.hasMoreElements()){
 Customer customer = (Customer)allCustomers.nextElement();java.util.Enumeration customerCards = customer.getCards().elements();while( customerCards.hasMoreElements()){
 Card card = (Card)customerCards.nextElement();if( card.getCardNumber().equals( cardParam.getCardNumber())){
 return customer;}
 }}return null;
 }
 public Card validCard( String cardParam) {java.util.Enumeration allCustomers = getCustomers().elements();while( allCustomers.hasMoreElements()){
 Customer customer = (Customer)allCustomers.nextElement();java.util.Enumeration customerCards = customer.getCards().elements();while( customerCards.hasMoreElements()){
 Card card = (Card)customerCards.nextElement();if( card.getCardNumber().equals( cardParam)){
 return card;}
 Customer
 Bank
 validCard
 1
 0..*
 getCustomer
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}}return null;
 }
 public String toString(){
 java.util.Enumeration allCustomers = getCustomers().elements();String returnString = "Bank Information";while( allCustomers.hasMoreElements()){
 returnString += "\n\t" + allCustomers.nextElement().toString();}return returnString;
 }
 Whew! You have completed the model for the ATM application. It may haveseemed like a lot of work, but the early work of designing and implementinga robust model pays off later.
 Before you congratulate yourself, however, take a moment to test your newATM model. In the Scrapbook you can exercise the model by typing in thecode listed below. Alternatively, you can use the Scrapbook to open theExerciseModel.txt file. This file is included with the sample code andcontains the code listed below.
 Select this code in the Scrapbook and then select Edit→Run:
 /* First create the bank */itso.atm.model.Bank bank = new itso.atm.model.Bank();/* Create the customers */itso.atm.model.Customer customer1 = new itso.atm.model.Customer();itso.atm.model.Customer customer2 = new itso.atm.model.Customer();/* Add the customers to the bank */bank.getCustomers().addElement(customer1);bank.getCustomers().addElement(customer2);/* Create the ATM cards */itso.atm.model.Card customer1Card = new itso.atm.model.Card();itso.atm.model.Card customer2Card = new itso.atm.model.Card();customer1Card.setCardNumber("100001");customer1Card.setPinNumber("3405");customer2Card.setCardNumber("100002");customer2Card.setPinNumber("0033");/* Add the cards to the customers */customer1.getCards().addElement(customer1Card);customer2.getCards().addElement(customer2Card);/* Set the customer information */customer1.setCustomerId("3056978");customer1.setLastName("Doe");customer1.setFirstName("John");
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customer1.setTitle("Mr.");customer2.setCustomerId("6979304");customer2.setLastName("Smith");customer2.setFirstName("Anne");customer2.setTitle("Ms.");/* Create the accounts */itso.atm.model.CheckingAccount checkingAccountCustomer1 = new itso.atm.model.CheckingAccount();checkingAccountCustomer1.setAccountId("34759023");checkingAccountCustomer1.setBalance(new java.math.BigDecimal(1000.));itso.atm.model.SavingsAccount savingsAccountCustomer1 = new itso.atm.model.SavingsAccount();savingsAccountCustomer1.setBalance(new java.math.BigDecimal(100.));savingsAccountCustomer1.setAccountId("34759023");itso.atm.model.CheckingAccount checkingAccountCustomer2 = new itso.atm.model.CheckingAccount();checkingAccountCustomer2.setAccountId("34744442");checkingAccountCustomer2.setBalance(new java.math.BigDecimal(10000.));/* Add the accounts to the customers and the cards */customer1.getAccounts().addElement(checkingAccountCustomer1);customer1.getAccounts().addElement(savingsAccountCustomer1);customer2.getAccounts().addElement(checkingAccountCustomer2);((itso.atm.model.Card) customer1.getCards().firstElement()).getAccounts().addElement(checkingAccountCustomer1);((itso.atm.model.Card) customer1.getCards().firstElement()).getAccounts().addElement(savingsAccountCustomer1);((itso.atm.model.Card) customer2.getCards().firstElement()).getAccounts().addElement(checkingAccountCustomer2);/* Make some transactions and look at the model */checkingAccountCustomer1.deposit("23455.33");System.out.println(bank.toString());checkingAccountCustomer1.deposit("533.");System.out.println(bank.toString());savingsAccountCustomer1.withdraw("5.");System.out.println(bank.toString());checkingAccountCustomer2.withdraw("533.");System.out.println(bank.toString());
 The output in the Console should match the following text (except for thetime stamps, of course):
 Bank InformationMr. John DoeCard: 100001 PIN: 3405Checking Account: 34759023 Balance: 24455.33Deposit Transaction: $23455.33 [1998-09-16 15:42:28.818]
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Savings Account: 34759023 Balance: 100Ms. Anne SmithCard: 100002 PIN: 0033Checking Account: 34744442 Balance: 10000Bank InformationMr. John DoeCard: 100001 PIN: 3405Checking Account: 34759023 Balance: 24988.33Deposit Transaction: $23455.33 [1998-09-16 15:42:28.818]Deposit Transaction: $533 [1998-09-16 15:42:32.562]Savings Account: 34759023 Balance: 100Ms. Anne SmithCard: 100002 PIN: 0033Checking Account: 34744442 Balance: 10000Bank InformationMr. John DoeCard: 100001 PIN: 3405Checking Account: 34759023 Balance: 24988.33Deposit Transaction: $23455.33 [1998-09-16 15:42:28.818]Deposit Transaction: $533 [1998-09-16 15:42:32.562]Savings Account: 34759023 Balance: 95Withdrawal Transaction: $5 [1998-09-16 15:42:32.589]Ms. Anne SmithCard: 100002 PIN: 0033Checking Account: 34744442 Balance: 10000Bank InformationMr. John DoeCard: 100001 PIN: 3405Checking Account: 34759023 Balance: 24988.33Deposit Transaction: $23455.33 [1998-09-16 15:42:28.818]Deposit Transaction: $533 [1998-09-16 15:42:32.562]Savings Account: 34759023 Balance: 95Withdrawal Transaction: $5 [1998-09-16 15:42:32.589]Ms. Anne SmithCard: 100002 PIN: 0033Checking Account: 34744442 Balance: 9467Withdrawal Transaction: $533 [1998-09-16 15:42:32.724]
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4 Building User InterfacesSupport for developing Java user interfaces has been limited. The userinterfaces of Java programs are not as sophisticated as those created in otherdevelopment environments. With the new graphical user-interface (GUI)toolkit that Java Foundation Classes (JFC) provide, Java developers can nowcreate user interfaces that provide the level of sophistication that usersexpect.
 This chapter introduces the JFC and shows you how to use them in theVisualAge for Java Visual Composition Editor. You will learn how to visuallycompose the user interface of your Java program and let the VisualComposition Editor generate the code automatically for you.
 As you use the JFC to create more complex user interfaces, you will want tolearn more about it from other resources, such as those listed in Appendix B,“Related Publications” on page 385.
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An Abstract Windowing Toolkit RefresherIn the JDK there is a set of classes called the Abstract Windowing Toolkit(AWT). Before the JFC, the AWT was the only standard API for providingGUIs for Java programs. The initial goal was to provide developers with arudimentary library for building applications and applets. Importantfeatures of the AWT are:
 ❑ 100% portability from a single set of source code
 ❑ A native look and feel on the deployment platform
 The AWT uses a layered toolkit model where each Java component creates anative component. It is referred to as the peer model. Each Java componentclass ‘wraps’ the peer or native implementation. The peer model can increasecomplexity because many native components maintain their own state.
 The first version of AWT included in JDK 1.0 had many limitations and aprogramming model that was awkward to use. The AWT version providedwith JDK 1.1 removes many of those limitations and introduces a newcomponent programming model based on JavaBeans. The programmingmodel eases the creation of GUIs by using visual programming tools such asthe Visual Composition Editor of VisualAge for Java.
 What Is the JFC?The JFC is also known by its code name Swing (derived from the music demogiven at the 1997 JavaOne convention in San Francisco). The JFC componentset is a new GUI toolkit that provides a rich set of windowing components,the visual components used in GUI-based programs.
 With the JFC, you can develop efficient GUI components that have exactlythe “look and feel” that you specify. For example, a program that uses JFCcomponents can be designed such that it will execute without modification onany kind of computer and can always look and feel just like a programwritten specifically for the particular computer on which it is running.
 The JFC provides:
 ❑ Improved runtime performance for GUI applications
 ❑ Improved “time to load” for applets with fewer classes to download thanthe AWT
 ❑ Easy conversion of existing AWT components to JFC lightweightcomponents
 100 Programming with VisualAge for Java Version 2

Page 127
                        

The JFC and the AWTAlmost all JFC components are said to be lightweight because they do notrely on user interface code that is native to the operating system on whichthey are running; they “borrow” the screen resource of an ancestor.
 The JFC contains far more components than the AWT toolkit. Many of thecomponents in the JFC are 100% Pure Java versions of pre-JFC AWTcomponents such as Button, Scrollbar, and List. But the JFC also includes apure Java set of higher-level components (such as trees and tabbed panes)that were not available in the AWT API.
 Like the AWT, JFC components follow the JavaBeans specification.JavaBean support is built into the JFC, so it makes it easy to use JFCcomponents in application-builder programs that use JavaBeans.
 The major differences between the AWT and the JFC are:
 ❑ The JFC uses the model-view-controller (MVC) paradigm to separate thedata from the user interface. This changes both the events that the userinterface uses and the way you interact with the components.
 ❑ The JFC has different look and feel settings that specify how the wholeuser interface looks and behaves.
 Some other differences:
 ❑ JFC components often have an inner element or content pane where youadd child components. In the AWT you add child components directly to asubtype of Frame or Applet, for example.
 ❑ The AWT has only two types of buttons; Button and CheckBox, whichinherit directly from the component class. In the JFC, the buttonhierarchy provides much more functionality (Figure 53).
 ❑ In the AWT, the Menu class descends from the Object class, not theComponent class. In the JFC, the JMenu class descends from JComponent, in amore complex tree that also encompasses the button tree. Thus it is easyto coordinate button events and menu events. The JFC has a newinterface, Action, that allows several controls to be associated with thesame function. For example, a single mouse click can activate ordeactivate both a menu item and a corresponding toolbar button.
 Mixing AWT and JFC components in the same program is possible but notrecommended. Not only will you have problems (especially with overlappingelements) but you will also have to maintain code with two separate GUItoolkits, and the AWT classes may not always be part of the JDK.
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JFC ComponentsThe JFC is huge and consists of 20 packages (Figure 52 on page 102)containing more than 250 classes and 75 interfaces. Although some JFCcomponents are similar to their AWT predecessors, in most cases there areimportant differences.
 Figure 52. JFC Packages
 Figure 53 on page 103 shows many of the user interface components of theJFC component hierarchy and how they relate to each other. Notice howmany JFC components have the same name as AWT components, but with aJ added at the beginning of the name. Some of these components, forexample, JApplet, JFrame, and JDialog, extend their AWT counterparts, butmost do not, for example, JPanel, JButton, JMenu, and JTextField.
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Figure 53. JFC Component Hierarchy
 Figure 53 shows only a part of the JFC component hierarchy. There areseparate hierarchies for models, tables, text, actions, events, trees, and undo.Notice the JApplet and JFrame. These are the initial components yousubclass when building new applications or applets.
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The JFC and the MVC ArchitectureThe MVC architecture separates your application into three parts:
 ModelThe model part is the business model or set of classes representingthe domain of the application. This part is where business rules ordomain logic are encapsulated. The model part can also (indirectlyor directly) contain the data your application needs.
 ViewThe view is the user interface of your application.
 ControllerThe controller handles the interaction between the user and theview and can also control the interaction between the model andthe view.
 MVC was originally created in Smalltalk development but is now recognizedas a valid architecture for many different environments. For a simpleexample of a controller, see “Building the BookmarkListController” on page126.
 The JFC has introduced MVC to Java developers. In the AWT, components donot expose an association with the data they display. For example, a listsimply has methods to add and remove elements. A text field has methods toset or get the string being displayed. The JFC now associates models witheach user interface element that displays data. For example a list isassociated with a list model, and a text field is associated with a documentmodel. Lists and other more complex components are also associated withselection models that handle the selection interaction of the component.
 To use JFC components you must be aware of the models that eachcomponent uses. In most cases, however, you do not have to explicitly use amodel. If you do use a model, it will probably be the default supplied by theJFC for the component. In “Visual Programming in Action” on page 124 youwill learn how to use the list model to instantiate and manipulate a list.
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Look and FeelThe JFC can assume several platform independent look and feels. The lookand feel packages are located under the com.sun.java.plaf package (plafstands for pluggable look and feel). They include:
 MetalThe Metal look and feel, officially called the Java Look and Feel, isthe default and the only look and feel available at design time inthe Visual Composition Editor. Metal is a good look and feel forapplications that run on many different platforms.
 WindowsThe Windows look and feel emulates an application running in theWindows NT, Windows 95, and Windows 98 environments. It isdesigned to work only in these environments.
 MotifThe Motif look and feel emulates the Motif desktop found on manyUNIX systems.
 MultiThe Multi look and feel allows a component to be associated withseveral different look and feels at the same time.
 Two other look and feels are not included in the standard JFC 1.02 packages:
 OrganicThe Organic look and feel was the original goal of Project Metal (adevelopment effort at Sun MicroSystems). The actual result ofProject Metal was the Java Look and Feel.
 MacThe Mac or MacOS look and feel emulates the look and feel of aMacintosh. It is designed to work only on Macintosh computers.
 The JFC Implementation of MVCIn the JFC implementation of MVC, the view and controller arecombined into one class. The primary component class (forexample, JList) contains the view and the controller, and themodel class (for example, DefaultListModel) contains the model.
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The look and feels are truly pluggable so it is easy to create an applicationthat allows a user to switch look and feels by usingcom.sun.java.swing.UIManager.getInstalledLookandFeels() to see which lookand feels are available on the workstation and then callingcom.sun.java.swing.UIManager.setLookandFeel(). Use the UIManager toquery and set most aspects of the user interface. If you have to be different, itis also possible to create your own look and feel.
 Layout ManagersJava uses layout managers to decide how components are positioned withintheir container. The choice of a layout manager for your container directlyaffects the size, shape, and placement of your components within thatcontainer. In addition, layout managers adapt dynamically to the dimensionsof the container, solving many problems related to display resolution or fontchanges.
 You have five layout managers to choose from in JDK 1.1, ranging from thevery simple FlowLayout and GridLayout, to the special-purposeBorderLayout and CardLayout and the flexible GridBagLayout. You can alsochoose not to have any layout manager by using the null layout.
 The classes implementing the layout managers in JDK 1.1 are:
 ❑ FlowLayout
 ❑ BorderLayout
 ❑ CardLayout
 ❑ GridLayout
 ❑ GridBagLayout
 In the IBMJavaExamples project, thecom.bim.ivj.example.examples.vc.swing.layoutmanagers package shows yousamples of the different layout managers.
 The JFC defines two new layout managers:
 ❑ BoxLayout
 ❑ Overlay Layout
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FlowLayoutFlowLayout lays out components from left to right, starting new rows ifnecessary (Figure 54).
 Figure 54. FlowLayout
 BorderLayoutBorderLayout organizes components, using constraints based on the compassdirections: North, East, South, and West. The fifth direction is Center. You donot have to use all directions in your programs if you do not need them(Figure 55). A component in the Center will expand to fill any space in thecontainer.
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Figure 55. BorderLayout
 BoxLayoutUse the BoxLayout to arrange components along either an x-axis or y-axis. Ina y-axis Boxlayout, components are arranged from top to bottom in the orderin which they are added. Unlike GridLayout, BoxLayout allows componentsto occupy different amounts of space along the primary axis.
 Along the nonprimary axis, BoxLayout attempts to make all components astall as the tallest component (for left-to-right BoxLayouts) or as wide as thewidest component (for top-to-bottom BoxLayouts). If a component cannotincrease to this size, BoxLayout looks at its y-alignment property orx-alignment property to determine how to place it.
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Figure 56. BoxLayout
 CardLayoutCardLayout simulates a deck of cards, or a notebook, in that you can put anumber of pages on top of each other, and you can traverse the pages inseveral ways. In other words you can have an area that can contain differentcomponents at different times. Figure 57 shows an example with two cards.
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Figure 57. CardLayout
 GridLayoutGridLayout organizes components, using a predefined number of rows andcolumns. It simply makes a number of components have equal size,displaying them in the requested number of rows and columns. It is possibleto have a gap between cells. The components are added to cells starting fromthe top left corner, then going to the right. When a row is full, the next row isstarted from the left. Figure 58 shows an example of a simple calculator thatuses the GridLayout manager for its digits buttons.
 Figure 58. GridLayout
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GridBagLayoutGridBagLayout is the most sophisticated and flexible but also most complexof the layout managers. The advantage of using GridBagLayout instead ofGridLayout, which it resembles, is that the components do not have to be ofthe same size. You can use several types of constraints when attachingcomponents to a container, including whether a component expandshorizontally or vertically. In Figure 59 you can see that the entry fieldexpands horizontally and the Clear button and list expand vertically.
 Figure 59. GridBagLayout
 OverlayLayoutOverlayLayout (Figure 60) places each added component on top of oneanother and sizes the container large enough to hold the largest of itscomponents.
 The OverlayLayout class does not have a default constructor, so you cannotuse it directly in the Visual Composition Editor. You must create itdynamically at runtime.
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Figure 60. OverlayLayout
 Using Layout Managers in VisualAge for JavaIn the Visual Composition Editor you can select which layout manager acontainer will use from the Property sheet for the component. Once you haveselected the layout manager, each component in the container will have a setof constraints on its Property sheet appropriate to that layout manager. Theexception is the OverlayLayout, which cannot be selected from the Propertysheet.
 When you drop components onto the container, VisualAge for Java providesvisual clues about the location of the component. Throughout this book youwill learn how to use several of the layout managers in VisualAge for Java.
 Visual Composition EditorThe Visual Composition Editor (Figure 61 on page 113) is a powerful GUIbuilder as well as a visual programming tool. Not only can you compose theuser interface of your application visually but you also can specify the logic ofyour application by connecting together visual or GUI beans with nonvisualor invisible beans. You build composite beans or applets and applications byconnecting beans together.
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Figure 61. The Visual Composition Editor
 The Visual Composition Editor can manipulate two types of beans:
 ❑ Visual beans, which are subclasses of the AWT Component class (whichincludes the JFC). Examples are List, JList, Button, JButton, andTextField. Visual beans have a visual representation at design time that issimilar to their appearance at runtime. The design-time appearance ofJFC beans is their default appearance using the Metal Look and Feel; atruntime they have the look and feel that your application specifies.
 ❑ Nonvisual beans usually represent the business logic in your programs,for example, a BankAccount bean. At design time nonvisual beans appearby default as a puzzle icon, or they may have a specific icon associatedwith them (Figure 62). They do not have a visual representation atruntime.
 Toolbar
 Class Browser Tabs
 Beans
 Choose Palette Category
 Selection
 Choose Bean
 Status Line
 Free-form Surface Visual Representation
 Palette
 Tool
 Tool
 of Bean
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Figure 62. Nonvisual Bean Icons
 The Beans PaletteWhen you first start VisualAge for Java, the Beans Palette contains all of theuser interface beans in the AWT and JFC as well as some “helper” beans.There are three categories of beans originally on the palette (Figure 63); youselect them using the Choose Palette Category drop-down list. The selectionsare:
 ❑ Swing
 ❑ AWT
 ❑ Other (the helper beans)
 There is also an Available selection on the Choose Palette Category that youuse to load additional features into the workspace.
 Each category is further separated into subcategories by function. For theJFC and AWT, there are three major subcategories:
 ❑ Button and data entry
 ❑ Containers
 ❑ Menus
 Within each sub-category you can identify individual beans, using hover help(explanations that appear at the cursor when you leave the cursor over anelement on the screen).
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Figure 63. The Beans Palette with Swing, AWT, and Other Bean Categories
 Always available directly below the Choose Palette Category button arethe Selection and Choose Bean tools:
 SelectionUse the Selection tool to select and move beans and connections onthe free-form surface.
 Choose BeanUse the Choose Bean tool to add beans to the free-form surfacethat are not on the Beans Palette.
 Beans Palette ModificationYou can modify the palette by resizing it, changing the icon size, or adding orremoving categories, separators, beans you have constructed yourself, orbeans supplied by a vendor.
 To modify the Beans Palette use the popup menu from the palette as shownin Figure 64 or select Bean→Modify Palette. After you invoke the function,the Modify Palette dialog appears (Figure 65) where you can choose the beanto modify on the palette.
 If you import beans from a JAR file, VisualAge for Java automaticallyprompts you with the Modify Palette dialog.
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Figure 64. Modifying the Beans Palette
 Figure 65. Modify Palette Dialog Box
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Free-Form SurfaceThe free-form surface is where you do all of your visual programming. Youselect a bean from the Beans Palette or use the Choose Bean tool and thendrop the bean on the free-form surface.
 If the bean you are editing (the bean opened in the class browser) is a GUIbean, that is, it descends from java.awt.Component, it will have a visualrepresentation (the large grey box shown in Figure 61 on page 113) on thefree-form surface. This representation is where you add other GUIcomponents to the bean. When you place beans onto any empty part of thefree-form surface, you are adding them to the bean and not to the visualrepresentation of the bean.
 The empty part of the free-form surface is where you add invisible beans tothe bean you are editing. For example, in the ATM application you will addbuttons and text fields to the visual representation of the bean but you willadd the model beans (for example, Bank and CheckingAccount) to thefree-form surface outside the visual representation of the bean.
 The ToolbarThe Visual Composition Editor’s toolbar (Figure 66 on page 118) provides youwith many useful shortcuts to menu actions.
 Adding Beans in the Visual Composition EditorA bean that is added to the visual representation of anotherContainer bean must be a subtype of java.awt.Component. Whenyou add a bean to the visual representation of a bean, adeclaration of the bean is added to the class declaration of theprimary bean, and the add method is called on the GUI bean towhich you added the bean. When you add a bean anywhere else on the free-form surface, onlythe attribute is added to the class declaration. You can add otherContainer beans to the free-form surface and add GUI beans tothem.
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Figure 66. The Visual Composition Editor Toolbar
 Open Debugger
 Match Height
 Match Width
 Distribute Vertically
 Distribute Horizontally
 Align Bottom
 Align Middle
 Align Top
 Align Right
 Align Center
 Align Left
 Show Connections
 Hide Connections
 Show Beans List
 Show Properties
 Run
 Using the Visual Composition Editor Alignment ToolsThe toolbar has several controls to align, distribute, and size thecomponents in the Visual Composition Editor. The controls onlywork with a null layout. Because using a null layout is notrecommended for writing portable programs, you are better offnot using the null layout and alignment tools unless you know thedisplays on which your programs will run or you are creating aquick prototype.You can also use the alignment and distribution tools to arrangethe nonvisual beans on the free-form surface. Using these toolsand rearranging connections can facilitate visual development.
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Working with Beans in the Visual Composition EditorIn this section you learn how to add beans to the free-form surface andcustomize beans through their Property sheet.
 Adding BeansThe free-from surface is like a blank sheet of paper or work area where youcan add, manipulate, and connect the beans that you work with to createyour composite bean.
 When you select a bean from the Beans Palette, the cursor is loaded withthat bean and appears as a set of crosshairs. The bean can then be added tothe free-from surface, the Beans List, or to an existing container bean (a beanthat descends from java.awt.Container). When unloaded, the cursor revertsback to the Selection tool arrow (Figure 67).
 Figure 67. Selection and Choose Bean Tools on the Palette
 Select the Choose Bean tool (the right icon in Figure 67) to retrieve a beanthat is not on the palette and drop it on the Beans List, the free-form surface,or an existing container bean.
 After you invoke the Choose Bean tool, the Choose Bean dialog (Figure 68)appears. You can type the class name of your bean in the Class name field(remember to use the fully qualified name) or use the Browse button to findthe class. In the Name field, type the name of the bean. Finally selectwhether you are creating a class, a variable, or a serialized bean read from aserialization file.
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Figure 68. Choose Bean Dialog
 Customizing BeansOnce you have dropped a bean on the free-form surface, you can customize itby double-clicking the bean to open its Property sheet. You can also open abean’s property sheet by selecting Properties from the bean’s pop-up menuor selecting the Show Properties button on the tool bar. Using the Propertysheet, you can change properties exposed by the bean as well as the beanname.
 You can edit the properties for a single bean or select several beans and opena Property sheet for them. When you change a property on the Property sheetfor multiple selected beans, the change affects all beans selected.
 Figure 69 shows the property sheet of a JTextField bean. Select the Showexpert features checkbox to access expert properties of the bean.
 The Sticky FunctionTo add multiple instances of the same bean, enable the Stickyfunction by holding down the Control key while selecting thebean. Selecting a new bean or the Selection tool disables Sticky.
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Figure 69. Property Sheet of a JTextField Bean
 Each bean also has a pop-up menu (Figure 70 on page 122) that you access byclicking the right mouse button. The pop-up menu has the following selectionitems:
 PropertiesOpen the Property sheet for the bean.
 Event to CodeStart an event-to-code connection from this bean.
 Open (class only)Open the bean’s class in a class browser.
 Promote Bean FeaturePromote a feature of the bean as a feature on the primary bean.
 Change Type (variable or factory only)Change the underlying type of the variable or factory.
 Morph IntoChange the type of this bean or variable to another closely relatedtype and update any conceitedness and properties. Morph Into canbe used to change a class to a variable and vice versa or to changeAWT components to JFC components.
 Change Bean NameChange the name of the bean in the Visual Composition Editor.
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The change will also affect the attribute name and the names ofaccessor and mutator methods.
 DeleteDelete this bean from the free-form surface.
 LayoutPosition the bean on the free-form surface.
 ConnectStart a connection from this bean.
 Browse ConnectionsList all connections to and from this bean. You can also hide andshow connections from the bean.
 Reorder Connections FromChange the order in which connections from this bean are fired.
 Tear-Off PropertyTear off a property from this bean so you can access it as avariable on the free-form surface.
 Refresh InterfaceIf the BeanInfo interface has changed, use Refresh Interface toupdate the Visual Composition Editor environment with thechanges.
 Figure 70. Bean Pop-up Menu for Class and Variable
 Naming BeansThe Visual Composition Editor assigns default names to distinguish beansand connections when you generate the code to build programs. It assignsbean names on the basis of the class name and the number of beans of thattype on the free-form surface or the name you specify when you use the
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Choose Bean tool. You can give a bean a different name at any time.VisualAge for Java uses the bean name in two ways:
 ❑ The bean name is shown on the free-form surface and in the Propertysheet. This name is not equivalent to the name property on objects of theComponent class.
 4. The bean name is also used as the basis for the attribute name in the Javasource and the getter and setter methods generated for the bean. Theattribute name is typically ivjBeanName, where BeanName is the name ofthe bean.
 Give beans meaningful names if they will be accessed using Java code thatyou write yourself. If you do not give beans meaningful names it will beextremely difficult to write code that accesses the beans. For example, if youadd an Exit button to an application, VisualAge for Java gives it a namebased on the number of default button names currently in use. For example,the name might be ivjButton111. It will be much easier to write code thataccesses the bean if you name the button ExitButton!
 Properties created in the BeanInfo page use a similar naming convention.The attribute has the prefix field instead of ivj, however.
 Beans ListThe Beans List is a very helpful tool. It shows all of the beans andconnections on the free-form surface. From the Beans List you can:
 ❑ Select or delete any bean ❑ Access the pop-up menu and Property sheet for any bean ❑ Move a bean to a different container or position in the container ❑ Select or delete any connection ❑ Connect beans
 Factory and VariableFactory and Variable are helper beans. Typically, when you add JavaBeans tothe free-form surface they are instantiated when your program starts orwhen the bean is first accessed. In many cases you do not want this behavior.For example:
 ❑ You may not know the specifics of a bean when the program starts.
 ❑ You may not want to use the resources when the program starts.
 ❑ You may only want a place holder or reference to an existing bean.
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In these and other cases, you would use factories and variables instead ofbeans. Factories are visual tools that create other beans. Variables are visualplace holders that reference other beans. Factories and variables are notreally JavaBeans, they are helpers that cause code to be generated for you.
 You can also use factories and variables to visually program the constructionand manipulation of objects that are not beans, for example, objects that donot have a default constructor.
 Visual Programming in ActionIn this section you create a simple applet: the Bookmark List, which willkeep track of your favorite URLs (Figure 71 on page 124). Along with theATM application, the Bookmark List is used in examples throughout thisbook.
 Figure 71. The Finished Bookmark List Applet
 The Bookmark List will enable you to add or delete URLs and surf to thoseURLs. It will demonstrate the use of such features as creating a visual bean,using BorderLayout and GridBagLayout, tearing off a property, makingevent-to-method connections, and making event-to-code connections.
 You will also build a controller for the Bookmark List. The controller willhandle the interaction between the GUI and the actual list of URLs. While acontroller is a bit of overkill for this example, it will let you expand theBookmark List later to access a database and run as a servlet!
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First you create two packages, itso.bookmark and itso.bookmark.applet, inthe Programming VAJ V2 project to hold the Bookmark List classes.
 Creating the Bookmark ClassesCreate the following three classes for the Bookmark List (note the packagesin which you create each class), using the Create Class SmartGuide:
 1. itso.bookmark.Bookmark, which extends java.lang.Object. Make sure youdeselect the Compose the class visually checkbox and select thetoString method on the second page of the SmartGuide.
 2. itso.bookmark.applet.BookmarkListController, which extendsjava.lang.Object
 3. itso.bookmark.applet.BookmarkListView, which extendscom.sun.java.swing.JApplet
 Building the Bookmark ClassThe Bookmark class is very simple. It holds the title and URL for a bookmarkand has a constructor that takes both the title and the URL and implementsthe toString method. Add the following properties:
 Add a new constructor to match the following code:
 public Bookmark( String title, String url) {setTitle( title);setUrl(url);
 }
 Name Type Readable Writeable Bound
 title String Yes Yes No
 url String Yes Yes No
 Using the Create Applet SmartGuideBy default, the Create Applet SmartGuide creates ajava.applet.Applet, not the JFC JApplet that you want. Tocreate the BookmarkListView, using the Create AppletSmartGuide, click on Browse and select JApplet.
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Modify the toString implementation to return the title only:
 public String toString() {return getTitle();
 }
 Building the BookmarkListControllerThe BookmarkListController class holds an instance of the DefaultListModelmodel and handles all interactions with the view. First add the followingimport statements to the top of the class declaration so you do not have totype those long package names:
 import com.sun.java.swing.*;import java.util.*;import itso.bookmark.Bookmark;
 Now add the model as a property feature:
 Now you have to add the functionality of the list. You want to be able to:
 ❑ Add an entry to the list
 ❑ Delete an entry from the list
 Adding an EntryTo add an entry, create a new method feature:
 Fill in the method:
 public void addEntry(String title, String url) {getBookmarkList().addElement( new Bookmark( title, url));return;
 }
 Deleting an EntryTo delete an entry, create a new method feature:
 Name Type Readable Writeable Bound
 bookmarkList DefaultListModel Yes No No
 Name Return Type Parameters Parameter1
 Parameter 2
 addEntry void 2 String title String url
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Fill in the method:
 public void deleteEntry(String title) {Enumeration e = getBookmarkList().elements();Bookmark b = null;while( e.hasMoreElements()){
 b = (Bookmark)e.nextElement();if( b.getTitle().equals( title)){
 getBookmarkList().removeElement(b);return;
 }}return;
 }
 Initializing the BookmarkListControllerTo start off with some data, create the following method feature in thecontroller:
 public void init( JApplet applet){StringTokenizer st = new StringTokenizer( applet.getParameter("Data"), ";");while (st.hasMoreTokens()) {
 addEntry( st.nextToken(), st.nextToken());}
 }
 Now you have a complete, if simple, model and controller!
 Building the BookmarkListView AppletFirst add the following import statement to the top of the BookmarkListViewclass declaration:
 import itso.bookmark.Bookmark;
 Setting the Applet Properties1. Open the Visual Composition page of the BookmarkListView class browser.
 2. Open the Beans List by selecting Tools→Beans List.
 Name Return Type Parameters Parameter1
 deleteEntry void 1 String title
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Notice that there are several beans in the list (Figure 72). The firstBookmarkListView represents the complete bean you are editing and isreally just a place holder. The second BookmarkListView is the subtype ofJApplet that you created, and the JAppletContentPane is the content panefor the applet. Remember that the JFC now splits the functionality ofmany components between a pane and the component itself.
 Figure 72. The Beans List
 3. Select BookmarkListView in the Beans List and open the Property sheet forit by double-clicking with the left mouse button, or clicking with the rightmouse button and selecting Properties or Tools→Properties. Expandthe constraints item and set width =300, and height =300.
 It is a good idea to select the Show expert features checkbox now, sothat you will always see all features. If you find that there are too manyfeatures and you do not use many of them, you can deselect the checkboxlater.
 4. Select JAppletContentPane. You can select it in the Beans List or byclicking anywhere within the visual representation of the applet. Open itsProperty sheet (Figure 73). Notice how many more properties thiscomponent has. Set layout to BorderLayout, then expand layout and sethgap=15 and vgap=15. Set the background to white by clicking on the colorrectangle next to it, and then on the small button that appears. In theBackground dialog box, select the Basic radio button and choose white.
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Figure 73. JAppletContentPane Property Sheet
 The Beans ListThe Beans List window displays an ordered list of the beans andconnections on the free-form surface. The beans are initially listedin the order in which they were dropped, which also reflects thetabbing order. If we change the order of beans that have tabbingset, the Visual Composition Editor reflects the updated tabbingorder.Keeping the Beans List visible is a good idea most of the time. Itwill help you:• Locate components that are under other components.• Move or manipulate components when layout managers are ineffect.• Quickly see the names of various components and connections.
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Adding the Invisible BeansThe only invisible bean you need is the controller. Click on the Choose Beantool and then Browse. Start typing BookmarkListController until you canselect it from the list (Figure 74 on page 130). Click OK and enter Controllerin the Name field of the Choose Bean dialog and click OK again. Your cursorwill change to crosshairs. Move the cursor over the free-form surface. If youmove it over the visual portion of the applet, it changes to a circle with a linethrough it: You cannot drop this bean on the visual portion of a bean (it is nota subtype of Component). Move the cursor outside the visual portion of theapplet and click the left mouse button to add the bean. Figure 75 on page 131shows the free-form surface with the Controller added.
 Figure 74. Choosing the Controller
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Figure 75. The Free-form Surface with the Controller
 Adding the GUI BeansNow you add the visual beans. To create an orderly interface, group thebuttons and entry fields on a separate panel (Figure 76 on page 132):
 1. Select JPanel from the Beans Palette and drop it on the free-form surfaceoutside the visual applet. Dropping a GUI component outside thecontainer is a way to work on the bean before it is influenced by the layoutmanager of the container. For example, if the panel is empty and isdropped on some areas of a border layout, its size becomes 0. Open theProperty sheet and set the layout to GridBagLayout and the background towhite.
 GridBagLayout is a very powerful layout manager but can be a littledifficult to use at first. When you are placing GUI beans in a containerusing GridBagLayout, drop the first bean anywhere in the container. Forsubsequent beans, select the bean from the Beans Palette and then holddown the left mouse button as you move over the visual portion of thecontainer. The cell where the component will be dropped is highlighted.Refer to Figure 76 on page 132 as you drop the beans.
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Figure 76. The GridBagLayout Panel with Components
 If you absolutely cannot visually place the component where you want,open the Property sheet for the component and manually set the gridX orgridY property to the cell you want.
 2. Drop 2 JLabels in JPanel1, one above the other, and set the text properties:JLabel1: Title:JLabel2: URL:
 3. Drop a JTextField in JPanel1 to the right of each label. Set the beanNamefor each text field:TextField1: TitleTextField.TextField2: URLTextField.
 Set the fill property (expand the constraints property) to HORIZONTAL andthe weightX property to 1.0 for both text fields. You can select multiplecomponents and set the constraints at one time.
 4. Drop three buttons to the right of the text fields and set their beanNameand text properties:
 5. Set the fill property (expand the constraints property to see the layoutconstraints) to HORIZONTAL for all three buttons.
 6. In the Beans List, move JPanel1 into the JAppletContentPane. Change theconstraints property for Panel1 to South.
 7. Drop a JList in the center portion of BookmarkList and set the beanNameproperty for JList1 to URLList.
 The free-form surface and the Beans List should now look similar to those inFigure 77.
 Button beanName text
 Top AddButton Add
 Center DeleteButton Delete
 Bottom GoToButton Go!
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Figure 77. The BookmarkListView
 Creating a Tear-off Property Now you are going to tear off the appletContext property from the applet. TheappletContext property is needed to surf to other URLs. You create a tear-offproperty to gain visual access to the encapsulated features of a bean.Creating a tear-off property can be necessary when a property is itself a beanand you want to connect to one of its features. The torn-off property is avariable that represents the property itself. Follow these steps to tear off aproperty from the primary bean (or applet in this case):
 1. Place the cursor in an empty area over the free-form surface.
 2. Click mouse button 2.
 3. Select Tear-Off Property.
 4. Select appletContext (Figure 78 on page 134).
 5. Click OK.
 Notice how variables are rendered differently from beans on the free-formsurface. The variable is enclosed in square brackets (Figure 79 on page 135).
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Figure 78. Tear-off Property
 Adding a VariableTo access the title and URL of the bookmark selected in the list, you need abookmark variable. Select the Choose Bean tool, type Bookmark in theInterface/Class name field and click Browse. Select Bookmark from the listand click OK. Enter SelectedBookmark in the Name field, select the Variableradio button, and click OK again.
 The cursor now becomes a cross-hair. Move the cursor over an empty area ofthe free-form surface and click the left mouse button to drop the variable.
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Figure 79. BookmarkListView with Variables
 Saving and Generating the BeanIt is a good idea to save your work frequently while visually programming, soselect Save Bean from the Bean menu bar item. This action generates theJava code to correspond to the interface and connections you haveconstructed in the Visual Composition Editor. To work with the code of thebeans and connections you add in the Visual Composition Editor, you mustsave the bean first. You cannot just switch to another view and edit code.
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Figure 80. Saving the Bean
 Connections The Visual Composition Editor provides you with four connection types:
 ❑ Property-to-Property connections
 ❑ Event-to-Method connections
 ❑ Code (script) connections
 ❑ Parameter connections
 Property-to-Property ConnectionsA property-to-property connection links two JavaBean properties together.This connection causes the value of one property to reflect the other. Aproperty-to-property connection appears as a dark blue line with dots ateither end. The solid dot indicates the target, and the hollow dot indicates thesource. When your bean is constructed at runtime, the target property is setto the value of the source property. These connections never take parameters.
 After the initial setting of the target property, property-to-propertyconnections require events to fire the connection. Both the source and thetarget can have events to fire them. If one end of the connection does not havean event, the connection is unidirectional. If neither end has an event, the
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connection only fires once to initialize the target. If both ends have events,the connection is bidirectional.
 Property-to-property connections have a Properties dialog where you canchoose the source and target properties and events and reverse theconnection.
 For indexed properties, VisualAge for Java generates two get-set methodpairs, one for the array and one for accessing elements within the array.When you connect indexed properties, VisualAge for Java uses the accessorsfor the entire array. If you want to access an individual element, you mustcreate an event-to-method or event-to-code connection to the specific accessor.
 Event-to-Method ConnectionAn event-to-method connection calls the specified method of the target objectwhenever the source event occurs. Often a good deal of the behavior of anapplication can be specified visually by causing a method of one bean to beinvoked whenever an event is signaled by another bean.
 If the method connected to takes parameters, you can specify them throughthe Connection Properties dialog box or with parameter connections. In theConnection Properties dialog box, you can also specify whether theparameter passed to the method will be the event object generated by theevent.
 An event-to-method connection appears as a unidirectional dark green arrowwith the arrowhead pointing to the target.
 Code (Script) ConnectionsEvent-to-code connections were known as script connections in VisualAge forJava Version 1. It often happens that you want some processing to occurwhen an event is signaled, but none of the beans on the free-form surfaceexposes a method that does exactly what you want. In this case, VisualAgefor Java enables you to connect to nonpublic methods in the class you areediting. These methods of the class are called code, to distinguish them fromthe public methods that you may have created for your primary class andexposed as bean methods.
 A code connection appears as a unidirectional dark green arrow starting fromthe side of the free-form surface (representing the primary class) with thearrowhead pointing to a grey box containing the name of the method.
 Code connections can simplify the number of connections you need to make inyour application.
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Parameter ConnectionsA parameter connection supplies an input value to the target of a connectionby passing either a property’s value or the return value from a method. In aparameter-from-method connection, the connection appears as aunidirectional violet arrow with the arrowhead pointing from the parameterof the original connection to the bean containing the method providing thevalue. In a parameter-from-property connection, the connection appears as aviolet line with the dots at either end. The solid dot indicates the target, andthe hollow dot indicates the source. The original connection is always thesource of a parameter connection; the source feature is the parameter itself.
 You can also make parameter connections from other connections. Someconnections have return values, and all connections can throw exceptions.You can connect these return values (normalResult) and exceptions(exceptionOccurred) as parameters on other connections.
 VisualAge for Java represents connections as private methods on the primarybean and names the connections on the basis of the type and number ofconnections using P (property/parameter), E (event), M (method), or C (code).For example, the first event-to-method connection in a bean would be namedconnEtoM1. You can change the connection names to make the code morereadable.
 Connection PropertiesEach connection type in VisualAge for Java has a different set of propertiesthat can be accessed through the Properties dialog box. To get to theProperties Dialog box, double-click on the connection or select the connectionon the free-form surface or in the Beans List and select Properties from thepop-up menu.
 The different property combinations for the connection types are:
 Property-to-Property ConnectionsSource property
 The source bean for the connection
 Target propertyThe target bean for the connection
 Source eventThe source bean event that fires the connection to set the targetbean property
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Target eventThe target bean event that fires the connection to set the sourcebean property
 Event-to-Method ConnectionsEventThe source object event that fires the connection
 MethodThe target object method that is invoked when the connection fires
 Pass event dataIf true (or checked), and if the method takes parameters, the event objectassociated with the event is passed as a parameter
 Code ConnectionsCode connections are essentially event-to-method connections, so you canspecify the same properties.
 Parameter ConnectionsParameter connection properties are the same as property-to-propertyconnection properties.
 Creating ConnectionsNow that you have been deluged with connection information, you can makesome connections in your BookmarkList applet. The first time you develop aprogram, using visual connections can be quite a change so make sure youread and understand the connection while you are making it. This will alsohelp you avoid errors as you work through the examples. Once youunderstand why you are creating the connections in the example, you will beable to decide which connections you need in your own programs.
 Keep in mind that almost all of the logic of the BookmarkListView is eventdriven. Unlike procedural programming where statements are simplyexecuted one after another, in event driven programming events drive theexecution of the program, and the order is governed by when events occur.
 To understand the connections of the BookmarkListView, consider Table 5,which shows the functions of the BookmarkListView and the corresponding
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connections. Once you have read and understood the table, follow theexample and create the specific connections.
 Table 5. BookmarkListView Connection Overview
 Function Source of Connection Target of Connection Connection Type
 Initialization: On startup thecontroller bean must beinitialized.
 Applet init event Controller initmethod
 Event-to-method
 Selecting an element in the list:When an element is selected inthe list of URLs, the URL anddescription should appear in thetext fields.
 URLListvalueChangedevent
 Set URL and Titletext fields withselected listelement
 Parameter-from-property
 When the Add button is clicked,the URL and description in thetextfields should be added to thelist.
 AddButtonactionPerformedevent
 ControlleraddEntry method
 Event-to-method
 When the Delete button isclicked the selected URL shouldbe deleted from the list.
 DeleteButtonactionPerformedevent
 ControllerdeleteEntry method
 Event-to-method
 When the Go! button is clicked,the browser should display theselected URL.
 GoButtonactionPerformedevent
 AppletContextshowDocumentmethod
 Event-to-method
 Pseudo EventsIn some cases, such as init() for an applet, you may want to signalactions that are not actually JavaBean events. Initialization is one ofthese times. VisualAge for Java creates pseudo events that you canconnect to when any component initializes. For applets, this pseudoevent is the init() event; for all other beans it is the initialize()event. Connections that originate from these events are placed in the init()or initialize() method as appropriate and are called when thecomponent is initialized.
 VisualAge for Java also creates start(), stop() and destroy() pseudoevents for applets. In Version 2.0 of VisualAge for Java you mustconnect these pseudo events from the visual representation of theapplet, not from the free-form surface.
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Event-to-Method Connection When the BookmarkListView applet initializes, it should read the parameterswith which it was supplied to build the URL list. The event that triggers thisis the init() event. Follow these steps to connect the init() event to theinit( JApplet) method on the Controller:
 1. Click with the right mouse button on an empty area of the free-formsurface (representing the primary class or applet). Select Connectfrom the pop-up menu. Select Connectable Features.
 2. In the Start Connection from (BookmarkListView) dialog select theEvent radio button. Then select init() and click OK.
 3. The cursor is now a spider connected to the source of the connection.Click the left mouse button over the Controller bean and selectConnectable Features. Select init( com.sun.java.swing.JApplet)from the list and click OK.
 Now the connection is shown as a dotted line from the side of the free-formsurface to the Controller. The dotted line indicates that the connection (ormore accurately, the method called by the connection) requires aparameter, in this case the applet itself.
 Parameter-from-Property ConnectionTo pass the applet as a parameter, you create a parameter-from-propertyconnection from the applet itself to the connection.
 Follow these steps to connect the applet’s this property to theevent-to-method connection you created in “Event-to-Method Connection” onpage 141.
 The this Property and EventAs you probably know, in Java code, this refers to the current object,that is, the object in the context of which the code is currentlyexecuting.Although this is not a true JavaBean property, VisualAge for Javaexposes it as a read-only property on all beans on the free-fromsurface. You use this to connect to the bean as a whole, as opposed toone of its properties. The this entry on the preferred connection listrefers to the this property not the event.Variables on the free-form surface expose the this property as a boundreadable and writable property because you set variables to the valueof an instantiated bean. When the setter method is called on avariable, the this event fires.
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1. Click with the right mouse button on an empty area of the free-formsurface (representing the primary class or applet). Select Connect fromthe pop-up menu. Select this from the Preferred List of features.
 2. Move the cursor over the connection from init() until a small rectangle isdisplayed over the connection. Click with the left mouse button and thenclick on applet to supply the parameter.
 The Applet PropertiesTo supply data to the applet, you must set the properties in the APPLET tag.Go to the Workbench window and select the BookmarkListView class. SelectSelected→Properties and make sure that the Applet tab is selected. Firstset the Width and Height under Attributes, to 300 and 300, respectively, tomatch your applet size. Now add the parameters from your URL list. On oneline in the Parameters text area enter:
 <param name=Data value="IBM;http://www.ibm.com;IBM Software;http://www.software.ibm.com;Javasoft;http://www.javasoft.com">
 When you run your applet, the data will show up in the list.
 Property-to-Property ConnectionsFollow these steps to create the property-to-property connections for theapplet:
 1. To connect the model to the view:
 Connect the bookmarkList property of the Controller to the model propertyof the URLList. Select the Controller and select Connect from the pop-upmenu. Select Connectable Features... and then select bookmarkListfrom the dialog. Click over the URLList and select model(Figure 81).
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Figure 81. Connecting to the List Model
 2. To connect the SelectedBookmark variable to the selected item in the list:
 Connect the selectedValue property of the URLList to the this property ofSelectedBookmark. For this connection to fire you must select an event tofire it. Double click the connection to open the Connection Propertiesdialog box (Figure 82 on page 144). Scroll down the Source event list andselect valueChanged. This selection causes the connection to fire wheneverthe selected list value changes. Each connection has a different set ofevents in the source and target lists. The set of events each connection hasdepends on the types of beans involved in the connection.
 3. To connect the features of the selectedBookmark to the text fields:
 Click with the right mouse button over the SelectedBookmark and thenselect title from the Connectable Features dialog. Click over theTitleTextField and select text from the list. Repeat the connection fromthe url property to the URLTextField. For both connections open theConnection Properties dialog and select this as the Source event.
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Figure 82. Connection Properties Dialog Box
 Connecting the Button EventsFollow these steps to connect the button events to the appropriate methodson the applet context and the controller:
 1. When the user clicks the Add button, the string in the title and URL textfields is added to URLList. From AddButton connect the actionPerformedevent (Figure 83) to the addEntry( java.lang.String, java.lang.String)method of the Controller. Connect the title and URL parameters from theconnection to the text properties of the TitleTextField and URLTextField.The connection becomes a solid line.
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Figure 83. Connecting the AddButton actionPerformed Event
 2. To delete an entry from the list, connect the Delete button to thedeleteEntry method. From DeleteButton connect the actionPerformedevent to the deleteEntry( java.lang.String) method of the Controller.Connect the title parameter from the connection to the title property ofSelectedBookmark. The Delete button should clear the text in the textfields. Connect DeleteButton actionPerformed to the text property ofTitleTextField. Although the connection is dotted, you can leave it as isbecause you only want to clear the field. Repeat the connection fromDeleteButton actionPerformed to the text property of URLTextField.
 3. To surf to a new URL, connect the Go! button to the showDocument methodof the applet context (the connection will not function until you run theapplet in a Web browser; see Chapter 10, “Deploying Your Java Programs”on page 327). From GoToButton, connect the actionPerformed event to theshowDocument(java.netURL) method of appletContext1. Once again theconnection is dotted, so connect this connection’s url parameter to theSelectedBookmark url property.
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4. If a URL is not valid, you will want to see the status when you click theGo! button. To display the status of the link, follow these steps to connectexceptionOccurred from the previous connection to the showStatus methodof AppletContext1:
 Select the connection from the Go! button toAppletContext1→showDocument. Press the right mouse button and selectConnect, then exceptionOccurred. Move the mouse overAppletContext1 and click with the left mouse button, select the Methodradio button, and then select showStatus( java.lang.String). Thisconnection appears as a dashed line. Open the property sheet for theconnection and check the Pass Event Data checkbox to make theexception text appear in the browser status area. This will pass theexception to the showStatus method.
 5. One final connection and you are done! In JFC Release 1.02 there is a bugin the JList code. When the first element in the list is deleted, an event isnot fired to update the list. To work around this, you can cause a listrepaint each time you delete an item. Connect actionPerformed on theDeleteButton to the repaint method on URLList.
 Figure 84 shows your applet with the connections. Now you can set your classpath and test your applet. To set the class path, select theBookmarkListView class in the Workbench and then select
 Connecting Different Property TypesWhen you make a connection to a property or parameter, the two endsof the connection may not be the same type. For example, theshowDocument method expects a java.net.URL type, and theTitleTextField text property is a String. If VisualAge for Java canconvert the field, it will. For example, there is a constructor for a URLthat takes a String. VisualAge for Java uses this constructor in theconnection.
 Manipulating ConnectionsWhen you select a connection, small black squares appear on it. Eachsquare is used to manipulate a part of the line representing theconnection. When the cursor is over these squares, it changes to a dragicon and can be used only to drag the connection itself. If you make amess of the connection, you can restore it through the Restore Shapeitem on the pop-up menu of the connection.
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Selected→Properties. Click the Class Path tab and then the Edit buttonto the right of the Project Path field. Make sure the checkbox next to JFCClass Libraries is selected and click OK. The class path will be discussedfurther in “The Class Path” on page 150.
 Click the Run button on the menu bar to test your applet.
 Figure 84. BookmarkList with Connections
 Enhancing the BookmarkListView AppletThe usability of the applet would be enhanced if the user could only clickthose buttons that should be enabled. Specifically the applet should:
 1. Start with all buttons disabled.
 2. Only enable the Add button if there is text in both text fields.
 3. Enable the Delete and Go! buttons when an element is selected.
 4. Disable all buttons when no item in the list is selected.
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Event-to-Code ConnectionsYou will use additional connections and a setState method to enable ordisable AddButton, DeleteButton, and GoToButton as appropriate on the basisof the state of the URLList. Follow these steps to enhance the applet:
 1. From TitleTextField tear off the document(Document) property creatingthe document1 variable. Start the connection from the document event onthe Document1 variable and click mouse button 2 over the free-formsurface. Select Event to Code from the list. In the Event-to-Code dialogbox, leave document as the event and <new method> selected as theMethod name. Make sure the Pass event data checkbox is not selected.
 2. Replace the code in the dialog box with the following code:
 public void setState(){String titleText = getTitleTextField().getText();String urlText = getURLTextField().getText();
 if (titleText.equals("") || urlText.equals("")){getAddButton().setEnabled(false);
 }else{
 getAddButton().setEnabled(true);}if ( getURLList().getSelectedIndex() < 0){
 getDeleteButton().setEnabled(false);getGoToButton().setEnabled(false);
 }else{
 getDeleteButton().setEnabled(true);getGoToButton().setEnabled(true);
 }getappletContext1().showStatus("");
 }
 3. Click OK on the dialog box.
 4. Tear off the document(Document) property from the URLTextField. Connectthe document event from the torn-off document variable to the free-formsurface and select Event-to-Code. In the Event-to-Code window leavedocument as the event, select setState as the Method name, and click OKto finish.
 5. From the URLList valueChanged event, connect to the free-form surface andselect Event-to-Code. In the Event-to-Code window leave valueChangedas the event, select setState as the Method name, and click OK to finish.
 Figure 85 shows the connections of your applet at this point.
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Figure 85. BookmarkListView Connection View
 Now run the applet and ensure that it works as designed. Figure 86 showsthe final applet.
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Figure 86. The BookmarkListView Applet
 The Class PathAs you know, Java uses the concept of a class path to locate classes that canbe loaded. In VisualAge for Java Version 1 the class path is only used to findresources at runtime. In Version 2, there are several uses of and several waysof setting the class path.
 RuntimeIn VisualAge for Java Version 2, the class path is used at runtime to locateclasses that are loaded dynamically and to locate resources used by theprogram. Note that this also applies to design time for tools running in theenvironment.
 Classes are loaded dynamically (or referenced indirectly) through theClass.forName() method. For example, Class c = Class.forName(“myclass”); would return an instance of the Class object representing theclass myclass. You then instantiate an instance of myclass, usingc.newInstance(). The forName method is commonly used with JDBC drivers.
 You still have to import code into VisualAge for Java to use it in development.That is, any class that you reference or any interface that you implementmust be in the workspace.
 Resources are still located through the class path so, for example, anyproperty files that you open or images that you load would be searched for inthe class path.
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Setting the Runtime Class PathYou can set the Runtime Class Path in several ways:
 Workbench OptionsUsing the Workbench Window→Options dialog in the Resourcessection, you can set the class path for all classes in the workspace.You specify a directory, JAR, or Zip file, and any running class willlook there for resources and dynamically loaded classes. Forexample, if you are using the JFC in a lot of programs, you couldspecify the JFC resources directory here rather than for eachprogram.
 Class PropertiesYou can also set the class path for each class separately. In theWorkbench Selected→Properties dialog, select the Class Pathtab (Figure 87 on page 152). Here you specify whether you wantthe current directory (the default project resources directory) inthe class path. You can select the resource directories of otherprojects through the Project path: option and you can specify otherdirectories or JAR or Zip files in the Extra directories path: field.The current Workspace class path is shown as well as thecomplete class path in effect.
 Compute NowClick the Compute Now button to automatically add the projectresources directory associated with any other packages yourprogram uses.
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Figure 87. The Class Path Page
 There are separate class paths to find external source code for debugging andBeanInfo classes. These class paths are set in the Options window.
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5 Managing and Fixing Your CodeBefore you finish building the ATM application and exploring otherVisualAge for Java features, you should know a little more about managingand fixing your code in VisualAge for Java. VisualAge for Java comes with apowerful set of tools to store and manage updates in your programs as well asdebug and fix problems in your code.
 In this chapter you will learn about the workspace and the repository andhow to work with multiple editions of program elements to facilitate codemanagement. You will be introduced to the Repository Explorer and searchcapabilities that you can use to find workspace program elements, such asclasses, interfaces, fields, or methods. You will also learn about the debuggerand Inspectors, which you use to diagnose problem code.
 Storing Your CodeWhen you start VisualAge for Java, a persistent working environment, calleda workspace, is automatically loaded to store the program elements (projects,
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packages, classes, interfaces, and methods) you are working with as well asyour current option settings and open windows.
 Your code is also stored in a larger database, called the repository, whichcontains other program elements in a defined state, or edition. You can addthese program elements to the workspace if you need to use them.
 The workspace stores the bytecodes of the programs you are working with,and the repository stores the source for the program elements in theworkspace as well as all other elements not currently in the workspace.
 By integrating the IDE closely with code management, VisualAge for Javacan support powerful features such as code clue, error detection, andsearches.
 As shown in Figure 88, Java code is loaded from the repository into theworkspace and automatically saved from the workspace to the repository. TheWorkbench and other browsers are used to manage code in the workspace;the Repository Explorer is used to browse code in the repository.
 VisualAge for Java Example CodeVisualAge for Java has a wealth of examples that are not shownin your workspace the first time you start the product. Theseexamples include IBM Java Examples, Sun BDK Examples, SunJDK Examples, Sun JFC Examples, and IBM Domino Examples.The examples are stored in the repository and you have load theminto the workspace to use them.In addition you have to explicitly load the following projects intothe workspace to use them: IBM Data Access Beans, Domino JavaClass Library, IBM IDE Utility Class Libraries, and Sun ClassLibraries Unix.
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Figure 88. Managing Your Code in VisualAge for Java
 The WorkspaceThe workspace is stored as a single file (IDE.icx) and contains the programelements that you are currently working with as well as your preferences andworking environment. You use the IDE (Workbench and Class Browser) tomanage the workspace.
 Workbench Repository Explorer
 Workspace Repository
 Save
 Load
 Team DevelopmentThis book describes the single-user environment of theProfessional version of VisualAge for Java. The Enterpriseversion of VisualAge for Java has a more powerful teamprogramming environment that allows several programmers toshare the same repository.Although it is possible to use VisualAge for Java Professional toshare code, using VisualAge for Java Enterprise will make yourteam more productive.It is also possible to use external code management products withVisualAge for Java. See “Interface to External SCM Tools” onpage 343.
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Whenever you close the last window of a VisualAge for Java session or selectFile→Exit VisualAge from the Workbench menu bar, VisualAge for Javadisplays a dialog that prompts you to confirm the save of your workspace. Ifyou click the Cancel button, VisualAge for Java does not exit and you stay inthe Workbench.
 You can also explicitly save the workspace during a long session by selectingFile→Save Workspace.
 The RepositoryThe repository is the database of your program elements. Each time youcreate or save a program element, it is stored in the repository as well as inthe workspace. The repository contains all editions of all program elements,so it is usually quite a bit larger than your workspace. In addition, yourworkspace does not usually contain all of the program elements that areavailable in the repository, because you do not necessarily need them for yourcurrent project. You can load program elements from the repository into yourworkspace, and you can delete program elements from your workspace.
 Resource FilesJava programs often use resource files, such as images, sound clips andproperty files. VisualAge for Java does not provide version control ormanagement for resource files. VisualAge for Java creates a resourcesdirectory for each project that you create or import or that is installed withVisualAge for Java.
 The directory hierarchy of resources directories under the main VisualAge forJava directory is:
 \IBMVJava\ide\project_resources<project name 1><project name 2>...<project name n>
 Because each project resources directory has the same name as the project,you must name a project with a valid directory name (the directory will becreated for you). You may add resources to your project through the resourcesdirectory or modify your class path to point to another location for resourcefiles.
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FeaturesThe Features item is in the Available palette category and the QuickStartdialog box. Features are Java class libraries and beans that have been addedto the repository and can be added to the workspace. The Features dialog is ashortcut to the usual Add from Repository function.
 If you want to provide beans or libraries to VisualAge for Java users, use theFeature Integrator. When the IDE starts, new features are automaticallyimported into the repository, and the user can then load them into theworkspace. See the VisualAge for Java product documentation forinstructions on using the Feature Integrator.
 Version ControlVisualAge for Java supports a repository-based source control mechanismthat enables you to keep track of all source code changes made over time. TheVisualAge for Java source code repository is automatically updated each timeyou make a change to the source code. A history of all changes made to thesource is kept in the repository, so you can back out of any or all source codechanges.
 As you will see in “Interface to External SCM Tools” on page 343, you canalso integrate VisualAge for Java repository management with existingsoftware configuration management systems. Thus you can use VisualAge forJava within your existing development processes.
 EditionsAll program elements (remember, a program element is a project, package,class, interface or method) in VisualAge for Java are stored as editions. Therecan be many editions of each program element.
 You can have more than one edition of a program element in the repository,but you can only load one edition in workspace at any given time. Thus youhave the flexibility to try several different approaches with the sameprogram element.
 Open EditionAn open edition is a program element that you can change. It is indicated bya time stamp containing the date and time of its creation. You cannot change
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this unique identifier. To see the edition names, click on the Show EditionNames button in the Workbench Toolbar.
 VisualAge for Java automatically creates an open edition, if you modify anexisting edition of a program element or create a new program element. Youcan think of an open edition as the default state of a program element beforeit is versioned.
 VersionsA version is a read-only edition of a program element that is assigned aversion number (such as 1.0). Whenever you version a program element, it isstored in the repository. You may want to version your program elements to:
 ❑ Take a snapshot of the state of your program elements to which you canrevert if you want to abandon subsequent modifications
 ❑ Have a baseline for code that you import from the file system and plan tomodify
 ❑ Freeze a finished program that you are ready to release
 ❑ Compact the repository
 ❑ Export an interchange file
 In Figure 89 the current workspace is loaded with the 6/3/98 10:23:45 AMedition of a program element. This edition is also stored in the repositoryalong with two different versions of the same program element.
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Figure 89. Program Elements in the Workspace and Repository
 Versioning Program ElementsWhen you version a program element, you create a read-only edition of theelement. Versions are also created of each open edition program elementcontained within the element you are versioning. Already versioned program
 Workspace
 Repository
 Program Elements
 6/3/98 10:23:45 AM
 V1.0
 V1.1
 6/3/98 10:23:45 AM
 BackupsBack up the repository and workspace files as well as the projectresources directory frequently. Also, you may want to save theoriginal versions of these files when you install VisualAge forJava, so that you can return to the original state of the repositoryif required.The workspace file (IDE.icx) is in the program directory with theVisualAge for Java programs (IBMVJava\Ide\Program). Therepository (ivj.dat) is in the repository directory under the mainVisualAge for Java IDE directory (IBMVJava\Ide\repository).
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elements contained within the program element you are versioning are notchanged. For example, assume you have the following package and classes:
 ch01 (5/24/98 1:57:43 PM)HiThere 1.0AnotherApplet (5/24/98 1:57:43 PM)
 The editions of ch01 and AnotherApplet are indicated in parentheses. Theversion of HiThere is 1.0. When you version ch01, the AnotherApplet class isalso versioned, but HiThere is not versioned because it already is at version1.0.
 To version an edition of a program element, select it and then clickSelected→Manage→Version in the menu bar. The Versioning SelectedItems dialog box appears (Figure 90).
 Figure 90. Versioning Selected Items Dialog Box
 You have three options for naming your versioned elements:
 ❑ Automatic: Each program element to be versioned (that is, each openedition program element) is given a version name, which is an incrementof its current version name.
 ❑ One Name: All program elements to be versioned are given the samename.
 ❑ Name Each: You are prompted to name each program element to beversioned.
 VisualAge for Java versions the selected program element and its containedopen edition elements and replaces the time stamps with the version names.
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Managing EditionsNow that you are familiar with editions and versions, you are ready tomanage editions of your program elements.
 Creating New EditionsWhen you add new program elements to the workspace or import Java codefrom the file system, VisualAge for Java creates an open edition of eachprogram element. The open edition is identified by a time stamp thatindicates when VisualAge for Java created the edition. You can click theShow Edition Names Workbench toolbar button (the last button on theright) to show or hide the edition names with which you are currentlyworking.
 When you subsequently modify a program element that you have versioned,VisualAge for Java automatically creates a new edition of the element(marked with a time stamp). VisualAge for Java then stores the new editionin the repository and replaces the versioned workspace edition with the newedition. The previous edition is still available from the repository.
 Any versioned program elements that contain the element that was modifiedalso become new editions. For example, if you modify a TestClass class that isat version 1.0, in a testpkg package at version 1.1:
 ❑ A new edition of TestClass is created with a time stamp.
 ❑ A new edition of testpkg is created with a time stamp.
 Deleting a Program Element from the WorkspaceWhen you delete a program element from the workspace, the edition is still inthe repository, so you can reload it later. To delete a program element, selectthe element and choose Selected→Delete from the Workbench.
 Editions of MethodsAll program elements are managed by the VisualAge for Javacode management system. However, methods are considered partof a class or interface for versioning purposes. That is, neweditions of a method are created each time you save the method,but you cannot version a method.Attributes of a class are not under separate code management,and a change to an attribute is considered a change to the class.
 Managing and Fixing Your Code 161

Page 188
                        

Replacing One Edition with AnotherThe workspace contains, at any one time, only one edition of a given programelement, whereas the repository holds all editions of all program elements.You may want to replace the edition of a program element in the workspacewith another edition so that you can abandon the modifications that youmade and revert to another edition that resides in the repository.
 To replace an edition of a program element with another edition, select theedition in the Workbench, select Selected→Replace With→AnotherEdition, and choose from the list that is displayed (Figure 91). The editionthat is currently in the workspace is marked, by default, with an asterisk (*).
 Figure 91. Replacing Editions
 To replace an edition with the edition from which it is derived, select theprogram element, and select Selected→Replace With→Previous Edition.When you replace an edition of a program element in the workspace,VisualAge also replaces the editions of the program elements that it contains,as required.
 Loading Available EditionsTo load an edition of a program element that is not currently loaded in theworkspace, use the Selected→Add menu in the Workbench. The menucontains some of the following items, depending on the selected item:
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❑ Project
 ❑ Package
 ❑ Class
 ❑ Interface
 ❑ Applet
 ❑ Method
 ❑ Field
 You cannot use the Applet and Field selections to load an edition from therepository. You cannot load a field from the repository because fields are notunder code management. The Applet selection only displays the CreateApplet SmartGuide to create a new applet. To load an applet from therepository, use the Class selection.
 If you want to add a project from the repository to the workspace, select theproject in which you want to add the package. Then, selectSelected→Add→Project to open the SmartGuide (Figure 92).
 Figure 92. SmartGuide to Load an Edition
 Select Add projects from the repository, and VisualAge for Java showsyou the available projects in the repository. Only the projects not currently inthe workspace are displayed.
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To load projects, select the projects that you want to load. If there is morethan one edition of a project, select the edition to load. Once you haveselected all projects and editions, click Finish.
 Using the Repository ExplorerUse the Repository Explorer to browse the contents of the repository. Youopen the Repository Explorer (Figure 93) by selecting Window→RepositoryExplorer.
 Figure 93. The Repository Explorer
 To switch between the Projects and Packages views, click the Projects andPackages tabs. The Projects view shows all projects (Figure 93). To show theeditions in the repository, just click the project, and the editions are listed inthe list to the right of the project. Selecting an edition shows the packages inthe selected edition, and selecting a package lists the types (classes andinterfaces) in that package.
 The Packages view shows you all packages in the repository. Selecting apackage lists all editions of the selected package, and selecting an editionshows you the types in that edition.
 To see all editions of a type (interface or class), select the type, then selectOpen from the Types menu bar and click the Editions tab.
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To compare two editions in the Projects or Packages view, select two editions(if there is more than one) and then select Editions→Compare in the menubar. A window (Figure 94) appears where you can analyze the differences.You can also compare editions in the Workbench, using Selected→CompareWith.
 Figure 94. Comparing Two Editions
 Compacting the RepositoryDuring development you are bound to create program elements that you willnot want to keep in the repository. These may be classes you created toexplore possibilities or classes that just did not work out. In addition, at somepoint in the life of your projects, things will probably be stable enough so thatyou will not want to keep open editions or particular versions of code in therepository.
 By periodically purging program elements and compacting the repository,you will increase the performance of VisualAge for Java.
 In VisualAge for Java you can purge editions of program elements from therepository. Purging marks a program element for later removal from therepository. Until you compact the repository, these program elements can stillbe restored. The Purge and Restore functions are found on the Names
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menu or the pop-up menu in the Repository Explorer. Before you compact therepository you must version all elements in the workspace.
 To compact the repository, click the Compact Repository item on theAdmin menu of the Repository Explorer. Compacting the repository:
 ❑ Creates a backup repository with a .bak extension
 ❑ Removes all open editions in the repository
 ❑ Removes all purged elements from the repository
 ❑ Removes all versioned editions of classes that are contained only in openeditions of packages
 Searching for Program ElementsAnother aspect of code management is finding all places where a particularclass, field, or method is used or declared. The following VisualAge for Javasearch capabilities make this task easy:
 The Search dialogThe Search dialog (accessed by selecting theWorkspace→Search menu item) searches for references to, ordeclarations of, classes, methods, and fields in the workspace.
 The Go To dialogThe Go To dialog (accessed through Selected→Go To) findsclasses and interfaces in the workspace or the repository.
 The References To and Declarations Of functionsThe References To and Declarations Of functions are extremelypowerful navigation tools that enable you to find methods, fields,and types referenced or accessed by a method or type.
 If you are looking only for the declaration of a class, use the faster Go Todialog box. If you want to find out where a class was referenced or you arelooking for methods or fields, use the Search dialog box.
 The Search Dialog BoxThe Search dialog box enables you to search for references to, or declarationsof, classes, methods, and fields. You access the Search dialog box (Figure 95)by selecting Workspace→Search.
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Figure 95. The Search Dialog Box
 In addition to entering a search string (using the * and # wildcards), you canconstrain the search by element type (type, field, constructor, text, andmethod), scope (workspace, project, package, hierarchy), and usage(references, declarations, or both).
 A Search Results window (Figure 96) lists any items that were found.
 Figure 96. Search Results Window
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While the Search Results window is open, you can switch to previoussearches, and you can always restart any previous search. You can also sortthe results by method or type name.
 References To and Declarations Of FunctionsFigure 97 shows the References To item in the Classes menu in the ClassBrowser. You can find references to:
 This TypeFind references to this type anywhere in the workspace.
 FieldFind any references of this field in the type. You are promptedwith a list of all fields declared in the type or inherited.
 Static FieldFind any references of this static field in the type. You areprompted with a list of all static fields declared in the type orinherited.
 Final FieldFind any references of this final field in the type. You areprompted with a list of all final fields declared in the type orinherited.
 Figure 98 on page 170 shows the References To and the Declarations ofitems in the Methods menu in the Class Browser and debugger. You can findreferences to, or declarations of:
 This MethodFind all references to or declarations of this method in the class.
 Sent MethodsFind all references to or declarations of methods called from thismethod.
 Accessed FieldsFind all references to or declarations of fields accessed within thismethod. You can define the scope of the search as workspace,project, package, or hierarchy in the Accessed Fields dialog box.
 Referenced TypesFind all references to or declarations of types referenced in thismethod. You can define the scope of the search as workspace,project, package, or hierarchy in the Referenced Types dialog box.
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Figure 97. References To Type
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Figure 98. References To and Declarations Of Methods
 Versioning Your CodeNow that you know how to use the VisualAge for Java versioningcapabilities, you can use them to manage your code.
 Version the itso.atm.model package to create a baseline for the work you doin the rest of the book:
 1. In the Workbench, select the itso.atm.model package andSelected→Manage→Version. The SmartGuide prompts you for thenames for the editions. The Automatic (Recommended) radio buttonshould be selected, and the entry in the field next to the One Name radiobutton should be 1.0 (although it is greyed out).
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2. Click OK. The Workbench window now displays your versioned package(Figure 99).
 If you do not see the edition names, click the Show Edition Names buttonin the toolbar.
 Figure 99. The Versioned itso.atm.model Package
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Now you have a package version to which you can always revert. To illustrateswitching editions: Modify the Bank class by simply adding a comment in theclass declaration and saving the Bank class. VisualAge for Java creates anew edition of the Bank class and the itso.atm.model package.
 You now have a new edition of the Bank class. The new edition name isdisplayed in the Workbench (Figure 100). Click the Show Edition Namestoolbar button if you do not see the name.
 Figure 100. The New Edition of the Bank Class
 You can load the previously versioned editions of the project, package, andclass back into your workspace. Now replace the Bank class. In theWorkbench, select the Bank class and select Selected→ReplaceWith→Another Edition. VisualAge for Java displays a list of the availableeditions in the repository. Select the 1.0 version you created previously andclick the OK button. The selected edition is loaded, and the Workbench showsyour package restored to the version shown in Figure 99.
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Versioning the Bookmark List PackagesAs you progress through this book, you will improve on and modify theBookmark List. Even though you will use different packages for most of theexamples, you should version the packages after each chapter. Create aversion of itso.bookmark and itso.bookmark.applet called _FinishedApplet:
 1. In the Workbench, select the itso.bookmark and itso.bookmark.appletpackages and Selected→Manage→Version. The SmartGuide promptsyou for the names for the editions. Select the One Name radio button andenter _FinishedApplet in the text field. The underscore is used simply tomake the version more readable when displayed in the browser.
 2. Click OK. The Workbench window now displays your versioned package(Figure 101).
 Figure 101. _FinishedApplet Version of Bookmark List
 Debugging a VisualAge for Java ProgramNow you will learn more about analyzing and fixing errors duringdevelopment. VisualAge for Java provides several tools, including theScrapbook, Inspectors, and the debugger, to find problems in your programs.
 InspectorsYou can use Inspectors to view and change the state of objects in yourprograms. For example, if you are working in the Scrapbook, you can open anInspector by following these steps.
 1. Open the Scrapbook and type the following code:
 new java.awt.Point(1,2);
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2. Highlight the code and from the menu bar select Edit→Inspect. AnInspector window similar to that in Figure 102 on page 174 opens.
 Figure 102. An Inspector Window
 You can also open an Inspector by highlighting the code and then pressingthe accelerator key, Ctrl-Q, choosing Inspect from the pop-up menu, orclicking the Inspect navigation button (the magnifying glass).
 Inspectors are most useful when you are using the debugger. You can open anInspector on each object in which you are interested. As you step through theprogram, you can see the state of all inspected objects at once.
 Opening an Inspector WindowAn alternative way of opening an Inspector is to insert aninstruction in your Java code to inspect a specific object. This is auseful method if you have a difficult-to-debug program thatshould not be interrupted with breakpoints. In the Scrapbooktype the following code:String[] numbers = {"one", "two", "three"};com.ibm.uvm.tools.DebugSupport.inspect(numbers);Highlight the code and from the menu bar select Edit→Run (orpress Ctrl-E or click the Run navigation button). Thecom.ibm.uvm.tools.DebugSupport.inspect(anObject) instructionadvises the JVM to open an Inspector on the specified object.
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The Inspector WindowThe title bar of an Inspector window displays the type of the displayed classand the context in which you have opened the Inspector. In the example inFigure 102 on page 174, the class is java.awt.Point, and the context is Page 1.There are two panes in the Inspector window:
 Fields
 Shows the fields of the object
 Value
 Displays the values of the fields of an object
 The Fields pane displays items in hierarchical order with the inherited fieldsfirst. Therefore, when you inspect a more complex object, the fields that youhave declared in your object are at the bottom of the Fields pane.
 Changing the Value of a FieldIn the Value pane of the Inspector window you can manipulate the values ofthe object’s fields (Figure 103 on page 175). Select the int x field and change1 to 100, then select Edit→Save (or use the accelerator key, Ctrl-S, or Savefrom the Value pane’s pop-up menu). VisualAge for Java also prompts you tosave the field when you access another field.
 Figure 103. Changing the Value of a Field
 When stepping through your code with the debugger, you also can change afield value on the fly and resume the execution of your program with thechanged field value.
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Navigating to Other Fields or ObjectsIf you have a more complex object, say, an aggregation of several objects, it iseasy to open an Inspector on the other objects. Just select the other object inthe Fields pane and choose Inspector→Inspect. In this way you can inspectvery complex data structures by accessing their different layers, just likepeeling an onion.
 Controlling the Display of FieldsWhen an Inspector first appears, all public, protected, and private fields ofthe inspected class and the inherited classes are displayed. You can modifythe fields that are displayed, using any of these Inspector menu bar items:
 ❑ Field Names Only
 ❑ Public Fields Only
 ❑ Hide Static Fields
 ❑ Show Fields In
 • Actual Type
 • Declared Type
 Evaluating Code in the Context of an ObjectIf you open an Inspector on a particular object, you can apply methods to thatobject and inspect the results. In Figure 104 on page 177, for example, thegetLocation method is invoked on a Point object.
 The String ClassBecause the String class represents immutable strings, youcannot change the characters of a String object in an Inspectorwindow. However, you can change the characters of aStringBuffer. In this case, you must enclose the new character insingle quotes.
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Figure 104. Evaluating Code in the Context of an Object
 To evaluate an expression and display its result, type in the expression in theValue pane, highlight it, and select Display from the menu bar or from theValue pane pop-up menu.
 The DebuggerYou use the debugger to step through and fix your Java code. As with theInspectors, you can also inspect and change the state of objects. Because thedebugger is tightly integrated with the VisualAge for Java IDE, you canmake changes to code in the debugger, and these changes are reflected inyour workspace.
 The debugger display consists of two pages: Debug and Breakpoints.
 The Debug PageThe Debug Page toolbar (Figure 105) provides easy access to common debugfunctions.
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Figure 105. Debug Page Toolbar
 The Debug page shows all currently running threads, grouped by program inthe All Programs/Threads pane. The running programs can be of three types(Figure 106 on page 179):
 System programsIf you have selected the Show system programs in debuggerand console option, system programs, including any open VisualComposition Editor sessions will be displayed. A VisualComposition Editor session can be identified in the list of runningprograms by the format of the program name: classname (VCE) (System) time. For example:BookmarkListView (VCE) (System) (8/17/98 1:46:34 PM)Visual Composition Editor programs have two threads: thecommon AWT event queue and a timer queue. Displaying theseprograms in the debugger is useful for debugging code, such asproperty editors or customizers, that is invoked by the VisualComposition Editor.
 Scrapbook sessionsScrapbook sessions are shown in the All Programs/Threads panewith the name of the Scrapbook page as the title in the form: page (time).For example:Page 1(8/17/98 1:56:51 PM)Simple Scrapbook programs have one thread named main.
 Applets and applicationsApplets and applications are shown in the All Programs/Threadspane in the form: Applet classname (time) for appletsclassname.main() (time) for applications.For example:
 RunDisplay
 Inspect
 Step over
 Run to return
 Resume
 Suspend
 Terminate
 Search
 Caught Exceptions
 External .class fileBreakpoints
 Step into
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Applet itso.bookmark.BookmarkListView (8/17/98 1:57:42 PM)itso.bookmark.BookmarkListView.main() (8/17/98 1:57:53 PM)Applets and applications have at least three threads: the AWTevent queue, a timer queue, and the other threads of the applet orapplication. When a program is suspended because of abreakpoint, the AWT event queue thread shows the call stack ofyour applet or application. If the program is suspended because ofan exception, the call stack shows up in the thread that threw theexception.
 Figure 106. Running Programs in the Debugger
 When a program is expanded, the threads in the program are shown. When asuspended thread is expanded, the execution or call stack is shown. Theexecution stack shows the methods entered leading up to the method thatwas executing when the thread was suspended.
 The other panes on the Debug page show code relating to a selectedsuspended thread:
 Visible VariablesShow the visible variables in the thread.
 ValueShow the value of the selected variable.
 SourceShow the source of the method that is suspended.
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The Breakpoints PageThe Breakpoints page shows:
 ❑ All methods in the workspace that have breakpoints set in them
 ❑ The source code for the methods
 The Breakpoints page toolbar (Figure 107) provides buttons for manipulatingbreakpoints.
 Figure 107. Breakpoints Page Toolbar
 Adding BreakpointsBreakpoints can be set on any instruction in source code in the workspace.The code must be saved and error free. You can set breakpoints only oninstructions, not on all statements in your code. For example, you cannot setbreakpoints:
 ❑ In class declarations ❑ In inner classes ❑ On try or catch statements ❑ On else or case statements ❑ On comments
 VisualAge for Java does not let you set a breakpoint in a class declaration. Ifyou try and set a breakpoint on an invalid statement in a method, thebreakpoint will be set on the next valid statement.
 Breakpoints can be set at any time, including while code is being debugged;that is, you can add a breakpoint to a method in a suspended thread’s stackwithout the execution of the program being reset to the beginning of themethod.
 Clear all breakpoints in workspaceClear all breakpoints in the method
 Global Enable Breakpoints
 Caught ExceptionsExternal .class File Breakpoints
 Search
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Follow these steps to set a breakpoint in the paint method of the HiThereapplet (see “Building Your First Applet” on page 5):
 1. Go to the Workbench and select the itso.samples.ch01 package and thenthe paint method of the HiThere applet.
 2. Double-click the left margin of the line containing g.drawString(str,xPos, 50).
 You can also place the cursor in the line of code and set a breakpoint byselecting Breakpoint from the Edit menu, typing Ctrl-B, or selectingBreakpoint from the pop-up menu.
 A breakpoint symbol appears in the margin of the Source pane next to theline in which you set the breakpoint (Figure 108 on page 181).
 Figure 108. Breakpoint in the Paint Method
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Removing BreakpointsOnce a breakpoint is set, you can remove it at any time, including while youare debugging the code that contains the breakpoint. If you remove abreakpoint from a method while the thread it is in is suspended, thedebugger does not drop to the top of the method.
 To remove a breakpoint in source code, double-click its symbol in the marginof the pane. You can remove breakpoints from any Source pane (not just theSource pane in the Breakpoints page in the debugger).
 If you are in the Breakpoints page, you can also use the clear toolbar buttonsto clear breakpoints.
 Disabling BreakpointsSuppose you want to run a program that has breakpoints set throughout itscode, but you do not want the debugger to open during this execution of theprogram. You can disable the breakpoints by clicking the EnableBreakpoints toolbar button so that it is in the "up" position. The IDEignores all breakpoints it encounters (although the debugger may still launchfor other reasons, such as an uncaught exception). All debugger symbols inthe margin of Source panes change color from blue to grey.
 To reenable all breakpoints in the workspace, click the Enable Breakpointsbutton so that it is in the "down" position.
 Conditional BreakpointsConditional breakpoints are breakpoints that suspend code and open thedebugger only when certain conditions are met. For example, you can set abreakpoint to suspend code only if a variable’s value falls within a particularrange of values.
 Opening the DebuggerAn alternative way of halting your program and opening thedebugger is to insert the halt method in your Java code. Like theinspect method, the halt method is useful if you have adifficult-to-debug program that should not be interrupted withbreakpoints. However, it is most useful in debugging innerclasses where you cannot set breakpoints. To halt your programand open the debugger insert the following code in your program:com.ibm.uvm.tools.DebugSupport.halt();
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To set conditions on the breakpoint in the paint method, click mouse button 2on the breakpoint symbol, and select Modify from the pop-up menu. EnterxPos == 50 and click OK (Figure 109). The debugger opens on this breakpointonly if the xPos variable is equal to 50.
 Figure 109. Conditional Breakpoint Configuring Dialog Box
 In the Configuring dialog box (Figure 109), you can select a condition, or youcan type in your own condition. The dialog box contains up to 10 conditionsyou have previously set on breakpoints. If the condition is evaluated to aboolean value of true, VisualAge for Java suspends the code and opens thedebugger.
 You can also configure a breakpoint to run a Java statement and then returntrue or false. For example, when the IDE encounters the breakpoint, you canhave it output a message and then evaluate to false and not suspend the code(Figure 110 on page 184).
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Figure 110. Conditional Breakpoint Configuring Dialog Box: Printing Diagnostics
 Caught ExceptionsIf an exception is thrown while a program is running in the IDE, and theprogram does not catch it, usually the IDE debugger opens and the offendingthread is suspended. However, if the program catches the exception, thedebugger will not open, and the program will continue. Even if the programoutputs the stack trace when it catches the exception, you might not be ableto determine the exception’s origin.
 To facilitate debugging, the IDE debugger lets you effectively set breakpointson types of exceptions. Therefore any time an exception of a certain type or asubtype of that exception is thrown, the JVM suspends the thread that threwthe exception and opens the debugger. The suspended thread will be of theform className (Exception Caught) exceptionclassname.
 Follow these steps to select a type of exception to be caught by the debugger:
 1. Select Debug→Caught Exceptions from the Window menu or click theCaught Exceptions toolbar button in the debugger.
 Code AssistThe text entry field in the Conditional Breakpoint dialog has CodeAssist. If you type in the start of a package or class name, you canpress Ctrl+Spacebar to get a pop-up list of available classes,methods, and fields. Select the desired class, method, or field bycontinuing to type or by using the arrow keys, and press Enter.
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2. From the list of available exception types (Figure 111), enable thecheckboxes of the types of exceptions on which you want to setbreakpoints. Remember that all subtypes of an exception are caught, so ifyou select java.lang.Exception, all exceptions thrown will cause theprogram to suspend.
 3. Click OK.
 Figure 111. Caught Exceptions Dialog Box
 Now when you run a program that throws an exception (of the types youselected), the thread is suspended and the debugger browser opens,regardless of whether the program catches the exception.
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External DebugVisualAge for Java Version 2 can run programs that dynamically load andrun external classes. External classes are classes that have not beenimported into the workspace, but rather reside in a class, Zip, or JAR file onthe file system. The path to the file must be part of the class path for theprogram or the workspace.
 If you want to debug such a program, you have the option of settingbreakpoints on methods in the external classes. Follow these steps to set abreakpoint on a method in an external class:
 1. Select Debug→External .class file breakpoints from the Windowmenu, or click the External Breakpoints toolbar button in the debuggerbrowser.
 2. The External Method Breakpoints dialog box shows a list of methodsavailable for setting breakpoints. Add methods to the list by clickingAdd.
 3. The Add External Methods dialog looks into class, Zip, and JAR files andlets you select methods of classes within those files to add to the list ofmethods available for setting breakpoints. To access methods in a .classfile:
 a. Click Directory.
 b. Browse through the file system to the directory that contains the .classfiles in which you want to set breakpoints.
 The handleException MethodWhen VisualAge generates the code in the Visual CompositionEditor, it generates a handleException method for each class. Thismethod is called when any generated code throws an exception.By default the body of this method is commented out, and you willnot see exceptions being thrown.By removing the comment symbols from the lines inhandleException, you can see the message and stack trace for eachexception that causes handleException to be run. Thus it is easy tospot problems during development, although many exceptionsmay be displayed, especially if you have manyproperty-to-property connections where one side of the connectionis not initialized when the program starts. It is possible to catchthese exceptions within the user code section of the connectionitself.
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To access methods in a .class file that has been archived:
 a. Click Archive.
 b. Select Zip Files (*.zip) or Jar Files (*.jar) in the Files of Typedrop-down list.
 c. Browse to the archive file that contains the .class files in which youwant to set breakpoints.
 The dialog lists all of the class files in the selected directory or archive.Select a file to see the list of methods available for setting breakpoints.
 4. If you want to add one of the listed methods to the list of methodsavailable for setting breakpoints, enable its checkbox.
 5. When you have selected all of the methods you want, click OK. The list ofmethods in the External Method Breakpoints dialog box now shows themethods you selected.
 6. To set a breakpoint on one of these methods, enable its checkbox.
 7. Click OK to exit the dialog.
 Figure 112 on page 188 shows the dialogs used to set external breakpoints.As you can see, the breakpoints are set at the method level, not on individualstatements. To see the source for the external file in the debugger, the Javacode must be available and included in the Source path for dynamicallyloaded classes setting in the Debugging section of the Options dialog. Oncethe breakpoint is set, any thread that calls it will be suspended when themethod is entered. External breakpoints cannot be conditional and do notdisplay the breakpoint symbol in the Source pane margin.
 Managing and Fixing Your Code 187

Page 214
                        

Figure 112. External Method Breakpoint Dialogs
 Removing External Debug BreakpointsTo remove a breakpoint from an external method, clear its checkbox in theExternal Method Breakpoints dialog. You can leave the method on the list sothat it is easily accessible if you want to set the breakpoint again later. If youwant to remove the method from the list, however, select it and clickRemove.
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Generating a Class TraceThe debugger generates a trace of class loading and initialization if youenable the Class Trace option. The class trace is useful for determining whichclasses your program uses and can help in debugging.
 The trace is enabled through the Trace class initialization for runningprograms option in the Debugging section of the Options dialog.
 To see the trace, select the program (not a thread) in the AllPrograms/Threads pane of the debugger. The trace is shown in the Sourcepane.
 Performance and the Class Trace OptionWhen the Class Trace option is enabled, some processing timeis required to compute and store the trace. As a result, theprogram may run significantly more slowly.
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6 Finishing the ATM ApplicationYou can promote code reuse and make your applications easy to maintain andchange by creating applications that are made up of distinct pieces orcomponents. This is true for both nonvisual beans and the GUI of yourapplications.
 In this chapter you will finish constructing the ATM application. You use themodel that you built in “Building the ATM Model” on page 68 as well as theknowledge you gained using the Visual Composition Editor and Swingclasses in Chapter 4, “Building User Interfaces”.
 You finish the ATM application by building separate panels and thencomposing them together to create the final application.
 ATM ApplicationYou are now ready to construct and combine the panels for the ATMapplication following the design in “ATM Application” on page 49. This
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chapter is all about creating and then combining user interface componentsand subpanels to produce a final application.
 The ATM is a fairly complex application consisting of several differentpanels. First you need the infrastructure that will provide the data transferand reusable beans for your application. The first bean you build is theAtmController, that manages the application flow and provides themechanism for data transfer between the different panels. After you haveconstructed the AtmController, you will build the main window, AtmView; somereusable beans (Keypad, AtmButtonPanel, and AtmNamePanel); and the panelsthat make up the ATM application.
 Finally you will combine the panels on a panel, using CardLayout in theAtmView. Figure 113 shows the relationships among the Controller on theAtmView and the ControllerVariable on each panel as well as the addition ofeach panel to the MainPanel.
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Figure 113. Relationships among Panels in the ATM Application
 AtmControllerThe AtmController manages the flow of the ATM application, using aCardLayout variable, and provides the data transfer between the differentpanels, using Bank, Card, Customer, and Account beans or variables. Inaddition the AtmController exposes several methods (next, previous, andexit) to navigate through the application.
 To create the AtmController, create a new class, AtmController, that extendsObject in the package, itso.atm.view. If you did not create the itso.atm.view
 ControllerVariable
 Controller
 ControllerVariable
 ControllerVariable
 ControllerVariable
 MainPanel
 AtmWelcomePanel
 AtmPinPanel
 AtmAccountPanel
 AtmTransactionPanel
 AtmView
 Controller to ControllerVariable Connections
 Add Panel to CardLayout
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package in “Creating Packages” on page 35, create it now. Typeitso.atm.view in the Package field in the Create Class SmartGuide to createthe package.
 Open the AtmController in the Visual Composition Editor and add the BeansListed in Table 6 to the free-form surface. The bean type is selected in theChoose Bean dialog when you are adding the beans to the free-form surface.Make sure you check that you are adding a variable or a bean as directed inthe instructions as you work through the examples.
 Note that there is no visual representation of the bean on the free-formsurface: this is not a visual bean.
 Table 6. AtmController Beans
 After you add the beans, the free-form surface should look like that in Figure114. Note the angle brackets around the variables on the free-form surface.Now save the bean, using Bean→Save Bean.
 Bean Name Class Name Bean Type
 LayoutVariable java.awt.CardLayout Variable
 Bank itso.atm.model.Bank Class
 CustomerVariable itso.atm.model.Customer Variable
 CardVariable itso.atm.model.Card Variable
 AccountVariable itso.atm.model.BankAccount Variable
 Adding Classes and Variables Make sure you check the Bean Type setting when adding classesand variables or serialized beans. The setting remembers theprevious type. For example, if you are dropping a class after avariable, you have to explicitly set the Bean Type to Class.You can drop a class or an interface as a variable and theninitialize it or call static methods on it. You cannot drop a variableon the visual portion of the bean on the free-form surface.You can also drop instances of serialized beans that read theirstate from a file.
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Figure 114. AtmController Free-Form Surface
 PromotionThe VisualAge for Java promotion function takes a feature on a bean on thefree-form surface and promotes it to the BeanInfo interface of the containerbean that holds it.
 In this example, all of the beans you added to the AtmController free-formsurface will have their this property promoted. Therefore other beans canaccess the promoted beans directly. In the application you will tear off thepromoted beans that you need in each panel.
 Previously Promoted FeaturesWhen you are working with the Promote Feature dialog, you donot see any of the previously promoted features. These featuresare accessed through the BeanInfo page of the container bean.This is a change from Version 1 where promotion information ismaintained in the Visual Composition Editor.
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Select each of the beans you just added to the free-form surface and promotethe this property. Select the bean, press mouse button 2, and select PromoteBean Feature (Figure 115).
 Figure 115. Promoting the AccountVariable this Property
 Make sure that the Properties radio button is selected, select the thisproperty, click on the >> button, and then click OK (Figure 116).
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Figure 116. The Promotion Dialog for the AccountVariable this Property
 On the BeanInfo page add two new readable and writeable property featuresto the AtmController bean:
 Add three new method features to the AtmController bean:
 The method bodies for the three method features are:
 public void exit(){
 getFrame().dispose();System.exit(0);
 Name Type Bound
 container java.awt.Container false
 frame com.sun.java.swing.JFrame false
 Name Return Type Parameters
 exit void 0
 next void 0
 previous void 0
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}public void next(){
 getLayoutVariable().next( getContainer());}public void previous(){
 getLayoutVariable().previous( getContainer());}
 The AtmController is now ready to be used in the ATM application!
 AtmViewThe AtmView is the main window of the ATM application (Figure 117). It is asubtype of JFrame and holds the AtmController as well as the MainPanel, thatuses CardLayout and holds the subpanels. The AtmView also provides ascrolling marquee, at the bottom of the window, that can showadvertisements or instructions. Before creating the AtmView you have tocreate the scrolling marquee or Ticker.
 Create Method and Method Feature ShortcutsA quick way of creating method features is to go to the Sourcepane in the Methods, BeanInfo, or Hierarchy page and type thenew method over existing methods. Then go back to the BeanInfopage and add the method features, using Add AvailableFeatures.To create a method you can type over an existing method or enterthe complete method in the class declaration. To replace a method,use Shift-Control-S to save and replace (as long as you have notchanged the Accelerator keys for saving methods option in theOptions dialog box).
 198 Programming with VisualAge for Java Version 2

Page 225
                        

Figure 117. The AtmView
 Creating the Ticker BeanThe Ticker is a generic marquee that scrolls text from right to left. It extendsthe JPanel class and holds the message property feature.
 To create the Ticker, create a new class, itso.atm.view.Ticker, that inheritsfrom com.sun.java.swing.JPanel. Deselect the Compose the class visuallycheckbox. Click Next and deselect the Copy constructors fromsuperclass checkbox. Click the Add button to the right of the Whichinterfaces should this class implement area. Enter or select Runnable and thenclick Add then Close. Click on Finish to create the class. By selectingRunnable you have instructed VisualAge for Java to create a stub for themethod defined in the Runnable interface, run.
 Open the class in the Class Browser and add the following attribute to theclass declaration:
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private int xOffset = getSize().width;
 Switch to the BeanInfo page. Add a read-write property feature with messageas the Property name and java.lang.String as the Property type. Because thebean does not need to send an event when this property is changed, you canuncheck the bound checkbox. Click Finish to create the property.
 Switch to the Methods page. Create a paint method with the followingsignature and body:
 public void paint(java.awt.Graphics g) {
 int fSize = getFont().getSize();java.awt.FontMetrics fm = getFontMetrics(getFont());int xMin = -fm.stringWidth(getMessage());int yOffset = (getSize().height - fSize) / 2 + fSize;g.clearRect( 0, 0, getSize().width, getSize().height);g.drawString(getMessage(), xOffset, yOffset);xOffset -= 1;if (xOffset < xMin) {
 xOffset = getSize().width;}
 }
 Create a default constructor for the Ticker, using the following code:
 public Ticker() {super();if( !java.beans.Beans.isDesignTime()){
 setMessage("");Thread paintThread = new Thread(this);paintThread.start();
 }}
 The java.beans.Beans.isDesignTime() method queries the current environment.If it is a runtime environment, the Ticker will run. If you are using the beanin a builder such as VisualAge for Java, there is no point in having the textscroll.
 Fill in the run method body:
 public void run() {while (true) {repaint();try {
 Thread.sleep(10);} catch (InterruptedException e)
 {} // if the thread is interrupted (woken early) it does not matter
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}}
 Testing the TickerTo test the Ticker (Figure 118), open the Scrapbook and enter the followingcode:
 com.sun.java.swing.JFrame f = new com.sun.java.swing.JFrame();itso.atm.view.Ticker t = new itso.atm.view.Ticker();t.setMessage("This is a message");f.getContentPane().add("Center", t);f.setSize( new java.awt.Dimension(300, 100));f.show();
 Figure 118. Testing the Ticker
 How the Ticker WorksIn order for the Ticker to work, you must separate the process of repaintingthe message from the rest of the program by using a thread. The threadexecutes in the same memory space as the rest of the program.
 Java supports multithreading through the Thread class. Thus, you canseparate your program into independently running sections, or threads.Multiple threads make your program more responsive to user interaction orable to perform actions (such as the scrolling text) that require processing inreal time. To create a thread in your program, you create an object of theThread class.
 Objects that can run as threads implement the Runnable interface thatprovides the run method — the method called when you invoke start on athread.
 Test Code in the main() MethodYou can place the code for testing the Ticker in the main() methodof the class, so to test the class you simply run it. This is a good strategy for visual beans; the simple test case stayswith the class, and the class is easily tested.
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Creating and Adding Beans to the AtmViewCreate a new class, AtmView, that extends com.sun.java.swing.JFrame. OpenAtmView in the Visual Composition Editor and select JFrameContentPane (thepanel on the frame). Open the Property sheet for JFrameContentPane and setlayout to BorderLayout.
 Drop an instance of the Ticker bean (make sure to select the Class BeanType) into the South portion of the JFrameContentPane. Once the cursor isloaded with the Ticker, hold down mouse button 1 as you move the cursorover the JFrameContentPane. You should see bounding boxes for each of theportions of the BorderLayout. Drop the bean when the rectangle is in theSouth portion of the MainPanel. If you do not get it right, you can alwayschange the constraint property in the Property sheet for the Ticker. In theTicker Property sheet set the preferredSize to 10,20 and the message to:“Welcome to the ATM, this week get a 5% mortgage rate! Apply Now!”. Youwill not see preferredSize, which is an expert feature, unless you select theShow expert features checkbox on the Property sheet.
 Add a JPanel to the Center portion of the JFrameContentPane. Set the newpanel’s beanName to MainPanel and layout to CardLayout.
 Drop an instance of AtmController anywhere on the free-form surface of theAtmView bean and name it Controller. Connect the layout property of theMainPanel to the layoutVariableThis property of AtmController. Open theConnection Property dialog and set the Target event to <none>. Connect thethis property of MainPanel to the container property of the AtmControllerand the this property of the AtmView to the frame property of theAtmController. Figure 119 shows the Visual Composition Editor with theController bean and connections.
 Adding Beans or Variables to the Free-Form SurfaceIt is extremely important that you add the correct form of a classthroughout the examples in the book. If the text says add a beanor an instance, you are adding an instance of a bean, and youselect Class for the Bean Type. If the text says add a variable, youare adding an attribute that will reference another instance, andyou select Variable for the Bean Type.Whenever you add something from the palette, except thevariable “bean” itself, it is always a bean, not a variable.When you are creating your own programs, your design andunderstanding of the program should make clear what you shouldadd.
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The AtmView bean (Figure 119) is now ready for the subpanels that make upthe flow of the application, but first you have to create some more of theinfrastructure: the reusable beans used in the subpanels.
 For now, select Bean→Save Bean and continue on to build the Keypad.
 Figure 119. Initial AtmView with Connections
 KeypadThe ATM application will use some beans several times. You build these nowand then reuse them as you build the other panels.
 The Keypad (Figure 120) is a generic keypad that can be used to enter anumber. The Keypad consists of 12 buttons (the numbers 0–9, a decimalpoint, and C for clear). The purpose of the Keypad is to accept button clicksand key presses and build a number that other beans can access.
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Figure 120. The Keypad
 There are many ways to build a keypad. One efficient way is to use an innerclass.
 Inner ClassesIn the JDK 1.0 only top-level classes can be defined, that is, classes cannot bedefined within other classes. It turns out that classes defined within otherclasses, or inner classes, are very powerful tools. They are especially helpfulin building the glue or adapter code needed to allow beans to exchangeinformation, especially for callback functionality in event handling where amethod is invoked on the listener object. Inner classes can be defined asmembers of other classes, within a block or (anonymously) within anexpression. A complete introduction to inner classes is outside the scope ofthis book, but many of the newer Java language books and the JDKdocumentation describe inner classes.
 For the ATM you define an inner class named Controller within the Keypad.This inner class can access all the instance information of the enclosingKeypad. The Controller listens for the actionPerformed event from the Keypadbuttons and key presses. By using an inner class you keep all code thatperforms event handling with the rest of the Keypad code while stillmaintaining a logical separation from the code that implements the Keypaditself. Each Keypad controls access to a single instance of the Controller,using the getController method. Thus the Controller can be added as alistener for events outside the Keypad.
 Using an inner class as an adapter, you can create classes that are not linkedto a particular means of communicating their state. You can also use an innerclass as an adapter to create the correct form for sending and receiving data.Inner classes are used extensively in the JFC.
 VisualAge for Java supports the import, creation, and use of inner classes.You define inner classes by entering the source code for the inner class withinan existing class declaration, block, or expression. If you import a class thatdefines inner classes, the inner classes show up as classes in the package list.
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If you define the inner class within VisualAge for Java or import Java source,the inner class is shown only in the source for the class declaration or in themethod where the inner class is defined. The enclosing method or classdefinition is also returned in a search for an inner class.
 Creating the KeypadThe Keypad has one nested inner class, Controller, that handles both buttonclicks or key presses and sets a string representing the number beingentered.
 To create the Keypad, follow these steps:
 1. Create a Keypad class in the itso.atm.view package that inherits fromcom.sun.java.swing.JPanel. Make sure the Compose the class visuallyradio button is not selected.
 2. Click Next and deselect the Copy constructors from superclasscheckbox, so that VisualAge for Java will not generate all constructorsthat a JPanel implements. Click Finish to create the class and load it inthe Class Browser (Figure 121).
 Figure 121. Creating the Keypad Class
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3. Switch to the BeanInfo page and create a new property feature:
 4. Select the setter method (setValueAsString) for the property in theDefinitions pane and then change the declaration for the setter to privateby typing over the public access modifier in the Source pane.
 When you change the setter to private, beans of other types cannot changethe value of the Keypad — which is what you want. You could create thesetter manually with the private access modifier, but when you use steps3 and 4 above, VisualAge for Java generates the property change code foryou.
 5. Select the new property, valueAsString, and in the Property FeatureInformation pane set Preferred to true, then select Information→Save.Now the valueAsString property will show up in the preferred list of theKeypad bean.
 6. Switch to the Hierarchy page and change the class declaration of Keypadto (you can copy this code from KeypadDeclaration.txt in the sample code):
 import com.sun.java.swing.*;import java.awt.event.*;import java.awt.*;import java.math.BigDecimal;
 public class Keypad extends JPanel {
 Name Type Bound Readable Writeable
 valueAsString java.lang.String True True True
 Generating Getter and Setter MethodsYou can use the Create Field SmartGuide to add attributes to aclass. With this SmartGuide you can specify the modifiers for thefield and an initial value and generate getters and setters. Youcan even specify code in the initial value and invoke a constructor.You can also add the attribute as a property feature automaticallythrough introspection or (if a BeanInfo class exists) through AddAvailable Features.You cannot easily make the property bound or constrained,however. If you set bound or constrained to true in the BeanInformation pane, the property will be marked as bound orconstrained, but events will not be fired when the property ischanged.
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private String[] buttonText = {"1", "2", "3", "4", "5", "6", "7", "8", "9", ".", "0", "C"
 };private JButton[] button = new JButton[12];private String fieldValueAsString = new String();private Controller controller = null;protected class Controller implements ActionListener, KeyListener{
 public void actionPerformed(ActionEvent e){if( ((JButton)e.getSource()).getText().equals( "C")){
 setValueAsString(""); // empty string - no spaces}else{
 setValueAsString( getValueAsString() + ((JButton)e.getSource()).getText());
 }}public void keyTyped(KeyEvent e){
 for( int i = 0; i < button.length; i++){if( button[i].getText().charAt(0) == e.getKeyChar()){
 if( button[i].getText().equals( "C")){ setValueAsString( "");
 }else{
 setValueAsString( getValueAsString() + button[i].getText());
 }}
 }}public void keyPressed(KeyEvent e){}public void keyReleased(KeyEvent e){}
 }}
 In the above code you defined the inner class, Controller. In VisualAge forJava you define inner classes in source code, not through SmartGuides.
 Notice the stub methods for keyPressed and keyReleased. Whenever youimplement an interface, in this case KeyListener and ActionListener, youmust implement all methods of the interface.
 7. Create an access method, getController, in the Keypad class that returnsthe controller. The Keypad$Controller specifies that the method returns aninstance of Controller that is an inner class of Keypad.
 public Keypad$Controller getController(){
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if( controller == null){controller = new Controller();
 }return controller;
 }
 8. Switch to the BeanInfo page again and add the getController method as aMethod Feature, using Add Available Features to make it possible forother beans to add the Controller as a KeyListener. You will add keyboardsupport for the ATM in “Adding Keyboard Input to the ATM Application”on page 247.
 9. Add a new method feature, clear, that takes no parameters and has areturn type of void with the following method body:
 public void clear() {setValueAsString("");
 }
 10.Create a default constructor for the Keypad and fill in the body:
 public Keypad(){
 super();setBorder( new com.sun.java.swing.plaf.basic.BasicFieldBorder());GridLayout g = new java.awt.GridLayout(4, 3);g.setVgap(2);g.setHgap(2);setLayout(g);for( int i = 0; i < button.length; i++){
 button[i] = new JButton( buttonText[i]);add( button[i]);button[i].addActionListener( getController());
 }}
 Notice that the buttons are added to the Keypad through code instead of theVisual Composition Editor and that the event handling connections are alsomade in code. In some cases coding the user interface is more efficient andmore understandable than using the Visual Composition Editor.
 Now you have a self-contained Keypad that handles its own events andpresents the complete number to other beans, whether the number wasentered through the buttons or the keyboard (provided the Controller isadded as a KeyListener).
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AtmButtonPanelAll ATM panels use the same set of buttons to navigate through theapplication. This composite bean is made up of Next, Previous, and Exitbuttons. The ability to listen for events from the buttons and enable anddisable the buttons is provided through promotion.
 Building the AtmButtonPanelCreate a new class, itso.atm.view.AtmButtonPanel, which extendscom.sun.java.swing.JPanel. Open the class in the Visual Composition Editor,select the panel, set the layout to FlowLayout, and add three JButtons. Setthe beanName and text properties as shown in Table 7.
 Table 7. AtmButtonPanel Button Properties
 Resize the panel so that it holds the three buttons horizontally and save thebean. For each button, promote the enabled property and theactionPerformed event.
 Follow these steps to promote the features for the PreviousButton:
 1. Select the button, hold down mouse button 2, and select Promote Beanfeature.
 2. Select the Property radio button in the Promote features from dialog box.
 3. Select enabled in the list below the Property radio button.
 4. Click the >> button.
 5. Select the Event radio button, then select actionPerformed from the list,and click >>, to promote the actionPerformed event.
 6. Click OK.
 Repeat steps 1 through 6 for the NextButton and ExitButton, then save thebean. Figure 122 shows the completed AtmButtonPanel.
 beanName text
 PreviousButton <Previous
 NextButton Next>
 ExitButton Exit
 Finishing the ATM Application 209

Page 236
                        

Figure 122. AtmButtonPanel with Promoted Features
 AtmNamePanelThe customer name is required in several places in the ATM application. Thename is stored as three separate properties in the Customer bean, but itwould be nice to access the visual representation with one bean. You createthe AtmNamePanel to accomplish this.
 Create a new class, itso.atm.view.AtmNamePanel, that extends JPanel. Set thelayout to FlowLayout and add four JLabels. (Remember that the Stickyfunction, invoked by holding down the Control key when you select a beanfrom the palette, allows you to drop more than one bean of a type.) Changethe text of the first label to Customer Name:. Change the text of the secondlabel to Title; of the third, to First Name; and of the fourth, to Last Name.Resize the panel so that it holds the four labels horizontally and there is asmall amount of space around each label.
 Drop an itso.atm.model.Customer variable on the free-form surface and nameit CustomerVariable. Connect the title, firstName, and lastName properties tothe text property of the appropriate JLabels. Select this for the source eventto fire the connections and select <none> for the target event (Figure 123).You want this connection to fire as soon as the Customer1 variable is set (thethis event fires), and you only want the connection to go one way — from thevariable to the labels.
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Figure 123. Setting the Source Event for a Property-to-Property Connection
 Finally, save the bean and then promote the this property of theCustomerVariable. Figure 124 shows the finished AtmNamePanel.
 Reversing a ConnectionProperty-to-property connections have an implied direction thataffects which end of the connection is set at initialization. If youwant to reverse the direction, click the Reverse button in theConnection Properties dialog.The firing of the event after initialization depends on the sourceand target events selected.
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Figure 124. The AtmNamePanel
 AtmWelcomePanelNow you are ready to build your first complete subpanel for the application!The AtmWelcomePanel (Figure 125 on page 213) displays a query for an ATMcard ID number.
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Figure 125. ATM Application AtmWelcomePanel
 Follow these steps to create the AtmWelcomePanel:
 1. In the itso.atm.view package create an AtmWelcomePanel class thatinherits from com.sun.java.swing.JPanel. Make sure the Compose theclass visually checkbox is selected. Click Finish to create the class andload it in the Visual Composition Editor.
 2. In the Visual Composition Editor, select the AtmWelcomePanel and set thelayout to GridBagLayout. If you are not clear about using theGridBagLayout, see “GridBagLayout” on page 111 and “Adding the GUIBeans” on page 131.
 3. Drop a JTextField onto the AtmWelcomePanel. Set the beanName toNumberTextField. Open the Property sheet and set enabled and editable tofalse, then check that the background to white. To set the background towhite:
 a. Click in the field containing the current background color.
 b. Click the button that appears at the right end of the field.
 c. Click the Basic radio button.
 d. Select white from the list.
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e. Click OK.
 Set the disabledTextColor to Black.
 Set the constraints for the bean as shown in Table 8 on page 214. It iseasiest to set each bean’s constraints when you are working with the bean.To set the individual constraints, expand the constraints property byclicking on the plus sign.
 4. Drop a JLabel in the AtmWelcomePanel in the row below theNumberTextField. Set the beanName to MessageLabel and the text to Pleaseenter your card number. Expand the AtmWelcomePanel as needed while youadd beans. Set the constraints for the bean as shown in Table 8 on page214.
 5. Drop an itso.atm.view.Keypad bean below the MessageLabel. Again, setthe constraints for the bean as shown in Table 8 on page 214.
 6. Drop an itso.atm.view.AtmButtonPanel in the AtmWelcomePanel in the rowbelow the Keypad. Open the Property sheet and set previousButtonEnabledto false. Set the constraints for the bean as shown in Table 8 on page 214.
 7. If you were not able to position the beans visually, set the gridX and gridYproperties of the beans as shown in Table 8.
 Table 8. AtmWelcomePanel Bean Constraints
 Leave all other constraints as the default values.
 8. Drop an AtmController on the free-form surface with a Bean Type ofVariable and name it ControllerVariable.
 Now you have all the beans on the surface (Figure 126 on page 215). You haveto connect them as well as add one method to the bean:
 Bean Name text anchor fill gridX gridY
 NumberTextField N/A WEST HORIZONTAL 0 0
 MessageLabel Please enter yourcard number.
 WEST HORIZONTAL 0 1
 Keypad1 N/A WEST BOTH 0 2
 AtmButtonPanel1 N/A WEST HORIZONTAL 0 3
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Figure 126. AtmWelcomePanel with Beans
 1. Tear off the bank property, the cardVariableThis property and thecustomerVariableThis property from the ControllerVariable. Name themBankVariable, CardVariable, and CustomerVariable. Tearing off theproperties will generate three property-to-property connections and threevariables on the free-form surface. You can drag these connections andvariables anywhere on the free-form surface to make the display moreunderstandable.
 2. Connect the valueAsString property of Keypad1 to the text property of theNumberTextField.
 3. Connect the AtmButtonPanel1.exitButtonAction_actionPerformed(java.awt.event ActionEvent) event to the exit method on theControllerVariable.
 4. Connect the AtmButtonPanel1.nextButtonAction_actionPerformed(java.awt.event ActionEvent) event to the validCard method on theBankVariable.
 5. Connect the valueAsString property of Keypad1 to the cardParamparameter on the connection in Step 4.
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6. Save the bean, using Bean→Save Bean, so that you can use thegenerated code in an event-to-code connection in step 7.
 7. Create an event-to-code connection from the normalResult (Figure 127 onpage 216) of the event-to-method connection in Step 4(nextButtonAction_actionPerformed event to the validCard method) byselecting the connection, selecting Connect→normalResult from thepop-up menu, clicking on any empty area on the free-form surface, andselecting Event To Code.
 Figure 127. Connecting from the Normal Result of a Connection
 8. Make sure the Pass event data checkbox is selected and replace the codein the Event-to-Code dialog (Figure 128 on page 217) with the followingcode:
 public void checkCardResult(itso.atm.model.Card arg1) {if( arg1 != null){
 setCardVariable( arg1);getControllerVariable().next();setCustomerVariable( getBankVariable().getCustomer( arg1));getKeypad1().clear();
 }
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else{getMessageLabel().setText("Invalid Card Number, try again");
 }}
 Figure 128. Event-to-Code Dialog Box
 9. Save the bean and promote the ControllerVariable this property.
 Note how the customer variable is set in code of the checkCardResult method.
 Figure 129 shows the Visual Composition Editor with the completedAtmWelcomePanel. Save and test the appearance of the panel by clicking theRun button. Remember that this is your first panel, so the Next button is notgoing to do much yet. Test each panel as you complete it, using the Runbutton. Not only do you catch errors early, you see that you are actuallycompleting something!
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Figure 129. The AtmWelcomePanel
 AtmPinPanelThe AtmPinPanel (Figure 130 on page 219) enables users to enter the PINassociated with their ATM card. The AtmPinPanel is very similar to theAtmWelcomePanel.
 Adding Beans of the Same TypeYou can use the drop-down list in the Interface/Class name fieldof the Choose Bean dialog to add recently used beans to thefree-form surface.
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Figure 130. ATM Application AtmPinPanel
 Create a new class, AtmPinPanel, that extends JPanel. Open the AtmPinPanelin the Visual Composition Editor and set the layout to GridBagLayout.
 Now that you have progressed this far in the book, you do not need the samelevel of detail that you needed earlier in the book. The instructions in the restof the book are less detailed and often in table form. You should also resizethe panels as needed when you are adding beans.
 Drop the visual beans listed in Table 9 on page 220 on the visual part of thepanel and set their properties as shown. The N/A in some table cells indicatesthat you do not need to enter a value for cells in the column. For example, inthe beanName column, N/A means you can accept the default name thatVisualAge for Java assigns. Use the placement of the GUI beans on theaccompanying figures to determine where to place a bean. Figure 131 on page221 shows the GUI beans on the ATMPinPanel.
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When you use the Choose Bean tool to add visual beans to the visualrepresentation of the primary bean, the Bean Type is always Class. Whenyou add a bean from the palette, the Bean Type is implicitly Class.
 Table 9. Visual Beans in the AtmPinPanel
 beanName Interface/ClassName
 text anchor fill gridX gridy gridWidth
 N/A AtmNamePanel
 N/A WEST HORIZONTAL 0 0 2
 N/A JLabel Card Number: WEST HORIZONTAL 0 1 1
 CardNumberLabel
 JLabel N/A CENTER HORIZONTAL 1 1 1
 MsgLabel JLabel Please enterYour PINnumber
 WEST HORIZONTAL 0 2 2
 PinTextField JTextField N/A WEST HORIZONTAL 0 3 2
 N/A Keypad N/A WEST BOTH 0 4 2
 N/A AtmButtonPanel
 N/A WEST HORIZONTAL 0 5 2
 The Morph Into FunctionAlthough Morph Into was designed primarily to help migratefrom AWT to Swing components, you can use it to change a classinto a variable and vice versa. If you make a mistake and drop avariable instead of a class, use Morph Into from the pop-up menuto change the bean to the correct bean type.
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Figure 131. AtmPinPanel with Visual Beans
 Open the Property sheet for the PinTextField and set enabled and editable tofalse, background to white, and disabledTextColor to Black.
 Now you need to add a controller to the free-form surface. Drop a variablecalled ControllerVariable of type AtmController, tear off thecardVariableThis property, and rename it CardVariable.
 Now make the connections shown in Table 10. In the table, the Connectionfrom and Connection to columns show bean_name,feature orbean_name,feature.method, for example,CardVariable,pincheck.handleValidPin. This corresponds to the wayconnections are shown in the status area at the bottom of the VisualComposition Editor window. For clarity, the connections in the figures arearranged quite differently from the way they are drawn when you connectbeans. If you use different naming conventions for beans or create anincorrect number of beans, the connection tables and descriptions will show
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names that differ from the names you see in your session. If this is a problem,you can load the sample code and follow it instead.
 Table 10. AtmPinPanel Connections
 ConnectionNumber inFigure 133
 ConnectionType
 Connection from Connection to Comments
 1 EtoM AtmButtonPanel1,exitButtonAction_actionPerformed
 ControllerVariable,exit()
 Exit theapplication.
 2 EtoM AtmButtonPanel1,nextButtonAction_actionPerformed
 CardVariable,checkPin( String)
 Check the Pinnumber (parameterfrom connection 3).
 3 PfromP Connection 2parameter:apinEntered
 Keypad1,valueAsString
 Supply pin numberto the checkPinmethod.
 4 PtoP KeyPad1,valueAsString
 PinTextField,text Connect currentKeypad value totext field.
 5 EtoM AtmButtonPanel1,previousButtonAction_actionPerformed
 ControllerVariable,previous()
 Return to thepreviousapplication panel.
 6 EtoM CardVariable,pinchecked.handleValidPin
 ControllerVariable,next()
 Go to the nextapplication panel.
 7 EtoM CardVariable,pinchecked.handleInValidPin
 MsgLabel,text Set the connectionparameter to:Invalid Pin, pleasetry again. Theprocess is explainedimmediatelyfollowing this table.
 8 PtoP CardVariable,cardNumber
 CardNumberLabel,text
 Source Event: thisTarget Event: None
 9 PtoP ControllerVariable,CustomerVariableThis
 AtmNamePanel1,customerVariableThis
 Show the customername in the panel.UsecustomerVariableThis as the sourceevent and set thetarget event asnone.
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To set the connections parameter in Connection 7, double-click the connection(not on one of the black squares used to move the connection) and click SetParameters in the Connection Properties dialog. Enter the text for theparameter and then click OK in the Constant Parameter Value dialog andclick OK in the Connection Properties dialog.
 Now save the bean and promote the ControllerVariable this property.
 Add the getKeypad1().clear() method to the connections that call previous()and next(), to clear the current value in the Keypad in case you return to itlater. Select the connections (5 and 6 in Figure 133) and note their names inyour session.
 Switch to the Methods page, select the two methods representing theconnections, and add the getKeypad1().clear(); statement in the user codesection of the connection code as shown in Figure 132 for the previous()connection.
 The completed AtmPinPanel with the connections in Table 10 is shown inFigure 133 on page 225.
 10 PtoP ControllerVariable,CardVariableThis
 CardVariable,this Automaticallygenerated by tearoff
 Notes:1. You can deduce the type of feature from the connection type, where P stands for property, E for
 Event, M for Method, and C for Code.2. Connections automatically generated by VisualAge for Java are shown in italic.
 ConnectionNumber inFigure 133
 ConnectionType
 Connection from Connection to Comments
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Figure 132. Adding the getKeypad().clear() Statement to the Connection Code
 224 Programming with VisualAge for Java Version 2

Page 251
                        

Figure 133. AtmPinPanel with Connections
 AtmAccountPanelThe AtmAccountPanel (Figure 134) enables users to choose the account theywant to perform transactions on once the PIN is validated.
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Figure 134. ATM Application AtmAccountPanel
 Create a new class, AtmAccountPanel, that inherits from JPanel. Once againthe panel uses GridBagLayout.
 Drop a JScrollPane on the free-form surface and name it ScrollPane. Drop aJList inside the ScrollPane. In Table 11, ScrollPane refers to the ScrollPaneyou just constructed. Use the Beans List to move the ScrollPane into theAtmAccountPanel and set the properties once it is within the panel.
 Working with Layouts, Lists, Panels, and PanesTo be able to scroll a JList, it must be embedded in a JScrollPane.If you drop a JScrollPane or a panel directly into a container thatis using a layout manager, it is extremely difficult to manipulateit because its size is effectively zero. To work around this, droppanels and panes outside the container and add beans to thembefore moving them into the final container.
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Add the visual beans in Table 11 to the AtmAccountPanel.
 Table 11. Visual Beans in the AtmAccountPanel
 Bean Name Interface/ClassName
 text anchor fill gridX gridy gridWidth
 N/A AtmNamePanel
 N/A WEST HORIZONTAL 0 0 2
 N/A JLabel Card Number: WEST HORIZONTAL 0 1 1
 CardNumberLabel
 JLabel N/A CENTER HORIZONTAL 1 1 1
 MsgLabel JLabel Please selectyour account.
 WEST HORIZONTAL 0 2 2
 ScrollPane Composite N/A WEST BOTH 0 3 2
 N/A AtmButtonPanel
 N/A WEST HORIZONTAL 0 4 2
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Figure 135. AtmAccountPanel with Visual Beans
 You do not want users to be able to click Next until they select an account, soset the nextButtonEnabled property in the AtmButtonPanel to false.
 Drop an AtmController variable on the free-form surface and name itControllerVariable. Drop a com.sun.java.swing.DefaultListModel bean onthe free-form surface and name it ListModel. Be careful that you create theControllerVariable as a variable and the ListModel as a bean, that is, with aBean Type of Class.
 Tear off the cardVariableThis and the accountVariableThis properties fromthe ControllerVariable and name them, respectively, CardVariable andAccountVariable.
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Now create the connections in Table 12 to complete the AtmAccountPanel(Figure 136 on page 231).
 Table 12. AtmAccountPanel Connections
 ConnectionNumber inFigure 136
 ConnectionType
 Connection from Connection to Comments
 1 PtoP CardVariable,cardNumber
 CardNumberLabel,text
 Source event: thisTarget event: None
 2 EtoC CardVariable,this new fillList method Described in thetext that followsthis table.
 3 EtoM AtmButtonPanel1,exitButtonAction_actionPerformed
 AtmController,exit()
 Exit theapplication.
 4 EtoM AtmButtonPanel1,previousButtonAction_actionPerformed
 AtmController,previous()
 Return to thepreviousapplication panel.
 5 PtoP ListModel,this JList1,model Set the model forthe JList.
 6 EtoM JList1,valueChanged
 AtmButtonPanel1,nextButtonEnabled
 Set the parameteron this connectionto true.
 7 PtoP ControllerVariable,customerVariableThis
 AtmNamePanel1,customerVariableThis
 Show the customername in the panel.
 8 EtoM AtmButtonPanel1,nextButtonAction_actionPerformed
 AccountVariable,this
 Set the accountobject (parameterfrom Connection 9).
 9 PfromP connection 8parameter
 JList1,selectedValue
 Account selected inlist instantiatesAccount object.
 10 EtoM AtmButtonPanel1,nextButtonAction_actionPerformed
 AtmController,next()
 Go to the nextapplication panel.
 11 PtoP ControllerVariable,CardVariableThis
 CardVariable,this
 Automaticallygenerated by tearoff
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12 PtoP ControllerVariable,accountVariableThis
 AccountVariable,this
 Automaticallygenerated by tearoff
 Notes:1. You can deduce the type of feature from the connection type, where P stands for property, E for
 Event, M for Method, and C for Code.2. Connections automatically generated by VisualAge for Java are shown in italic.
 ConnectionNumber inFigure 136
 ConnectionType
 Connection from Connection to Comments
 Reordering ConnectionsConnections from a bean are fired in the order in which they werecreated. Quite often this is not what you want to happen. Toreorder connections, select the bean and select ReorderConnections from the pop-up menu. The connections are listedin firing order, and you can reorder them by dragging them beforeor after other connections.
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Figure 136. AtmAccountPanel with Connections
 Save the bean and then enter the following code for the method created in theevent-to-code (EtoC) connection (connection 2 in Table 12):
 public void fillList(itso.atm.model.Card arg1) {for( int i = 0; i < arg1.getAccounts().size(); i++){
 getListModel().addElement( arg1.getAccounts().elementAt(i));}
 }
 The valueChanged events from the JList indicate that a list element has beenselected or deselected. You only want to respond to events that indicate thatan item has been selected.
 Find the method containing connection 6 (that enables the Next button) bysaving the bean, selecting the connection on the free-form surface, andlooking in the status line at the bottom of the Visual Composition Editorwindow. You will see a status line similar to this: connEtoM3:(JLIst1,valueChanged--> AtmButtonPanel1,nextButtonEnabled) selected.
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The method that contains the selection shown in the status line is: voidconnEtoM3(com.sun.java.swing.event.ListSelectionEvent).
 To locate the method, you can also select the connection, and thecorresponding method is then highlighted in the Beans List.
 Open the method in your environment that contains connection 6. In the firstuser code section (see Figure 137) enter the following code:
 if(getJList1().isSelectionEmpty()){getAtmButtonPanel1().setNextButtonEnabled(false);return;
 }
 VisualAge for Java provides user code sections so that you can associate logicwith the firing of the connection. Add only simple, connection-related logic(such as setting a wait cursor) in the user code sections.
 Figure 137. Checking for a Selected Item in JList1
 Call the getJList1().clearSelection() method in the two connections thatcall getControllerVariable().next and getControllerVariable().previous.Figure 138 shows the clear statement in the connection to the next method.Make sure that the connection that calls getControllerVariable().next
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(connection 10) is invoked after the connection that callssetAccountVariableThis() (connection 9).
 Figure 138. Clearing the List Selection in the AtmAccountPanel
 Now save the bean and promote the ControllerVariable this property.
 AtmTransactionPanelThe AtmTransactionPanel is where users deposit and withdraw amounts fromtheir accounts (Figure 139 on page 234). The panel is similiar to those youhave already created. It has buttons to select the type of transaction and liststhe history of transactions that the user has already completed.
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B
 N
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 C
 Figure 139. ATM Application AtmTransactionPanel
 As usual, create the itso.atm.view.AtmTransactionPanel as a subtype ofJPanel and use the GridBagLayout. Drop the visual beans in Table 13 onto thepanel (see Figure 140), using the properties listed in the table. Resize thepanel as needed to hold all of the beans.
 To create the ScrollPane bean you will use in Table 13, drop a JScrollpanenamed ScrollPane onto the free-form surface, and add a JList to it (see“AtmAccountPanel” on page 225).
 Table 13. Visual Beans in the AtmTransactionPanel
 ean Name Interface/ClassName
 text anchor fill gridX gridy gridWidth
 /A AtmNamePanel
 N/A WEST HORIZONTAL 0 0 2
 /A JLabel Card Number: WEST NONE 0 1 1
 ardNumberLabel JLabel N/A CENTER HORIZONTAL 1 1 1
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 /A JLabel AccountNumber:
 WEST NONE 0 2 1
 ccountNumberLabel JLabel N/A CENTER HORIZONTAL 1 2 1
 /A JLabel Account Type: WEST NONE 0 3 1
 ccountTypeLabel JLabel N/A CENTER HORIZONTAL 1 3 1
 /A JLabel Balance: WEST NONE 0 4 1
 alanceLabel JLabel N/A CENTER HORIZONTAL 1 4 1
 ithdrawButton JButton Withdraw CENTER NONE 0 5 1
 epositButton JButton Deposit CENTER NONE 1 5 1
 /A JLabel Amount: WEST NONE 0 6 1
 mountTextField JTextField N/A CENTER HORIZONTAL 1 6 1
 sgLabel JLabel Enter anamount andselect yourtransaction
 WEST HORIZONTAL 0 7 2
 /A Keypad N/A CENTER BOTH 0 8 2
 /A JLabel TransactionHistory:
 WEST NONE 0 9 1
 crollPane N/A N/A WEST HORIZONTAL 0 10 2
 /A AtmButtonPanel
 N/A WEST HORIZONTAL 0 11 2
 ean Name Interface/ClassName
 text anchor fill gridX gridy gridWidth
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Figure 140. AtmTransactionPanel with Visual Beans
 Open the Property sheet for the AmountTextField and set enabled and editableto false, background to white, and disabledTextColor to Black.
 Open the Property sheet for the AtmButtonPanel1 and set nextButtonEnabledto false because this is the last panel in the application.
 Now drop an AtmController variable on the free-form surface, name itControllerVariable, and drop a DefaultListModel class and name it
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CNF
 1
 2
 3
 4
 5
 6
 7
 8
 9
 1
 1
 1
 ListModel. Again, be careful that you create the ControllerVariable as avariable and the ListModel as a bean, that is, with a Bean Type of Class.
 Tear off the accountVariableThis and cardVariableThis properties from theControllerVariable and name them AccountVariable and CardVariable,respectively. Create the connections listed in Table 14 to complete theAtmTransactionPanel (see Figure 141 on page 239).
 Table 14. AtmTransactionPanel Connections
 onnectionumber inigure 141
 ConnectionType
 Connection from Connection to Comments
 PtoP ControllerVariable,cardVariableThis
 CardVariable,this
 Automaticallygenerated by tearoff.
 PtoP ControllerVariable,accountVariableThis
 AccountVariable,this
 Automaticallygenerated by tearoff.
 PtoP ListModel,this JList1,model Set the model for theJList.
 PtoP AccountVariable,balance
 BalanceLabel,text
 Source Event: balanceTarget Event: none
 PtoP AccountVariable,accountId
 AccountNumberLabel,text
 Source Event: thisTarget Event: none
 PtoP CardVariable,cardNumber
 CardNumberLabel,text
 Source Event: thisTarget Event: none
 PtoP AccountVariable,accountType
 AccountTypeLabel,text
 Source Event: thisTarget Event: none
 EtoM AtmButtonPanel1,exitButtonAction_actionPerformed
 ControllerVariable,exit()
 Exit the application.
 EtoM AtmButtonPanel1,previousButtonAction_actionPerformed
 ControllerVariable,previous()
 Return to the previousapplication panel.
 0 EtoM WithdrawButton,actionPerformed
 AccountVariable,withdraw
 Parameter isconnection 11.
 1 PfromP Connection 10parameter, amount
 Keypad1,valueAsString
 Pass amount towithdraw method.
 2 EtoC connection 10normalResult
 new methodupdateTransactions
 updateTransactions isdescribed in the textthat follows this table.
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1
 1
 1
 1
 1
 1
 1
 2
 2
 N1
 2
 CNF
 3 EtoM connection 10normalResult
 Keypad1,clear() Clear the Keypadvalue.
 4 EtoM DepositButton,actionPerformed
 AccountVariable,deposit
 Parameter isconnection 13.
 5 PfromP Connection 12parameter
 Keypad1,valueAsString
 Pass amount to depositmethod.
 6 EtoC connection 10normalResult
 updateTransactionsmethod
 7 EtoM connection 10normalResult
 Keypad1,clear() Clear the Keypadvalue.
 8 EtoM AccountVariable,handleLimitExceeded
 MsgLabel,text Set parameter as“Insufficient funds forwithdrawal.”
 9 EtoM AccountVariable,balance
 MsgLabel,text Set parameter as“Enter an amount andselect a transaction.”
 0 PtoP ControllerVariable,customerVariableThis
 AtmNamePanel1,customerVariableThis
 Source Event:customerVariableThisTarget Event: none
 1 PtoP Keypad1,valueAsString
 AmountTextField,text
 otes:. You can deduce the type of feature from the connection type, where P stands for property, E for
 Event, M for Method, and C for Code.. Connections automatically generated by VisualAge for Java are shown in italic.
 onnectionumber inigure 141
 ConnectionType
 Connection from Connection to Comments
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Figure 141. AtmTransactionPanel with Connections
 Here is the code for the updateTransactions() method (save the bean beforeentering the code):
 public void updateTransactions(){getListModel().clear();for( int i = 0; i < getAccountVariable().getTransactions().size(); i++){
 getListModel().addElement( getAccountVariable().getTransactions().
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elementAt(i));}
 }
 Now you add code to clear both the transaction list and the Keypad valuewhen the user clicks the Previous button. Find the method representingconnection 9, the event-to-method connection from theAtmButtonPanel1.previousButtonAction_actionPerformed event to theControllerVariable.previous() method, and open the method in a Sourcepane. In user code section 2, enter the following lines as shown in (Figure142):
 getListModel().clear();getKeypad1().clear();
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Figure 142. Clearing the Transaction List and Keypad in the AtmTransactionPanel
 You will also want to list the transactions when the user presses the Previousbutton and returns to the AtmTransactionPanel. As with most code you createin VisualAge for Java, you can add the function through a visual connectionor through code. In this case you add the function in the code of a connectionby updating the transactions when the AccountVariable is set. In the firstuser code section of the setAccountVariable method add the following line:
 updateTransactions();
 Finally, save the bean and promote the ControllerVariable this property.
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Finishing the AtmViewNow that you have created the infrastructure, you have the relatively easyjob of composing the final application.
 Open the AtmView in the Visual Composition Editor. Add the subpanels to theMainPanel in the order in which they will be accessed:
 1. AtmWelcomePanel
 2. AtmPinPanel
 3. AtmAccountPanel
 4. AtmTransactionPanel
 If you do not drop the beans in the correct order, you can use the Beans Listto rearrange the order. Once you have dropped more than one panel in thecard layout, you can use Switch To on the pop-up menu to display thedifferent panels.
 Resize the AtmView frame so that the AtmTransactionPanel has enough spaceand set the AtmView title property to ATM Application.
 For each panel connect the AtmController bean in the AtmView to thepromoted controllerVariableThis property in the panel. This is best doneusing the Beans List.
 Finally, create a method to initialize the Bank (you can copy this code fromthe buildbank.txt file included with the sample code):
 public void buildBank() {/* Get the bank from the controller */itso.atm.model.Bank bank = getController().getBank();/* Create the customers */itso.atm.model.Customer customer1 = new itso.atm.model.Customer();itso.atm.model.Customer customer2 = new itso.atm.model.Customer();/* Add the customers to the bank */bank.getCustomers().addElement(customer1);bank.getCustomers().addElement(customer2);/* Create the ATM cards */itso.atm.model.Card customer1Card = new itso.atm.model.Card();itso.atm.model.Card customer2Card = new itso.atm.model.Card();customer1Card.setCardNumber("100001");customer1Card.setPinNumber("3405");customer2Card.setCardNumber("100002");customer2Card.setPinNumber("0033");/* Add the cards to the customers */customer1.getCards().addElement(customer1Card);customer2.getCards().addElement(customer2Card);
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/* Set the customer information */customer1.setCustomerId("3056978");customer1.setLastName("Doe");customer1.setFirstName("John");customer1.setTitle("Mr.");customer2.setCustomerId("6979304");customer2.setLastName("Smith");customer2.setFirstName("Anne");customer2.setTitle("Ms.");/* Create the accounts */itso.atm.model.CheckingAccount checkingAccountCustomer1 = new itso.atm.model.CheckingAccount();checkingAccountCustomer1.setAccountId("34759023");checkingAccountCustomer1.setBalance(new java.math.BigDecimal(1000.));itso.atm.model.SavingsAccount savingsAccountCustomer1 = new itso.atm.model.SavingsAccount();savingsAccountCustomer1.setBalance(new java.math.BigDecimal(100.));savingsAccountCustomer1.setAccountId("34759023");itso.atm.model.CheckingAccount checkingAccountCustomer2 = new itso.atm.model.CheckingAccount();checkingAccountCustomer2.setAccountId("34744442");checkingAccountCustomer2.setBalance(new java.math.BigDecimal(10000.));/* Add the accounts to the customers and the cards */customer1.getAccounts().addElement(checkingAccountCustomer1);customer1.getAccounts().addElement(savingsAccountCustomer1);customer2.getAccounts().addElement(checkingAccountCustomer2);((itso.atm.model.Card) customer1.getCards().firstElement()).getAccounts().addElement(checkingAccountCustomer1);((itso.atm.model.Card) customer1.getCards().firstElement()).getAccounts().addElement(savingsAccountCustomer1);((itso.atm.model.Card) customer2.getCards().firstElement()).getAccounts().addElement(checkingAccountCustomer2);
 }
 Create an event-to-code connection from the initialize event on the AtmViewfree-form surface to the buildbank() method. Figure 143 shows the AtmViewwith the completed connections.
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Figure 143. AtmView Bean with Connections
 You can test the ATM. Use the following card numbers and PINs to test theATM:
 Customer 1— Card ID number: 100001, PIN: 3405
 Customer 2 — Card ID number: 100002, PIN: 0033
 Is Your ATM Working Correctly?If it is, congratulations. The ATM is not a trivial application, andconstructing it should help you with other programming projects. If yourATM is not working, here are some pointers:
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❑ Check that the beans you dropped on the free-form surface are the correctBean Type (Class or Variable).
 ❑ Check that the direction and source and target events of the connectionsare correct.
 ❑ Uncomment the handleException method in the AtmView to see whetherany exceptions are being thrown.
 ❑ Load the ATM application from the sample code and compare it with yourimplementation.
 ❑ Now that you know how to use the debugger and inspectors, placebreakpoints in the code and inspect suspect objects:
 • ControllerVariable - make sure each ControllerVariable instance is setwith the Controller value.
 • Keypad - make sure the valueAsString property is being set and firingevents.
 • Make sure the balance property is being set and firing correctly.
 Now that the ATM is working, why not improve it? It would be nice if youcould use keys to enter the numbers. The next section shows you how to addthat function.
 Figure 144 shows the flow of the application.
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Figure 144. ATM Application Flow
 246 Programming with VisualAge for Java Version 2

Page 273
                        

Adding Keyboard Input to the ATM ApplicationIt is easy to enable the keyboard to enter the card number, PIN, and amountsin the ATM. The Keypad is ready to deal with keyboard input; all you have todo is add it as a listener for the keyboard input.
 The ATM application has three Keypads, which have to start listening forinput as they are shown on the screen and stop listening when they arehidden.
 Add two new methods to the AtmController and then add them as methodfeatures, using Add Available Features. The method bodies are:
 public void addKeyListener( Keypad keypad) {getFrame().addKeyListener( keypad.getController());
 }public void removeKeyListener( Keypad keypad) {
 getFrame().removeKeyListener( keypad.getController());}
 To use the Keypad in the AtmWelcomePanel as a key listener, add six newconnections to the AtmWelcomePanel (Table 15).
 Table 15. AtmWelcomePanel Connections
 To add the keyboard handling in the AtmPinPanel andAtmTransactionPanel, create connections 3 – 6 from Table 15 in each panel.
 ConnectionNumber
 Connection Type Connection from Connection to
 1 EtoM ControllerVariable,this ControllerVariable,addKeyListener
 2 PfromP Connection 1 keypad parameter Keypad,this
 3 EtoM AtmWelcomePanel,componentShown
 ControllerVariable,addKeyListener
 4 PfromP Connection 3 keypad parameter Keypad,this
 5 EtoM AtmWelcomePanel,componentHidden
 ControllerVariable,removeKeyListener
 6 PfromP Connection 5 keypad parameter Keypad,this
 Notes:1. You can deduce the type of feature from the connection type where P stands for property, E for
 Event, M for Method, and C for Code.
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Now run the ATM application. You can use the keys as well as the buttons toenter numbers.
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7 Making Your Data PersistentSo far you have created the data you need for your Java programs by usingspecial code (the customers and accounts in the ATM application) or appletparameters (the titles and URLs in the Bookmark List). In the real world youhave to store the data somewhere when the program is not running. In otherwords you have to make the data persistent.
 Most programs need some sort of persistence, ranging from a simpleinitialization file for user preferences to a large database that stores recordsfor a utility company. Java supports these requirements, for example,through the Properties class and the JDBC interface, and provides thoroughsupport for reading and writing files and objects.
 There are many kinds of persistence. In this chapter you will focus on twokinds of persistence: serialization and relational databases. The serializationmechanism provided by Java enables programs to read and write Javaobjects from streams. The objects can be read from a local disk or from amachine across the network. Relational databases are probably the mostwidely used persistence mechanism in the world. They have been proven overmany years to be secure, scalable, and efficient ways of storing data.
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In this chapter you will save, or make persistent, your Bookmark List in twoways: using the serialization mechanism of Java and using the DB2Universal Database, VisualAge for Java data access beans, and the JavaJDBC interface.
 Serialization
 Each time you run the BookmarkListView applet that you created in “VisualProgramming in Action” on page 124, the URLs in the list are passed asparameters to the applet. It would be much more useful if you could store theURLs in a file.
 JDK 1.1 introduces object serialization, which enables you to convert anobject to a stream of bytes that can later be restored to the original object.
 In this chapter you add persistence to your Bookmark List objects. You learnhow to store and read your objects to and from files, using the java.io.Serializable interface.
 Serialization is designed to work not only on a single machine but also acrossa network. Thus, you can flatten an object on one machine and send the bytestream representation of the object over the network to another machine,that can then resurrect the object to use it. The object serializationmechanism and the JVM take care of any differences between operatingsystems or data representation on different machines.
 The Serializable Interface
 The Serializable interface is part of the java.io package. It providespersistence for your objects so that they can live beyond the existence of arunning program. When your object is serializable, it can be written to diskand restored later when the program is run again.
 The general steps to making your object serializable are (see Figure 145):
 1. Implement the Serializable interface in all classes that you want to bepersistent and in any classes that your objects hold as attributes that youalso want to make persistent.
 2. Mark any computed or redundant fields as transient. These fields will notbe saved when you save the object.
 3. To serialize an object, create an ObjectOutputStream object. Then use thewriteObject method to serialize the object and send it to the OutputStream.
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4. To deserialize an object, create an ObjectInputStream and call readObjectto read the object from the InputStream.
 Figure 145. The Serialization Process
 Serialization is achieved through the use of ObjectOutputStream and itswriteObject method. The objects are written to the ObjectOutputStream (bythe defaultWriteObject method) and flattened. The object’s informationincludes the fields, type information, and references to other objects.
 The restoration of the object is achieved through the use of ObjectInputStreamand its readObject method. The ObjectInputStream reads the data from thefile and restores the objects (type, data, and dependencies). This process ishandled automatically by the defaultReadObject method.
 Object DependenciesThe serialization mechanism serializes, or deserializes, not only the objectbut all its dependencies during writeObject or readObject execution.Therefore if your object contains references to other objects, those objects alsowill be serialized as long as their classes implement the Serializableinterface and have not been flagged with the transient keyword. If a class is
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found that is not marked transient but does not implement Serializable,the NotSerializableException will be thrown.
 The serialization of the dependencies of an object can result in a lot ofinformation being serialized along with your object. Plan your serializationearly and design objects with serialization in mind. If you are serializingobjects over a network, these planning and design activities are particularlyimportant.
 Behind the Scenes of SerializationAs instances of a class implementing the Serializable interface, objects havea default behavior, supplied by Java, for writing their data to an outputstream. The default behavior is to write the following information:
 ❑ Class of the object
 ❑ Class signature
 ❑ Values of the fields of the object’s superclasses
 ❑ Values of nontransient and nonstatic fields
 When primitive types are serialized, a simple call to the correspondingOutputStream write method is made. For objects, the serialization process isdone through a call to the writeObject(anObject) method ofObjectOutputStream. This method checks whether the instance implementsSerializable and has an overridden writeObject method. If so, it uses theoverridden method; otherwise it uses the defaultWriteObject method definedin ObjectOutputStream.
 When an object is read and deserialized, the class type, class signature, andthe values of the nontransient and nonstatic fields of the object’s superclassesare read. Objects referenced by this object are read transitively so that acomplete equivalent graph of objects is reconstructed by readObject. ThenreadObject returns an object of type Object. You need to cast the returnedobject back to the original class to use it.
 The default deserialization for a class is handled by the defaultReadObjectmethod of ObjectInputStream and can be modified by overriding thereadObject of the class. The readObject method must be used in conjunctionwith the override of writeObject.
 If you have marked some fields as transient, it is your responsibility tore-create the fields when your object is instantiated. You can do this usingseveral methods:
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1. By using lazy initialization through accessor methods. This is the processused by VisualAge for Java for access to beans. The get method generatedby VisualAge for Java for the object checks whether the object is null. Ifthe object is null, it is instantiated by the get method.
 2. By overriding the readObject method to re-create these fields after callingthe defaultReadObject method to restore the nontransient fields.
 Examples of transient fields are found in the property change event handlingcode generated by VisualAge for Java, for example, in theitso.atm.model.BankAccount class ( see “Building the BankAccount Bean” onpage 71). The propertyChange field is marked transient. The value of thepropertyChange field would be meaningless if the object were deserialized inanother location because the object refers to other objects listening for theevent. The declaration of the propertyChange field is:
 protected transient java.beans.PropertyChangeSupport propertyChange;
 Controlling the SerializationTo gain more control during the serialization or deserialization of an object,you can provide customized read and write methods that are responsible forreading and writing the object’s state. In this case the stream is onlyresponsible for storing the name of the object’s class.
 The Externalizable interface identifies objects that can be saved to a streambut are responsible for saving their own state. For this purpose,externalizable objects must provide a writeExternal method for storing theirstate during serialization and a readExternal method for restoring their stateduring deserialization.
 Bookmark List SerializationIn this section you make the Bookmark List persistent. You make theBookmark class itself serializable and make changes to theBookmarkListController to support the serialization. Finally you make theconnections to the init and save methods in the Visual Composition Editor toinvoke the serialization.
 During the init method the applet reads and restores the Bookmark Listfrom a file containing the serialized version of the list. When the destroymethod is called on the applet, the object is serialized and written to thesame file.
 In this example, and the next, you reuse the classes from theitso.bookmark.applet package. You copy the classes from the
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itso.bookmark.applet package and then modify them to provide thepersistence. In a real project you could reuse more of the code, but for thepurposes of these examples, it is simpler to copy and modify the code.
 Create a New Package and Copy the Classes1. Create a new package in the Programming VAJ V2 project named
 itso.bookmark.serialized.
 2. Select the BookmarkListController and BookmarkListView classes in theitso.bookmark.applet package in the Workbench. SelectSelected→Reorganize→Copy. Click Browse and then enteritso.bookmark.serialized and click OK. Deselect the Rename (copy as)checkbox and click OK.
 Because the applet contains a reference to the originalBookmarkListController, you will see an error created by the copy. You willfix that error in “Modifying the BookmarkList Applet to SupportSerialization” on page 257.
 Marking the Bookmark Class as Serializable1. Select the itso.bookmark.Bookmark class in the Workbench. Modify the
 class declaration to implement the Serializable interface (Figure 146):
 public class Bookmark implements java.io.Serializable
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Figure 146. Class Declaration for the Serializable Bookmark Class
 Modifying the BookmarkListController1. Add the import statement; import java.io.*;, to the class declaration of
 itso.bookmark.serialized.BookmarkListController.
 2. Add the file name of the serialized object to theitso.bookmark.serialized.BookmarkListController class declaration:
 String fileName = "bookmarks.ser";
 Files containing the serialized form of objects usually have the .serextension. The bookmarks.ser file will be created in the project resourcesdirectory for your project. Once you have run the applet and then closedthe Applet Viewer, look in project_resources\Programming VAJ V2 underthe VisualAge for Java ide directory and you should see bookmarks.ser.
 The BookmarkListController controls the reading and writing of theserialized bookmarks that will be performed in the init method and anew method, save. Add both methods as method features on the BeanInfopage.
 3. Create a new addEntry method that takes a Bookmark instead of strings:
 public void addEntry( Bookmark bookmark) {getBookmarkList().addElement( bookmark);
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}
 You need the new addEntry method to add the restored objects directly tothe list.
 4. Modify the init( JApplet) method so that it looks like this:
 public void init( JApplet applet){
 try {FileInputStream fIn = new FileInputStream( fileName);ObjectInputStream in = new ObjectInputStream( fIn);while( fIn.available() > 0){
 addEntry( (Bookmark)in.readObject());}in.close();
 }catch( Exception e){
 System.out.println("Error in init: " + e);}
 }
 5. Create a new save method:
 public void save() {
 FileOutputStream fOut = null;ObjectOutputStream out = null;try {
 fOut = new FileOutputStream( fileName);out = new ObjectOutputStream( fOut);for( int i = 0; i < getBookmarkList().size(); i++){
 out.writeObject( getBookmarkList().elementAt(i));}out.close();
 }catch( IOException e) {
 System.out.println("Error in save: " + e);}
 }
 6. Open the BookmarkListController Class Browser to the Bean Info page.Check that both the init and save methods are listed as method featuresas shown in Figure 147. If they do not appear in the list, add them usingAdd Available Features on the Features menu.
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Figure 147. The BookmarkListController BeanInfo Page
 Modifying the BookmarkList Applet to Support SerializationNow you are ready to implement serialization in the BookmarkListViewapplet. Most of the work is already done; all you have to do is load the datawhen the applet starts and serialize the model before closing the applet.First, because you copied this class from the itso.bookmark.applet package,you must change the Controller to the correct class:
 1. Open the BookmarkListView class in the Visual Composition Editor, selectthe Controller bean and then select Morph Into from the pop-up menu.Change the Class name field to:itso.bookmark.serialized.BookmarkListController and click OK.
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Figure 148. Morphing the Controller bean
 2. Save the bean and add a new method, destroy, to the applet:
 public void destroy() {getController().save();
 }
 3. Select the Delete button and select Reorder Connections From in thepop-up menu. Check that the deleteEntry connection is called first. Theorder may have been changed when you performed the Morph Intofunction. If the connection to deleteEntry is not at the top of the list, dragit to the top of the list.
 Now you can test the BookmarkList applet. Run the applet and add someURLs, then close and restart it (Figure 149). The first time you run theapplet you will get a message because the serialized list was not found. Thatis OK because the applet will create the file when the applet is destroyed.
 Figure 149. The Bookmark List Applet
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Relational DatabasesStoring program data in relational databases is probably the most commonform of persistence in existence. Many of today’s client-server applicationsare simply user interfaces to relational databases.
 Relational databases provide secure, scalable, and efficient ways of storingand accessing large amounts of data. The common language for manipulatingdata in relational databases is the Structured Query Language (SQL). If youare new to relational databases or SQL, you may want to explore an SQLresource such as A Guide to the Sql Standard: A User’s Guide to theStandard Database Language Sql listed in “Related Publications” onpage 385.
 To access relational databases, Java developers typically use JDBC. TheJDBC API is a standard SQL database access interface for Java. UsingJDBC, you can:
 ❑ Access most SQL databases
 ❑ Concentrate on business logic instead of database and communicationprogramming
 JDBC is similar to Microsoft’s Open Database Connectivity (ODBC) API, awidely used API for accessing relational databases in Windows operatingsystems.
 To access a particular database, an application must have access to a JDBCdriver for the database. These drivers encapsulate the database-specific andplatform-specific code.
 JDBC DriversThere are four kinds of JDBC drivers:
 JDBC - Not an AcronymAlthough it is widely believed that JDBC stands for JavaDatabase Connectivity, it does not. Sun has trademarked JDBCas a separate name. It is much easier to think of it as JavaDatabase Connectivity, however.
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❑ JDBC-ODBC bridge: This driver provides JDBC access through mostODBC drivers. In many cases some ODBC binary code and databaseclient code must be loaded on each client machine that uses this driver.
 ❑ Native-API part-Java driver: This driver converts JDBC calls into calls onthe client API for the database in question. It requires that some binarycode be loaded on each client machine. This type of driver supports whatis commonly known as a thick, or fat, client: a client that requiresdatabase code to be installed.
 ❑ Net-protocol all-Java driver: This driver translates JDBC calls into adatabase independent net protocol, which is then translated to a DBMSprotocol by a server. This type of driver supports what is commonly knownas a thin client: a client that does not require database code to beinstalled.
 ❑ Native-protocol all-Java driver: This driver converts JDBC calls into thenetwork protocol used by the DBMS.
 JDBC URL FormatTo access a database through JDBC, you initially use a URL to establish adatabase connection. The URL has different formats depending on the driverthat it uses to access the database. The standard JDBC URL isjdbc:<subprotocol>:<subname>, where:
 jdbc is the name of the protocol.
 <subprotocol> is the name of the driver or the name of a databaseconnectivity mechanism.
 <subname> is a way of identifying the database, usually the database name.
 DB2 JDBC DriversDB2 Universal Database supports two drivers:
 Application driver: The application driver is a type 2 driver thatprovides support for the thick client version of DB2 JDBC access. That is,the Client Application Enabler (CAE) or the DB2 database must beinstalled on the machine where the Java program is running. The CAEprovides a runtime environment that enables client applications to accessone or more remote databases. The application driver is typically used byJava applications or servlets. The application URL isjdbc:db2:<database-name>, and the JDBC driver class isCOM.ibm.db2.jdbc.app.DB2Driver.
 Net driver: The net driver is a type 3 driver that provides support for athin client. This driver is more applicable than an application driver inWeb browser situations or wherever the client is unknown or constrained.
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The net driver does not require any database-specific code on the clientplatform where the Java program is running except for access to thedriver itself. However, the server where the DB2 database is runningmust also be running the DB2 Applet Server, which provides theconnection between the driver and DB2. The applet server waits forconnections from applets and translates the applet’s request into nativeDB2 requests. The URL for the net driver isjdbc:db2://host:port/<database-name>, and the driver class isCOM.ibm.db2.jdbc.net.DB2Driver. The convention is to use 8888 for theport on which the Applet Server listens, but any port can be used.
 JDBC FunctionalityTo access databases with VisualAge for Java you do not have to know toomuch about the JDBC interface, but an introduction to a few key areas willhelp. The code in the steps following this paragraphs illustrates some keypoints. The example connects to a database, using the thick client driver andthen lists the names of the employees in the EMPLOYEE table of theSAMPLE database shipped with DB2. You can try the example yourself inthe VisualAge for Java Scrapbook, but first you must add the DB2 Java JARfile to the workspace class path (see “Setting the Class Path” on page 268)and you must have DB2 running on your machine with the SAMPLEdatabase installed.
 1. Find and load the JDBC driver. Each JDBC program dynamically loadsthe correct driver on the basis of the URL. When a JDBC driver class isloaded, it creates an instance of the driver and registers itself with thedriver manager:
 Class.forName("COM.ibm.db2.jdbc.app.DB2Driver");
 2. Create a connection to the database:
 java.sql.Connection jc = java.sql.DriverManager.getConnection("jdbc:db2:SAMPLE");
 All ensuing SQL statements are executed in the context of this connection.
 3. Create a statement object:
 java.sql.Statement stmt = jc.createStatement();
 To execute an SQL query you need a statement object.
 4. Execute a query and return a result set:
 java.sql.ResultSet rs = stmt.executeQuery("Select * FROM EMPLOYEE");
 In this case, all records from the EMPLOYEE database are returned as aresult set. The ResultSet class provides methods to access each column inthe row and return an object.
 5. Print a header for the list:
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System.out.println( "Names: ");
 6. Iterate through the result set, printing two columns (FIRSTNME and LASTNAME)from each row:
 for ( int i=1; rs.next(); i++) {System.out.println( "\t" + rs.getString( "FIRSTNME".trim()
 + " " + rs.getString( "LASTNAME").trim());}
 The ResultSet class also provides a cursor with which you can iteratethrough the result set by using the next method.
 7. Close the connections:
 rs.close(); stmt.close(); jc.close();
 For more information about JDBC, consult a JDBC resource such as theJavaSoft JDBC documentation or Database Programming with JDBC andJava or JDBC Database Access With Java: A Tutorial and AnnotatedReference (see “Related Publications” on page 385).
 Database Access Using VisualAge for JavaUsing VisualAge for Java Professional you can access databases throughJDBC in two ways:
 ❑ Code JDBC manually: You can code straight to the JDBC interface if youneed that level of control over your database code.
 ❑ Use the Data Access beans feature: The Data Access beans feature enablesyou to create Data Access beans that provide access to relationaldatabases through JDBC. The Data Access beans SmartGuides create allof the JDBC code for you.
 One drawback to relational databases is that they do not store objects. Theystore data in rows and tables. As indicated in the example in “JDBCFunctionality” on page 261, the JDBC interface does not map database rowsor records to objects. Mapping the data from tables and rows to objects(object-relational mapping) is one of the tasks you face when using relationaldatabases with Java programs.
 The Data Access beans map columns to Java objects. If you have morecomplex data access requirements, VisualAge for Java Enterprise providestwo other data access features:
 VisualAge for Java Data Access BuilderGenerates Data Access Builder beans to access relational
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databases through JDBC. These beans map rows and result setsto Java objects.
 VisualAge for Java Persistence BuilderGenerates complete object models supporting persistence
 In this section you learn how to make the Bookmark List persistent, usingthe Data Access beans and DB2 Universal Database.
 VisualAge for Java Data Access BeansThe Data Access beans feature provides two JavaBeans on the VisualComposition Editor palette:
 SelectThe com.ibm.ivj.db.uibeans.Select bean is a nonvisual bean withwhich you can query a relational database. You can also insert,update, or delete a row in the result set and commit the changesin the database. The Select bean exposes a query property thatcontains a connection alias and an SQL specification for the Selectbean.
 DBNavigatorThe com.ibm.ivj.db.uibeans.DBNavigator bean is a visual beanthat is used with a Select bean. The DBNavigator bean provides aset of buttons that execute the SQL statement for the associatedSelect bean; perform other relational database operations, such ascommit updates to the database; and navigate rows in the resultset. You can use the DBNavigator bean to test your database accessor in the deployed Java program.
 Select Bean FeaturesThe Select bean provides a set of events, methods, and properties forrelational database access.
 Events The Select bean can inform listeners before and after any of thefollowing events:
 ❑ Adding a new row to the result set
 ❑ Committing changes to the database
 ❑ Closing the database connection
 ❑ Connecting to the database
 ❑ Deleting a row from the result set
 ❑ Disconnecting from the database
 ❑ Executing the SQL query
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❑ Rolling back changes to the database
 ❑ Updating the current row in the result set
 Using the Table Changed event, the Select bean can also inform listenersthat the underlying database table has changed.
 Methods The Select bean provides more than forty methods, many of whichdeal with getting and setting column values in the result set. Each column inthe result set can be accessed through its index or name and returned as anobject of type Object or String. As well the parameters for an SQL query canbe read and set through methods on the Select bean.
 Some of the other methods that the Select bean exposes are:
 commit: Commit the current updates to the database.
 rollback: Roll back the current updates to the database (if Auto-commit isnot enabled).
 execute: Execute the query defined when you created the Select bean.
 firstRow, nextRow, lastRow: Navigate through the result set created by theexecute method.
 updateRow: Update a row in the database on the basis of the data in thecurrent row of the result set.
 deleteRow: Delete the row in the database corresponding to the current row ofthe result set.
 Properties The Select bean exposes several properties that affect databaseaccess (the last three are expert properties):
 query: The query property is where you set the connection alias and the SQLspecification for your Select bean.
 fillCacheOnExecute: Whether to fetch all rows of the result set of an executemethod into the cache. If this is false, the maximumRows property along withthe packet properties determine the number of rows to fetch.
 lockRows: Specifies whether a lock is immediately acquired for the row. Avalue of True indicates that a lock is immediately acquired for the currentrow. A value of False indicates that a lock is not acquired for the row until anupdate request is issued. The default value is False.
 readOnly: Specifies whether updates to the database are allowed. A value ofTrue indicates that updates are disallowed even if the database manager
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would permit them. A value of False indicates that updates are allowed,provided that the database manager permits them. The default value isFalse.
 For a complete description of the Data Access beans see their JavaDocdescriptions in the VisualAge for Java online documentation.
 Database Access ClassDuring the specification of your Select bean you are asked to specify a namefor the Database Access class. This class is used to hold the connection aliasand SQL specification. You can reuse the same Database Access class andconnection alias for several SQL specifications.
 Connection AliasA connection alias specifies the database connection characteristics for theSelect bean, for example, the URL for the connection, and the user ID andpassword to be passed with the connection request.
 As previously stated, you can reuse the same connection alias for severalSQL specifications. If different Select beans specify the same connectionalias, they share the database connection associated with that connectionalias. If one Select bean commits updates to a database, it commits alluncommitted updates made by any Select bean sharing the databaseconnection.
 During the creation of the connection alias, you can check the Auto-commitcheckbox if you want database updates to be automatically committed foreach SQL query. If you do not check the checkbox, database updates are notautomatically committed. This checkbox is checked by default.
 SQL SpecificationAn SQL specification specifies an SQL statement for the Select bean. You canenter the SQL statement manually (through an editor) or you can use theSQL Assist SmartGuide to help you visually compose the SQL statement.
 A Select bean can be associated with only one SQL specification.
 Making the BookmarkList Persistent Using Data Access BeansYou have already used serialization to make the Bookmark List persistent.Now you will create a database table to hold the bookmarks from the list.When you add or delete entries from the list, they will be added or removedfrom the database.
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The BookmarkListController encapsulates the database access, and theBookmarkListView simply accesses the controller as before. The controlleruses two database queries: the first to build and return the completeBookmark List, and the second to access an individual bookmark in the list.The two database queries require two different Select beans.
 PrerequisitesTo complete this example you need access to a relational database, and youhave to create the database table used by the example. The example usesDB2 Universal Database running on Windows NT. If you use any otherenvironment, modify the example as appropriate. The example assumes youhave already installed DB2 successfully.
 You will also need to have TCP/IP configured and running on your machine.
 Creating the Bookmark List Table and Starting DB21. Make sure that DB2 and the DB2 Windows NT Security Server are
 started. Use the Services dialog box from the Windows NT Control Panel(Figure 150).
 Figure 150. Starting DB2 and the DB2 Windows NT Security Server
 2. Start the DB2 Applet Server from the Windows NT command line (Figure151 on page 267) using the following statement: db2jstrt 8888. (8888 isthe port where the server will listen for requests and must match the portspecified in the URL.)
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Figure 151. Starting the DB2 Applet Server
 3. Open a DB2 Command Window, using Start→Programs→DB2 forWindows NT→Command Window.
 If you are using DB2 5.2 you have to run the DB2TSART command in theCommand window before proceeding to the next step.
 4. From the examples directory, copy the files in the DATABEANS directoryto a local drive and run the BUILDBOOKMARKS.BAT file in the DB2Command Window.
 Running the BUILDBOOKMARKS file creates a new database calledBKMARKS, and a new table in the database called BOOKMARKS. Theschema definition for the table is:
 CREATE TABLE BOOKMARKS ( \title CHAR( 50) NOT NULL PRIMARY KEY, \url CHAR( 50) NOT NULL \
 )
 The BUILDBOOKMARKS file then gives public access to the table andfills the table with the bookmark list data:
 LOAD FROM COMP.DEL OF DEL INSERT INTO bookmarksCOMMITGRANT BINDADD ON DATABASE TO PUBLICGRANT CONNECT ON DATABASE TO PUBLICGRANT ALL ON BOOKMARKS TO PUBLICCONNECT RESET
 The list is filled with the following values:
 IBM,http://www.ibm.comIBM Software,http://www.software.ibm.comJavasoft,http://www.javasoft.com
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Adding the Data Access Beans Feature1. In the Workbench select File→Quick Start, select Features→Add
 Feature and click OK.
 2. Select IBM Data Access Beans 1.0 from the list in the SelectionRequired dialog box and click OK.
 Creating a New Package and Copying the Classes1. To reuse the classes from the itso.bookmark.applet package, create a new
 package in the Programming VAJ V2 project nameditso.bookmark.databeans.
 2. Select the BookmarkListController and BookmarkListView classes in theitso.bookmark.applet package in the Workbench. SelectSelected→Reorganize→Copy. Click Browse, then enteritso.bookmark.databeans, and click OK. Deselect the Rename (copy as)checkbox and click OK.
 Fixing the Incorrect Controller Reference 1. Open the itso.bookmark.databeans.BookmarkListView applet in the Visual
 Composition Editor.
 2. Select the Controller bean and then select Morph Into from the pop-upmenu. Change the Class name field toitso.bookmark.databeans.BookmarkListController and click OK.
 Setting the Class Path1. In the Workbench select Window→Options and then select Resources
 from the list. In the Workspace class path field enter:X:\sqllib\java\db2java.zip; (where X is the drive where DB2 isinstalled). You can also use the Edit and Add Jar/Zip buttons to locatethe file. The DB2 Zip or JAR file is required for both the applet running inthe Applet Viewer and the Visual Composition Editor itself when you arespecifying the connection properties.
 2. In the Workbench select itso.bookmark.BookmarkListView and then selectSelected→Properties. Click the Class Path tab. Click the Edit buttonand select the IBM Data Access Beans checkbox (Figure 152 on page269). Click OK to exit.
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Figure 152. Setting the Class Path
 Creating the Select Beans1. Open the itso.bookmark.databeans.BookmarkListController in the Visual
 Composition Editor and select Database from the Palette Categoryselection pull-down menu. The Beans Palette changes to the Data Accessbeans: Select and DBNavigator (Figure 153 on page 270).
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Figure 153. The Database Access Beans Palette
 2. Drop a Select bean on the free-form surface. Change the beanNameproperty to List.
 3. Drop another Select bean on the free-form surface. Change the beanNameproperty to Bookmark.
 Setting the Connection Properties for the Select Beans1. Open the Property Sheet for the List bean (Figure 154 on page 271).
 270 Programming with VisualAge for Java Version 2

Page 297
                        

Figure 154. The Property Sheet for the List Bean
 2. Click in the field to the right of query and then click the small button thatappears.
 3. Click the New button in the Query dialog box and fill the New DatabaseAccess Class dialog box in as follows (Figure 155 on page 271):
 Package: itso.bookmark.databeans
 Class name: DataAccess
 4. Click OK to create the Data Access class.
 Figure 155. Setting the Class and Package of the Data Access Class
 5. In the Query dialog box, click the Add button to the right of theConnections text area.
 6. Fill in the Connection Alias Definition dialog box as follows (Figure 156 onpage 272):
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Connection Name: Bookmark (This must be a valid Java method name.)
 URL: jdbc:db2://hostname:8888/BKMARKS
 Substitute the host name of your machine for hostname. You can find thehost name of your machine from the Network Properties dialog box or bytyping hostname on the command line on most platforms.
 JDBC Driver Choices: COM.ibm.db2.jdbc.net.DB2Driver
 User ID: Your user ID
 Password: Your password
 For the purposes of the example, use your own user ID and password toaccess the database. This is not a recommended practice for realdeployment, however.
 Figure 156. Setting the Connection Alias
 7. Click Test Connection. If the connection is not successful, check theerror message and then go back and check that you performed the stepscorrectly.
 8. Click OK on the Connection Alias Definition dialog box.
 Do not select the OK button on the Query Specification dialog box at thispoint. You want the dialog to stay open so that you can create the first SQLspecification.
 Setting the SQL Specification for the List BeanIn the same Query dialog:
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1. Click the SQL tab, then click the Add button to the right of the SQL textfield.
 2. In the New SQL Specification dialog box (Figure 157 on page 273), enterSelectAll for the SQL Name and select the Use SQL AssistSmartGuide (recommended) checkbox. Click OK.
 Figure 157. The New SQL Specification Dialog Box
 3. In the SQL Assist SmartGuide (Figure 158 on page 273):
 a. Click the Tables tab and select the USERID.BOOKMARKS checkbox whereUSERID is your userid.
 Figure 158. Specifying the Database Table
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b. Under the Columns tab (Figure 159 on page 274) select TITLE and URLand click Add>>. This setting specifies the columns that will bereturned in the result set.
 Figure 159. Specifying the Columns for the Result Set
 c. Select the SQL tab and then select Run SQL to test the query (Figure160 on page 275).
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Figure 160. Testing the Query
 d. Select Close on the SQL Execution Result Set dialog box, then click onFinish in the SQL Assist Smart Guide, then OK in the Query dialogbox.
 Setting the SQL Specification for the Bookmark BeanThe steps for setting the SQL specification the Bookmark bean are very similarto those for the List bean.
 1. Select the Bookmark bean on the free-form surface and open the Propertysheet.
 2. Click the field to the right of the query property and then the small buttonthat appears in the field.
 3. Select the Bookmark connection, click the SQL tab, and then click Add.
 4. In the New SQL Specification dialog box, enter findBookmark for the SQLName, select the Manually write SQL checkbox, and click OK.
 5. In the SQL Editor, enter:
 SELECT USERID.BOOKMARKS.TITLE, USERID.BOOKMARKS.URL FROM USERID.BOOKMARKS WHERE ( ( USERID.BOOKMARKS.TITLE = :MYTITLE ) )
 where USERID is your userid, and :MYTITLE represents a variable thatwill be replaced through the setParameter method. You use thesetParameter method to set queries or update statements with data fromyour program.
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6. Click OK to exit the SQL Editor. Click OK to exit the Query dialog box.
 7. Save the bean.
 Modifying the BookmarkListController MethodsModify the add and delete methods in the Controller to add and deleteentries from the database table. You will also add a new init method, whichwill return the contents of the table. You can copy the code fromBookmarkListController.java in the examples directory.
 1. Modify the init( JApplet) method:
 public void init( JApplet applet){
 String title = new String();String url = new String();int currentRow,rows;try{
 getList().execute();getList().firstRow();rows=getList().getNumRows();for (currentRow=1;currentRow<=rows;currentRow++){
 title= getList().getColumnValueToString("BOOKMARKS.TITLE");url= getList().getColumnValueToString("BOOKMARKS.URL");Bookmark b = new Bookmark( title, url);getBookmarkList().addElement( b);getList().nextRow();
 }} catch (java.lang.Throwable ivjExc) {
 handleException(ivjExc);}return;
 }
 2. Modify the addEntry method:
 public void addEntry(String title, String url) {try{
 getBookmarkList().addElement( new Bookmark(title, url));getList().newRow(false);getList().setColumnValueFromString("BOOKMARKS.TITLE",title);getList().setColumnValueFromString("BOOKMARKS.URL",url);getList().updateRow();
 } catch (java.lang.Throwable ivjExc){
 handleException(ivjExc);}return;
 }
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3. Modify the deleteEntry method:
 public void deleteEntry(String title) {
 Enumeration e = getBookmarkList().elements();Bookmark b = null;while( e.hasMoreElements()){
 b = (Bookmark)e.nextElement();if( b.getTitle().equals( title)){
 getBookmarkList().removeElement(b);}
 }try{
 getBookmark().setParameterFromString("MYTITLE",title);getBookmark().execute();getBookmark().deleteRow();
 }catch (java.lang.Throwable ivjExc){
 handleException(ivjExc);}return;
 }
 Notice how you set the MYTITLE parameter (which you created in the SQLspecification) to the current value of title.
 Select the Delete button and select Reorder Connections From in thepop-up menu. Check that the deleteEntry connection is called first. The ordermay have been changed when you performed the Morph Into function. If theconnection to deleteEntry is not at the top of the list, drag it to the top of thelist.
 Run the ExampleBecause you modified only the implementation of theBookmarkListController, you do not have to modify the BookmarkListView.You can simply run the example (Figure 161 on page 278).
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Figure 161. The itso.bookmark.databeans.BookmarkListView Applet
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8 Creating ServletsServlets have become a very popular way of providing Web-based functions.Not only do they benefit from the advantages of the Java language andexecuting in the JVM, they can be faster than other server-side Webtechniques.
 In VisualAge for Java Professional, you can create, run, and debug servletswithin the VisualAge for Java environment. The VisualAge for JavaEnterprise Edition has more powerful servlet support, including a ServletBuilder with a set of visual beans for building your HTML pages.
 In this chapter you create the Bookmark List as a servlet that uses HTMLpages to interact with the user.
 Servlets: A RefresherA servlet is a specialized Java program that a server invokes in response to arequest from a client. Typically the server is a Web server, and the client is aWeb browser.
 Servlet development is supported by the Java Servlet Development Kit(JSDK) from JavaSoft, soon to be included as part of the standard JDK.
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A servlet, like an applet, has a set of life-cycle methods that it mustimplement to provide functions (see Figure 162). Servlets extend thejavax.servlet.GenericServlet and must implement thejavax.servlet.Servlet interface. Most servlet developers use thejavax.servlet.http.HttpServlet, which provides convenience methods andfacilities specific to HTTP Web servers.
 Figure 162. Servlet Architecture
 The lifecycle methods are:
 ❑ init - Called once when the Web server loads the servlet. The Web servermay load the servlet the first time a client requests the servlet, or earlierdepending on the configuration of the Web server. In contrast to CommonGateway Interface (CGI) programs, servlets are long running and do notincur the cost of initialization at each request. A servlet will continue torun until it is removed from the server.
 ❑ service - The service method is called each time the servlet is requested.Typically most servlet developers do not use the service method, insteadthey use the doPost and doGet methods supplied by the HttpServlet class.
 First Request of Servlet
 Client Server
 Servlet.init
 Servlet.service
 Build Context ObjectBuild Request Object
 Other Requests of Servlet
 Servlet.service
 Build Context ObjectBuild Request ObjectBuild Response Object
 Remove ServletServer Administrator
 Build Response Object
 Servlet.destroy
 Read Servlet Response
 Read Servlet Response
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• doPost - Invoked in response to a request from the server through thePOST method, typically from an HTML form. POST methods should beused whenever the request will modify some information on the server.Examples of an HTML form using the POST method will be built inthe example. The simplest form looks like this:
 <FORM ACTION=http://localhost:8080/servlet/itso.bookmark.servlet.BookmarkListServlet METHOD=POST><INPUT TYPE=HIDDEN NAME=action VALUE=save><INPUT TYPE=SUBMIT NAME=SaveButton VALUE=Save></FORM>
 This form simply calls the servlet, passing the action parameter with avalue of save. The servlet is invoked when the user clicks the Savebutton on the Web page.
 • doGet - Invoked in response to a request from the server through theGET method, typically from a simple URL request or an HTML form.GET methods should be used whenever the request will not modify anydata on the server.
 The GET method is the default when you use a URL in the Webbrowser. For example, clicking on the following link:
 <a href=http://localhost:8080/servlet/itso.bookmark.servlet.BookmarkListServlet>Invoke the servlet!</a>
 or typing:http://localhost:8080/servlet/itso.bookmark.servlet.BookmarkListServletinto the Location (also called Address or Netsite) field in the Webbrowser invokes the servlet’s doGet method.
 The Web server passes two parameters to the service, doGet and doPostmethods:
 HttpServletResponse: This object contains an output stream for writinginformation back to the Web browser as well as accessing the HypertextTransfer Protocol (HTTP) header information.
 HttpServletRequest: This object contains an input stream for reading thebrowser’s request as well as convenience methods for retrievingparameters from the request.
 ❑ destroy - The destroy method is called when the servlet is removed fromthe Web server. Release any resources in the destroy method and writeany persistent data back to storage.
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The ServletContext class provides information about the environment to theservlet, including the names of other servlets running in the environmentand the network service under which the service is running.
 For more information about the servlet classes, see the JSDK documentation.
 Designing Servlet SystemsA servlet is typically used to generate dynamic HTML pages, on the basis of asimple URL link or in response to information from an HTML form. Theservlet obtains any needed resources during the init method and thenservices requests, using one of the service methods.
 The service typically consists of processing the passed data and then writingHTTP header and HTML tags to the output stream supplied in theparameters to the connection.
 Servlets are not limited to generating dynamic HTML pages. Manyservlet-based systems serve HTML pages containing APPLET tags. Once theapplet is running in the Web browser, it uses the java.net.URL openStreammethod to communicate with the servlet. Distributed systems built in thisway can transmit serialized objects between the applet and servlet withoutconsideration for firewalls or encrypting the transmission because theseissues are handled by the Web browser and server. Sophisticated servlets canalso obtain the names of other servlets running on the Web server and invokemethods on them.
 Servlets are inherently multithreaded. The Web server, depending on itsconfiguration, invokes the service methods of a servlet every time a request isreceived. Therefore a servlet can have many requests executing the same
 Separating User Interface Code from Business LogicMixing HTML tags with your Java code is not always a good idea.Just as you separate the user interface logic of your Javaprograms from the business logic, you should try and separateyour HTML generation from your business logic. One approach (ifyour server supports it) is to use the SERVLET HTML tag. Usingthe this tag within server-side include files (.shtml) enables you toseparate much of your HTML from your Java code. You can createyour HTML pages, using your favorite tools, and then addSERVLET tags. When the servlet runs, it places the output on thepage where the SERVLET tag originally was placed.
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service methods at one time. Although this brings a small amount ofcomplexity to coding servlets, it is also a great advantage. For example, aservlet that accesses a database could create a pool of connections in the initmethod and then use them as requests are received. The servlet could alsocache data that each service request accesses. If you do not want the servletto be multithreaded, use the SingleThreadModel interface when creating yourservlet.
 When a servlet encounters errors, it should, if possible, throw aServletException or an UnavailableException so that the Web server willsend the appropriate message to the Web browser and take any otherappropriate action. The HttpServlet also supplies the setStatus andsendError methods to send the status or error code back to the browser.
 Making the Bookmark List a ServletIn this section you modify the Bookmark List program to become aservlet-based program. The servlet serves dynamic HTML pages that formthe user interface to the Bookmark List. Figure 163 shows the program flow.
 Figure 163. The BookmarkList Servlet Architecture
 BookmarkListServlet
 Initial HTML page or requestWebServer
 BookmarkListServlet
 Serve HTML page
 BookmarkListServlet
 Serve HTML page
 add/delete title,URL
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The servlet is a subclass of javax.servlet.http.HttpServlet and implementsfour methods:
 ❑ init: Load the current serialized Bookmark List into memory.
 ❑ doPost: Respond to three requests from a browser:
 • Delete: Delete the element from the list and send the updated list backto the browser.
 • Add: Add the element to the list and send the updated list back to thebrowser.
 • Save: Save the current Bookmark List to disk.
 ❑ doGet: Respond to one request from a browser.
 • Send the dynamic HTML page to the browser.
 ❑ destroy: Store the serialized current Bookmark List to disk.
 Before building the servlet, create a new package in the Programming withVAJ V2 project: itso.bookmark.servlet. You deploy the servlet to a Web serverin Chapter 10, “Deploying Your Java Programs” on page 327.
 To create the servlet (as usual you can load the source fromBookmarkListServlet.java):
 1. Load the JSDK. You will need to download the JSDK from the JavaSoftwebsite, www.javasoft.com, and install it on your machine.
 a. Create a new project named JSDK. Select the new project.
 b. Select File→Import from the Workbench menu bar. Select the Jarfile radio button and click Next. In the Select files of type .jar or .zipdialog box, select Zip files (*.zip) from the Files of type drop-down list.Browse to the directory where you installed the JSDK. Select thejsdk.zip file and click Open. Click Finish in the SmartGuide to startthe import.
 2. Create a new class in the itso.bookmark.servletpackage — BookmarkListServlet — that extendsjavax.servlet.http.HttpServlet. Use the SmartGuide to import thejavax.servlet, java.io, javax.servlet.http and java.util packages aswell as the type: itso.bookmark.Bookmark.
 a. Add a string attribute to the class declaration to hold the name of theserialized Bookmark List file:
 private String SerializedBookmarkFileName = "C:\\TEMP\\BOOKMARK.SER";
 Make sure you change the above pathname to an appropriate locationon your machine.
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b. Add an attribute to hold the servlet URL (you dynamically set thestring during the request):
 private String ServletURL = null;
 c. You will use a Vector to hold the list. Use the BeanInfo page to add anonbound Vector property named bookmarkList to hold the list.
 Figure 164 shows the class declaration.
 Figure 164. BookmarkListServlet Class Declaration
 3. If you have not already made the itso.bookmark.Bookmark classserializable, do so now:
 public class Bookmark implements java.io.Serializable
 Figure 165 shows the class declaration.
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Figure 165. Modified Bookmark Class Declaration
 4. Copy the addEntry and deleteEntry methods from theBookmarkListController you created in “Building theBookmarkListController” on page 126. You can almost use these methodsas is to add and delete entries from the bookmarkList vector. To copy themethods (Figure 166):
 a. Select the addEntry and deleteEntry methods from theitso.bookmark.applet.BookmarkListController in the Workbench.
 b. Select Selected→Reorganize→Copy, click Browse and begin typingBookmarkListServlet. Select BookmarkListServlet, click OK, anddeselect the Rename (Copy as) checkbox.
 c. Click OK.
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Figure 166. Copying the addEntry and deleteEntry Methods
 5. Make the addEntry and deleteEntry methods thread-safe. These methodsmust be synchronized to keep the list from being corrupted. Change theclass declarations to add the synchronized keyword:
 public synchronized void addEntry(String title, String url)public synchronized void deleteEntry(String title)
 This is a very simple use of synchronization. In a production applicationyou probably would also want to synchronize the reading with the writingof the Bookmark List and use separate read and write locks to improveperformance.
 Creating Servlets 287

Page 314
                        

6. Add the init method that reads the serialized Bookmark List from disk.The init method tries to load the serialized file from disk. If the file doesnot exist, a new Bookmark List is created. Making the Bookmark Listpersistent is simple when you use the Java serialization facilities.
 public void init(ServletConfig config) throws ServletException{
 try{FileInputStream fIn = new FileInputStream(
 SerializedBookmarkFileName);ObjectInputStream in = new ObjectInputStream( fIn);setBookmarkList((Vector)in.readObject());
 }catch( FileNotFoundException e){
 setBookmarkList( new Vector());}catch( Exception e){
 log( "Error initializing servlet: " + e);throw new ServletException( "Error initializing servlet: " + e);
 }}
 7. Add the sendList method. This method is invoked during the doGet anddoPost methods. The sendList method sends a dynamic HTML page backto the browser. The page contains:
 • HTML title and heading tags
 • A list of all bookmarks, each implemented as an HTML form with aDelete button
 • The Add function implemented as another form
 • A Save button to write the serialized Bookmark List to disk
 The sendList method encapsulates all of the HTML generation thatthe servlet performs.
 All the HTML forms invoke the servlet using the hidden HTML actiontag to specify the action for the servlet to take. All the forms use theMETHOD=POST directive which causes the doPost method on the servlet tobe invoked.
 The code for the sendList method is:
 private void sendList(HttpServletRequest req, HttpServletResponse resp){
 PrintWriter pOut = null;ServletURL = req.getScheme() + "://" + req.getServerName() + ":" +
 req.getServerPort() + req.getServletPath();try{
 resp.setContentType( "text/html");pOut = new PrintWriter( resp.getOutputStream());
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pOut.println("<TITLE>BookmarkList Application</TITLE>");pOut.println("<H1>BookmarkList Application</H1>");pOut.println("<H2>Bookmarks:</H2>");pOut.println("<TABLE>");for( int i = 0; i < getBookmarkList().size(); i++){
 String Url = ((Bookmark)getBookmarkList().elementAt(i)).getUrl();
 String Title = ((Bookmark)getBookmarkList().elementAt(i)).getTitle();
 pOut.println("<TR>");pOut.println("<TD VALIGN=TOP>");pOut.println("<A HREF=" + Url + ">" + Title + "</a>");pOut.println("<TD>");pOut.println("<FORM ACTION=" + ServletURL + " METHOD=POST>");pOut.println("<INPUT TYPE=HIDDEN NAME=action VALUE=delete>");pOut.println("<INPUT TYPE=HIDDEN NAME=title VALUE=\""
 + Title + "\">");pOut.println("<INPUT TYPE=SUBMIT NAME=DeleteButton
 VALUE=Delete>");pOut.println("</FORM>");pOut.println("</TR>");
 }pOut.println("</TABLE>");pOut.println("<HR>");pOut.println("<FORM ACTION=" + ServletURL + " METHOD=POST>");pOut.println("<INPUT TYPE=HIDDEN NAME=action VALUE=add>");pOut.println("<b>Title:</b>");pOut.println("<INPUT TYPE=TEXT NAME=title SIZE=30>");pOut.println("<b>URL:</b>");pOut.println("<INPUT TYPE=TEXT NAME=url SIZE=30 VALUE=http://>");pOut.println("<INPUT TYPE=SUBMIT NAME=AddButton VALUE=Add>");pOut.println("</FORM>");pOut.println("<HR>");pOut.println("<FORM ACTION=" + ServletURL + " METHOD=POST>");pOut.println("<INPUT TYPE=HIDDEN NAME=action VALUE=save>");pOut.println("<INPUT TYPE=SUBMIT NAME=SaveButton VALUE=Save>");pOut.println("</FORM>");resp.setStatus( HttpServletResponse.SC_OK);pOut.close();
 }catch( IOException e){
 pOut.close();log("Error writing to browser: " + e);
 }}
 Look at the fourth line in the sendList method:
 ServletURL = req.getScheme() + "://" + req.getServerName() + ":" +
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req.getServerPort() + req.getServletPath();
 Using the HttpServletRequest object, you build the URL to the servletdynamically. Thus you can move the servlet to different servers ordifferent locations on a server or change the port that the Web server islistening on, without changing the servlet code.
 The seventh line of the sendList method tells the browser to expect anHTML page:
 resp.setContentType( "text/html");
 The eighth line of the sendList method returns a stream that theservlet uses to write to the browser:
 pOut = new PrintWriter( resp.getOutputStream());
 The rest of the method builds the dynamic HTML page that containsthe HTML forms providing the interface to the Bookmark List. Onceyou have finished the example, look at the generated HTML in yourWeb browser, using the View Source capability.
 8. Add the saveList method:
 public synchronized void saveList(){
 try{ FileOutputStream fOut = new FileOutputStream(
 SerializedBookmarkFileName); ObjectOutputStream out = new ObjectOutputStream( fOut); out.writeObject( getBookmarkList());
 out.close();}catch( IOException e){
 log("Error saving list: " + e);}
 }
 The saveList method writes a serialized version of the Bookmark List todisk. It must be synchronized so that it does not write the wrong versionof the list.
 9. Add the destroy method, which simply saves the list when the servlet isdestroyed:
 public void destroy(){
 saveList();}
 10. Add the doPost method:
 protected void doPost(HttpServletRequest req,HttpServletResponse resp)
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throws ServletException, IOException{
 boolean sendTheList = true;String action = req.getParameter("action");String title = req.getParameter("title");String url = req.getParameter("url");if( action.equals("add")){
 addEntry( title, url);}else if( action.equals("delete")){
 deleteEntry( title);}else if( action.equals("save")){
 saveList();}else{
 sendTheList = false;log("Bad request");
 }if( sendTheList){
 sendList( req, resp);}
 }
 The doPost method accesses the passed values, using the getParametermethod and, depending on the value of the action field, adds or deletesan entry or saves the list and then always sends it back.
 You specify the action field in the HTML form, using:
 <INPUT TYPE=HIDDEN NAME=action VALUE=delete>
 If the form data is incorrect, the servlet simply writes a message to theservlet log of the server.
 11. Add the doGet method:
 protected void doGet(HttpServletRequest req,HttpServletResponse resp) throws ServletException, IOException
 {sendList( req, resp);
 }
 The doGet method simply returns the current Bookmark List when abrowser invokes the URL of the servlet.
 Testing the ServletTo test the servlet you use the Servlet Runner that is included in the JSDK.You will need to have TCP/IP installed and running on your machine, and
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you must be able to successfully run the ping localhost command. If thecommand is not working, see the documentation on installing the VisualAgefor Java Help system which has the same requirements. (The Hlp.txt file inthe IBMVJAVA\EAB\RELNOTES directory may help.) You must run theServlet Runner on an unused TCP/IP port (8080 by default).
 Select the sun.servlet.http.HttpServer class and Selected→Properties.Click the Program tab and enter -v in the Command line arguments field.Click the Class Path tab and add the Programming VAJ V2 project to theProject Path.
 Click the Run button, and the Console will show the running server.
 Figure 167. Servlet Runner Output in the VisualAge for Java Console
 Start a Web browser and enter the following URL:
 http://localhost:8080/servlet/itso.bookmark.servlet.BookmarkListServlet
 You can set breakpoints in the servlet code and debug the servlet as youinteract with it through the Web browser. Figure 168 on page 293 shows theBookmark List in the Web browser.
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Figure 168. Dynamic Page Generated by Bookmark List Program
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9 InternationalizationWith the expansion of the Internet, the whole world can have access to yourapplet or servlet, and you may want to deploy applications anywhere in theworld. Thus, it is important that you provide internationalization support foryour programs. By making your Java program international, people all overthe world can use it in their own language and with the correct format ofspecific data such as date, currency, and time.
 Programs that support different languages and conventions are usuallycalled National Language Support (NLS) enabled or internationalapplications.
 In this chapter you will learn what the JDK provides to help you writeinternational Java programs and how international support is integratedinto VisualAge for Java. Once you have learned the concepts you will makeyour BookmarkListView applet international and work with several otherexamples.
 Java Internationalization FrameworkTo simplify the support of international applications, the JDK provides theInternationalization framework. This framework was originally developed inC++ by Taligent, a former IBM company, and has since been ported to the
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Java environment. Sun adopted this framework without major modificationsand made it part of the official JDK since Version 1.1.
 The main components of the Internationalization framework are locales andresource bundles.
 LocalesJava uses the term locale to identify a geographic or political region for whichspoken language and format conventions are specific. TheInternationalization framework defines the java.util.Locale class tosupport this framework. Locale objects contain information about supportedgeographic or political regions.
 Classes that provide support for different locales are known aslocale-sensitive classes. These classes use either a default or a specific localeto determine which locale to support. The approach is very flexible. If theparticular locale is not supported, the locale hierarchy is traversed until asupported locale is found or the default locale is reached.
 To create a Locale object, you specify a language, and optionally a countryand variant. For example, to create a Locale object for British English, youwould use the following statement:
 Locale myLocale = new Locale (“en”, “UK”, ““);
 All Locale List SampleThe classes in both the java.text and the java.util.Calendar packagesprovide the getAvailableLocales method that returns an array of all localesthat are supported by the class. This list of locales can be used to listdifferent languages associated with the locales.
 Follow these steps to create an applet that lists the different languagessupported by the NumberFormat class:
 1. Create a JApplet named AllLocaleList in a new package named itso.nlsin the Programming VAJ V2 project and open it in the Visual CompositionEditor.
 2. Drop a JScrollPane on the middle of the applet and drop a JList in theJScrollPane.
 3. Drop a DefaultListModel bean and a DefaultListSelectionModel bean onthe free-form surface and name them DefaultListModel andDefaultListSelectionModel, respectively.
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4. Connect the model of the JList to the this of DefaultListModel (Figure169).
 5. Connect the selectionModel of the JList to the this of theDefaultListSelectionModel (Figure 169).
 Figure 169. AllLocaleList Connections
 6. Save the bean.
 7. Switch to the Methods page and select the init method. Modify it to looklike this:
 public void init(){
 try {setName("AllLocaleList");setSize(426, 240);setContentPane(getJAppletContentPane());initConnections();// user code begin {1}java.util.Locale[] allLocales =
 java.text.NumberFormat.getAvailableLocales();java.util.Locale locale = java.util.Locale.getDefault();for (int i = 0; i < allLocales.length; i++) {
 /* Check if it’s a valid country */if (allLocales[i].getDisplayCountry().length() > 0) {/* get name of the current Locale, add it to the list */
 getDefaultListModel().
 Internationalization 297

Page 324
                        

addElement(allLocales[i].getDisplayName());/* if it’s the current setting, select it */if (allLocales[i].getDisplayName().
 equals(locale.getDisplayName())) {getDefaultListSelectionModel().addSelectionInterval(i,i);
 }}
 }// user code end
 } catch (java.lang.Throwable ivjExc) {
 // user code begin {2}// user code endhandleException(ivjExc);
 }}
 8. Change the applet width in the Properties dialog to 500 and run the applet(Figure 170).
 Figure 170. AllLocaleList Applet
 Resource BundleJava provides resource bundle classes that store and retrieve information,using identifiers or keys. Resource bundle classes (derived directly orindirectly from java.util.ResourceBundle) are collections of resourcesdesigned to aggregate the resources needed for a specific language. Thus youcan separate the program code from the locale-specific data (for example,separate the label of a button from the code that creates it).
 A naming convention is used to identify specific resource bundle classesaccording to their locale, so that the resource bundle methods know which
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resource bundle classes to select on the basis of the current locale. By usinginheritance among locale resources, you can minimize resource duplicationacross countries and achieve graceful degradation if he exact locale does nothave localized resources. For example, your program could use resourcesfrom Standard French if there is no explicit support for Canadian French.
 Because a locale can be set on a per-object basis, in addition to a default,system-wide basis, it is possible to deal with more than one locale at a time inthe same program.
 Because java.util.ResourceBundle is an abstract class, you must createyour own classes that derive from it or one of the abstract subclassesdiscussed below.
 Accessing Resource ValuesThe resource bundle classes provide several methods to access resourcevalues:
 getContentsReturn the set of resource key-value pairs.
 getKeysReturn all the keys.
 getObjectReturn a resource value given the key. You must cast the value tothe correct type.
 getStringReturn a resource value given the key. This is a conveniencemethod for string values.
 getStringArrayReturn a resource value given the key. This is a conveniencemethod for string array values.
 The two types of resource bundles are List and Property. AListResourceBundle stores the key-value pairs in an array of objects, whilethe PropertyResourceBundle stores the key-value pairs in property files. Youmay see better performance with a ListResourceBundle than aPropertyResourceBundle because use of the PropertyResourceBundle implies afile access for each bundle. However when you use the ListResourceBundle,application code is being modified during translation work, which is notalways desirable.
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List Resource BundlesThe java.util.ListResourceBundle class is an abstract class that derivesfrom ResourceBundle. It stores the localized data in an array of Object types.Therefore the localized data can be of any type, for example, Image.
 When localizing your program, you subclass ListResourceBundle with yourown classes, that must override the getContents method and provide anarray, where each item in the array is a pair of objects. The first element ofeach pair is a String key, and the second is the value associated with thatkey.
 A sample ListResourceBundle class might look like this:
 import java.util.*;public class MyResources extends ListResourceBundle {
 public Object[][] getContents(){
 return contents;}static final Object[][] contents = {
 {“GreetingLabel”, “Hello World!”},{“AddButton”, “Add”},
 };}
 Property Resource BundlesThe PropertyResourceBundle class is an abstract subclass of ResourceBundlethat manages resources for a locale through a set of strings loaded from aproperty file. Property files must have a .properties extension. They containkeys and their corresponding values. You can use those keys in your sourcecode to call ResourceBundle.getString in order to retrieve the associatedvalues.
 Unlike ListResourceBundle, PropertyResourceBundle can be used to storestrings only, not other objects.
 Internationalization in VisualAge for JavaVisualAge for Java supports internationalization through the ExternalizeString function. Given a string property (in the Visual Composition Editor) ora class containing strings, VisualAge for Java can generate code thatreferences the string indirectly through a resource bundle (property or list)and create the bundle for you. Note that strings that VisualAge for Java
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generates in user code blocks will not be externalized, and you should movethem into separate methods.
 VisualAge for Java adds an entry (composed of the key and value) in thearray or property file at each point in your code where a string was directlyreferenced, for example:
 JTextField1.setText(“A string”);
 The string parameter will be replaced by a call to the resource bundle:
 JTextField1.setText( getResourceBundle1( getString(“AStringLabel”)).);
 Externalizing All Strings in a ClassThe steps to externalize all the strings in a class at one time are:
 1. From the Projects page of the Workbench, select the class whose stringsyou want to externalize.
 2. Select Selected→Externalize Strings. Or, click mouse button 2 andselect Externalize Strings from the pop-up menu.
 The Externalizing dialog box appears, with a list of hardcoded strings foundin the class (Figure 171). As you can see in the figure, not all strings need tobe externalized; for example, the “Center” string is a parameter to a calladding the component to a BorderLayout and should not be externalized.
 If the same value appears more than once, VisualAge for Java will associatethe same key with the value.
 International Edition of VisualAge for JavaThis chapter covers how you can make your Java programsinternational. This is not the same as using the internationaledition of VisualAge for Java that supports developers working intheir native languages, including French, German, Spanish,Chinese, Japanese, Korean, Italian, and Portuguese.
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Figure 171. Externalizing Strings
 3. Specify the type of resource bundle by selecting one of the following radiobuttons:
 • List resource bundle
 • Property resource file
 4. Specify the name of the resource bundle: Use the Browse button to choose an existing resource bundle, or use theNew button to create a new bundle.
 5. Under Strings to be separated, you can mark an item by clicking theiconic checkbox to the left of the column. By default all strings are markedfor externalization so no action is required to externalize the string.
 • For strings that are never to be externalized, click once and a red Xappears (Figure 171). The string will be removed from the Strings to beseparated list.
 • To leave the string hardcoded for now, click twice and a ? shouldappear. The string will not be removed from the Strings to beseparated list.
 If you are not sure of a string, review it in the Context field. Then clickOK to proceed with the externalization.
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Externalizing a String PropertyIf you need more control over the externalization of individual strings, youcan externalize each string property separately. The steps to externalize astring property are:
 1. In the Visual Composition Editor, open the Property sheet for the beanthat contains the string property you want to externalize. Select the valuefield to the right of the property name. A small button with three dotsappears to the right of the text field.
 2. Select the button. The Text dialog box appears (Figure 172).
 Figure 172. String Externalization Editor
 3. Select the appropriate radio button:
 Removing the Externalization InformationVisualAge marks each item that you have chosen to externalize ornever to externalize with a special comment. To make a stringappear in the externalization list once again, find the accessor forthe string resource or the string itself in the code and delete thecomment at the end of the line: //$NON-NLS-1$. Then performthe steps 1 through 5 again.
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• Do not externalize string
 • Externalize string
 4. If you select Do not externalize string, you are finished. Just click OKto close the window. Use this selection if the string value is long or runsover multiple lines. You must use the Text dialog to enter the string butyou do not have to externalize the string.
 5. If you select Externalize string, specify the type of resource bundle byselecting one of the following radio buttons:
 • List resource bundle
 • Property resource file
 6. Specify the name of the resource bundle:
 • Use the Browse button or the drop-down list to choose an existingresource bundle, or use the New button to create a new bundle.
 • The name of the bundle appears in the bundle list.
 7. To define a new resource, type its name in the Key field. The existingresources can be accessed through the pull-down list on the key field. TheValue: text area contains the current value of the string property. If a keyis selected, the text area contains the current value of the selected key.Click OK to close the window.
 The next time you save the class, VisualAge for Java modifies the generatedget methods for the beans so that the text property is set from the resourcebundle.
 Making the BookmarkListView Applet InternationalIn this section you will add international capabilities for yourBookmarkListView applet. Specifically you will add support for English,French, and Italian. When the applet starts, the strings loaded for the userinterface will be in the language of the current locale for the computer.
 Externalizing the Strings1. Create a new package in the Programming with VAJ V2 project:
 itso.bookmark.nls.
 2. Select the BookmarkListController and BookmarkListView classes in theitso.bookmark.applet package in Workbench. SelectSelected→Reorganize→Copy. Click Browse and then enter
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itso.bookmark.nls and click OK. Deselect the Rename (copy as)checkbox and click OK.
 Because the applet contains a reference to the originalBookmarkListController, you will see an error created by the copy. Openthe BookmarkListView in the Visual Composition Editor and fix thereference, using the Morph Into function and the same process as in“Modifying the BookmarkList Applet to Support Serialization” on page257.
 3. In the Visual Composition Editor, open the Property Sheet for the JLabelthat has a text property of Title:. Select the Title: text in the Propertysheet and then select the button that appears in the field. The buttonrepresents the property editor.
 4. In the Text dialog that appears (Figure 173 on page 306), clickExternalize String, then select the ListResourceBundle radio button,then click New. Enter itso.bookmark.nls for the Package andBookmarkResources for the Class name.
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Figure 173. Externalizing the text Property
 5. Enter TitleLabelKey in the Key field. Click OK.
 6. For each of the three buttons, enter the key as shown in Table 16. Againselect the List resource bundle radio button and use the sameListResourceBundle. The URL: field is not changed because the URL stringis used in all the languages supported by the Bookmark List. Use the
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same class, BookmarkResources, and package, itso.bookmark.nls, for all ofthe strings.
 Table 16. Externalizing the BookmarkListView Buttons
 7. Now, save the bean so you can work with the generated code.
 Creating the Alternate Resource BundlesSwitch to the Workbench. You see a new class, BookmarkResources, in theitso.bookmark.nls package. BookmarkResources contains an array of objects.The array contains the key-value pairs that you specified when youexternalized the strings. The values of the strings in this array are thedefault values of the strings. Now you subclass BookmarkResources to providethe support for the other locales.
 Copy BookmarkResources to another class, BookmarkResources_fr, in the samepackage, using Selected→Reorganize→Copy. Change the classdeclaration:
 public class BookmarkResources_fr extends BookmarkResources{static final Object[][] contents = {
 {"GoButtonLabel", "Aller!"}, {"DeleteButtonKey", "Effacer"}, {"AddButtonkey", "Ajouter"}, {"TitleLabelKey", "Titre:"},
 };}
 Notice that BookmarkResources_fr extends BookmarkResources and provides theFrench translations of each string. Now copy BookmarkResources_fr toBookmarkResources_it and change the values of the strings to the Italiantranslation:
 public class BookmarkResources_it extends BookmarkResources{static final Object[][] contents = {
 {"GoButtonLabel", "Vai!"}, {"DeleteButtonKey", "Cancella"}, {"AddButtonkey", "Aggiungi"}, {"TitleLabelKey", "Titolo:"},
 };}
 Button Key
 Add AddButtonKey
 Delete DeleteButtonKey
 Go! GoButtonKey
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You are done. Now when the BookmarkListView applet runs, the languagedisplayed will be that of the default locale of the machine provided that thedefault locale is Standard French, Standard Italian, or U.S. English.
 If the locale of the machine is another version of French or Italian, thelanguage displayed is the Standard French or Italian. If the default locale isany other locale, U.S. English will be displayed.
 If you are running Windows NT, you can change your default locale throughthe Regional Settings. This action requires access to the NT install imageand may cause VisualAge for Java to re-install some files. In the next sectionyou build a program where the user can change the locale settingsdynamically.
 Figure 174 shows the running applet.
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Figure 174. The Three Languages Supported in the BookmarkListView Applet
 Building a Language PanelWhen you created the French, Italian and U.S. English resource bundles inthe last section, you probably did not change your default locale and rebootyour machine just to see the different languages displayed by your applet. Inthis section you build a LanguagePanel that changes the display on the basisof user input.
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First copy the three .gif files (frflag.gif, itflag.gif and usflag.gif) from theexamples directory into the project resources directory of the Programmingwith VAJ V2 project (ibmvjava\ide\project_resources\Programming VAJ V2).You will use the .gif files to display the country flags of the different localesby adding an icon to a JLabel.
 LanguagePanel View1. In the itso.nls package create a LanguagePanel class that inherits from
 com.sun.java.swing.JFrame. Make sure you select the Compose the classvisually checkbox to open the Visual Composition Editor.
 2. Add a JLabel to the center of the panel and a JComboBox to the bottom ofthe panel and change the bean names to SelectLanguageLabel andLanguageChoice.
 3. Change the text property of SelectLanguageLabel to Select Your Languageof Preference. Change the foreground color to Black and ensure thatverticalAlignment and verticalTextPosition are set to CENTER,horizontalAlignment to LEFT, and horizontalTextPosition to RIGHT.
 4. Click the field to the right of the SelectLanguageLabel icon property andthen click the button that appears in the right of the field. Select the fileradio button and click Browse. Select Programming with VAJV2\usflag.gif and click OK.
 5. Resize the frame and the textfield to see the complete text and image(Figure 175 on page 311).
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Figure 175. The LanguagePanel in the Visual Composition Editor
 Creating the Resource Bundles1. Externalize the text property of the SelectLanguageLabel (see Figure 176
 on page 312):
 a. Select the List resource bundle radio button.
 b. Enter itso.nls for the Package name and LanguageResources for theClass Name.
 c. Enter SelectLanguageLabel in the Key field.
 d. The Value field should already be filled in with Select Your Languageof Preference.
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Figure 176. Externalizing the SelectLanguageLabel
 In “Creating the Alternate Resource Bundles” on page 307, you created thealternate resource bundles by copying the created class. You can also useVisualAge for Java to produce the different bundles.
 2. Externalize the text property of the SelectLanguageLabel again. This timechoose itso.nls for the Package and LanguageResources_fr for the Classname.
 a. Enter SelectLanguageLabel in the Key field.
 b. Enter Choisissez une Langue de Préférence in the Value field.
 To create an international character, hold down the ALT key and input theASCII code for the character, using the number pad on the right-hand sideof your keyboard, then release ALT. For this example you only need the ésymbol: 0233.
 3. Repeat the externalization one more time, usingitso.nls.LanguageResources_it for Italian:
 a. Enter SelectLanguageLabel in the Key field.
 b. Enter Selezionare un Linguaggio dello Preferenza in the Value field.
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c. Save the bean. The free-form surface shows the text field with anAmerican flag and Italian text. Don’t worry, you will fix that when theapplication starts.
 You now have three resource bundle classes in your itso.nls package:LanguageResources, LanguageResources_fr, and LanguageResources_it. To usethe generic resource bundle, LanguageResources, to support the default locale,English, and all the other locales that are not French or Italian, subclass theFrench and Italian resource bundles from LanguageResources instead of fromjava.util.ListResourceBundle. Add the icon for the American flag to thedefault language resources so the LanguageResources class looks like these:
 public class LanguageResources extends java.util.ListResourceBundle {static final Object[][] contents = {
 {"SelectLanguageLabel", "Select your language of preference"},{"Icon",new com.sun.java.swing.ImageIcon("usflag.gif")}
 };}
 Modify the two subclasses to match the following code:
 public class LanguageResources_fr extends LanguageResources {static final Object[][] contents = {
 {"SelectLanguageLabel", "Choisissez une Langue de Préférence"}, {"Icon",new com.sun.java.swing.ImageIcon("frflag.gif")}};
 }
 public class LanguageResources_it extends LanguageResources {static final Object[][] contents = {
 {"SelectLanguageLabel", "Selezionare un Linguaggio dello Preferenza"},{"Icon",new com.sun.java.swing.ImageIcon("itflag.gif")}
 };}
 Dynamically Changing the LocaleIn “Making the BookmarkListView Applet International” on page 304, theresource bundle for the default locale was loaded automatically when theprogram started. To dynamically change the locale, you have to add code tochange the locale-specific components.
 Loading Resource BundlesTo load a resource bundle you use the static method, getBundle, from theResourceBundle with the name of the resource bundle base class (including
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package information if not in the same package as the calling application)and the preferred locale. For example:
 ResourceBundle myBundle = ResourceBundle.getBundle(“MyResources”, aLocale);
 where aLocale is your Locale object, and MyResources is the name of yourresource bundle.
 In the LanguagePanel applet, you will use only one resource bundle hierarchy.If the current locale is set to French Canadian, the getBundle method firstlooks for a class called MyResources_fr_CA. If it does not find the class, it looksfor Standard French (MyResources_fr). If that search fails, the method loadsthe generic class MyResources. If the method cannot find MyResources, itthrows a MissingResourceException.
 Retrieving Resources from Resource BundlesOnce your resource bundle class is loaded, you can use the keys to access thestored objects. The getObject method returns an element of the static arrayof resources. As the resource is always returned as a java.lang.Object, youhave to cast it to the correct type of your object. As you learned in “AccessingResource Values” on page 299, a getString method is provided forconvenience. For example, if you want to set a JLabel to the “HelloWorld”resource, you use:
 myJLabel.setText(myBundle.getString(“HelloWorld”));
 When you use the ListResourceBundle class, you can also store objects otherthan strings. For example, you could use myBundle to retrieve the“BigNumber” resource into a variable:
 Integer myBigNumber = (Integer)myBundle.getObject(“BigNumber”));
 Finishing the LanguagePanelTo make LanguagePanel a multilingual panel, create two methods:
 Number of Resource BundlesIn complex applications, you typically define many resourcebundle hierarchies; for example, one for each window or one forlabels, one for numbers, one for pictures, and one for sounds.
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❑ The changeLanguage() method is called whenever a user selects a newlanguage from LanguageChoice. This method translates the languageselected into a supported locale and calls the setLocale method by passingthe new locale as a parameter.
 ❑ The updateGui(java.util.Locale) method retrieves a resource bundleinstance and updates the GUI components according to the locale passedas a parameter.
 To create the updateGui method:
 1. Select LanguagePanel and Selected→Add→Method. Type in voidupdateGui(java.util.Locale aLocale) as the method name and chooseprivate as the access modifier. Click Finish to create the method.
 2. Select the method and modify its code:
 private void updateGui(java.util.Locale aLocale) {
 java.util.ResourceBundle aResourceBundle=null;try {
 aResourceBundle=java.util.ResourceBundle.getBundle("itso.nls.LanguageResources",aLocale);
 }catch (Exception e) {
 System.out.println(e);}getSelectLanguageLabel().
 setText(aResourceBundle.getString("SelectLanguageLabel"));getSelectLanguageLabel().setIcon((com.sun.java.swing.ImageIcon)
 aResourceBundle.getObject("Icon"));}
 At the beginning of the method, a local variable is created to hold theresource bundle object. Then the resource bundle instance is retrieved, usingthe current locale. Once the resource bundle instance has been retrieved, it isused to get the resources for each label.
 To create the changeLanguage method:
 1. In the Workbench, select the LanguagePanel class andSelected→Add→Method or click the M icon on the toolbar.
 2. Enter void changeLanguage() as the method name and select private asthe access modifier. Click Finish to create the method.
 3. Select the method and modify its code:
 private void changeLanguage() {
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if( getLanguageChoice().getSelectedItem().equals(java.util.Locale.FRANCE.getDisplayLanguage())) {
 updateGui(java.util.Locale.FRANCE);}else if(getLanguageChoice().getSelectedItem().equals(
 java.util.Locale.U.S..getDisplayLanguage())) {updateGui(java.util.Locale.U.S.);
 }else if (getLanguageChoice().getSelectedItem().equals(
 java.util.Locale.ITALY.getDisplayLanguage())) {updateGui(java.util.Locale.ITALY);
 }}
 To change the GUI when the user selects another language, just add anevent-to-code connection from the itemStateChanged event of theLanguageChoice to the changeLanguage method (Figure 177). Now save thebean.
 Finally, you need to populate the list of languages for the Select languagedrop-down list and set the GUI to the default locale on initialization. Changethe initialize method to look like this:
 private void initialize() {// user code begin {1}// user code endsetName("LanguagePanel");setDefaultCloseOperation(com.sun.java.swing.WindowConstants.DISPOSE_ON_CLOSE);setSize(528, 299);setContentPane(getJFrameContentPane());initConnections();// user code begin {2}getLanguageChoice().addItem(java.util.Locale.U.S..getDisplayLanguage());getLanguageChoice().addItem(java.util.Locale.FRANCE.getDisplayLanguage());getLanguageChoice().addItem(java.util.Locale.ITALY.getDisplayLanguage());updateGui(java.util.Locale.getDefault());// user code end
 }
 Save and run the LanguagePanel (Figure 178).
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Figure 177. LanguagePanel Connection
 Length of Translated StringsOne problem encountered when translating user interfaceelements is the relative length of strings. A translated string canbe much longer or shorter than the original string. When youdesign your user interfaces keep this in mind and use layouts andconstraints that will adjust to changing string lengths.
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Figure 178. Running LanguagePanel
 Formatting Dates and Times The DateFormat class and its subclasses are used to handle the formatting ofdate and time information. You have to use the getDateTimeInstance methodto get the date and time formatter or getDateInstance to get only the dateformatter. The following code shows you how to use getDateInstance for agiven locale attribute:
 Date myDate = new Date(“21 September 1998”); DateFormat df = DateFormat.getDateInstance(DateFormat.DEFAULT, locale); String formattedDate = df.format(myDate);
 The first parameter in the getDateInstance method call is used to specify theformat of the date or time to be used. Refer to the JDK documentation for allpossible formats.
 Adding Dates to the LanguagePanelFollow these steps to update the Language Panel with international datesand times:
 1. Open your LanguagePanel class and add four JLabels and rename them:TimeLabel, Time, DateLabel, and Date. Set the text properties to Time:,TimeValue, Date:, and DateValue (place them as shown in Figure 179).
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2. Save the bean.
 Figure 179. LanguagePanel View2
 3. Externalize the TimeLabel and the DateLabel strings through theirproperty sheets to update their appropriate values in the correct resourcebundles:
 LanguageResources:
 LanguageResources_fr:
 Key Value
 TimeLabel Time:
 DateLabel Date:
 Key Value
 TimeLabel Heure:
 DateLabel Date:
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LanguageResources_it:
 4. Modify the updateGui(Locale) method in LanguagePanel:
 private void updateGui(java.util.Locale aLocale) {java.util.ResourceBundle aResourceBundle=null;try {
 aResourceBundle=java.util.ResourceBundle.getBundle("itso.nls.LanguageResources",aLocale);
 }catch (Exception e) {
 System.out.println(e);}getSelectLanguageLabel().setText(aResourceBundle.
 getString("SelectLanguageLabel"));getSelectLanguageLabel().setIcon((com.sun.java.swing.ImageIcon)
 aResourceBundle.getObject("Icon"));getTimeLabel().setText(aResourceBundle.getString("TimeLabel"));getDateLabel().setText(aResourceBundle.getString("DateLabel"));java.text.DateFormat dFormat, tFormat;dFormat = java.text.DateFormat.getDateInstance(
 java.text.DateFormat.DEFAULT, aLocale);tFormat = java.text.DateFormat.getTimeInstance(
 java.text.DateFormat.DEFAULT, aLocale);java.lang.String timeString = tFormat.format(new java.util.Date());java.lang.String timeZone = tFormat.getTimeZone().getID();getTime().setText(timeString + " " + timeZone);java.lang.String dateString = dFormat.format(new java.util.Date());getDate().setText(dateString);
 }
 5. Save and test your work. Figure 180 shows the output.
 Key Value
 TimeLabel Ora:
 DateLabel Data:
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Figure 180. LanguagePanel Output with Dates and Times
 Other Internationalization ConsiderationsThis section covers resources other than strings and dates that you mustconsider when internationalizing your Java programs.
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Using Predefined FormatsThe JDK supplies the NumberFormat class and its subclasses, ChoiceFormatand DecimalFormat, for the different locale number formats. By invoking themethods provided by the NumberFormat class, you can format numbers,currencies, and percentages according to locale. However, there is a catch:NumberFormat may not support the locale you specify. To find out which localedefinitions NumberFormat supports, invoke the getAvailableLocales method:
 Locale[] locales = NumberFormat.getAvailableLocales();
 NumbersYou can use the NumberFormat factory methods to format primitives, such asdouble, and their corresponding wrapper objects, such as Double.
 This code example formats a Double according to locale. Invoking thegetNumberInstance method returns a locale-specific instance of NumberFormat.The format method accepts the Double as an argument and returns theformatted number in a String.
 Double amount = new Double(123456.789);NumberFormat numberFormatter;String amountOut;numberFormatter = NumberFormat.getNumberInstance(currentLocale);amountOut = numberFormatter.format(amount);System.out.println(amountOut + " " + currentLocale.toString());
 The output from this example shows how the format of the same numbervaries with locale:
 123 456,789 fr_FR123.456,789 de_DE123,456,789 en_U.S.
 Custom Number FormatsIf NumberFormat does not support a locale that you need, you cancreate your own formats. You can use the DecimalFormat class toformat decimal numbers into locale-specific strings. With thisclass you can control the display of leading and trailing zeros,prefixes and suffixes, grouping (thousands) separators, and thedecimal separator. If you want to change formatting symbols suchas the decimal separator, you can use the DecimalFormatSymbolsclass in conjunction with the DecimalFormat class. These classesoffer a great deal of flexibility in the formatting of numbers, butthey can make your code more complex. For more details refer tothe JDK documentation.
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CurrenciesYou format currencies the same way you format numbers, except withcurrencies you call getCurrencyInstance to create a formatter. When youinvoke the format method, it returns a String that includes the formattednumber and the appropriate currency sign.
 The following code example shows how to format currency in a locale-specificmanner:
 Double currency = new Double(1234567.89);NumberFormat currencyFormatter;String currencyOut;currencyFormatter = NumberFormat.getCurrencyInstance(currentLocale);currencyOut = currencyFormatter.format(currency);System.out.println(currencyOut + " " + currentLocale.toString());
 Here is the output generated by the preceding lines of code:
 1 234 567,89 F fr_FR1.234.567,89 DM de_DE$1,234,567.89 en_U.S.
 PercentagesYou can also use the methods of the NumberFormat class to formatpercentages. To get the locale-specific formatter, invoke thegetPercentInstance method. With this formatter, a fraction such as 0.75 isdisplayed as 75%. The following code sample shows how to format apercentage:
 Double percent = new Double(0.75);NumberFormat percentFormatter;String percentOut;percentFormatter = NumberFormat.getPercentInstance(currentLocale);percentOut = percentFormatter.format(percent);
 Converting CurrenciesAt first glance this output may look wrong because all of thenumeric values are the same. Of course, 1 234 567,89 F is notequivalent to 1.234.567,89 DM. However, bear in mind that theNumberFormat class is unaware of exchange rates. The methodsbelonging to the NumberFormat class format currencies but do notconvert them.
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MessagesPrograms often need to build messages from sequences of strings, numbers,and other data. To produce the “The disk ‘MyDisk’ contains 3 files.” message,you would use the following code:
 int numFiles = 3;String diskName = “MyDisk”;String message = “The disk” + diskName + “ contains”+ numFiles + “files.”;
 The above code, although easy to understand, is extremely difficult to localizebecause it hard codes both the strings that make up the message and theorder in which they are put together. Note, for example, that the Frenchtranslation of the message, “Il y a 3 fichiers sur le disque ‘MyDisk’.”, reversesthe strings.
 The MessageFormat class provides a way to build messages in alanguage-neutral way. It is constructed from a pattern string. The patternstring describes the structure of the message and the substitution order forthe parameters. When you use a MessageFormat, the code used to create “Thedisk ‘MyDisk’ contains 3 files.” would look like this:
 Object[] arguments = new Object[2];arguments[0] = new Integer(3);arguments[1] = "MyDisk";StringBuffer message = new StringBuffer();MessageFormat fmt= new MessageFormat("Disk {0} contains {1} files.");fmt.format(arguments, message, null);fmt = new MessageFormat("Il y a {1} fichiers sur le disque {0} ");fmt.format(arguments, message, null);
 The format method formats the given arguments and substitutes the resultinto the pattern string to form the final message. The MessageFormat tries toformat the given arguments in several ways. An array of Format objects canbe passed to the MessageFormat. If the array is present, parameter n will beformatted using the nth entry of the format array. If an explicit format arrayhas not been passed as a parameter, a default Format will be obtained. If theparameter to be formatted is a number, NumberFormat.getDefault is called.Otherwise, the parameter's toString method is called.
 An additional type of Format, ChoiceFormat, is available for use in formattingthe parameters of a message. A ChoiceFormat allows text to be associatedwith a number or range of numbers.
 CollationsApplications that search or sort through text perform frequent stringcomparisons. A report generator performs string comparisons when sorting a
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list of strings in alphabetical order. However, the order of certain charactersin the alphabets of different locales may be significantly different.
 If your application audience is limited to people who speak English, you canprobably perform string comparisons with the String.compareTo method.This method performs a binary comparison of the Unicode characters withinthe strings. For many languages, you cannot rely on this binary comparisonto sort strings, because the Unicode values do not correspond to the relativeorder of the characters.
 Fortunately, the Collator class allows your application to perform stringcomparisons for different languages. You use the Collator class to performlocale-independent comparisons. The Collator class is locale-sensitive.
 To see which locales the Collator class supports, invoke thegetAvailableLocales method:
 Locale[] locales = Collator.getAvailableLocales();
 When you instantiate the Collator class, you invoke the getInstance methodand specify the locale:
 Collator myCollator = Collator.getInstance(new Locale("en", "U.S."));
 The getInstance method actually returns a RuleBasedCollator, which is aconcrete subclass of Collator. The RuleBasedCollator class contains a set ofrules that determine the sort order of strings for the locale you specify. Theserules are predefined for each locale. Because the rules are encapsulatedwithin the RuleBasedCollator, your program does not need special routines todeal with the way collation rules vary with language.
 You invoke the Collator.compare method to perform a locale-independentstring comparison. The method returns an integer less than, equal to, orgreater than zero when the first string argument is less than, equal to, orgreater than the second string argument. For example:
 myCollator.compare(“abc”, “xyz”); // returns -1: “abc” is less than “xyz”myCollator.compare(“abc”, “abc”); // returns 0: the two strings are equalmyCollator.compare(“xyz”, “abc”); // returns 1: “xyz” is greater than “abc”
 You can use the Collator compare method when performing sort operations.The sample program (taken from the JDK Demo package) presented belowuses the compare method to sort an array of English and French words. Itshows what can happen when you sort the same list of words with twodifferent collators.
 Collator fr_FRCollator = Collator.getInstance(new Locale("fr","FR"));Collator en_U.S.Collator = Collator.getInstance(new Locale("en","U.S."));
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The method for sorting, called sortStrings, can be used with any Collator.Notice that the sortStrings method invokes the compare method:
 public static void sortStrings(Collator collator, String[] words) {
 String tmp;for (int i = 0; i < words.length; i++) {
 for (int j = i + 1; j < words.length; j++) {// Compare elements of the array two at a time.if (collator.compare(words[i], words[j] ) > 0 ) {// Swap words[i] and words[j]tmp = words[i];words[i] = words[j];words[j] = tmp;}
 }}
 }
 The English Collator sorts the words like this:
 peachpêchepéchésin
 According to the collation rules of the French language, the preceding list isin the wrong order. In French, "pêche" should follow "péché" in a sorted list.Therefore the French Collator sorts the array of words like this:
 peachpéchépêchesin
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10 Deploying Your Java ProgramsTraditionally, you develop an application for a specific platform, test it onthat platform, and create a platform-specific installation utility to deploy theapplication. Deploying a Java program is different; the program could be anapplet, an application, or a servlet, all with different deployment techniques.In addition, the program is expected to run wherever there is a JVM.
 This chapter shows you how to deploy a Java program, whether it is anapplet, servlet, or application, to the runtime, or target environment.
 Deploying a Java program is usually quite simple. However, because Java is"write once, run anywhere," deployment is not always trivial. The level ofJDK, especially when deploying applets, can present problems as can thecorrect settings for CLASSPATH, and the configuration of the Web server, inthe case of servlets.
 It is important to test your Java programs on as many JVMs as possible.There are differences in virtual machine implementations, especially inscheduling and time-critical programs.
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Deployment can become quite difficult if the Java program contains calls tononJava code or uses nonstandard Java extensions. Writing pure Java codeis necessary to ensure trouble-free deployment.
 Before You StartTo complete the exercises in this chapter, you must set up the correct runtimeenvironments for your Java programs. The requirements for the Javaprograms are:
 Requirements for Applications1. JDK 1.1.6
 The JDK for Windows platforms can be downloaded from:
 http://java.sun.com/products/jdk/1.1/download-jdk-windows.html
 2. JFC 1.0.2
 The JFC can be downloaded from:
 http://java.sun.com/products/jfc/index.html#download-swing
 For further information about using the JFC, see the README file in theSun JFC Swing Set project resources directory.
 Requirements for Servlets1. A Web server that supports servlets
 A trial version of the Domino Go Web server can be downloaded from:
 http://www.software.ibm.com/Web servers/dgw/download.htm
 Follow the links to register and download the appropriate edition for yourplatform and location.
 2. JDK 1.1
 The Domino Go Web server includes a version of the JDK 1.1.
 The JDK can be downloaded from:
 http://java.sun.com/products/jdk/1.1/download-jdk-windows.html
 Requirements for Applets1. A Web browser that supports JDK 1.1 and the JFC.
 The VisualAge for Java install image contains Netscape Navigator 4.04.For information about installing the Web browser, see the productdocumentation.
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To run JDK 1.1 applets in Netscape 4.04, you have to install the JDK 1.1patch from: http://developer.netscape.com/software/jdk/download.html.
 If you are using a newer version of Netscape, ensure that full JDK 1.1support is included in the version.
 To run applets that use JFC components, the JFC JAR file, swingall.jar,must be in the system CLASSPATH when you start the Web browser.
 2. JFC 1.0.2
 The JFC can be downloaded from:
 http://java.sun.com/products/jfc/index.html#download-swing
 For further information about using the JFC, see the README file in theSun JFC Swing Set project resources directory.
 3. A Web server
 You can use the Domino Go Web server. However, almost any Web serveris adequate.
 All of the examples in this chapter assume that you are deploying the Javaprograms on the machine where VisualAge for Java is installed. If you aredeploying the programs on another machine, you must transfer the files tothe target machine after you export them from VisualAge for Java.
 Deploying an ApplicationA Java application is a Java program that is started from a main method. AJava object that is to be run as an application must implement a mainmethod.
 Applications have full access to the host environment. They can startprograms and read and write files, and they have the same permissions asnative applications. Java applications can be run on any platform thatsupports a JVM at the correct level.
 To deploy a Java application from VisualAge for Java you have to export theJava code:
 1. Choose the export type: class files or JAR file.
 2. Choose that classes to include in the export:
 • Include referenced types
 • Exclude design time classes
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3. Choose whether to include Debug information in the classes. Choose thisoption only if you are going to debug the application remotely.
 Once you have exported the application, you should be able to run it on thetarget platform provided:
 ❑ The target platform has the same or a compatible level of the JDKinstalled.
 ❑ All classes that your application references are either packaged with yourapplication or in the CLASSPATH on the target machine. If you haveexported a JAR file, add the complete path and file name of the JAR file tothe CLASSPATH. For example, if your JAR file is MyClasses.jar and youhave exported it to C:\JavaClasses, the CLASSPATH entry should beC:\JavaClasses\MyClasses.jar. If you have exported class files toC:\JavaClasses, the CLASSPATH entry would simply be: C:\JavaClasses.
 You may also want to package your Java application as a self-installingimage. Several utilities, such as InstallShield Java Edition, are available forthat purpose.
 Follow these steps to deploy the finished ATM application (from Chapter 6,“Finishing the ATM Application”):
 1. Install JDK 1.1.6 on your target machine and add the bin directory toyour PATH statement as directed in the installation instructions.
 2. Install the JFC 1.0.2 classes on the target machine.
 3. Export the itso.atm.model and itso.atm.view packages as a JAR file,Atm.jar, and record the directory to which you export the file (Figure 181on page 331). Click the Deselect BeanInfo and Property Editorbutton.
 4. Set the CLASSPATH of the target machine to include the Swing classes,the JDK classes, and the JAR file you exported in Step 3. For example:
 Include Referenced TypesBe careful if you select Include Referenced Types. VisualAge forJava adds all the types that your class references to the JAR fileor directory export, which may include the complete JFC or JDBChierarchies if you use those classes. You may not want to includethe classes in your export.
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SET CLASSPATH=D:\SWING-1.0.2\SWINGALL.JAR;D:\JDK1.1.6\LIB\CLASSES.ZIP;D:\JAVACLASSES\ATM.JAR
 Start the application (Figure 182 on page 332) by entering javaitso.atm.view.AtmView. Note that the package and class names arecase-sensitive. Provided that the Java interpreter is in your PATH statementand the AtmView is in the CLASSPATH, everything should run smoothly(Figure 183 on page 332).
 Figure 181. Exporting the ATM to a jar File
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Figure 182. Starting the ATM Application
 Figure 183. The ATM Application Running Outside the VisualAge for Java Environment
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Deploying a ServletDeploying a servlet involves installing the servlet classes in the correctlocation on the Web server and ensuring that the Web server is correctlyconfigured to execute servlets. You may have to install the JDK and set theCLASSPATH on the host or specifically for the Web server.
 Different Web servers have different configurations, and some Webapplication servers, such as IBM’s WebSphere, execute servlets inconjunction with a Web server.
 Depending on the Web server you are using, when you deploy a servlet youcan specify initialization parameters and other settings, such as where theservlet executes.
 This example uses the Lotus Domino Go Web server. If you are using adifferent Web server or servlet environment, consult the documentation forthe correct procedure.
 Installing the Domino Go Web ServerTo install the Domino Go Web Server, run the installation utility and followthe installation instructions. The choices you need to make are:
 1. Select Components: For this example select at least the followingcheckboxes:
 • Lotus Domino Go Web Server • NT Service • Java Servlet
 2. Target Directory: Install the Lotus Domino Go Web Server in anydirectory, the default, C:\WWW, is fine for the example. Note the locationthat you choose for the target directory.
 3. Component Directories: You can leave the defaults. Note the location ofthe HTML directory.
 4. Configuration Parameters: You have to choose an Administrator ID andPassword. Using your own user ID and password is fine for the purposesof this example. Be careful with the Administrator Password though; it isechoed in the field as you type it. Record the Host Name and theAdministrator ID and Password you use.
 5. Reboot your computer or log out and log back in.
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Starting the Lotus Domino Go Web ServerYou can start the Web server from the command line, using whttpg, or fromControl Panel→Services. If you want to see the Web server user interface,click Startup and then select the Allow Service to Interact with Desktopcheckbox. Select Lotus Domino Go Web server and click Start.
 Configuring the Web ServerFor the purposes of the example, the default Web server configuration is fine.If you plan to use the Web server for production purposes, you should readthe documentation and configure it to suit your needs.
 Deploying the BookmarkListServletTo deploy the BookmarkListServlet on the Lotus Domino Go Web server:
 1. Export the itso.bookmark.servlet.BookmarkListServlet and theitso.bookmark.Bookmark classes as Java class files to the Web serverdefault servlet directory: WWW\SERVLETS\PUBLIC (Figure 184 on page 335).In a production environment you would want to create a separatedirectory and define it to the Web server, but for this example the defaultdirectory is fine. You cannot export all servlet classes as a JAR filebecause the Web server must have the main servlet class as a .class file.
 2. Make sure the Web server is running, enter the URL(http://hostname/servlet/itso.bookmark.servlet.BookmarkListServlet)in the Web browser, and you’re off! Figure 185 on page 336 shows thedynamic HTML page generated by the servlet.
 334 Programming with VisualAge for Java Version 2

Page 361
                        

Figure 184. Exporting the Servlet Classes
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Figure 185. Running the BookmarkListServlet
 Deploying an AppletYou have probably invoked many applets as you have surfed the Web,whether you were aware of it or not. Applets are Java programs that executewithin a Web browser. By default they run in a "sandbox," or protectedenvironment. Also by default, they cannot access files on your machine, andthey cannot connect to other machines on the network except to the Webserver from which they were accessed.
 In Chapter 4, “Building User Interfaces” you created the BookmarkListapplet and ran it in VisualAge for Java. VisualAge for Java provides anApplet Viewer to run and test applets within the VisualAge for Javaenvironment. Although the Applet Viewer is good for initial testing ofapplets, you have to test with Web browsers to see how the applet integrateswith HTML pages and whether there are any differences in the way the Webbrowsers display components or interact with the user.
 Deploying an applet consists of two separate tasks:
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1. Installing the applet on the Web server, where it can be served to a Webbrowser.
 2. Ensuring that the correct JDK and classes are either supported by thetarget browsers or available from the Web server.
 Web BrowsersVisualAge for Java produces JDK 1.1.6 Java code. Your Web browser must beJava enabled and must support JDK 1.1 to run the code. Another alternativeis to use the Java Plug-In from JavaSoft.
 Although there are many Web browsers, the vast majority of users run eitherNetscape Navigator or Microsoft Internet Explorer. Recent versions of bothbrowsers support JDK 1.1 applets.
 Netscape NavigatorBoth Netscape Navigator 4.04 and 4.05 can support JDK 1.1 applets.However, the support is not completely straightforward:
 Version 4.04: If you are using Version 4.04, you must download and install theJDK 1.1 patch from Netscape to run JDK 1.1 applets.
 Version 4.05: A specific Netscape 4.05 version supports JDK 1.1: PreviewRelease 1 (AWT 1.1.5). You must install this version fromhttp://developer.netscape.com to run JDK 1.1 applets.
 To use the Navigator with applets that use JFC components, the JFC JARfile must be in the CLASSPATH when you start Netscape. For example:CLASSPATH=D:\SWING-1.0.2\SWINGALL.JAR.
 For newer releases of Netscape check whether the JFC is included with theNavigator and that JDK 1.1 support is included.
 Microsoft Internet ExplorerMicrosoft Internet Explorer 4.01 and 5.0 support JDK 1.1 applets withoutmodification. They do not support RMI, however. You can download RMIsupport for the Internet Explorer from IBM at www.alphaworks.ibm.com.
 To use Internet Explorer with applets that use JFC components, the JFCJAR file must be in the CLASSPATH when you start Netscape. For example:CLASSPATH=D:\SWING-1.0.2\SWINGALL.JAR.
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JavaSoft Java Plug-inThe Java Plug-in supports most versions of Netscape Navigator andMicrosoft Internet Explorer and allows the use of Sun’s Java RuntimeEnvironment (JRE) or another Java Virtual Machine, instead of thebrowser’s default Java runtime. For more information about the JavaPlug-In, see the JavaSoft Web pages. The use of the Plug-in requires changesin your HTML that are dependent upon the browser being used.
 CLASSPATH or CODEBASEA Web server that serves an applet does not need to know anything aboutJava and therefore does not use the CLASSPATH. When you deploy yourapplet, you can specify the location of classes through the CODEBASE tag;otherwise the Web server, by default, searches for the classes or JAR files inthe same directory as the HTML file that contains the applet. The classes aresearched for in a directory relative to the codebase (or current directory)according to the package name of the class. For example, if you deploy anapplet in an HTML page in the /bookmarklist directory and the applet classis itso.bookmark.applet.BookmarkListView, the Web server attempts to servethe class from the /bookmarklist/itso/bookmark/applet directory unless youspecify a JAR file through the ARCHIVE tag.
 Applet TagsVisualAge for Java can create a simple .html file for your applet to run in abrowser on the Internet. This file simply contains the applet tag and a title.For example:
 <HTML><HEAD><TITLE>TestEventQCheck</TITLE></HEAD><BODY><H1>AppletName</H1><APPLET CODE=pkgname.Appletname.class WIDTH=250 HEIGHT=300></APPLET></BODY></HTML>
 The complete syntax for the applet tag ([ ] means optional and the spacing isfor readability) is:
 <APPLET[CODEBASE = codebaseURL]CODE = appletFile[ALT = alternateText][NAME = appletInstanceName]
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WIDTH = pixels HEIGHT = pixels[ALIGN = alignment][VSPACE = pixels] [HSPACE = pixels][ARCHIVE = JARFile1, JARFile2 ...]
 >[< PARAM NAME = appletAttribute1 VALUE = value >][< PARAM NAME = appletAttribute2 VALUE = value >]. . .[alternate HTML]
 </APPLET>
 where:
 ❑ CODEBASE = codebaseURL is an optional attribute that specifies thebase URL of the server directory that contains the applet’s code. If thisattribute is not specified, the document’s URL is used.
 ❑ CODE = appletFile is a mandatory attribute that gives the name of thefile that contains the applet’s compiled Applet subclass. This file isrelative to the base URL of the applet. It cannot be absolute.
 ❑ ALT = alternateText is an optional attribute that specifies any text thatshould be displayed if the browser understands the APPLET tag butcannot run Java applets.
 ❑ NAME = appletInstanceName is an optional attribute that specifies aname for the applet instance, that makes it possible for applets on thesame page to find (and communicate with) each other.
 ❑ WIDTH = pixels and HEIGHT = pixels are mandatory attributes thatgive the initial width and height (in pixels) of the applet display area, notcounting any windows or dialogs that the applet brings up.
 ❑ ALIGN = alignment is an optional attribute that specifies the alignmentof the applet. The possible values of this attribute are the same as those ofthe IMG tag: left, right, top, texttop, middle, absmiddle, baseline, bottom,and absbottom.
 ❑ VSPACE = pixels and HSPACE = pixels are optional attributes thatspecify the number of pixels above and below the applet (VSPACE) and oneach side of the applet (HSPACE). They are treated in the same way asthe VSPACE and HSPACE attributes of the IMG tag.
 ❑ ARCHIVE = JARFile1, JARFile2 ... is an optional attribute thatspecifies one or several archive files to load.
 You can also use .cab or cabinet files to transfer your class files whenusing Microsoft Internet Explorer.
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❑ <PARAM NAME = appletAttribute1 VALUE = value> ... is a tag thatspecifies an applet-specific attribute. Applets access their attributes withthe getParameter method.
 A Java-enabled browser that understands the <APPLET> tag ignores the[Alternate HTML] part, whereas a browser that does not support Javaignores everything until [Alternate HTML]. Thus Web pages can be createdthat make sense for both types of browsers.
 To specify that the archive file is not in the same directory as the HTML pagecontaining the <APPLET> tag, use the CODEBASE attribute.
 Whenever a browser has to load a file needed by an applet, it looks in thedirectories or archives specified in the CLASSPATH of the browser first.Then it checks the applet’s JAR files specified in the ARCHIVE parameter. Ifthe browser fails to find the class file in a JAR file, it looks in the applet’scodebase directory hierarchy. Any combination of JAR files and exported.class files can be used.
 Deploying the BookmarkListView AppletIn this section you export the BookmarkListView applet as a JAR file andaccompanying HTML file and access it from a Web browser.
 Follow these steps to deploy the BookmarkListView applet:
 1. Select the itso.bookmark.applet and itso.bookmark packages and selectFile→Export. In the Export to a jar file SmartGuide (Figure 186 on page341):
 a. Click the Jar File radio button and then click Next> to continue.
 b. Select the root directory of the Web server that you have installed. Forexample, if you installed the Domino Go Web server into C:\WWW,select C:\WWW\HTML. If you are using or are going to use the Webserver for production purposes, you may want to configure the Webserver for a different directory.
 c. Name the JAR file: Bookmark.jar.
 d. Click the Deselect BeanInfo and Property Editor button.
 e. Select the Do you want to create a .html files to launch appletsand the Compress the contents of the jar file checkboxes.
 f. Click Finish.
 2. Set the CLASSPATH on your machine to point to the JFC classes andstart the Web browser. Enter the URL
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(http://hostname/BookmarkListView.html) in the location field and pressEnter. Figure 188 on page 342 shows the running applet.
 Figure 186. Exporting the BookmarkListView Applet
 Figure 187. Starting Netscape Navigator
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Figure 188. Running the BookmarkListView Applet
 Deploying Supporting CodeQuite often you have to supply code with your Java programs that you didnot create. Typically these are packaged in JAR, Zip, or CAB (for Microsoft
 BordersYou might think that the BookmarkListView applet could use someseparation from the surrounding HTML page. In the VisualComposition Editor you can set a border on Swing componentsusing the border property. You can select from a list of predefinedborders or code your own.
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Internet Explorer) files. If you are deploying an applet, you can use theARCHIVE tag to specify these other JAR files. If you are developing servletsor applications, you must place the JAR file in the CLASSPATH of theapplication or servlet. Deploying a program that uses the Data Access beansin VisualAge for Java is a good example.
 To deploy a program that uses the Data Access beans, you must package therequired JAR files with the program or make them available to the program.Programs using the Data Access beans and DB2 need access to:
 ❑ ivjdab.jar Data Access beans JAR file (found in IBMVJava\eab\runtime20)
 ❑ db2java.zip (found in SQLLIB\java)
 For example, an applet using the Data Access beans might have an APPLETtag like this:
 <APPLET CODE=MyDBAccessApplet.class WIDTH=250 HEIGHT=300 ARCHIVE=ivjdab.jar, db2java.zip>
 In the above APPLET tag the applet class and the two JAR files would existin the same directory as the HTML file.
 To deploy an application, you would place the two JAR files in a directory (forexample, C:\JAVACLASSES) and then reference the JAR files explicitly inthe CLASSPATH. For example:
 SETCLASSPATH=%CLASSPATH%;C:\JAVACLASSES\ivjdab.jar;C:\JAVACLASSES\db2java.jar;
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11 Advanced TopicsThis chapter introduces you to these advanced features of VisualAge for JavaProfessional:
 ❑ Interface to external SCM tools
 ❑ AgentRunner: Lotus Domino Connection
 ❑ Remote Method Invocation
 ❑ Tool Integration Framework
 Interface to External SCM ToolsSoftware configuration management (SCM) is the process of managingchanges to the components of your software development effort. SCMhelps members of a development team retrieve and build any versionof an application in a consistent and repeatable manner.
 VisualAge for Java provides a development environment that uses anobject-based source code repository. This is VisualAge for Java’simplementation of SCM; it provides software configuration support fordevelopment projects and support for multiple versions of program code.
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Version control and repository management are integrated into VisualAge forJava. The repository offers excellent support for day-to-day teamprogramming activities. However, you may want to use the interface toexternal SCM tools if your development process requires:
 ❑ Defects or features to be linked to specific code levels
 ❑ Documentation or other development artifacts be versioned along with thecode
 ❑ The use of a particular SCM system or tool
 ❑ Automated building, packaging, and testing outside the VisualAge forJava environment
 ❑ That some members of the development team use an alternative Javadevelopment environment
 The integration of VisualAge for Java and the SCM tool is based on importingand exporting Java source code. The editions and versions within theVisualAge for Java repository do not relate to versions within the SCM tool.For example, you can check a class into the SCM tool but still modify itwithin VisualAge for Java. There is no relationship between the versionnames in VisualAge for Java and the versions used by the SCM tool.
 The development flow when working with an external SCM tool is:
 1. Create the class within VisualAge for Java and then add it to the SCMtool archive. The term archive simply refers to the location where theSCM tool stores the files under source control.
 2. Check out the class from the archive.
 3. Work on the class until a desired level of functionality or a baseline isreached.
 4. Check the class into the SCM tool.
 Preparing to Connect to the SCM Tool from VisualAge for JavaVisualAge for Java Version 2 on Windows platforms offers an interface forchecking source files (.java) in and out of an external SCM system. Thisinterface is a complementary feature that you can select when you installVisualAge for Java. The interface to external SCM tools uses the MicroSoftSource Code Control (SCC) interface to communicate with SCM tools. Itsupports the following SCM tools:
 • ClearCase 3.2 for Windows NT, from Rational Software Corporation
 • PVCS Version Manager 6.0, from INTERSOLV, Inc.
 • VisualAge TeamConnection Version 3.0, from IBM Corporation
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The interface to external SCM tools is fully described in the VisualAge forJava product documentation and README files.
 Before you can use the interface to external SCM tools you must:
 1. Install the client code for your SCM tool and any required SCCfunctionality on your workstation
 2. Ensure that the ProviderRegKey variable in theHKEY_LOCAL_MACHINE\SOFTWARE\SourceCodeControlProviderregistry entry is set to your SCM tool (Figure 189). If this variable doesnot appear, refer to the SCC function of your SCM tool’s documentation. Ifyou are not familiar with the Windows registry or the regedit utility, donot attempt to modify the registry.
 Figure 189. ProviderRegKey in the Windows NT Registry
 3. Have access to at least one work directory that your SCM tool recognizes.
 4. Create or have access to an organizational structure that your SCM toolwill use to manage your .java files. Depending on the SCM software thatyou use, one or more of the following organizational units may berequired:
 Using SCM ToolsCheck the Web site of the SCM tool vendor before using theinterface to external SCM tools to see whether any fixes orpatches to the SCM tool or SCC interface are required.
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❑ Version object bases (VOBs) and views (ClearCase)
 ❑ Project files (PVCS Version Manager)
 ❑ Families, releases, components, and work areas (VisualAgeTeamConnection)
 You will need this organizational information when you define yourSCM connection.
 In addition you should:
 ❑ Test your native SCM client with the structure mentioned above. A goodexercise is to export a few classes from VisualAge for Java to the filesystem and to check them in, using your native SCM client program.
 ❑ Be familiar with settings that your SCM tool requires, such as drivemappings, file mounts, or the creation of views.
 Some SCM tools may also need to be reconfigured to handle four-character(.java) file extensions.
 Setting your SCM Connection ParametersThis example uses PVCS Version Manager Version 6. If you use another SCMtool, the example may differ. If you experience problems using PVCS, run theChange Connection action before any other SCM action. You must create aPVCS project and archive directory before working with the example.
 Before you can use the VisualAge for Java interface for checking classes inand out of an external SCM tool, you must set your default SCM connectionparameters. Follow these steps to establish the default parameters for yourexternal SCM connection:
 1. Select any VisualAge for Java project, package, or class in the Workbenchwindow.
 2. From the pop-up menu, select Tools→External SCM→ChangeConnection (Figure 190). The SCM Connection dialog box opens (Figure191 on page 348).
 346 Programming with VisualAge for Java Version 2

Page 375
                        

Figure 190. VisualAge for Java’s Interface to External SCM Tools
 3. Click Change to request a list of projects that your SCM tool recognizes.The term project refers to your SCM tool’s basic unit of organization (seeFigure 191).
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Figure 191. Changing the SCM Connection
 4. Select a project from the list. (If you are using ClearCase, it does notactually matter which project you select from the list.) The SCMConnection dialog box reappears, with the Project Name field filled in(Figure 191).
 5. Click Browse to select a default work directory that the SCM interfaceshould use when it adds Java files to source control and checks them intothe SCM repository (Figure 191).
 6. Click OK in each dialog box.
 These parameters will be passed from VisualAge for Java to your externalSCM tool when you check classes in and out or perform other SCMoperations.
 Interface to External SCM FunctionsThe external SCM functions listed below are available from theSelected→Tools menu (Figure 192). The menu is contextual and depends onthe current selection in VisualAge for Java. The Compare and Propertiesactions are available only for classes.
 ❑ Change Connection: Set up or modify the connection to the SCM tool.
 348 Programming with VisualAge for Java Version 2

Page 377
                        

❑ CheckIn: Check the source for Java classes into the SCM archive.
 ❑ CheckOut: Check the source for Java classes out of the SCM archive.Replace the editions that were in your workspace with the new openeditions.
 ❑ Undo Checkout: Leave the current version in the archive and mark it aschecked in.
 ❑ Get Latest: Retrieve the latest version from the repository but do notmark it as checked out. Replace the editions that were in your workspacewith the new open editions.
 ❑ Add: Add new classes, that exist in VisualAge for Java, to the archive.
 ❑ Launch SCM Program: Start the client SCM application.
 ❑ Compare: Compare a Java class in VisualAge for Java with a version inthe SCM tool.
 ❑ History: Show the SCM history for a class.
 ❑ Properties: Show the SCM properties for a class.
 Most of the SCM functions support the selection of projects, packages,classes, or interfaces. For example, if you select a package and then CheckIn, all the types within the package are checked in to the archive.
 Figure 192. External SCM Functions Menu
 Visual and Bean InformationRemember that you are now working with Java source code. If youhave classes that were generated in the Visual CompositionEditor, make sure the Generate meta data method option inthe Design Time section of the Options dialog box is selected. Inaddition, add the BeanInfo class to the archive if a BeanInfo existsfor any given bean and check the bean and BeanInfo class in andout together.
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Adding Classes Before you can check classes in to and out of an SCM tool, you must add themto source control in the SCM tool’s repository.
 Follow these steps to add classes and interfaces from VisualAge for Java tosource control in the SCM repository:
 1. From the Workbench window, select one or more projects, packages,classes, or interfaces.
 2. From the pop-up menu, select Tools→External SCM→Add. VisualAgefor Java passes the list of classes and interfaces to the SCM tool, whichvalidates the request.
 3. If there are no problems, the Set Comments dialog box appears (Figure193). Enter any comments that you want the SCM tool to log when it addsthe .java files to its repository. Click OK.
 Figure 193. Adding Files to the SCM
 VisualAge for Java exports the classes and interfaces to the file system onyour computer, in the work directory that you specified when you set yourSCM connection parameters (Figure 193). Next, VisualAge for Java
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invokes the SCM client function to add those source files to the SCMarchive.
 4. Wait for the Operation Complete dialog box (Figure 193) to appear beforeyou do any other software configuration tasks. Click OK to close theOperation Complete dialog box.
 Checking Out ClassesYou have the choice of checking out classes, interfaces, or complete projectsand packages from your SCM tool. When you can select classes andinterfaces, VisualAge for Java automatically:
 ❑ Invokes your SCM client software to check out the most recent version ofeach class and interface
 ❑ Creates new open editions of the classes and interfaces in the VisualAgefor Java repository
 ❑ Replaces the editions that were in your workspace with the new openeditions
 Follow these steps to check classes and interfaces out of your SCM tool’srepository:
 1. From the Workbench window, select the classes and interfaces that youwant to check out, or select the projects or packages that contain theclasses you want to check out.
 2. From the pop-up menu, select Tools→External SCM→Checkout.VisualAge for Java passes the list of classes and interfaces to the SCMtool, that validates the request.
 Synchronizing VisualAge and the External SCM ToolAs you create new classes and interfaces in your VisualAgefor Java projects and packages, remember to add them tothe SCM repository as well. There is no automatedrelationship between the VisualAge for Java source coderepository and external SCM repositories. The classes andinterfaces remain in your VisualAge for Java workspace andrepository. When you want to change them, remember tocheck them out of the SCM repository. VisualAge for Javadoes not enforce SCM checkout, but your SCM tool does notallow you to check in changes to program elements that youhave not checked out.
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3. If there are no problems, the Set Comments dialog box appears. Enter thecomments that you want the SCM tool to log when it checks the classesout of its repository. Click OK.
 Undoing CheckoutFollow these steps to undo a previous Checkout action:
 1. From the Workbench window, select the classes and interfaces for whichyou want to undo the checkout action.
 2. From the pop-up menu, select Tools→External SCM→Undo Checkout.
 3. VisualAge for Java passes the list of classes and interfaces to the SCMtool, that validates the request.
 4. If there are no problems, the Operation Complete dialog box appears.Click OK.
 Checking In ClassesClasses or interfaces that are checked out of your SCM tool remain checkedout until you either check them back in again or undo the checkout operation.Follow these steps to check classes and interfaces from VisualAge for Javainto the SCM repository:
 1. From the Workbench window, select one or more projects, packages,classes, or interfaces.
 2. From the pop-up menu, select Tools→External SCM→Checkin.VisualAge for Java passes the list of classes and interfaces to the SCMtool, that validates the request.
 3. If there are no problems, the Set Comments dialog box appears. Enter anycomments that you want the SCM tool to log when it checks the files intoits repository. Click OK.
 4. VisualAge for Java exports the classes and interfaces to the file system onyour computer in the work directory that you specified when you set yourSCM connection parameters. Next, VisualAge for Java invokes the SCMclient function to check those Java files into the SCM repository.
 5. If there are no problems, the Operation Complete dialog box appears.Click OK.
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Getting the Latest VersionFor testing or integration purposes you might want to have the most recentversions of classes and interfaces without checking them out. Follow thesesteps to get the most recently checked-in versions of classes and interfacesfrom your SCM repository:
 1. From the Workbench window, select the classes and interfaces that youwant to retrieve, or select the projects or packages whose classes you wantto retrieve.
 2. From the pop-up menu, select Tools→External SCM→Get Latest.VisualAge for Java passes the list of classes and interfaces to the SCMtool, that validates the request.
 3. If there are no problems, the Operation Complete dialog box appears.Click OK. Open editions of the classes and interfaces are created in theVisualAge for Java repository and are added to your workspace.
 As with checkout, when you get the latest classes and interfaces from yourSCM library, VisualAge for Java:
 ❑ Retrieves the most recently checked-in versions of the classes andinterfaces, from the project that you specified when you set your SCMconnection parameters, and copies them to the work directory that youspecified.
 ❑ Automatically imports the class files from the work directory to theVisualAge for Java repository and creates new open editions of theclasses.
 ❑ Replaces the editions that were in your workspace with the new openeditions.
 Launching the SCM Tool from VisualAge for JavaTo launch the SCM tool client:
 Using Undo Checkout instead of CheckinIf you have not modified a class but want to check it in to the SCMarchive, use the Undo Checkout action instead of Checkin.Depending on the SCM tool that you use, when you try to check infiles that have not changed, you may see an error messageindicating that the SCM operation failed.
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1. From the Workbench window, select one or more projects, packages,classes, or interfaces.
 2. From the pop-up menu, select Tools→External SCM→Launch SCMProgram.
 Comparing ClassesYou may want to compare the edition of a checked out class that is in yourworkspace with a previous edition in the SCM tool’s repository:
 1. From the Workbench window, select the class or interface.
 2. From the pop-up menu, select Tools→External SCM→Compare.VisualAge for Java passes the class name to the SCM tool for validation.Depending on the SCM tool, you may have several comparison options.With PVCS you have the choice of comparing (Figure 194):
 • A revision and a workfile
 • Two workfiles
 • Two revisions in one archive
 • Revisions in two archives
 Figure 194. PVCS Compare Function
 3. If there are no problems, the class is automatically exported from theVisualAge for Java repository to the file system on your workstation, inthe work directory that you specified when you set your SCM connectionparameters.
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If the automatic export step is successful, VisualAge for Java invokes thecompare function of your SCM software program.
 If the export is not successful, confirm that you have checked the class outof the SCM repository. (If the file is checked in, the file status in the workdirectory is read-only.)
 PropertiesFor classes, you can also view the SCM properties, that is, the classes’present status in the external SCM tool.
 Follow these steps to invoke the Properties action:
 1. From the Workbench window, select the class or interface.
 2. From the pop-up menu, select Tools→External SCM→Properties. Adialog box appears with the present status and property of the selectedclass (Figure 195).
 .
 Figure 195. External SCM Property Function Using PVCS
 SCM HistoryYou may want a history of SCM events for selected classes and interfaces.Examples of SCM events include:
 ❑ Adding classes to source control
 ❑ Checking in and out of the SCM repository
 ❑ Undoing checkout
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Follow these steps to request a history of the SCM events:
 1. From the Workbench window, select one or more projects, packages,classes, or interfaces. You can select projects or packages as a convenientway of seeing the SCM history of all of their contained classes andinterfaces at once.
 2. From the pop-up menu, select Tools→External SCM→History.VisualAge for Java passes the list of classes and interfaces to the SCMtool, that validates the request (Figure 196). To view a detailed reportclick on View Report.
 3. If there are no problems, the SCM client software on your workstation isinvoked to display a history for the selected classes and interfaces.
 Figure 196. External SCM History Function
 AgentRunner: Lotus Domino ConnectionLotus Domino is an applications and messaging server that enables you tohost secure, interactive business solutions for the Internet and corporateintranets. A Domino agent is a piece of software that runs within the Dominoenvironment and is invoked by specific actions such as receiving mail.
 The AgentRunner included with VisualAge for Java enables you to build anddebug Domino agents within VisualAge for Java while still accessing LotusDomino. The powerful development and debugging features of VisualAge forJava can then be used to tune and perfect your agent before you export theproduction code to the Domino environment. Using the Domino Java ClassLibraries, also included with VisualAge for Java, you develop agents andthen use the AgentRunner to provide the Domino environment whiledebugging. For more information about the Domino Java Class Libraries seethe Lotus documentation at http://www.lotus-developer.com/. For further
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information about the AgentRunner, see the VisualAge for Javadocumentation and README files.
 In this section you will create a simple Domino agent that searches your mailfolder for all mail that has a subject field that contains the subject field of aselected mail document. The results are mailed back to the user.
 The general steps for creating a Domino agent within VisualAge for Java are:
 1. Set up the VisualAge for Java and Domino environments.
 2. Create the agent’s classes.
 3. Generate an AgentContext document in Notes.
 4. Test and debug the agent in VisualAge for Java.
 5. Deploy the agent.
 The rest of this section demonstrates the example in a Windows NTenvironment, where:
 ❑ The Lotus Notes client is installed in: C:\LOTUS\NOTES. You need a LotusNotes 4.6 or later client installed on your computer with access to a LotusDomino server.
 ❑ VisualAge is installed in D:\IBMVJAVA. Substitute the correct pathnamesfor your environment as you work through the example.
 Setting Up The EnvironmentFollow these steps to set up the VisualAge for Java and Notes environmentsfor agent development:
 1. Add the D:\IBMVJava\ide\runtime\IVJAgentRunner.jar file to theJavaUserClasses statement in your C:\WINNT\NOTES.INI file. If you do nothave a JavaUserClasses statement, use this one:JavaUserClasses=D:\IBMVJava\ide\runtime\IVJAgentRunner.jar. Put thestatement at the top of the notes.ini file.
 Because you have edited the notes.ini file, you must shut down andrestart your Notes client so that your changes take effect.
 2. Add your Notes directory (C:\LOTUS\NOTES) to your PATH environmentvariable. You must restart your computer or your session once you havechanged your PATH statement.
 3. Copy D:\IBMVJava\ide\runtime\AgentRunner.nsf to C:\lotus\notes\data.This is the database that will hold the AgentContext that theAgentRunner uses.
 4. Use the Quick Start→Add Feature function to add the Domino JavaClass Library 4.6.1 project from the repository to the environment.
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Creating the AgentThe agent you create in VisualAge for Java initially must be a subclass oflotus.notes.DebugAgentBase. Once you are satisfied with the code, you willchange the superclass to lotus.notes.AgentBase and deploy the agent.Follow these steps to create the agent:
 1. Create a new package called itso.notes.agents in the Programming VAJ V2project.
 2. Create a new class, SearchMail, that extends lotus.notes.DebugAgentBase.Use the SmartGuide to import the lotus.notes package into SearchMail.
 Notes agents need a NotesMain method, which is invoked when the agentis started. Within the NotesMain method, the agent creates a Notes sessionand an agent context. Then the agent connects to the database and readsthe mail.
 3. Create the public void NotesMain() method in SearchMail. The code forthe NotesMain method is combined in this step with the text describing thecode. You can copy the complete code from the SearchMail.java file in theexamples.
 All of the code must be enclosed in a try block because many of themethods in the Domino Java classes throw the NotesException.
 public void NotesMain(){try{
 Get the session from the AgentBase:
 Session session = getSession();
 A Session is the root of the Notes back-end object containment hierarchy,providing access to the other Notes objects, and represents the Notesenvironment of the current program.
 Get the agent context, that is, the agent environment of the currentprogram:
 AgentContext ac = session.getAgentContext();
 Get the current database where the agent is running:
 Database db = ac.getCurrentDatabase();
 Get the currently highlighted document in the view (discontinue if thereare no documents selected):
 Document doc = ac.getDocumentContext();if (doc != null) {
 Get the Subject field of the current document (discontinue if there is noSubject field).
 String subject = doc.getItemValueString("Subject");
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if (subject != null) {
 Find all documents in the database that contain the selected document’ssubject (discontinue if there are no matches):
 DocumentCollection dc = db.FTSearch("FIELD Subject contains " + subject);
 if (dc.getCount() > 0) {
 Create a new Newsletter document containing the document links:
 Newsletter nl = session.createNewsletter(dc);
 Make the matched document’s subject line the subject shown in theDocLink:
 nl.setSubjectItemName("Subject");
 Set the format, form type, and subject and send the results to the currentuser:
 Document nlDoc = nl.formatMsgWithDoclinks(null);nlDoc.appendItemValue("Form", "Memo");nlDoc.appendItemValue("Subject",
 "Documents with subject ’" + subject + "’");
 nlDoc.send(false, session.getUserName());}
 }}else{
 System.err.println("Error: No document context");}
 }catch( NotesException e){
 System.err.println("Error, Notes Exception: " + e);}
 }
 Installing and Preparing the Agent for AgentRunner Testing1. Export the SearchMail class to a class file (Figure 197).
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Figure 197. Exporting the SearchMail Class
 2. Start your Notes client (Lotus Notes 4.6 or later and open your Maildatabase.
 3. Select Create→Agent from the menu bar. The Untitled Agent dialog boxappears (Figure 198):
 a. Enter a name for the agent, such as SearchMail.
 b. Select Manually From Actions Menu in the When should this agentrun field.
 c. Select Selected documents from the Which document(s) should it acton field.
 d. Select the Java radio button for the What should this agent run field.
 e. Click the Import class files button.
 f. Select the SearchMail.class file in the directory hierarchy to which youexported it (Figure 199).
 g. Click Add.
 h. Click OK.
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i. Press the Esc key to close the Create Agent window. When askedwhether to save your changes, click Yes.
 Figure 198. Creating the SearchMail Agent
 Figure 199. Importing the Class
 4. Run the agent: Open the mail database, select a mail message, and selectActions→SearchMail from the Notes client menu bar. Running the
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agent from within the Notes environment, using an agent that subclassesDebugAgentBase, will create the AgentContext document that is needed torun the agent in the VisualAge for Java IDE. It will not actually run thecomplete agent (getSession returns null). Figure 200 shows theAgentContext document and database.
 Figure 200. AgentContext Database
 Testing with AgentRunnerNow that you have created your agent and the AgentContext, you can runand test the agent within VisualAge for Java:
 1. Set a breakpoint somewhere within the NotesMain code.
 2. Select the SearchMail class and then select Selected→Tools→AgentRunner→Run. The agent will stop at the breakpoint, and you caninspect and debug the code even though it is accessing the Notesenvironment (Figure 201).
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Figure 201. Debugging the Agent
 3. Click the Resume button in the debugger. The agent will run and sendyou a mail message that contains links to all documents in the databasethat have the same subject as the document selected when you originallycreated the AgentContext.
 If you need to change the SearchMail class, make sure you repeat these steps:
 1. Export the class from VisualAge for Java.
 2. Import the class into the Notes client. You can access the agent by openingthe Agents view.
 3. Run the agent from within Notes to regenerate the AgentContext.
 You can also open the AgentContext database and delete any earlier contexts.
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You can also run the agent or change the properties of the AgentContext,using Selected→Tools→Agent Runner→Properties (Figure 202 andFigure 203).
 Figure 202. The AgentRunner Properties Dialog Box
 Figure 203. The AgentRunner Properties - Update AgentContext Dialog Box
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Deploying the AgentTo deploy the agent, change the DebugAgentBase superclass to AgentBase andrepeat the steps for changing the SearchMail class. Figure 204 shows themail message from the agent.
 Figure 204. Mail Message Sent by the SearchMail Agent
 Remote Method Invocation: A RefresherYou have seen how to use servlets to distribute the Bookmark List applet.Another option for Java distribution is RMI. Using RMI, clients can obtainreferences to remote objects and invoke methods on those objects.
 From a conceptual point of view, RMI enables a Java application to call aremote Java object as if it were on the local machine. From an applicationpoint of view, one object invokes a method in another object, RMI providesthe necessary services to locate the remote object, route the method call with
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all its parameters through TCP/IP to the server, invoke the method on theserver object, and pass back the return object along the same path (Figure205 on page 367).
 RMI sends objects over the network. To transmit objects over the network,the RMI system serializes objects before they are transmitted anddeserializes them at the other end. Therefore, any object that is to be used inRMI must implement the java.io.Serializable interface.
 ArchitectureRMI calls are handled by different layers until they eventually arecommunicated from the client to the server, where they cross the samenumber of layers until they arrive at the server object (Figure 205 on page367).
 Stub and SkeletonThe stub and skeleton classes are the interfaces between the applicationlayer and the rest of the RMI system. The stub resides on the client andmarshals the arguments, triggers the call to the remote object by calling theremote reference layer, and unmarshals return objects and exceptions.
 The skeleton on the server side is responsible for unmarshaling thearguments, calling the server object, and marshaling the return objects andexceptions.
 Remote Reference LayerThe remote reference layer has a client and a server component. It isresponsible for maintaining a reference protocol between the componentsthat is independent of a specific stub or skeleton. It keeps references andreconnects if a connection is lost.
 Transport LayerThe transport layer creates and monitors the connections on behalf of theremote reference layer. It establishes socket connections and passes theconnections to the remote reference layer. It also listens for incoming callsand sets up connections for them.
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Figure 205. RMI Architecture
 The high-level steps for using RMI to create a distributed system are:
 1. Create a server interface that extends java.rmi.Remote.
 2. Create a server implementation that extendsjava.rmi.UniCastRemoteObject.
 3. Generate the stub and skeleton classes.
 4. Create a client that obtains a remote reference to the server and performsthe application functions.
 To run the distributed system you must:
 1. Instantiate the RMI server object on the server computer. The RMI objectthen:
 a. Sets a Security Manager
 b. Registers itself with the RMI Naming Registry on the server
 2. Invoke the client, which:
 a. Sets a security manager, if required
 b. Obtains a remote reference to the server object
 For more information, see the JDK documentation.
 RMI Using VisualAge for JavaVisualAge for Java Professional supports RMI through the RMI - GenerateStub and Skeleton selection on the Tools menu. This function is much thesame as using the rmic compiler in the JDK.
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 RMI
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If you are planning on doing further RMI development, VisualAge for JavaEnterprise provides more support for RMI through the RMI Proxy Builder,which builds the complete RMI infrastructure from a simple nondistributedJavaBean.
 Distributing the BookmarkListBecause you created the Bookmark List by using a controller that separatedthe view from the data, the distribution of the BookmarkList is fairly simple.For this exercise you make the BookmarkListController a remote object thatthe client will access through RMI.
 Follow these steps to build the distributed Bookmark List:
 1. Create a new package, itso.bookmark.rmi. Copy theBookmarkListController and BookmarkListView classes from theitso.bookmark.applet package to the new itso.bookmark.rmi. Select theclasses and Selected→Reorganize→Copy. In the Copying types dialogbox (Figure 206 on page 368), enter itso.bookmark.rmi, deselect Rename(copy as), and click OK.
 Figure 206. Copy Types Dialog
 Because the BookmarkListView class uses the controller from the appletpackage, the copy produces an error that you will fix later.
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Figure 207. The Morph Into Feature
 Three methods must be exposed on the BookmarkListController:
 • addEntry
 • deleteEntry
 • getBookmarkList
 2. Using the Selected→Add→Interface menu item, create a new interface,BookmarkListControllerI, that extends java.rmi.Remote (Figure 208). Addthe three methods to the interface, specifying that each method can throwthe java.rmi.RemoteException. All methods in the interface must throwthis exception. The three method declarations look like this:
 public void addEntry(String title, String url) throws java.rmi.RemoteException;
 public void deleteEntry(String title) throws java.rmi.RemoteException;
 public com.sun.java.swing.DefaultListModel getBookmarkList() throws java.rmi.RemoteException;
 Another Shortcut for Adding MethodsYou have already seen that you can create new methods by typingover an existing method. Two other ways of creating the firstmethod in a class or interface are:1. Use the Selected→Method Template menu item and thentype over the method template and replace it usingShift-Control-S.2. Create the method in the class declaration.
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Figure 208. Creating the BookmarkListControllerI Interface
 3. Change the BookmarkListController class declaration to:
 public class BookmarkListController extends java.rmi.server.UnicastRemoteObject implements BookmarkListControllerI
 You get an error because there is no default constructor that throwsjava.rmi.RemoteException.
 4. Replace the default constructor:
 public BookmarkListController() throws java.rmi.RemoteException{}
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5. Add a main function to the BookmarkListController:
 public static void main( String argv[]) {
 try{java.rmi.registry.LocateRegistry.createRegistry(1099);// start manuallyBookmarkListController controller = new BookmarkListController();System.out.println( "Registering the Security Manager ...");System.setSecurityManager( new java.rmi.RMISecurityManager());System.out.println("Publishing the server");java.rmi.Naming.rebind("rmi:///Controller1", controller);System.out.println("Controller server is ready");
 }catch( Exception e){
 System.out.println("Exception caught: " + e.getMessage());}
 }
 6. Select BookmarkListController and Selected→Tools→RMI - GenerateStub and Skeleton to generate:
 BookmarkListController_SkelBookmarkListController_Stub
 7. Delete the old void init( JApplet applet) method from theBookmarkListController and the server is complete. Now you need tomake a few changes in the BookmarkListView client.
 8. Open the BookmarkListView class in the Visual Composition Editor anddrop a variable on the free-form surface of type BookmarkListControllerIand name it RemoteController. (Always use the interface of the remoteobject, not the stub.) Delete the connection from AtmView.init toController.init. Drag the rest of the Controller’s connections to the newRemoteController. Delete the original Controller.
 9. Change the Source event to this on the property-to-property connectionfrom the RemoteController.bookmarkList to URLList.model.
 Locating the RMI Stub and Skeleton ClassesYou can start the RMI registry from the VisualAge for JavaProfessional Options dialog box. However, unless you haveexported your stub, skeleton, and interface classes and addedtheir location to the VisualAge for Java Class Path, they will notbe found.An alternative is to start the RMI Registry in the code of theserver object as you do in this example using createRegistry.
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10. Create a new event-to-code connection from AtmView.init to a newmethod:
 public BookmarkListControllerI initRMI( String serverName){
 BookmarkListControllerI server = null;try{
 String urlString = "rmi://" + serverName + "/Controller1";server = (BookmarkListControllerI)
 java.rmi.Naming.lookup( urlString);}catch( Exception e){
 handleException(e);}return server;
 }
 11. Set the serverName parameter on the connection to your host name.Connect normalResult of the connection to RemoteController.this.
 12. If you did not do so earlier, change the class declaration of the Bookmark toimplement Serializable:
 public class Bookmark implements java.io.Serializable
 Now the BookmarkList will work, but the updates will not be shown in thelist because the client has no way of knowing the list has changed.
 13.Create the connections in Table 17 to cause the list to update:
 Table 17. BookmarkList Connection Details
 ConnectionNumber inFigure 209
 ConnectionType
 Connection from Connection to Comments
 1 EtoM normalResult ofAddButton.actionPerformed→RemoteController.addEntry
 URLList.setModel
 Use connection 2 asparameter.
 2 PfromP aModel parameteron connection 1
 RemoteController.bookmarkList
 3 EtoM normalResult ofAddButton.actionPerformed→RemoteController,addEntry
 URLList,repaint()
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The other option for automatically updating the URLList is to have the clientimplement a remote object that listens for events from the server. You cancode this option manually, but VisualAge for Java Enterprise automates theconstruction of remote listeners for you and is a good choice if you arebuilding RMI systems.
 4 EtoM normalResult ofDeleteButton,actionPerformed→RemoteController,deleteEntry
 URLList,setModel
 Use connection 5 asparameter.
 5 PfromP aModel parameteron connection 4
 RemoteController,bookmarkList
 6 EtoM normalResult ofDeleteButton,actionPerformed→RemoteController,deleteEntry
 URLList,repaint()
 ConnectionNumber inFigure 209
 ConnectionType
 Connection from Connection to Comments
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Figure 209. The AtmView Client Using the RemoteController
 Testing the RMI BookmarkListViewBefore starting the server, make sure the JFC Project is added to the ClassPath of the BookmarkListView applet and the BookmarkListController class.
 Start the server by selecting the BookmarkListController class and selectingSelected→Run→Run main. Then start the client by selecting theBookmarkListView class and Selected→Run→In Applet Viewer and testthe system.
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Tool Integration FrameworkWith VisualAge for Java Version 2 you can add tools to the environment andprogrammatically access the running environment. Remember, using theTool Integration Framework is advanced development; approach it cautiouslyand read the product documentation.
 In this section you create the BaseLine tool, which gives the same versionname to all program elements within a selected project. This is a nice featureif you are sharing code or using code for demonstration purposes. Again, thisis advanced development and you should be very careful before attempting it.
 You should copy the ivj.dat and ide.icx files to another location, as describedin Backups on page 159, before writing code that modifies elements in yourworkspace.
 If you do complete the exercise, you can easily improve on the BaseLine toolto take different types of program elements or to implement better errorchecking.
 Creating the BaseLine ToolFollow these steps to create the BaseLine tool:
 1. Add the IBM IDE Utility Class Libraries project to your workspace. Inthe Programming with VAJ V2 project create a package called baseline. Thecode you are going to create for the tool is fairly simple. Create a classnamed BaseLine that extends com.sun.java.swing.JFrame. In the CreateClass SmartGuide specify the import of the com.ibm.ivj.util.basepackage.
 2. Open the class in the Visual Composition Editor and set the title of theframe to BaseLine and set the layout of the JFrameContentPane toGridBagLayout.
 3. Add the visual beans in Table 18 to the content pane of the frame asshown in Figure 210 on page 379. Now that you have used theGridBagLayout, you should be able to use the constraints to make yourGUI look like Figure 210. Using the insets property specifies the externalpadding of the component, that is, the minimum amount of space between
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the component and the edges of its display area. You can use the insetsproperty if the components look "squashed" into the panel.
 Table 18. Visual Beans in the BaseLine GUI
 4. Add a variable of type java.lang.System to the free-form surface and nameit SystemVariable, and then save the bean.
 The BaseLine tool is installed into VisualAge for Java so that it can onlybe invoked when you have selected one or more projects. To make theexample simple, you will not check for any errors in the project parameterpassed to the tool or for errors connecting to the workspace.
 5. Add the following attribute to the class declaration:
 Workspace ws = null;WorkspaceModel programElement = null;
 6. Create the following three methods (the BaseLine.java file is in theexample directory so you can also copy the code):
 public void init( String[] args){
 ws = ToolEnv.connectToWorkspace();programElement = ws.loadedProjectNamed(args[1]);getProjectNameLabel().setText(programElement.getName());show();
 }
 public boolean checkVersion( String versionName) {
 try{ProjectEdition[] allEditions =
 ((Project)programElement).getAllEditions();for (int p = 0; p < allEditions.length; p++){
 if( allEditions[p].isVersion()){if( allEditions[p].getVersionName().equals( versionName)){
 Bean Type beanName text
 JLabel N/A Project Name:
 JLabel ProjectNameLabel N/A
 JLabel N/A Version Name:
 JTextField VersionTextField N/A
 JButton ApplyButton Apply
 JButton CancelButton Cancel
 JLabel StatusLabel Enter the version name.
 376 Programming with VisualAge for Java Version 2

Page 405
                        

return false;}
 }}
 }catch( IvjException e){
 getStatusLabel().setText( "Error checking for existing version.");}return true;
 }
 public void makeVersion( String versionName) {
 if( !checkVersion( versionName)){getStatusLabel().setText("Version already exists.");return;
 }else{
 getStatusLabel().setText("");}try{
 Project project = (Project)programElement;if( programElement.isVersion()){
 project.createNewEdition();}Package[] packages = project.getPackages();for (int p = 0; packages != null && p < packages.length; p++){
 Package pkg = packages[p];if( pkg.isVersion()){
 pkg.createNewEdition();}Type[] types = pkg.getTypes();for (int t = 0; types!= null && t < types.length; t++){
 Type type = types[t];if( type.isVersion()){
 type.createNewEdition();}type.createVersion(versionName, true);
 }pkg.createVersion(versionName);
 }project.createVersion(versionName);
 }catch( IvjException e){
 getStatusLabel().setText( "Error creating new version.");}
 }
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7. Replace the contents of the main method with the following code:
 public static void main(java.lang.String[] args) {
 BaseLine aBaseLine = new BaseLine();aBaseLine.init(args);
 }
 8. Make the connections indicated in Table 19.
 Table 19. BaseLine Connections
 ConnectionNumber inFigure 210
 ConnectionType
 Connection from Connection to Comments
 1 EtoM BaseLine,windowClosed(from free-formsurface)
 SystemVariable,exit()
 Exit the application.You do not have tosupply a parameter.
 2 EtoM CancelButton,actionPerformed
 BaseLine,dispose() (to free-formsurface)
 Close and dispose ofthe frame.
 3 EtoM ApplyButton,actionPerformed
 BaseLine,makeVersion()
 Invoke the makeVersionmethod. Parameter issupplied in Connection4.
 4 PfromP Connection 3parameter
 VersionTextField,text
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Figure 210. BaseLine Class in the Visual Composition Editor
 Testing the BaseLine Tool in the IDETo test the BaseLine tool you have to set the ClassPath and command lineparameters to simulate VisualAge for Java invoking the tool.
 On the Class Path page of the Properties dialog box in the Workbench, addthe IBM IDE Utility class libraries and the JFC Class libraries project inthe Project path: field and the X:\IBMVJAVA\IDE\project_resources\IBM IDEUtility local implementation directory in the Extra directories path: field,where X is the drive where you installed VisualAge for Java.
 Adding the IDE Utility Classes to the Class PathIn addition to the IBM IDE Utility class libraries project, youmust add the IBMVJAVA\IDE\project_resources\IBM IDE Utilitylocal implementation; in the Extra directories path: field to runtools that use the tool integration facilities.Also, make sure the JFC classes are added to the Class Path forthe BaseLine example.
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On the Program page of the Properties dialog, enter -P project-name in theCommand line arguments: field, where project-name is the name of a projectin your environment. You may want to create a test project with somepackages and classes to test the BaseLine tool.
 The -P project-name represents the selection_group with which your tool willbe invoked. When your tool is run in the VisualAge for Java environment, thecurrently selected projects are passed as the command line arguments to it.
 You can choose to have your tool invoked with no arguments, or with thecurrently selected projects, packages, or types. Your choice will influencefrom which Tools menu the tool is invoked. The selection_group syntax is:
 [-P project1 project2 ...] | [-p package1 package2 ...] | [-c type1 type2 ...][] optional| exclusive or... repeat
 Now run the BaseLine class and enter the new version name for the project.
 Installing the BaseLine ToolThe final step is to deploy your new tool in VisualAge for Java. In order toinvoke your tool from a VisualAge for Java Tools menu, you must:
 1. Create a subdirectory for the tool, called the base directory.
 2. Copy all application classes, resource files, and HTML help into the basedirectory.
 3. Create a control file that provides the IDE with details on the integration.
 4. Optionally create additional control files for other supported languages.
 Adding Class Path Entries and Exporting FilesIf you specified a lower-case drive letter when you installedVisualAge for Java you may encounter errors when trying to addClass Path entries by using the Edit and Add Directorybuttons. VisualAge for Java informs you that it cannot access theprogram directory. If this happens, type the complete Class Pathextension in the Extra directories path field.The same error may occur when exporting files. Make sure youspecify an upper-case drive letter.
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Follow these steps to install the BaseLine tool:
 1. Create the base directory.
 Create a directory under the IBMVJAVA\IDE\TOOLS directory. Thedirectory name should be the complete name (package and class) of themain tool class with the periods replaced by hyphens. Create thedirectory: \IBMVJAVA\IDE\TOOLS\BASELINE-BASELINE.
 2. Copy the tool’s files to the base directory.
 Use File→Export and export the BaseLine.class file to the\IBMVJAVA\IDE\TOOLS\BASELINE-BASELINE directory.
 3. Create the control file.
 Create the control file, default.ini, in the base directory with thefollowing contents:
 Name = BaseLineVersion = 1.0Menu-Items = BaseLine,baseline.BaseLine,-P
 By placing the -P context switch in the Menu-Items line, you cause the menuitem to be added to the Selected menu only when a project is selected.
 The BaseLine tool is simple, it does not have any associated resource or helpfiles, and it is not enabled for any other languages. For more informationabout the control file, see the product documentation.
 Running the BaseLine ToolNow restart VisualAge for Java and select the project where you want tocreate a baseline version. Then select Selected→Tools→BaseLine. Figure211 shows the running tool.
 Figure 211. The Running BaseLine Tool
 Advanced Topics 381

Page 410
                        

382 Programming with VisualAge for Java Version 2

Page 411
                        

A Special NoticesThis publication is intended to help VisualAge for Java developers develop applications using VisualAge for Java Version 2. The information in this publication is not intended as the specification of any programming interfaces that are provided by VisualAge for Java. See the PUBLICATIONS section of the IBM Programming Announcement for VisualAge for Java for more information about what publications are considered to be product documentation.
 References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.
 Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.
 IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM
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Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.
 Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.
 Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.
 The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.
 Any pointers in this publication to external Web sites are provided for convenience only and do not in any manner serve as an endorsement of these Web sites.
 The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:
 The following terms are trademarks of other companies:
 Java, JDBC and HotJava are trademarks of Sun Microsystems,Incorporated.
 Microsoft, Windows, Windows NT, and the Windows 95 logo are trademarksor registered trademarks of Microsoft Corporation.
 PC Direct is a trademark of Ziff Communications Company and is usedby IBM Corporation under license.
 IBM DB2VisualAge WebSphereTeamConnection
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Pentium, MMX, ProShare, LANDesk, and ActionMedia are trademarks orregistered trademarks of Intel Corporation in the United States and othercountries.
 UNIX is a registered trademark in the United States and othercountries licensed exclusively through X/Open Company Limited.
 InstallShield and InstallShield Java Edition are trademarks orregistered trademarks of InstallShield Corporation.
 Netscape and Netscape Navigator are registered trademarks of NetscapeCommunications Corporation in the United States and other countries.
 Lotus, Domino, Domino Go Webserver and Lotus Notes are registeredtrademarks of Lotus Development Corporation in the United States andother countries.
 ClearCase and Rational are registered trademarks of Rational SoftwareCorporation.
 PVCS Version Manager and INTERSOLV are registered trademarks ofINTERSOLV, Inc.
 Other company, product, and service names may be trademarks orservice marks of others.
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B Related PublicationsThe publications listed in this section are considered particularly suitable fora more detailed discussion of the topics covered in this redbook.
 International Technical Support Organization Publications
 For information on ordering these ITSO publications see “How to Get ITSORedbooks” on page 389.
 ❑ VisualAge for Java Enterprise Version 2 Team Support, SG24-5245
 ❑ Application Development with VisualAge for Java Enterprise, SG24-5081
 ❑ Unlimited Enterprise Access with Java and VisualAge Generator,SG24-5246
 ❑ Connecting the Enterprise to the Internet with MQSeries and VisualAge forJava, SG24-2144
 ❑ Factoring JavaBeans in the Enterprise, SG24-5051
 ❑ JavaBeans by Example: Cooking with Beans in the Enterprise, SG24-2035,published by Prentice Hall, 1997
 ❑ Using VisualAge UML Designer, SG24-4997
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Redbooks on CD-ROMsRedbooks are also available on CD-ROMs. Order a subscription andreceive updates 2-4 times a year at significant savings.
 Product DocumentationThe documentation from the following products may be helpful.
 ❑ DB2 Universal Database
 • SQL Getting Started, Version 5, S10J-8156-00
 • SQL Reference, Version 5, S10J-8165-00
 ❑ Lotus Domino Go WebServer
 • Programming Guide
 • Webmasters Guide
 • Quick Beginnings
 ❑ VisualAge for Java
 The VisualAge for Java documentation is available online through theproduct installation and at the VisualAge for Java Web site. It includesthe JDK 1.1.6 documentation.
 For any other Java API documentation, see the JavaSoft Web site.
 CD-ROM Title Subscription Number
 Collection Kit Number
 System/390 Redbooks Collection SBOF-7201 SK2T-2177
 Networking and Systems Management Redbooks Collection SBOF-7370 SK2T-6022Transaction Processing and Data Management Redbook SBOF-7240 SK2T-8038Lotus Redbooks Collection SBOF-6899 SK2T-8039
 Tivoli Redbooks Collection SBOF-6898 SK2T-8044AS/400 Redbooks Collection SBOF-7270 SK2T-2849RS/6000 Redbooks Collection (HTML, BkMgr) SBOF-7230 SK2T-8040
 RS/6000 Redbooks Collection (PostScript) SBOF-7205 SK2T-8041RS/6000 Redbooks Collection (PDF Format) SBOF-8700 SK2T-8043Application Development Redbooks Collection SBOF-7290 SK2T-8037
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Other PublicationsThese publications are also relevant as further information sources:
 ❑ Carrel-Billiard, Marc and John Akerley. 1998. Programming withVisualAge for Java. Englewood Cliffs, NJ: Prentice Hall; ISBN0-13-911371-1
 ❑ Nilsson Dale and Peter Jakab. 1998. Developing JavaBeans UsingVisualAge for Java. New York, NY: John Wiley; ISBN 0-471-29788-7
 ❑ Sanders, Roger E. 1997. The Developer’s Handbook to DB2 for CommonServers, New York, NY: McGraw-Hill, ISBN 0070577250
 ❑ Chamberlin, Don. 1998. A Complete Guide to DB2 Universal Database,San Francisco, CA: Morgan Kaufman; ISBN 1558604820
 ❑ Date, C.J. and Hugh Darwen. 1987. A Guide to the Sql Standard : AUser’s Guide to the Standard Database Language Sql, Reading, MA:Addison-Wesley Publishing Company; ISBN 0201964260
 ❑ Hamilton, Graham, Rick Cattell, and Maydene Fisher. 1997. JDBCDatabase Access with Java: A Tutorial and Annotated Reference (JavaSeries), Reading, MA: Addison-Wesley Publishing Company; ISBN0201309955
 ❑ Reese, George E. 1997. Database Programming with JDBC and Java,Sebastopol, CA: O’Reilly & Associates; ISBN 1565922700
 ❑ Horstmann. Cay S. and Gary Cornell. 1997. Core Java 1.1: Fundamentals,Englewood Cliffs, NJ: Prentice Hall; ISBN: 0137669577
 ❑ Horstmann. Cay S. and Gary Cornell. 1997. Core Java 1.1: AdvancedFeatures, Englewood Cliffs, NJ: Prentice Hall; ISBN: 0137669658
 ❑ Flanagan, David. 1997. Java in a Nutshell: A Desktop Quick Reference,Sebastopol, CA: O’Reilly & Associates; ISBN: 156592262X
 ❑ Topley, Kim.. 1998. Core Java Foundation Classes, Englewood Cliffs, NJ:Prentice Hall; ISBN: 0130803014
 ❑ Rumbaugh, James et al. 1991. Object-Oriented Modeling and Design,Englewood Cliffs, NJ: Prentice Hall; ISBN: 0136298419
 ❑ Jacobson, Ivar. 1992. Object-Oriented Software Engineering : A Use CaseDriven Approach, Reading, MA: Addison-Wesley Publishing Company;ISBN: 0201544350
 ❑ Booch, Grady. 1994. Object-Oriented Analysis and Design withApplications (Addison-Wesley Object Technology Series), Reading, MA:Addison-Wesley Publishing Company; ISBN: 0805353402
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How to Get ITSO Redbooks
 This section explains how both customers and IBM employees can find out about ITSO redbooks, CD-ROMs, workshops, and residencies. A form for ordering books and CD-ROMs is also provided.
 The information in this section was current at the time of publication but is continually subject to change. For the latest information see http://www.redbooks.ibm.com.
 How IBM Employees Can Get ITSO Redbooks
 Employees may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:
 • PUBORDER – to order hardcopies in United States
 • GOPHER link to the Internet – type GOPHER WTSCPOK.ITSO.IBM.COM
 • Tools disks
 To get LIST3820s of redbooks, type one of the following commands:
 TOOLS SENDTO EHONE4 TOOLS2 REDPRINT GET SG24xxxx PACKAGE TOOLS SENDTO CANVM2 TOOLS REDPRINT GET SG24xxxx PACKAGE (Canadian users only)
 To get lists of redbooks:
 TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET ITSOCAT TXT
 To register for information on workshops, residencies, and redbooks:
 TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ITSOREGI 1996
 For a list of product area specialists in the ITSO:
 TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ORGCARD PACKAGE
 • Redbooks Web Site on the IBM Intranet
 http://w3.itso.ibm.com/redbooks
 • IBM Direct Publications Catalog on the World Wide Web
 http://www.elink.ibmlink.ibm.com/pbl/pbl
 IBM employees may obtain LIST3820s of redbooks from this page.
 • REDBOOKS category on INEWS
 • On-line – send orders to: USIB6FPL at IBMMAIL or DKIBMBSH at IBMMAIL
 • Internet Listserver
 With an Internet E-mail address, anyone can subscribe to an IBM Announcement Listserver. To initiate the service, send an E-mail note to [email protected] with the keyword subscribe in the body of the note (leave the subject line blank). A category form and detailed instructions will be sent to you.
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How Customers Can Get ITSO Redbooks
 Customers may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:
 • On-line Orders (Do not send credit card information over the Internet) – send orders to:
 • Telephone orders
 • Mail Orders – send orders to:
 • Fax – send orders to:
 • 1-800-IBM-4FAX (United States) or (+1) 408 256 5422 (Outside USA) – ask for:
 Index # 4421 Abstracts of new redbooksIndex # 4422 IBM redbooksIndex # 4420 Redbooks for last six months
 • Direct Services – send note to [email protected]
 • On the World Wide Web
 • Internet Listserver
 With an Internet E-mail address, anyone can subscribe to an IBM Announcement Listserver. To initiate the service, send an E-mail note to [email protected] with the keyword subscribe in the body of the note (leave the subject line blank).
 In United StatesIn CanadaOutside North America
 IBMMAILusib6fpl at ibmmailcaibmbkz at ibmmaildkibmbsh at ibmmail
 [email protected]@[email protected]
 United States (toll free)Canada (toll free)
 1-800-879-27551-800-IBM-4YOU
 Outside North America(+45) 4810-1320 - Danish(+45) 4810-1420 - Dutch(+45) 4810-1540 - English(+45) 4810-1670 - Finnish(+45) 4810-1220 - French
 (long distance charges apply)(+45) 4810-1020 - German(+45) 4810-1620 - Italian(+45) 4810-1270 - Norwegian(+45) 4810-1120 - Spanish(+45) 4810-1170 - Swedish
 IBM PublicationsPublications Customer SupportP.O. Box 29570Raleigh, NC 27626-0570USA
 IBM Publications144-4th Avenue, S.W.Calgary, Alberta T2P 3N5Canada
 IBM Direct ServicesSortemosevej 21DK-3450 AllerødDenmark
 United States (toll free)CanadaOutside North America
 1-800-445-92691-800-267-4455(+45) 48 14 2207 (long distance charge)
 Redbooks Web SiteIBM Direct Publications Catalog
 http://www.redbooks.ibm.comhttp://www.elink.ibmlink.ibm.com/pbl/pbl
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IBM Redbook Order Form
 Please send me the following:
 We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card notavailable in all countries. Signature mandatory for credit card payment.
 Title Order Number Quantity
 First name Last name
 Company
 Address
 City Postal code
 Telephone number Telefax number VAT number
 Invoice to customer number
 Country
 Credit card number
 Credit card expiration date SignatureCard issued to
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Glossary
 This glossary defines terms and abbrevia-tions that are used in this book. If you do notfind the term you are looking for, refer to theIBM Dictionary of Computing, New York:McGraw-Hill, 1994.
 This glossary includes terms and definitionsfrom the American National Standard Dic-tionary for Information Systems, ANSIX3.172-1990, copyright 1990 by the Ameri-can National Standards Institute (ANSI).Copies may be purchased from the AmericanNational Standards Institute, 1430 Broad-way, New York, New York 10018.
 Aabstract class. A class that provides com-mon behavior across a set of subclasses butis not itself designed to have instances. Anabstract class represents a concept; classesderived from it represent implementations ofthe concept. See also base class.
 access modifier: A keyword that controlsaccess to a class, method, or attribute. Theaccess modifiers in Java are public, private,protected, and package, the default.
 accessor methods. Methods that an objectprovides to define the interface to itsinstance variables. The accessor method toreturn the value of an instance variable iscalled a get method or getter method, and themutator method to assign a value to aninstance variable is called a set method orsetter method.
 applet. A Java program designed to runwithin a Web browser. Contrast with appli-cation.
 application. In Java programming, a self-contained, stand-alone Java program thatincludes a main() method. Contrast withapplet.
 application programming interface(API). A software interface that enablesapplications to communicate with each
 © Copyright IBM Corp. 1998
 other. An API is the set of programming lan-guage constructs or statements that can becoded in an application program to obtainthe specific functions and services providedby an underlying operating system or serviceprogram.
 argument. A data element, or value,included as a parameter in a method call.Arguments provide additional informationthat the called method can use to performthe requested operation.
 attribute. A specification of an element of aclass. For example, a customer bean couldhave a name attribute and an addressattribute.
 Bbase class. A class from which other classesor beans are derived. A base class may itselfbe derived from another base class. See alsoabstract class.
 bean. A definition or instance of a Java-Beans component. See also JavaBeans.
 BeanInfo. (1) A companion class for a beanthat defines a set of methods that can beaccessed to retrieve information on thebean’s properties, events, and methods. (2)In the VisualAge for Java IDE, a page in theClass Browser that provides bean informa-tion.
 beans palette. In the Visual CompositionEditor, a pane that contains beans that youcan select and manipulate to create pro-grams. You can add your own categories andbeans to the beans palette.
 break point. A point in a computer programwhere the execution will be halted.
 browser. (1) In VisualAge for Java, a win-dow that provides information about pro-gram elements. There are browsers forprojects, packages, classes, methods, andinterfaces. (2) An Internet-based tool thatlets user browse Web sites.
 393
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C
 category. In the Visual Composition Editor,a selectable grouping of beans on the palette.Selecting a category displays the beansbelonging to that category. See also beanspalette.
 class. A template that defines properties,operations, and behavior for all instances ofthat template.
 class hierarchy. The relationships amongclasses that share a single inheritance. AllJava classes inherit from the Object class.
 class library. A collection of classes.
 class method. See method.
 CLASSPATH. (1) In VisualAge for Java thelists of pathnames which will be searched fordynamically loaded classes, BeanInfo infor-mation and external source for debugging.(2) In your deployment environment, theenvironment variable that specifies thedirectories in which to look for class andresource files.
 client/server. The model of interaction indistributed data processing where a programat one location sends a request to a programat another location and awaits a response.The requesting program is called a client,and the answering program is called aserver.
 Class Browser. In the VisualAge for JavaIDE, a tool used to browse the classes loadedin the workspace.
 component model. An architecture and anAPI that allows developers to define reus-able segments of code that can be combinedto create a program. VisualAge for Java usesthe JavaBeans component model.
 composite bean. A bean that is composedof other beans. A composite bean can containvisual beans, nonvisual beans, or both. Seealso bean, nonvisual bean, and visual bean.
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 concrete class. A non-abstract subclass ofan abstract class that is a specialization ofthe abstract class.
 connection. In the Visual Composition Edi-tor, a visual link between two componentsthat represents the relationship between thecomponents. Each connection has a source, atarget, and other properties. See also event-to-method connection, parameter connec-tions, and property-to-property connection.
 console. In VisualAge for Java, the windowthat acts as the standard input (System.in)and standard output (System.out) device forprograms running in the VisualAge for JavaIDE.
 construction from parts. A softwaredevelopment technology in which applica-tions are assembled from existing and reus-able software components, known as parts.In VisualAge for Java, parts are calledbeans.
 constructor. A special class method thathas the same name as the class and is usedto construct and possibly initialize objects ofits class type.
 container. A component that can hold othercomponents. In Java, examples of containersinclude Applets, Frames, and Dialogs. In theVisual Composition Editor, containers can begraphically represented and generated.
 current edition. The edition of a programelement that is currently in the workspace.See also open edition.
 Ddemarshal. To deconstruct an object so thatit can be written as a stream of bytes. Syn-onym for flatten and serialize.
 deserialize. To construct an object from ade-marshaled state. Synonym for marshaland resurrect.
 double-byte character set (DBCS). A setof characters in which each character is rep-resented by 2 bytes. Languages such as Jap-anese, Chinese, and Korean, which contain
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more symbols than can be represented by256 code points, require double-byte charac-ter sets. Compare with single-byte characterset.
 Eedition. A specific “cut” of a program ele-ment. VisualAge for Java supports multipleeditions of program elements. See also cur-rent edition, open edition, and versioned edi-tion.
 encapsulation. The hiding of a softwareobject’s internal representation. The objectprovides an interface that queries andmanipulates the data without exposing itsunderlying structure.
 event. An action by a user program, or aspecification of a notification that may trig-ger specific behavior. In JDK 1.1, eventsnotify the relevant listener classes to takeappropriate actions.
 event-to-method connection. A connec-tion from an event generated by a bean to amethod of a bean. When the connected eventoccurs, the method is executed. See also con-nection.
 Ffactory. A nonvisual bean capable of dynam-ically creating new instances of a specifiedbean.
 feature. (1) A component of VisualAge forJava that is installed separately using theQuickStart. (2) A method, field, or event thatis available from a bean’s interface and towhich other beans can connect.
 field. See attribute
 flatten. Synonymous with demarshal.
 free-form surface. The open area of theVisual Composition Editor where you canwork with visual and nonvisual beans. Youadd, remove, and connect beans on the free-form surface.
 G
 graphical user interface (GUI). A type ofinterface that enables users to communicatewith a program by manipulating graphicalfeatures, rather than by entering commands.Typically, a GUI includes a combination ofgraphics, pointing devices, menu bars andother menus, overlapping windows, andicons.
 H
 Hypertext Markup Language (HTML).The basic language that is used to buildhypertext documents on the World WideWeb. It is used in basic, plain ASCII-textdocuments, but when those documents areinterpreted, or rendered, by a Web browsersuch as Netscape, the document can displayformatted text, color, a variety of fonts,graphical images, special effects, hypertextjumps to other Internet locations, and infor-mation forms.
 Hypertext Transfer Protocol (HTTP).The protocol for moving hypertext filesacross the Internet. Requires an HTTP clientprogram on one end, and an HTTP serverprogram on the other end. HTTP is the mostimportant protocol used in the World WideWeb.
 IIDE. See Integrated Development Environ-ment.
 inheritance. (1) A mechanism by which anobject class can use the attributes, relation-ships, and methods defined in classes relatedto it (its base classes). (2) An object-orientedprogramming technique that allows you touse existing classes as bases for creatingother classes.
 instance. Synonym for object, a particularinstantiation of a data type.
 integrated development environment(IDE). In VisualAge for Java, the set of win-dows that provide the user with access to
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development tools. The primary windows areWorkbench, Class Browser, Log, Console,Debugger, and Repository Explorer.
 interchange file. A file that you can exportfrom VisualAge for Java that contains infor-mation about selected projects or packages.This file can then be imported into any Visu-alAge for Java session.
 interface. A named set of method declara-tions that is implemented by a class. TheInterface page in the Workbench lists allinterfaces in the workspace.
 Internet. The collection of interconnectednetworks that use TCP/IP and evolved fromthe ARPANET of the late 1960s and early1970s.
 intranet. A private network, inside a com-pany or organization, that uses the samekinds of software that you would find on thepublic Internet. Many of the tools used onthe Internet are being used in private net-works; for example, many companies haveWeb servers that are available only toemployees.
 Internet Protocol (IP). The protocol thatprovides basic Internet functions.
 IP number. An Internet address that is aunique number consisting of four parts sepa-rated by dots, sometimes called a dottedquad (for example: 198.204.112.1). EveryInternet computer has an IP number, andmost computers also have one or moredomain names that are mappings for thedotted quad.
 JJDBC. In JDK 1.1, the specification thatdefines an API that enables programs toaccess databases that comply with this stan-dard.
 Java. A programming language invented bySun Microsystems that is specificallydesigned for writing programs that can besafely downloaded to your computer through
 396 Programming with VisualAge for Java Version 2
 the Internet and immediately run withoutfear of viruses or other harm to your com-puter or files.
 Java archive (JAR). A platform-indepen-dent file format that groups many files intoone. JAR files are used for compression,reduced download time, and security.
 JavaBeans. The specification that definesthe platform-neutral component model usedto represent parts. Instances of JavaBeans(often called beans) may have methods,properties, and events.
 K
 keyword. A predefined word reserved forJava, for example, return, that may not beused as an identifier.
 Llistener. In JDK 1.1, a class that receivesand handles events.
 local area network (LAN). A computernetwork located on a user’s establishmentwithin a limited geographical area. A LANtypically consists of one or more servermachines providing services to a number ofclient workstations.
 log. In VisualAge for Java, the window thatdisplays messages and warnings duringdevelopment.
 M
 marshal. Synonymous with deserialize.
 message. A communication from one objectto another that requests the receiving objectto execute a method. A method call consistsof a method name that indicates therequested method and the arguments to beused in executing the method. The methodcall always returns some object to therequesting object as the result of performingthe method. Synonym for method call.
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method. A fragment of Java code within aclass that can be invoked and passed a set ofparameters to perform a specific task.
 method call. Synonymous with message.
 model. A nonvisual bean that representsthe state and behavior of an object, such as acustomer or an account. Contrast with view.
 mutator methods. Methods that an objectprovides to define the interface to itsinstance variables. The accessor method toreturn the value of an instance variable iscalled a get method or getter method, and themutator method to assign a value to aninstance variable is called a set method orsetter method.
 Nnamed package. In the VisualAge for JavaIDE, a package that has been explicitlynamed and created.
 nonvisual bean. In the Visual CompositionEditor, a bean that has no visual representa-tion at run time. A nonvisual bean typicallyrepresents some real-world object that existsin the business environment. Compare withmodel. Contrast with view and visual bean.
 O
 object. (1) A computer representation ofsomething that a user can work with to per-form a task. An object can appear as text oran icon. (2) A collection of data and methodsthat operate on that data, which togetherrepresent a logical entity in the system. Inobject-oriented programming, objects aregrouped into classes that share common datadefinitions and methods. Each object in theclass is said to be an instance of the class. (3)An instance of an object class consisting ofattributes, a data structure, and operationalmethods. It can represent a person, place,thing, event, or concept. Each instance hasthe same properties, attributes, and meth-ods as other instances of the object class,although it has unique values assigned to itsattributes.
 object class. A template for defining theattributes and methods of an object. Anobject class can contain other object classes.An individual representation of an objectclass is called an object.
 object-oriented programming (OOP). Aprogramming approach based on the con-cepts of data abstraction and inheritance.Unlike procedural programming techniques,object-oriented programming concentrateson those data objects that constitute theproblem and how they are manipulated, noton how something is accomplished.
 ODBC driver. An ODBC driver is adynamic link library that implements ODBCfunction calls and interacts with a datasource.
 Open Database Connectivity (ODBC). AMicrosoft-developed C database API thatallows access to database management sys-tems calling callable SQL, which does notrequire the use of an SQL preprocessor. Inaddition, ODBC provides an architecturethat allows users to add modules (databasedrivers) that link the application to theirchoice of database management systems atrun time. Applications no longer need to bedirectly linked to the modules of all the data-base management systems that are sup-ported.
 open edition. An edition of a program ele-ment that can still be modified; that is, theedition has not been versioned. An open edi-tion may reside in the workspace as well asin the repository.
 operation. A method or service that can berequested of an object.
 Ppackage. A program element that containsrelated classes and interfaces.
 palette. See beans palette.
 parameter connection. A connection thatsatisfies a parameter of an action or methodby supplying either a property’s value or the
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return value of an action, method, or script.The parameter is always the source of theconnection. See also connection.
 parent class. The class from which anotherbean or class inherits data, methods, or both.
 part. An existing, reusable software compo-nent. In VisualAge for Java, all parts createdwith the Visual Composition Editor conformto the JavaBeans component model and arereferred to as beans. See also nonvisual beanand visual bean.
 primitive bean. A basic building block ofother beans. A primitive bean can be rela-tively complex in terms of the function it pro-vides.
 private. In Java, an access modifier associ-ated with a class member. It allows only theclass itself to access the member.
 process. A collection of code, data, and othersystem resources, including at least onethread of execution, that performs a dataprocessing task.
 program. In VisualAge for Java, a termthat refers to both Java applets and applica-tions.
 program element. In VisualAge for Java, aterm referring to any of the entities undersource control. Program elements areprojects, packages, classes, interfaces, ormethods.
 project. In VisualAge for Java, the topmostkind of program element. A project containsJava packages.
 promotion. Within a JavaBean, to makefeatures of a contained bean available to beused for making connections. For example, abean consisting of three push buttons on apanel. If this bean is placed in a frame, thefeatures of the push buttons would have tobe promoted to make them available fromwithin the frame.
 property. An initial setting or characteristicof a bean; for example, a name, font, text, orpositional characteristic.
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 property sheet. In the Visual CompositionEditor, a set of name-value pairs that specifythe initial appearance and other bean char-acteristics.
 property-to-property connection. A con-nection from a property of one bean to aproperty of another bean. See also connec-tion.
 protected. In Java, an access modifier asso-ciated with a class member. It allows theclass itself, subclasses, and all classes in thesame package to access the member.
 protocol. (1) The set of all messages towhich an object will respond. (2) Specifica-tion of the structure and meaning (thesemantics) of messages that are exchangedbetween a client and a server. (3) Computerrules that provide uniform specifications sothat computer hardware and operating sys-tems can communicate.
 prototype. A method declaration or defini-tion that includes the name of the method,the return type and the types of its argu-ments. Contrast with signature.
 RRemote Method Invocation (RMI). InJDK 1.1, the API that enables you to writedistributed Java programs, allowing meth-ods of remote Java objects to be accessedfrom other Java virtual machines.
 repository. In VisualAge for Java, the stor-age area, separate from the workspace, thatcontains all editions (both open and ver-sioned) of all program elements that haveever been in the workspace, including thecurrent editions that are in the workspace.You can add editions of program elements tothe workspace from the repository.
 Repository Explorer. In VisualAge forJava, the window from which you can viewand compare editions of program elementsthat are in the repository.
 resource file. A file that is referred to fromyour Java program. Examples includegraphics and audio files.
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resurrect. Synonymous with deserialize.
 RMI compiler. The compiler that generatesstub and skeleton files that facilitate RMIcommunication. This compiler can be auto-matically invoked from the Tools menu item.
 RMI registry. A server program that allowsremote clients to get a reference to a serverbean.
 SScrapbook. In VisualAge for Java, the win-dow from which you can write and test frag-ments of code, without having to define anencompassing class or method.
 serialize. Synonymous with demarshal.
 signature. The part of a method declarationconsisting of the name of the method and thenumber and types of its arguments. Contrastwith prototype.
 single-byte character set. A set of charac-ters in which each character is representedby a 1- byte code.
 SmartGuide. In IBM software products, aninterface that guides you through perform-ing common tasks.
 sticky. In the Visual Composition Editor, themode that enables an application developerto add multiple beans of the same class (forexample, three push buttons) without goingback and forth between the beans paletteand the free-form surface.
 superclass. See abstract class and baseclass.
 Ttear-off property. A property that a devel-oper has exposed as a variable to work withas though it were a stand-alone bean.
 thread. A unit of execution within a process.
 type. In VisualAge for Java, a generic termfor a class or interface.
 U
 Unicode. A character coding systemdesigned to support the interchange, pro-cessing, and display of the written texts ofthe diverse languages of the modern world.Unicode characters are typically encodedusing 16-bit integral unsigned numbers.
 uniform resource locator (URL). A stan-dard identifier for a resource on the WorldWide Web, used by Web browsers to initiatea connection. The URL includes the commu-nications protocol to use, the name of theserver, and path information identifying theobjects to be retrieved on the server. A URLlooks like this:
 http://www.matisse.net/seminars.html
 or telnet://well.sf.ca.us.br
 or news:new.newusers.question.br
 user interface (UI). (1) The hardware, orsoftware, or both that enables a user tointeract with a computer. (2) The term userinterface typically refers to the visual pre-sentation and its underlying software withwhich a user interacts.
 V
 variable. (1) A storage place within anobject for a data feature. The data feature isan object, such as number or date, stored asan attribute of the containing object. (2) Abean that receives an identity at run time. Avariable by itself contains no data or pro-gram logic; it must be connected such that itreceives run-time identity from a bean else-where in the application.
 versioned edition. An edition that hasbeen versioned and can no longer be modi-fied.
 versioning. The act of making an open edi-tion a versioned edition; that is, making theedition read-only.
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view. (1) A visual bean, such as a window,push button, or entry field. (2) A visual rep-resentation that can display and change theunderlying model objects of an application.Views are both the end result of developingan application and the basic unit of composi-tion of user interfaces. Compare with visualbean. Contrast with model.
 visual bean. In the Visual Composition Edi-tor, a bean that is visible to the end user inthe graphical user interface. Compare withview. Contrast with nonvisual bean.
 visual programming tool. A tool that pro-vides a means for specifying programsgraphically. Application programmers writeapplications by manipulating graphical rep-resentations of components.
 Visual Composition Editor. In VisualAgefor Java, the tool where you can creategraphical user interfaces from prefabricatedbeans and define relationships (connections)between both visual and nonvisual beans.The Visual Composition Editor is a page inthe class browser.
 WWorkbench. In VisualAge for Java, themain window from which you can managethe workspace, create and modify code, andopen browsers and other tools.
 workspace. The work area that contains allthe code you are currently working on (thatis, current editions). The workspace also con-tains the standard Java class libraries andother class libraries.
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Abbreviations
 ANSI American National Standards Institute
 API application programming inter-face
 ATM automated teller machine
 AWT Abstract Windowing Toolkit
 CAE Client Access Enabler
 URL uniform resource locator
 CLI call level interface
 DB2 DATABASE 2
 DBCS double-byte character set
 DBMS database management system
 DLL dynamic link library
 DNS domain name server
 DRDA Distributed Relational Data-base Architecture
 ECD edit-compile-debug
 ECI external call interface
 FTP File Transfer Protocol
 GUI graphical user interface
 HTML Hypertext Markup Language
 HTTP Hypertext Transfer Protocol
 IBM International Business Machines Corporation
 IDE integrated development envi-ronment
 IDL interface definition language
 IIOP Internet inter-ORB protocol
 IMS Information Management Sys-tem
 IOR interoperable object reference
 ITSO International Technical Sup-port Organization
 JAR Java archive
 JDK Java Developer’s Kit
 JNI Java Native Interface
 JVM Java Virtual Machine
 © Copyright IBM Corp. 1998
 LAN local area network
 MOFW managed object framework
 MVS Multiple Virtual Storage
 NLS National Language Support
 NT new technology
 ODBC Open Database Connectivity
 OMG Object Management Group
 OMT object modeling technique
 OO object-oriented
 OOA object-oriented analysis
 OOD object-oriented design
 ORB Object Request Broker
 OS/2 Operating System/2
 OTS object transaction service
 PIN personal identification number
 RAD rapid application development
 RDBMS relational database manage-ment system
 RMI Remote Method Invocation
 SBCS single-byte character set
 SDK Software Developer’s Kit
 SQL structured query language
 TCP/IP Transmission Control Proto-col/Internet Protocol
 TP transaction processing
 UOW unit of work
 URL uniform resource locator
 WWW World Wide Web
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Index
 Symbols.cab files 338.dat File. See interchange files.properties files 300.ser files 255.SHTML files 282Aabstract method feature 74Abstract Windowing Toolkit 100, 101access modifier 6AgentContext 357AgentRunner 356, 359, 365agents 356alternate language bundles 307applet properties
 setting 127Applet Server 261, 266applet tags
 ALIGN 338ALT 338ARCHIVE 338CODE 338CODEBASE 338generated 337HEIGHT 14, 338HSPACE 338NAME 338PARAM NAME 339VSPACE 338WIDTH 14, 338
 Applet Viewer 10, 335applets
 defined 5deploying 335properties 13, 142
 applications
 ATM 49building your first 14deploying 329
 archive 344ATM application
 building 68concepts 49errors 244keyboard support 247model 68object model 51
 ATM modeltesting 95
 attributesdefined 5initialization 84
 Automatic Code Completion 23, 84, 184AWT. See Abstract Windowing ToolkitBbackups 159Bank class
 getCustomer method 94validCard method 94
 BankAccount classaccountType method feature 74creating 72deposit method 75limitExceededEvent 78toString method 80withdraw method 77
 BeanInfo class 57, 66BeanInfo page
 bean information 64concepts 62deleting features 90event features 66Features menu 63method features 65
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property features 65using 63
 beansAtmAccountPanel 225AtmButtonPanel 209AtmController 193AtmNamePanel 210AtmPinPanel 218AtmTransactionPanel 233AtmView 198AtmWelcomePanel 212Bank 94BankAccount 71Checking Account 81DBNavigator 263Keypad 203Select 263Ticker 199
 Beans List 123, 127, 129Beans Palette
 Choose Bean tool 115, 119modifying 115Selection tool 115
 Bookmark Listversioning 173
 business logic 53Ccabinet files 338CAE 260call stack 179Card class
 accounts property 89getAccount method 89pinChecked Event 87
 CheckingAccount classgetAccountType method 85
 Choose Bean toolbean type 194
 404 Programming with VisualAge for Java Version 2
 Class Browser 58BeanInfo Page 62Editions Page 61Hierarchy Page 59Methods Page 58Visual Composition Editor 61, 112
 Class Path 14, 150, 151, 268, 292, 379,380classes
 AgentBase 358, 365AgentContext 358AtmAccountPanel 225AtmButtonPanel 209AtmController 193AtmNamePanel 210AtmPinPanel 218AtmTransactionPanel 233AtmView 198AtmWelcomePanel 212Bank 94BankAccount 71BeanInfo 57Beans 200Bookmark 125BookmarkListController 126, 253BookmarkListServlet 284BookmarkListView 127, 304BookmarkResources 307Calendar 296Card bean 87CheckingAccount 81ChoiceFormat 322, 324Class 150, 261Collator 325Connection 261Customer 91Customizer 56Database 358
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DebugAgentBase 358, 365defined 5Document 358DocumentCollection 359Format 324HiAgain 15HiThere 9HttpServer 292HttpServlet 283HttpServletRequest 281, 290HttpServletResponse 281inner 204InputStream 251Introspector 57JApplet 103JAppletContentPane 128JFrame 103JLabel 310JList 226JScrollPane 226Keypad 203LanguagePanel 310ListResourceBundle 299Locale 296MessageFormat 324NumberFormat 296, 322Object 300ObjectInputStream 251ObjectOutputStream 250OutputStream 250PropertyResourceBundle 299ResourceBundle 298ResultSet 261RuleBasedCollator 325SavingsAccount 86ServletContext 282Session 358Statement 261
 String 176, 325StringBuffer 176System 376Thread 201Ticker 199Transaction 69UniCastRemoteObject 367URL 282Vector 89, 285
 CLASSPATH or CODEBASE 337ClearCase 344Client Application Enabler. See CAECode Assist. See automatic code comple-tionCode Clue. See automatic code comple-tioncode management 153command line arguments 380connections
 code 137event-to-code 137event-to-method 137exceptionOccurred 146manipulating 146names 138parameter 138parameter-from-method 138parameter-from-property 138pass event data 216properties 138property types 146property-to-property 136reordering 230reversing 211tables 221user code sections 232
 Console window 14, 17, 18Customer class
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property features 92testing 93toString method 92
 Customizer class 56DDAT file. See interchange filesData Access beans
 concepts 262Connection alias 265Database Access class 265SQL specification 265
 DB2Applet Server 261JDBC drivers 260NT Security Server 266
 DebuggerBreakpoints page 180caught exceptions 184class trace 189concepts 177conditional breakpoints 182Debug page 177external debug 186opening 182
 debuggingadding breakpoints 180disabling breakpoints 182removing breakpoints 182removing external breakpoints 188
 default package 36deployment
 applets 335applications 329servlets 332supporting code 341
 domain model 53Domino agents 356Domino Go Webserver 333
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 Domino Java Class Libraries 356dynamic HTML 282dynamic HTML pages 283Eeditions
 concepts 154creating 161loading available 162managing 161methods 161open 157replacing 162
 English 313errors
 copying classes 254, 268, 305in the ATM application 244in your code 42
 event featuresBeanInfo page 66
 eventsaction 101creating 88creating a new interface 78event set 66firing 54listener interface 66multicast event 66pinChecked 87property change 54property features 55pseudo 140this 141unicast event 66
 exceptionsMissingResourceException 314NotSerializableException 252ServletException 283UnavailableException 283
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execution stack. See call stack.exporting
 include referenced types 329externalize string 300Ffactory 123features
 Data Access beans 262, 268preferred 206previously promoted 195promotion 195
 field 5fix on save 84flatten 250formatting
 collations 324currencies 323custom number formats 322dates and times 318messages 324numbers 322percentages 323
 free-form surfaceadding beans 220adding beans of the same type 218adding classes and variables 194beans or variables 202
 French 299, 313HHlp.txt 292Hover help 114HTML forms
 ACTION tag 281INPUT tag 281METHOD tag 281
 HTML tagsAPPLET 282FORM 281
 SERVLET 282title 288
 IIBM IDE Utility Class Libraries 375IDE 2, 6, 155IDE utility classes 379inner classes 204insets 376Inspectors
 changing field values 175concepts 173navigating 176opening 174windows 175
 InstallShield 330integrated development environment. SeeIDEinterchange files
 importing and exporting 43interface to external SCM tools
 adding classes 350checking classes in 352checking classes out 351comparing classes 354get the latest version 353launching the SCM tool 353properties 355SCM history 355undoing checkout 352
 interfacesActionListener 207defined 5Externalizable 253KeyListener 207Runnable 199Serializable 250, 254, 366SingleThreadModel 283
 internationalization
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predefined formats 321Internet Explorer. See Microsoft InternetExplorerINTERSOLV 344introspection
 concepts 53Introspector class 57
 Italian 313JJAR files
 importing and exporting 43Java class files
 importing and exporting 43Java code
 importing 43Java foundation classes
 and AWT 101components 102content pane 101JApplet 103JFrame 103lightweight components 101list model 104look and feel 100, 105MVC 104selection model 104
 Java internationalization framework 295Java Servlet Development Kit. See JSDKJava source code
 importing and exporting 43JavaBeans
 customizing 120defined 3deleting features 90event features 54events 54features 54introspection 53
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 method features 56methods 54naming 122nonvisual 113persistence 54portability 53properties 54property editors 92property features 55Property sheet 120specification 53visual 113
 JavaSoft Java Plug-in 337JavaUserClasses statement 357JDBC
 concepts 259DB2 drivers 260drivers 259functionality 261URLs 260
 JSDK 279Kkeywords
 import 36, 43, 255package 36synchronized 287, 290transient 250, 252
 Llayout managers
 BorderLayout 107BoxLayout 108CardLayout 109concepts 106FlowLayout 107GridBagLayout 111GridLayout 110in VisualAge for Java 112OverlayLayout 111
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working with 226Listener Interface
 creating 78locale sensitive 296locales
 concepts 296dynamically changing 313
 look and feel 105Lotus Domino 356Lotus Notes 357Mmessages 6method features
 adding parameters 77BeanInfo page 65
 methodsadding 369compare 325compareTo 325concepts 6createRegistry 371creating 198defaultReadObject 251defaultWriteObject 251destroy 281doGet 281doPost 281editions 161forName 150, 261generating getter and setter 206getAvailableLocales 296, 322, 325getBundle 313getContents 300getCurrencyInstance 323getDateInstance 318getDateTimeInstance 318getDefault 324getObject 314
 getParameter 291, 339handleException 186init 280isDesignTime 200keyPressed 207keyReleased 207main 14, 16, 18, 201NotesMain 358openStream 282readExternal 253readObject 251run 199sendError 283sendList 288service 280setParameter 275setStatus 283toString 324writeExternal 253writeObject 250
 Microsoft Internet Explorer 336Model View Controller. See MVCmultithreading 201, 282MVC 104NNational Language Support. See interna-tionalizationNetscape Communicator 336NLS. See internationalizationnonvisual beans 113Oobject 5object serialization 250ObjectOutputStream class 252object-relational mapping 262ODBC 259options
 appearance 26
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cache 26coding 26design time 27general 26printer 26RMI 27source 26
 Ppackages
 com.ibm.ivj.db.uibeans 263com.ibm.ivj.util.base 375copying 254, 268, 305creating 35default 36defined 6itso.bookmark.applet 253itso.bookmark.nls 307itso.bookmark.rmi 368itso.bookmark.serialized 254, 268,
 305itso.bookmark.servlet 284java.io 250, 255java.lang 376java.rmi 367java.sql 261java.text 296java.util 284, 296, 298javax.servlet 284javax.servlet.http 284lotus.notes 358sun.servlet.http 292
 performancecache 26class trace 189compacting the repository 165
 persistenceconcepts 250through serialization 250
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 ping localhost command 292primary part 58program elements
 deleting 161purging 165restoring 165searching 166version 158versioning 159
 project resources 310projects
 concepts 29default 30naming 156resources 36
 promotion 195properties
 bound 56, 72connecting different types 146constrained 56, 72expert 56hidden 56indexed 56preferred 206tearing off 215this 141
 property change event 54Property Editor 81, 92Property Features 55
 BeanInfo Page 65Property sheet 128ProviderRegKey 345PVCS Version Manager 344QQuick Start 8, 268, 357RRational Software Corporation 344reflection 57
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regedit 345relational databases 249, 259Remote Method Invocation. See RMIremote reference layer 366repository
 compacting 165concepts 154, 156purging program elements 165
 Repository Explorer 164resource bundles
 accessing values 299concepts 298loading 313retrieving resources 314
 resource files 156resurrect 250RMI 365runtime requirements 328SSavingsAccount
 getAccountType method 86minAmount property 86withdraw method 86
 SCC 344SCM 343Scrapbook
 context 22correcting errors 23restarting 25
 scrolling 226searching
 Go To dialog box 166References To and Declarations Of
 166Search Dialog box 166
 Select beanconnection properties 270features 263
 SQL specification 272, 275Selected menu 13Serializable interface 250serialization
 files 255ObjectInputStream 251ObjectOutputStream 250
 serialized objects 282Servlet Runner 291servlets
 concepts 279deploying 332design 282
 SmartGuidesAdd Project 163Bean Icon Information 67Bean Information 83BeanInfo Class 67Create Applet 125Create Class 205, 284, 375Create Field 206defined 8New Event Listener 79New Method Feature 76, 89New Property Feature 83SQL Assist 265
 software components 53software configuration management. SeeSCMSource Code Control interface. See SCCSticky function 120, 210strings
 externalization information 303length of translated 317
 synchronization 287Ttab order 129Taligent 295
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TCP/IP 291team development 155tear-off property 133testing 93, 95, 201threads
 defined 201run method 199Runnable interface 199thread-safe 287
 Tickerconcepts 201
 tool integrationconcepts 375control file 381selection_group 380
 Tools menu 380Transaction class
 creating 69toString method 71
 transient 250UUndo Checkout instead of Checkin 353Vvariable 123, 133, 134version control 153, 157, 165versioning
 ATM model 170versions
 Bookmark List 173concepts 158naming 160
 view 53virtual machine 327visual beans 113Visual Composition Editor 112
 adding beans 119alignment tools 118Beans List 123
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 Beans Palette 114concepts 3, 112connections 136loading the cursor 119Morph Into 220, 257, 268naming beans 122save bean 135toolbar 117visual beans 113
 visual programming 124VisualAge and the external SCM tool 351VisualAge Developers Domain 2VisualAge for Java
 Class Path 150customizing 25Data Access Builder 262database access 262Entry Edition 4example code 154exporting 42, 45features 157importing 42, 43inner class support 204International Edition 301internationalization 300layout managers 112Persistence Builder 263products 1Professional Edition 2projects 29Remote Method Invocation 367updates 5
 VisualAge for Java Enterprise 262VisualAge TeamConnection 344WWeb browser
 Microsoft Internet Explorer 336Netscape Navigator 5
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WebSphere 2, 332windows
 Console 14Options 25
 WorkbenchAll Problems page 40Classes page 30, 38concepts 30Interfaces page 30, 39options 25Packages page 30, 34Projects page 30, 32Source pane 31toolbar 31Unresolved Problems page 30
 Workspace 153, 155
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